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Chapter 1

About ClearPass Policy Manager

The ClearPass Policy Manager platform provides role- and device-based network access control across any wired,
wireless and VPN. Software modules for the ClearPass Policy Manager platform, such as Guest, Onboard, Profile,
OnGuard, QuickConnect, and Insight simplify and automate device configuration, provisioning, profiling, health
checks, and guest access.

With built-in RADIUS, SNMP and TACACS+ protocols, ClearPass Policy Manager provides device registration,
device profiling, endpoint health assessments, and comprehensive reporting to automatically enforce user and endpoint
access policies as devices connect to the network.

Common Tasks in Policy Manager

As you work in Policy Manager, you'll encounter many things that work similarly in different places. For
example, importing or exporting from a list of items. This section explains how to do these common
tasks.

e '"Importing" on page 3

e '"Exporting" on page 4.

Importing

On most pages with lists in ClearPass Policy Manager. you can import the information about one or more
items. That information is stored as an XML file, and this file can be password protected. The tags and
attributes in the XML file are explained in the API Guide.

To import into Policy Manager

1. Click the Import link. The Import from File dialog box appears.

Import from file (<]

Select File: | || Browse.. |

Enter secret for the file {if any): | |

2. Click Browse and select the file you want to import from your hard drive.

The file must be an XML file in the correct format. If you've exported files from different places in Policy Manager,
make sure you're selecting the correct one. The API Guide contains more information about the format and contents
of these XML files.

3. If the file is password protected, enter the password (secret).
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4. Click Import.

On most pages with lists in ClearPass Policy Manager. you can export the information about one or more items. That
information is exported as an XML file, and this file can be password protected. The tags and attributes in the
XML file are explained in the API Guide. You can:

e Export all the items.

e Export one or more items.

To export all the items in a list

1. Click the Export link. The Export to File dialog box appears.

Export to file D

Export file with password

i @
protection: 2 Yes 1 No

Secret Key:

Verify Secret:

2. If you want the file password protected, select Yes and enter a password twice (in the Secret Key and Verify Secret
fields). If you do not want the file passowrd protected, select No.

3. Click Export.

Depending on which browser you use, the file is automatically saved to your hard drive or you are asked to save it,
and you may be asked where.

To export one or more items in a list

1. Select the check box next to the items you want to export.

2. Click the Export button at the bottom of the list.. The Export to File dialog box appears.

Export to file o

Export file with password

! @
protection: ® Yes > No

Secret Key:

Verify Secret:
[ Eport | oo |

3. Ifyou want the file password protected, select Yes and enter a password twice (in the Secret Key and Verify Secret
fields). If you do not want the file passowrd protected, select No.

4. Click Export.

Depending on which browser you use, the file is automatically saved to your hard drive or you are asked to save it,
and you may be asked where.
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Chapter 2

Powering Up and Configuring Policy Manager Hardware

The Policy Manager server requires initial port configuration. Its backpanel contains three ports.

Server Port Overview

Figure 1 Policy Manager Backplane
() o

E—d
A B C

The ports in the figure above are described in the following table:

el =5

Table 1: Device Ports

Key Port Description

A Serial Configures the ClearPass Policy Manager appliance initially, via hardwired
terminal.

B - Management Provides access for cluster administration and appliance maintenance via

eth0 | (gigabit Ethernet) | web access, CLI, or internal cluster communications.
Configuration required.

C- Data (gigabit Provides point of contact for RADIUS, TACACS+, Web Authentication and
eth1 Ethernet) other data-plane requests.

Configuration optional. If not configured, requests redirected to the
management port.
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Server Port Configuration

Before starting the installation, gather the following information that will need, write it in the table below, and keep it
for your records:

Table 2: Required Information

Requirement Value for Your Installation

Hostname) Policy Manager
server)

Management Port IP
Address

Management Port Subnet
Mask

Management Port Gateway

Data Port IP Address Data Port IP Address must not be in the same subnet as the Management
(optional) Port IP Address

Data Port Gateway
(optional)

Data Port Subnet Mask
(optional)

Primary DNS

Secondary DNS

NTP Server (optional)

Perform the following steps to set up the Policy Manager appliance:

1. Connect and power on

Using the null modem cable provided, connect a serial port on the appliance to a terminal, then connect power and
switch on. The appliance immediately becomes available for configuration.

Use the following parameters for the serial port connection:
e Bit Rate: 9600
e Data Bits: 8
e Parity: None
e Stop Bits: 1
e Flow Control: None
2. Login
Later, you will create a unique appliance/cluster administration password. For now, use the following preconfigured
credentials:
login: appadmin
password: eTIPS123
This starts the Policy Manager Configuration Wizard.
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3. Configure the Appliance
Replace the bolded placeholder entries in the following illustration with your local information:
Enter hostname:verne.xyzcompany.com
Enter Management Port IP Address: 192.168.5.10
Enter Management Port Subnet Mask: 255.255.255.0
Enter Management Port Gateway: 192.168.5.1
Enter Data Port IP Address: 192.168.7.55
Enter Data Port Subnet Mask: 255.255.255.0
Enter Data Port Gateway: 192.168.7.1
Enter Primary DNS: 198.168.5.3
Enter Secondary DNS: 192.168.5.1
4. Change your password
Use any string of at least six characters:
New Password:*kxkxkkkkkkkkx
Confirm Password: ****kkxkkkkkk
Going forward, you will use this password for cluster administration and management of the appliance.
5. Change the system date/time
Do you want to configure system date time information [y|n]: y
Please select the date time configuration options.
1) Set date time manually
2) Set date time by configuring NTP servers
Enter the option or press any key to quit: 2
Enter Primary NTP Server: pool.ntp.org
Enter Secondary NTP Server: time.nist.gov
Do you want to configure the timezone? [yln]: y
After the timezone information is entered, you are asked to confirm the selection.
6. Commit or restart the configuration
Follow the prompts:
Proceed with the configuration [y[Y]/n[N]/g[Q]
y[Y] to continue
n[N] to start over again
qlQ] to quit
Enter the choice:Y¥
Successfully configured Policy Manager appliance
KA AR AR A A AR A AR A A AR A AR KA A A KA A A AR A A A AR AR A A A A A AR A AR A AR AR AR A AR Ak kK
* Initial configuration is complete
* Use the new login password to login to the CLI.

* Exiting the CLI session in 2 minutes. Press any key to exit now.

When your Policy Manager system is up and running, navigate to the Administration > Agents and
Software Updates > Software Updates page to view and download any available software updates.
Refer to "Updating the Policy Manager Software " on page 305for more information.

Perform the following to power off the system gracefully without logging in:
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Connect to the CLI from the serial console via the front serial port and enter the following:

login: poweroff
password: poweroff

This procedure gracefully shuts down the appliance.

Administrator passwords in Policy Manager can be reset to factory defaults by logging into the CLI as the apprecovery

user. The password to log in as the apprecovery user is dynamically generated.

Perform the following steps to generate the recovery password:

1.

Connect to the Policy Manager appliance via the front serial port (using any terminal program). See "Server Port
"on page 6 for details.

Configuration
Reboot the system. See the restart command.

When the system restarts, it waits at the following prompt for 10 seconds:
Generate support keys? [y/n]:
Enter ‘y’ at the prompt. The system prompts you with the following choices:

Please select a support key generation option.

1) Generate password recovery key

2) Generate a support key

3) Generate password recovery and support keys

Enter the option or press any key to quit:
To generate the recovery key, select option 1 (or 3, if you want to generate a support key, as well).
Once the password recovery key is generated, email the key to Aruba technical support. A unique password will be
generated from the recovery key and emailed back to you.
Enter the following at the command prompt:
[apprecovery] app reset-passwd
KA AR A AR KR A AR KA A A AR AR KA A AR A AR R A A AR A AR A A AR A AR R A AR A AR A A A A x K
* WARNING: This command will reset the system account *
* passwords to factory default values *
Xk ok kK ok kK kK K ok ok K K ok Kk ok ok Kk ok R ok ok kK o ok Rk ok ok kK kR ko ok kK kK K
Are you sure you want to continue? [y/n]l: y
INFO - Password changed on local node
INFO - System account passwords have been reset to

factory default values

To troubleshoot certain critical system level errors,Aruba technical support might need to log into a support shell.
Perform the following steps to generate a dynamic support password:

1.

Log into the Command Line Interface (CLI) and enter the command: system gen-support-key. See gen-support-
key for details.

Connect to the Policy Manager appliance via the front serial port (using any terminal program). See "Server Port

Configuration " on page 6 for details.
Reboot the system. See the restart command.

When the system restarts it waits at the following prompt for 10 seconds:
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Generate support keys? [y/n]:
Enter ‘y’ at the prompt. The system prompts with the following choices:
Please select a support key generation option.
1) Generate password recovery key
2) Generate a support key
3) Generate password recovery and support keys
Enter the option or press any key to quit:
5. To generate the support key, select option 2 (or 3, if you want to generate a password recovery key, as well).

6. Once the password recovery key is generated, email the key to Aruba technical support. A unique password can
now be generated by Aruba technical support to log into the support shell.
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Chapter 3

Policy Manager Dashboard

The Policy Manager Dashboard menu allows you to display system health and other request related statistics. Policy
Manager comes pre-configured with different dashboard elements. The screen on the right of the dashboard menu is
partitioned into five fixed slots. You can drag and drop any of the dashboard elements into the five slots. The
dashboard elements are listed below:

All Requests
Trend all eTIFS requests

This shows a graph of all requests processed by
Policy Manager over the past week. This includes
RADIUS, TACACS+ and WebAuth requests. The
default data filter “All Requests” is used to plot
this graph. Clicking on each bar in the graph drills
down into the Access Tracker and shows the
requests for that day.

Health Status
+ Trend Healthy and Unhealthy
reguests

This shows a graph of the “Healthy” vs.
“Unhealthy” requests over the past week. Healthy
requests are those requests where the health
state was deemed to be healthy (based on the
posture data sent from the client). Unhealthy
requests are those requests whose health state
was deemed to be quarantined (posture data
received but health status is not compliant) or
unknown (no posture data received). This
includes RADIUS and WebAuth requests. The
default data filters “Health Requests” and
“Unhealthy Requests” are used to plot this graph.
Clicking on each circle on the line graph drills
down into the Access Tracker and shows the
healthy or unhealthy requests for that day.

Authentication Status
Trend Successful and Failed

authentications

This shows a graph of the “Failed” vs.
“Successful” requests over the past week. This
includes RADIUS, WebAuth and TACACS+
requests. The default data filters “Failed
Requests” and “Successful Requests” are used to
plot this graph. Clicking on each circle on the line
graph drills down into the Access Tracker and
shows the failed or successful requests for that
day.

Latest Authentications
Latest Authentications

This shows a table of the last few authentications.
Clicking on a row drills down into the Access
Tracker and shows requests sorted by timestamp
with the latest request showing first.
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,i~ Device Category
Device Categories

This chart shows the graph of all profiled devices
categorized into builtin categories -
Smartdevices, Access Points, Computer, VOIP
phone, Datacenter Appliance, Printer, Physical
Security, Game Console, Routers, Unknown and
Conflict.

Unknown devices are devices that the profiler
was not able to profile.

Conflictindicates a conflictin the categorization
of the device. For example, if the device category
derived from the HTTP User Agent string does not
match with the category derived from DHCP
fingerprinting, a conflictis flagged, and the device
is marked as Conflict.

_;Q Device Family
Device Family

The Device Family widget allows you to drill
down further into each of the built-in device
categories. For example, selecting SmartDevice
shows the different kinds of smartdevices
identified by Profile.

Successful
(2 Authentications
B8 riock the fatest successful

suthentications

This shows a table of the last few successful
authentications. Clicking on a row drills down into
the Access Tracker and shows successful
requests sorted by timestamp with the latest
request showing first.

Failed Authentications
Track the latest failed

suthentications

This shows a table of the last few failed
authentications. Clicking on a row drills down into
the Access Tracker and shows failed requests
sorted by timestamp with the latest request
showing first.

Service Categorization
i Monitor Service Categorization of
:" Q authentications

This shows a bar chart with each bar
representing an Policy Manager service requests
were categorized into. Clicking on a bar drills
down into the Access Tracker and shows the
requests that were categorized into that specific
service.

Alerts
Latest Alerts

This shows a table of last few system level
events. Clicking on a row drills down into the
Event Viewer

12
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Quick Links
Launch configuration
interfaces with a single click

A Quick Links o

{x Start Configuring Policies
1t Manage Services

& Access Tracker

Analysis and Trending

{x Network Devices

i Server Manager

#! ClearPass Guest

@ ClearPass Onboard

Quick Links shows links to common configuration

tasks:

e Start Configuring Policies links to the Start
Here Page under Configuration menu. Start
configuring Policy Manager Services from
here.

o Manage Services links to the Services page
under Configuration menu. Shows a list of
configured services.

o Access Tracker links to the Access Tracker
screen under Reporting & Monitoring menu.

o Analysis & Trending links to the Analysis &
Trending screen under Reporting &
Monitoring menu.

o Network Devices links to the Network Devices
screen under Configuration menu. Configure
network devices from here.

o Server Manager links to the Server
Configuration screen under Administration
menu.

o ClearPass Guest links to the ClearPass Guest
application. This application opens in a new
tab.

o ClearPass Onboard links to the ClearPass
Onboard screen within the ClearPass Guest
application. This application opens in a new
tab.

@_#@ Applications
&7 Launch other ClearPass
Applications

This shows links to the Aruba applications that
are integrated with Policy Manager. E.g.,
GuestConnect, Insight.

S Cluster Status
~ Monitor the status of the
SISEY entire cluster

This shows the status of all nodes in the cluster.

The following fields are shown for each node:

e Status This shows the overall health status of
the system. Green indicates healthy and red
indicates connectivity problems or high CPU
or memory utilization. The status also shows
red when a node is out-of-sync with the rest of
the cluster.

e Host Name Host name and IP address of the
node

e CPU Util Snapshot of the CPU utilization in
percentage

e Mem Util Snapshot of the memory utilization
in percentage

o Server Role Publisher or subscriber

ClearPass Policy Manager 6.1 | User Guide
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Chapter 4

Monitoring

The Policy Manager Monitoring menu provides the following interfaces:

@ Monitoring

-4 Live Monitoring

& Access Tracker

& Accounting

& OnGuard Activity
M Analysis & Trending
M Endpoint Profiler

M System Monitor

& Audit Viewer
& Event Viewer
& Data Filters

Access Tracker

The Access Tracker provides a real-time display of system activity, with optional auto-refresh, at: Monitoring > Live
Monitoring > Access Tracker. Click on Edit to change the Access Tracker display parameters.

Figure 2 Fig: Access Tracker (Edit Mode)

Monitoring & Reporting » Live Monitoring » Access Tracker

Access Tracker jun 1s, 2012 12:45:01 pOT

Select Server:

Select Filter:

etips (10.2.48 217) -

[All Requests] - [ 9P add

Select Date Range: Last 1day ~ before Show Latest

Live Monitoring

"Access Tracker " on page 15
"Accounting" on page 17

"OnGuard Activity " on page 24
"Analysis and Trending" on page 26
"Endpoint Profiler " on page 27
"System Monitor" on page 28

"Audit Viewer" on page 30

"Event Viewer " on page 32

"Data Filters " on page 33

@ Auto Refresh

3 Em

Filter: Type = contains show 10~ records
Server Type A Uuser Service Name Login Date and Time
10.2.48.217 RADIUS animkar Avenda Wireless Service REJECT 2012/06/18 12:07:40
10.2.48.217 RADIUS host/SIC-BHAGYA-VM.a Avenda Wireless Service REJECT 2012/06/18 10:06:21
10.2.48.217 RADIUS host/SIC-BHAGYA-VM.a Avenda Wireless Service REJECT 2012/06/18 10:06:22
10.2.48.217 RADIUS sohag Avenda Wireless Service ACCEPT 2012/06/18 12:10:59
10.2.48.217 RADIUS bhagya Avenda Wireless Service REJECT 2012/06/18 10:08:04
10.2.48.217 RADIUS sfatima@arubanetwork Avenda Wireless Service REJECT 2012/06/18 12:13:10
10.2.48.217 RADIUS cggallego Avenda Wireless Service ACCEPT 2012/06/18 10:11:21
10.2.48.217 RADIUS animkar Avenda Wireless Service ACCEPT 2012/06/18 12:20:29
10.2.48.217 RADIUS animkar Avenda Wireless Service ACCEPT 2012/06/18 10:11:23
10.2.48.217 RADIUS host/S]C-BHAGYA-VM.a Avenda Wireless Service ACCEPT 2012/06/18 10:06:46

Showing 1-10 of more than 10 records B>

Table 3: Access Tracker Display Parameters

Container Description

Select Select server for which to display dashboard data. Select All to display transactions from
Server all nodes in the Policy Manager cluster.

Auto Click to toggle On/Off.

Refresh

ClearPass Policy Manager 6.1 | User Guide
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Container Description

Select Filter Select filter to constrain data display.

E Modify the currently displayed data filter
Go to Data Filters page to create a new data filter.
" Add
Add

Select Date Select the number of days prior to the configured date for which Access Tracker data is to
Range be displayed. Valid number of days is 1 day to a week.

Show Latest Sets the date to Today in the previous step to Today.

Save/Cancel | Save or cancel edit operation

To display a specific set of records, use the simple filter controls. The filter controls enable you to filter by Protocol
Type, User, Service Name, MAC Address, or Status. Note that this filter is applied on top of the display constraints
configured previously (See table above).

Table 4: Access Tracker Simple Filter

Container Description

Filter Select a filter type from the dropdown list: Type, User, Service Name, MAC Address,
Login

contains Enter the string to search for.

Clear Filter Clear the currently applied filter and show all entries.

Show n Show 10, 20, 50 or 100 rows. Once selected, this setting is saved and available in

Records subsequent logins.

Table 5: Access Tracker Session Types

Container Description

RADIUS All RADIUS transactions (802.1X, MAC-Auth, generic RADIUS)

TACACS+ All TACACS+ transactions

WebAuth Web authentication transactions (Dissolvable Agent, OnGuard)

Application All Aruba application authentications (Insight, GuestConnect, EdgeManager)

Viewing Session Details

To view details for a session, click on the row containing any entry. Policy Manager divides the view into multiple
tabs. Depending on the type of authentication - RADIUS, WebAuth, TACACS, Application - the view displays

16
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different tabs.

e Summary - This tab shows a summary view of the transaction, including policies applied.

e Input - This tab shows protocol specific attributes that Policy Manager received in the transaction request; this
includes authentication and posture details (if available). It also shows Compute Attributes, which are attributes
that were derived from the request attributes. All of the attributes can be used in role mapping rules.

e Output - This tab shows the attributes that were sent to the network device and the (posture capable) endpoint.
e Alerts - This tab shows the reason for authentication or authorization failure.

e Accounting - This tab is only available for RADIUS sessions. This shows the RADIUS accounting details for the
session, including reauthentication details.

e Authorizations - This tab is only available for TACACS+ sessions. This shows the commands entered at the
network device, and the authorization status.

e RADIUS CoA - This tab is only available for RADIUS transactions for which a RADIUS Change of Authorization
command was sent to the network device by Policy Manager. The view shows the RADIUS CoA actions sent to
the network device in chronological order.

Table 6: Session Details Popup Actions

Container Description

Change This button allows you to change the access control status of a session. This function is
Status only available for RADIUS and WebAuth.

e Agent- This type of control is available for a session where the endpoint has the
OnGuard Agent installed. Actions allowed are: Bounce, Send Message and tagging the
status of the endpoint as Disabled or Known.

e SNMP - This type of control is available for any session for which Policy Manager has
the switch- and port-level information associated with the MAC address of the endpoint.
Policy Manager bounces the switch port to which the endpointis attached, via SNMP.
Note that, for this type of control, SNMP read and write community strings have to be
configured for the network device; furthermore, Policy Manager must be configured as
an SNMP trap receiver to receive link up/down traps.

o RADIUS CoA - This type of control is available for any session where access was
previously controlled by a RADIUS transaction. Note that the network device must be
RADIUS CoA capable, and RADIUS CoA must be enabled when you configure the
network device in Policy Manager. The actions available depend on the type of device.
The Disconnect (or Terminate Section) action is supported by all devices. Some devices
support setting a session timeout, changing the VLAN for the session, applying an ACL,
etc.

Export Export this transaction and download as a compressed (.zip extension) file. The
compressed file contains the session-specific logs, the policy XML for the transaction,
and a text file containing the Access Tracker session details.

Show Show logs of this session. Error messages are color coded in red. Warning messages are
Logs color coded in orange.

Close RADIUS response attributes sent to the device

The Accounting display provides a dynamic report of accesses (as reported by the network access device by means of
RADIUS/TACACS+ accounting records), at: Monitoring > Live Monitoring > Accounting.
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Figure 3 Accounting (Edit Mode)

Monitoring » Live Monitoring » Accounting
Accounting

Select Server:

| testlab178 (10.2.50.178) [+]
| [All Requests]

Select Filter:

© Select ALL matches @ Select ANY match

| 4 add
Select Date Range: Last | 1week || before E  show Latest

2@

Access Device

Start Time 7

Fier[User  []contains
Fiter: Access Dice _[=]contains

Server Protocol User
10.2.50.178 RADIUS

10.2.50.178 RADIUS au immant
10.2.50.178 RADIUS

10.2.50.178 RADIUS

10.2.50.178 RADIUS " -
10.2.50.178 RADIUS

10.2.50.178 RADIUS

10.2.50.178 RADIUS

10.2.50.178 RADIUS

10.2.50.178 RADIUS

Showing 1-10 of more than 10 records B

10.2.50.197:10
10.2.50.197:10
10.2.50.197:10
10.2.50.197:10
10.2.50.197:10
10.2.50.197:10
10.2.50.197:10
10.2.50.197:10
10.2.50.197:10
10.2.50.197:10

May 16, 2012 17:17:27 PDT
May 16, 2012 17:12:39 PDT
May 16, 2012 17:12:39 PDT
May 16, 2012 17:12:01 PDT
May 16, 2012 17:11:44 PDT
May 16, 2012 17:11:17 PDT
May 16, 2012 17:11:12 PDT
May 16, 2012 17:11:03 PDT
May 16, 2012 16:58:37 PDT
May 16, 2012 16:56:47 PDT

Table 7: Accounting

Container Description

Select Select server for which to display dashboard data.
Server
Select Filter Selectfilter to constrain data display.

Modify@

Modify the currently displayed data filter

9" Add

Add Go to Data Filters page to create a new data filter.

Select Date
Range

Select the number of days prior to the configured date for which Accounting data is to be
displayed. Valid number of days is 1 day to a week.

Show Latest

Sets the date to Today in the previous step to Today.

Save/Cancel Save or cancel edit operation
Show <n> Show 10, 20, 50 or 100 rows. Once selected, this setting is saved and available in
records subsequent logins.

Click on any row to display the corresponding Accounting Record Details.

18
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Figure 4 RADIUS Accounting Record Details (Summary tab)

Accounting Record Details o
Auth Sessions Utilization Details

Session ID: RO0D0D003e-01-49b57348

Account Session ID: 192.168.5.214 11/14/93 08:48:26 01820000
Start Timestamp: Mar 09, 2009 10:51:30 PDT

End Timestamp: Still Active

Status: Active

Username:

Termination Cause: =

Service Type: Framed-User

NAS IP Address: 192.168.5.214:50101
NAS Port Type: Ethernet

Calling Station ID: 00-14-38-1A-74-56
Called Station ID: 00-19-56-ED-43-01

Framed IP Address: =
Account Auth: RADIUS

Figure 5 RADIUS Accounting Record Details (Auth Sessions tab)

Accounting Record Details o

Utilization Details

Number of Authentication Sessions: 3

A1)

Authentication Sessions Details ¢

SessionId Type Time Stamp
RO0ODDD033-01-49b5571f initial Mar 09, 2009 10:51:30 PDT
ROODDD0D37-01-49b56533 re-auth Mar 09, 2009 11:51:35 PDT

ROD0D003e-01-49b57348 re-auth Mar 09, 2009 12:51:38 PDT
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Figure 6 RADIUS Accounting Record Details (Utilization tab)

Accounting Record Details o

Summary Auth Sessions

Details

Active Time: 9027 Sec

Account Delay Time: =

Account Input Octets : 2647001
Account Output Octets : 11540248
Account Input Packets : 14200

Account Output Packets : 37866

Figure 7 RADIUS Accounting Record Details (Details tab)

Accounting Record Details o

Summary Auth Sessions utilization

Tunnel-Private-Group-1d5

For Session Id RO0O00000d-01-49b1b0a5

NAS-Identifier avenda-wapcontroller
Airespace-Wlan-Id 1
Tunnel-Type VLAN

Tunnel-Medium-Type  IEEE-802
Tunnel-Private-Group-1d5

For Session Id RO0O000011-01-49b1be22

NAS-Identifier avenda-wapcontroller
Airespace-Wlan-Id 1
Tunnel-Type VLAN

Tunnel-Medium-Type  IEEE-802
Tunnel-Private-Group-1d5

For Session Id ROD0D00015-01-49b1cbof

NAS-Identifier avenda-wapcontroller

Details

Mar 06, 2009 14:26:49 PST

Mar 06, 2009

at  5:24:21 psT

Mar 06, 2009 15:24:21 PST
Mar 06, 2009 15:24:21 PST
Mar 06, 2009 15:24:21 PST
Mar 06, 2009 15:24:21 PST
Mar 06, 2009 15:24:21 PST

Mar 06, 2009

At 16:21:54 PST

Mar 06, 2009 16:21:54 PST
Mar 06, 2009 16:21:54 PST
Mar 06, 2009 16:21:54 PST
Mar 06, 2009 16:21:54 PST
Mar 06, 2009 16:21:54 PST

Mar 06, 2009

at  47:10:27 psT

Mar 06, 2009 17:19:27 PST

(o

EI@

Table 8: RADIUS Accounting Record Details

Container  Description

Summary Session ID Policy Manager session identifier (you can correlate this record with a record
in Access Tracker)

Session ID

Account A unique ID for this accounting record
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Tab Container  Description
Startand Start and end time of the session
End
Timestamp
Status Current connection status of the session
Username Username associated with this record
Termination | The reason for termination of this session
Cause
Service The value of the standard RADIUS attribute ServiceType
Type
NAS IP IP address of the network device
Address
NAS Port The access method - For example, Ethernet, 802.11 Wireless, etc.
Type
Calling In most use cases supported by Policy Manager this is the MAC address of
Station ID the client
Called MAC Address of the network device
Station ID
Framed IP IP Address of the client (if available)
Address
Account Type of authentication - In this case, RADIUS.
Auth
Auth Session ID Policy Manager session ID
Sessions
Type Initial authentication or a re-authentication
Time Stamp | When the event occurred
Utilization | Active Time How long the session was active
Account How many seconds the network device has been trying to send this record
Delay Time for (subtract from record time stamp to arrive at the time this record was
actually generated by the device)
Account
Input Octets
Octets sent and received from the device port over the course of the session
Account
Output
Octets
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Tab Container  Description

Account
Input
Packets

Account
Output
Packets

session

Packets sent and received from the device port over the course of the

Details

Shows details of RADIUS attributes sent and received from the network
device during the initial authentication and subsequent reauthentications
(each section in the details tab corresponds to a “session” in Policy Manager.

Figure 8 TACACS+ Accounting Record Details (Request tab)

Accounting Record Details o

Auth Sessions Details

Session ID:

User Session ID:
Start Timestamp:
End Timestamp:

User Name:

Client IP :

Remote IP:

Flags:

Privilege Level:
Authentication Method:
Authentication Type:

Authentication Service:

23-2590462887-1236600700
TO0000002-04-49b506f1
Mar 09, 2009 18:39:45 MMT
Mar 09, 2009 18:41:40 MMT
james

192.168.12.27:tty2
192.168.12.101

4

1
AUTHEN_METH_TACACSPLUS
AUTHEN_TYPE_ASCIIL
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Figure 9 TACACS+ Accounting Record Details (Auth Sessions tab)

Accounting Record Details o

Request Details

Number of Authentication Sessions: 5

Authentication Sessions Details @

SessionId Type Time Stamp

11-909277769-1236600585  initial Mar 09, 2009 18:39:45 MMT
13-143960378-1236600597  authz Mar 09, 2009 18:39:57 MMT
17-4035598695-1236600653 authz Mar 09, 2009 18:40:53 MMT
21-2720020714-1236600682 authz Mar 09, 2009 18:41:22 MMT

23-2590462887-1236000700 authz Mar 09, 2009 18:41:40 MMT

Figure 10 TACACS+ Accounting Record Details (Details tab)

Accounting Record Details
Request Auth Sessions

Accounting Packet Details

]

For 11-909277769-1236600585 at Mar 09, 2009 18:39:45 MMT

G}
[

cmd show running-config
priv-hvl 15
service shell

start_time 1236600588
task_id 305

timezone IST
For 13-143960378-1236600597 at Mar 09, 2009 18:39:57 MMT

elapsed_time 110

service shell

start_time 1236600490

task_id 304

timezone IST V]

Table 9: TACACS+ Accounting Record Details

Tab Container Description

Request Session ID Unique ID associated with a request
User Session A session ID that correlates authentication, authorization and accounting
ID records
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Tab

Container

Startand End

Description

Start and end time of the session

Timestamp

Username Username associated with this record

Client IP The IP address and tty of the device interface

Remote IP IP address from which Admin is logged in

Flags Identifier corresponding to start, stop or update accounting record

Privilege Level

Privilege level of administrator: 1 (lowest) to 15 (highest).

Authentication

Method

Authentication

Type

Authentication

Service
Auth Number of Total number of authentications (always 1) and authorizations in this
Sessions | Authentication session

Sessions

Authentication For each request ID, denotes whether it is an authentication or

Session Details | authorization request, and the time at which the request was sent
Details For each authorization request, shows: cmd (command typed), priv-Ivi

(privilege level of the administrator executing the command), service
(shell), etc.

OnGuard Activity

The OnGuard Activity screen shows the realtime status of all endpoints that have Aruba OnGuard persistent or
dissolvable agent, at: Monitoring > Live Monitoring >OnGuard Activity. This screen also presents configuration
tools to bounce an endpoint and to send unicast or broadcast messages to all endpoints running the OnGuard agent.
Note that bouncing of endpoints will only work with endpoints running the persistent agent.

Figure 11 Fig: OnGuard Activity

Monitering & Reporting » Live Monitoring » OnGuard Activity
OnGuard Activity may 16, 2012 17:16:26 pOT

@ Auto Refresh
#* Bounce Client (using SNMP)
@ Broadcast Message

Showing 1-4 of 4

Filter: User  |v]contains Show records
‘ # [ usera Host MAC Host IP Host 0S Status  Date and Time Authentication Records ‘
1.|D jbond 3C-07-54-3D-C9-9F  10.2.50.66 Mac 0S X 10.7.4 e 2012/05/16 17:13:36
2.|D mahesh 68-A8-6D-19-A9-9C  10.2.50.70 Mac 0S X 10.7.4 @ 2012/05/16 14:43:40
3.|D vivek 24-77-03-47-85-18 10.11.8.23 Microsoft Windows 7 @ 2012/05/16 16:32:00
4.|D vivek FO-DE-F1-C1-85-78 10.2.50.63 Microsoft Windows 7 @ 2012/05/16 15:29:28
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Table 10: OnGuard Activity

Container Description

Auto Refresh Toggle auto-refresh. If this is
turned on, all endpoint activities
are refreshed automatically.

Bounce Client (using SNMP) Given the MAC or IP address of
the endpoint, perform a bounce
operation (via SNMP) on the
switch port to which the endpointis
connected. This feature only works
with wired Ethernet switches.

Note that, for this operation to
work:

Client IP or MAC Address:  (02312016c39
Host MAC:

Host IP:

Switch IP Address:

itch : .
Switeh Pors e The network device must be
Description: added to Policy Manager, and
Status: SNMP read and write
Added by: parameters must be
Bounce | (TR configured.

e SNMP traps (link up and/or
MAC notification) have to
enabled on the switch port.

o In order to specify the IP
address of the endpoint to
bounce, the DHCP snooper
service on Policy Manager
must receive DHCP packets
from the endpoint. Refer to
your network device
documentation to find out how
to configure IP helper address.

Broadcast Message Send a message to all active
endpoints
You have selected 2 Agents to be notified
Display Message: Network policy has changed. Your system
will be disassociated from the wireless
network in a few minutes.
Web link for more details (Optional): [ Al el ie R L e e e e ] |
[send
Send Message Send a message to the selected
endpoints.
Bounce Initiate a bounce on the managed

interface on the endpoint.

e Display Message - An optional
message to display on the
endpoint (via the OnGuard
interface).

o Web link - An optional clickable
URL thatis displayed along
with the Display Message.

e Endpoint Status -
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Container Description

No change - No change is

made to the status of the
You have selected 1 Agent to be bounced endpoint. The existing status of
Display Message (Optional): You have not installed required soﬂ_:ware Known, Unknown or Disabled
Dlocked until you take comective sction. continues to be applied.
Please contact help desk after you have Access control is granted or
denied based on the

| »

m

1

taken corrective action.

Web link for more details (Optional): endpoint’s existing status.
Endpoint Status: © No change in status Allow network access - Always
@ Allow network access allow network access. Whitelist
Block network access this endpoint. Note that this

action just sets the status of the

endpointas “Known”. You
need to configure Enforcement
Policy Rules to allow access to
“Known” endpoints.
Block network access - Always
block network access. Blacklist
this endpoint. Note that this
action just sets the status of the
endpoint as “Disabled”. You
need to configure Enforcement
Policy Rules to allow access to
“Disabled” endpoints.
This action results in tags being
created for the specified endpoint
in the Endpoints table
(Configuration > Identity >
Endpoints). One or more of the
following tags are created:
Disabled by, Disabled Reason,
Enabled by, Enabled Reason, Info
URL.

Analysis and Trending
Monitoring > Live Monitoring > Analysis & Trending

The Analysis and Trending Page displays monthly, bi-weekly, weekly, daily, or 12-hourly, 6-hourly, 3-hourly or
hourly quantity of requests for the subset of components included in the selected filters. The data can be aggregated by
minute, hour, day or week. The summary table at the bottom shows the per-filter count for the aggregated data.

Each bar (corresponding to each filter) in the bar graph is clickable. Clicking on the bar drills down into the "Access
Tracker " on page 15, showing session data for that time slice (and for that many requests). Similarly, for a line graph,
clicking on the circle (corresponding to each plotted point in the graph) drills down into Access Tracker.

Figure 12 Analysis and Trending
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Monitoring » Live Monitoring » Analysis & Trending
Analysis & Trending

Last updated at: 2009/03/09 16:29:45 PDT

Requests

5-Mar

Select Sarver:l etips (192.1685.217)

Customize This! JE3] Toggle Chart Type [J[EE4 Add new Data filter

6-Mar 7-Mar
Time

W All Requests i Failed Requests

<]

Update Now!

—Minute

—Hour

—weel

B . { : | . . -
M 2w 1w i 12H &H 3H 1H
Time Scale
Select - Requests/day Requests/day Requests/Sec

RS [Mar-02 to Mar-09] [Mar-09 to now] [Mar-09 to now]
All Requests 343 36 0
Failed Requests 18 3 1]

Aggregate By

To add additional filters, refer to "Data Filters " on page 33.

o Select Server - Select a node from the cluster for which data is to be displayed.

o Update Now- Click on this button to update the display with the latest available data.

e Customize This- Click on this link to customize the display by adding filters (up to a maximum of 4 filters)

o Toggle Chart Type- Click on this link to toggle chart display between line and bar type.
e Add New Data Filter - Click on this to add a new data filter in the global filter list.

Endpoint Profiler

If the Profile license is enabled, a list of the profiled endpoints will be visible in the Endpoints Profiler table. The list
of endpoints you see is based on the Category, OS Family, and Device Name items that you selected. Click on the
Change Selection link to change the selection criteria used to list the devices.

Figure 13 Endpoint Profiler

Monitoring & Reperting » Live Menitoring » Endpoint Profiler

Endpoint Profiler

Change View
Generate Report

41 Total Devices  1(2%) smartdevices 16(39%0) computers

24(599%0) unmanaged Devices

)

Device Category Device Family Device Name
=» 8 »
ClearPass (7)
» »
=S =
change Selection ‘® Mark known @ Mark unknown @ Mark pisabled
‘ MAC Address A Hostname Category 0S Family Status.

00164137582 drone-1341 Computer Windows Unknown
0016cf9bf3es drone-1341 Computer Windows Unknown
00247edde033 SSTRONG-T400-7 Computer Windows Unknown
00271367dces DAVIDF-T400-7 Computer windows Unknown
002713b4b742 33GCM-T4005-7 Computer Wwindows Unknown
047d7b65bbe1 arubausatest-PC Computer Windows Unknown
5cff350bd153 JKOSTELZ-T410S Computer Windows Unknown
648099029620 SHUKO-PC Computer Windows Unknown
74250bc33f50 arubausatest-PC Computer Windows Unknown
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You can view endpoint details about a specific device by clicking on a device in the table below the graphs. Select
the Cancel button to return to the Endpoint Profiler page.

Figure 14 Fig: Endpoint Profiler Details

MAC Address 000c2903c9bf 1P Address 10.2.50.42
Description Hostmame
Status Unknown MAC Vendor WMware, Inc.
Added by Policy Manager Category Unknown
0S Family Unknown
Device Name Unknown
Updated At Apr 19, 2012 15:01:26 PDT

Show Fingerpnnt

The System Monitor is available by navigating to Monitoring > Live Monitoring > System Monitor.

o Select Server- Select a node from the cluster for which data is to be displayed.

e Update Now- Click on this button to update the display with the latest available data.
The System Monitor Page includes two tabs:

e System Monitor. For the selected server, provides load statistics, including CPU, memory, swap memory, physical
disk space, and swap disk space:

Figure 15 System Monitor Graphs
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Monitoring » Live Monitoring » System Monitor

System Monitor

Last updated at: 2009/03/09 17:10:02 PDT Select Server:| efips (192.1685.217) [~
Update Now!
System Monitor Process Monitor
CPU
1
User 0 %
=® System 0 %
10 Wait 0%
Uptime 96 H42m
1642 1644 1646 1648 16:50 1652 1654 1656 16.56 17,00 1702 17.04 17.06 17:08 17.10
Time
< User <OxSystem =10 Wait
Memory
25
20 Ot
15
*® Free Memory 3020300 KB

Total Memory 4031756 KB

1642 1644 1646 16:48 1650 16:52 16:54 1656 1658 17:00 17:02 17:04 17:06 17:08 17:10
Time

Swap Memory
5{ O=—O—Q—O0—0—O0—0—0—0—0—0—0—0—0—0

" Free Swap Memory 1918120 KB
Total Swap Memory 3040212 KB

1646 1648 1650 16:52 16:54 1656 1658 17:00 17:02 17:04 17:06 1708 1710 17:12 1714
Time

< =Swap Memory

Disk - /

/ space - Used 3397604 kB
/ space - Total 110577824 KB

@ Used @ Free

Disk - Swap

Swap space - Used 125022 kB
Swap space - Totalzpgg188 KB

e Process Monitor. For the selected server and process, provides critical usage statistics, including CPU, Virtual
Memory, and Main Memory. Use Select Process to select the process for which you want to see the usage statistics.

Figure 16 Figure Process Monitor Graphs
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System Monitor Prol:ess Monitor

Select Process:

| Policy server

CPU
5
4
3
a
2
1
0

20008 2010 20012 2014 20116 2018 20020 20022 2024 20°26 20128 20330 20032 2034 20136
Time

Virtual Memory
2,000,000

1,500,000
921,000,000
500,000

0

20:08 20:10 20:12 20:14 20:16 20:18 20:20 20:22 20:24 20:26 20:28 20:30 20:32 20:34 20:36 20:38
Time

Main Memory
2,000,000

1,500,000
921,000,000
500,000

0

20:10 20:12 20:14 20:16 20:18 20:20 20:22 20:24 20:26 20:28 20:30 20:32 20:34 20:36 20:38 20:40
Time

Audit Viewer

The Audit Viewer display provides a dynamic report of Actions, filterable by Action, Name and Category (of policy
component), and User, at: Monitoring > Audit Viewer.

Figure 17 Audit Viewer

Monitoring & Reporting » Audit Viewer

Audit Viewer
Fiter: Categayy _[<] contains Show records
# Action Name Category user Timestamp ¥

1] mopiFy ashwath Local User admin 3un 15, 2012 11:53:14 PDT
Z.‘ MODIFY ashwath Local User admin Jun 15, 2012 11:52:33 PDT
3| aop AirGroup Service Radius Enforcement Service santhosh Jun 14, 2012 10:45:18 PDT
4.‘ MODIFY AirGroup Enforcement Enforcement Policy santhosh Jun 14, 2012 10:45:18 PDT
5| MoprFY AirGroup Response RADIUS Enforcement Profile santhosh Jun 14, 2012 10:45:17 POT
5| MopIFY AirGroup Role Sharing RADIUS Enforcement Profile santhosh Jun 14, 2012 10:45:17 PDT
7.‘ MODIFY AirGroup Device Owner RADIUS Enforcement Profile santhosh Jun 14, 2012 10:45:17 PDT
& MopIFY AirGroup User Sharing RADIUS Enforcement Profile santhosh Jun 14, 2012 10:45:17 PDT
g.‘ MODIFY AirGroup Location Sha. RADIUS Enforcement Profile santhosh Jun 14, 2012 10:45:17 PDT
10/ ApD AirGroup Role Mapping Role Mapping Policy santhosh Jun 14, 2012 10:45:17 POT
Showing 1-10 of 2111 B> B

Table 11: Audit Viewer

Container Description

Select Filter Select the filter by which to constrain the display of audit data.
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Container Description

Show <n> Show 10, 20, 50 or 100 rows. Once selected, this setting is saved and available in
records subsequentlogins.

Click on any row to display the corresponding Audit Row Details:

e For Add Actions, a single popup displays, containing the new data.

Figure 18 Audit Row Details (Old Data tab)

Audit Row Details o

Enforcement Policy - Test_enf_Pol

Enforcement Details

Name Test_enf_Pol
Description =
Type RADIUS

Default Profile =

Rules Evaluation Algorithm  evaluate-all

Conditions Enforcement Profiles

(Tips:Role EQUALS Role_Engineer) AND
(Tips:Posture EQUALS HEALTHY (0))
(Tips:Role EQUALS Senior_Mgmt) AND
2. (Tips:Posture GREATER_THAN EMPLOYEE_VLAN
QUARANTINE (20))

(Tips:Role EQUALS eTIPS_Guest) AND
(Date:Day-of-Week BELONGS_TO
Monday, Tuesday, Wednesday,

EMPLOYEE_VLAN

| T

WIRELESS_GUEST_MNETWORK

EIEI

For Modify Actions, a popup with three tabs displays, comparing the old data and the new.
Figure 19 Audit Row Details (Old Data tab)

Audit Row Details o

Old Data New Data Inline Difference

Service Log Configuration - Radius server

Log Configuration

Node IP 192.168.5.96
Service Radius server

Can override default log level true

Syslog support false
Maodules
Module Name Log Level
1. Radius Server INFO
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Figure 20 Audit Row Details (New Data tab)

Audit Row Details o

Old Data Inline Difference

Service Log Configuration - Radius server

Log Configuration

Node IP 192.168.5.96
Service Radius server

Can override default log level true

Syslog support false
Module Name Log Level
1. Radius Server DEBUG

Figure 21 Audit Row Details (Inline Difference tab)

Audit Row Details 0

Old Data New Data
Module Name Log Level
. NFS
1. Radius Server DEBUG
Modified Added [l Deleted 4+ Movedup ¥ Moved down

For Remove Actions, a popup displays the removed data.

The Event Viewer display provides a dynamic report of system level (not request-related) Events, filterable by Source,
Level, Category, and Action, at: Monitoring > Event Viewer.

Figure 22 Event Viewer

Monitoring & Reporting » Event Viewer

Event Viewer

Select Server| etips (10.248.217)

Fitter Source lcontains Show (10 [] records

#  Source Level category Action Timestamp ¥
1] Admin ur INFO Logged in None Jun 18, 2012 11:37:38 PDT
2| Admin ur mFo Logged in None Jun 18, 2012 11:33:03 PDT
2 Admin ur NFo Logged out None Jun 18, 2012 11:33:03 PDT
4| Admin ur INFO Logged in None Jun 18, 2012 11:05:28 PDT
5| Clearpass Updater NFO AV/AS Updates Success  Jun 18, 2012 11:03:01 POT
& Admin ur NFo Logged in None Jun 18, 2012 10:58:39 PDT
7 Admin ur INFO Logged in None Jun 18, 2012 10:32:51 PDT
8| Clearpass Updater mFo AV/AS Updates Success  Jun 18, 2012 10:03:02 PDT
o Admin ur NFo Logged in None Jun 18, 2012 09:49:39 PDT
10/ ClearPass Updater INFO AV/AS Updates Success Jun 18, 2012 09:03:02 PDT
Showing 1-10 of 1191 B> Bf
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Table 12: Event Viewer

Container Description

Select Server Select the server for which to display accounting data.

Filter Select the filter by which to constrain the display of accounting data.

Show <n> Show 10, 20, 50 or 100 rows. Once selected, this setting is saved and available in
records subsequent logins.

Click on any row to display the corresponding System Event Details.

Figure 23 System Event Details

System Event Details ©

Source RADIUS
Level INFO
Category Authentication
Action MNone
Timestamp Mar 10, 2009 02:24:48 PDT
Description Created EAP-FAST master keys for this
server.
[ Close

Data Filters

The Data Filters provide a way to filter data (limit the number of rows of data shown by defining custom criteria or
rules) that is shown in "Access Tracker " on page 15, "Syslog Export Filters " on page 277, "Analysis and Trending" on
page 26, and "Accounting" on page 17 components in Policy Manager. It is available at: Monitoring> Data Filters.

Figure 24 Data Filters

Monitoring » Data Filters

Data Filters T Add Filter
& Import Fiters
&, Export Filters
Fiter:[Name  [~]contains Show records
# M Name A Description
1.|[E [All Requests] All session log requests
2@ [ClearPass Application Requests] All Application session log requests
3.|@ [Failed Requests] All Failed session log requests
4.|@ [Guest Access Requests] All Healthy session log requests
5.|O [Healthy Requests] All Healthy session log requests
6.0 [RADIUS Requests] All RADIUS requests
7.|@3 [Successful Requests] All Successful session log requests
g.|@ [TACACS Requests] All TACACS requests
9.|d [Unhealthy Requests] All Unhealthy session log requests
10.|0 [webauth Requests] All webauth Requests
Showing 1-10 of 10 Copy | Export | Delete

Policy Manager comes pre-configured with the following data filters:

e All Requests - Shows all requests (without any rows filtered)

e ClearPass Application Requests - All Application session log requests

o Failed Requests - All authentication requests that were rejected or failed due to some reason; includes RADIUS,

TACACS+ and Web Authentication results.
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e Guest Access Requests - All requests - RADIUS or Web Authentication - where the user was assigned the built-in
role called Guest.

e Healthy Requests - All requests that were deemed healthy per policy
e RADIUS Requests - All RADIUS requests

o Successful Requests - All authentication requests that were successful.
o TACACS Requests - All TACACS requests

e Unhealthy Requests - All requests that were not deemed healthy per policy.

o WebAuth Requests - All Web Authentication requests (requests originated from the Aruba Guest Portal).

Table 13: Data Filters

Container Description
Add Filter Click to open the Add Filter wizard.
Import Filters Click to open the Import Filters popup.

Export Filters

Click to open the Export Filters popup. This exports all configured filters.

Copy Copy the selected filters.
Export Click to open the Export popup to export selected reports
Delete Click to delete the selected filters.

Add a Filter

To add a filter, configure its name and description in the Filter tab and its rules in the Rules tab.

Figure 25 Add Filter (Filtertab)

Data Filters

Monitoring » Data Filters » Add

Rules Summary

Name:

Description:

Configuration Type:
Custom SQL:

( Back to Data Filters

| All RADIUS Requests

Filter for all RADIUS requastsl

© Specify Custom SQL @ Select Attributes

34
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Table 14: Add Filter (Filter tab)

Container Description

Name Name and description of the filter (freeform).
Description
Configuration Choose one of the following configuration types:

Type o Specify Custom SQL - Selecting this option allows you to specify a custom SQL entry
for the filter. If this is specified, then the Rules tab disappears, and a SQL template
displays in the Custom SQL field. Note that selecting this option is not recommended.
For users who need to utilize this, however, we recommend contacting Support.

o Select Attributes - This option is selected by default and enables the Rules tab. If this
option is selected, use the Rules tab to configure rules for this filter.

Custom SQL If Specify Custom SQL is selected, then this field populates with a default SQL template.
In the text entry field, enter attributes for the type, attribute name, and attribute value.
NOTE: We recommend that users who choose this method contact Support. Support can
assist you with entering the correct information in this template.

The Rules tab displays only when Select Attributes is selected on the Filter tab.
Figure 26 Add Filter (Rules tab)

Monitoring » Data Filters » Add

Data Filters

Filter m Summary

Rules Evaluation Algorithm: @ Select ANY match © Select ALL matches

Data Filter Conditions:
Conditions

1.‘( Common:Source EQUALS RADIUS )

Add Rule

Table 15: Add Filter (Rules tab)

Container Description

Rule Evaluation Select first match is a logical OR operation of all the rules. Select all matches is a
Algorithm logical AND operation of all the rules.

Add Rule Add a rule to the filter

Move Up/Down Change the ordering of rules.

EdivRemove Edit or remove a rule.

Rule

Save Save this filter

Cancel Cancel edit operation

When you click on Add Rule or Edit Rule, the Data Filter Rules Editor displays.

ClearPass Policy Manager 6.1 | User Guide

35



Figure 27 Add Filter (Rules tab) - Rules Editor

Dashboard Filters o

Matches @ ANY or ) ALL of the following conditions:
Type

Name Operator Value

1.“

i
I=| @ @

2_‘ Common
RADIUS
TACACS
WEBAUTH

Save | Cancel

Table 16: Add Filter (Rules tab) - Rules Editor

Container Description

Matches ANY matches one of the configured conditions.

ALL indicates to match all of the configured conditions.

Type This indicates the namespace for the attribute.

e Common - These are attributes common to RADIUS, TACACS, and WebAuth requests
and responses

o RADIUS - Attributes associated with RADIUS authentication and accounting requests
and responses

o TACACS - Attributes associated with TACACS authentication, accounting, and policy
requests and responses

e Web Authentication Policy - Policy Manager policy objects assigned after evaluation of
policies associated with Web Authentication requests. Example: Auth Method, Auth
Source, Enforcement Profiles

Name Name of the attributes corresponding to the selected namespace (Type)

Operator A subset of string data type operators (EQUALS, NOT_EQUALS, LESS_THAN, LESS_
THAN_OR_EQUALS, GREATER_THAN, GREATER_THAN_OR_EQUALS, CONTAINS,
NOT_CONTAINS, EXISTS, NOT_EXISTS)

Value The value of the attribute

36
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Chapter 5

Policy Manager Policy Model

From the point of view of network devices or other entities that need authentication and authorization services, Policy
Manager appears as a RADIUS, TACACS+ or HTTP/S based Authentication server; however, its rich and extensible
policy model allows it to broker security functions across a range of existing network infrastructure, identity stores,
health/posture services and client technologies within the Enterprise.

Refer to the following topics for additional information.

e "Services Paradigm" on page 37

m  "Viewing Existing Services " on page 39

m "Adding and Removing Services " on page 40

m  '"Links to Use Cases and Configuration Instructions " on page 41
e '"Policy Simulation" on page 42

m  "Add Simulation Test" on page 43

= "Import and Exporting Simulations " on page 48

Services Paradigm
Services are the highest level element in the Policy Manager policy model. They have two purposes:

e Unique Categorization Rules (per Service) enable Policy Manager to test Access Requests (“Requests”) against
available Services to provide robust differentiation of requests by access method, location, or other network vendor-
specific attributes.

Policy Manager ships configured with a number of basic Service types. You can flesh out these Service types, copy
them for use as templates, import other Service types from another implementation (from which you have previously
exported them), or develop new Services from scratch

e By wrapping a specific set of Policy Components, a Service can coordinate the flow of a request, from
authentication, to role and health evaluation, to determination of enforcement parameters for network access.

The following image illustrates and describe the basic Policy Manager flow of control and its underlying architecture.

ClearPass Policy Manager 6.1 | User Guide 37



Figure 28 Generic Policy Manager Service Flow of Control

Switch sends network e B
access request to eTIPS asslgns matduwng Servica
A l
ﬂ Paolicy Manager initiates authentication

handshake; negotiates Authentication
Method

.

B Folicy Manager initiates authentication against
Authentication Source

C s [ [ ¥ D-E'F

Palicy Manager reads atiributes from Palicy Manager evaluates internal posiure
configured Authorization Sources; policy, brokers health request to external
applies Role Mapping Policy posture server; applies Posture Policy
{rules for role mapping) (mnalysis of client health)
| T
Role or Roles returned from Sysfam Postura Token refumed
the role mapping policy from various health evaluations

System
L Roes)  Postre — |

Tiken
Tirme or Day ¢

of Week! Policy Manager applies Enforcement Policy

— Other ——p| (rules for mapping Role, Posture and system G
Adtributes. time to Enforcement Profiles)

Parameters for the session to the switch

Access f{_llcy Manager sends Enforcement Profile atlnbu5 H

Table 17: Policy Manager Service Components

Service:
Component  component Description

ratio
A- Zero or more EAP or non-EAP method for client authentication.
Authentication | per service Policy Manager supports four broad classes of authentication
Method methods:

o EAP, tunneled: PEAP, EAP-FAST, or EAP-TTLS.

o EAP, non-tunneled: EAP-TLS or EAP-MD5.

o Non-EAP, non-tunneled: CHAP, MS-CHAP, PAP, or [MAC AUTH].
[MAC AUTH] must be used exclusively in a MAC-based
Authentication Service. When the [MAC AUTH] method is selected,
Policy Manager: (1) makes internal checks to verify that the
request is indeed a MAC Authentication request (and not a
spoofed request) and (2) makes sure that the MAC address of the
device is present in the authentication source.

Some Services (for example, TACACS+) contain internal

authentication methods; in such cases, Policy Manager does not

make this tab available.

B- Zero or more An Authentication Source is the identity repository against which
Authentication | per service Policy Manager verifies identity. It supports these Authentication
Source Source types:

e Microsoft Active Directory

any LDAP compliant directory

RSA or other RADIUS-based token servers

SQL database, including the local user store.

Static Host Lists, in the case of MAC-based Authentication of
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Service:

Component  component Description
ratio
managed devices.
C- One or more An Authorization Source collects attributes for use in Role
Authorization per . . .
_— Mapping Rules. You specify the attributes you want to collect
Source Authentication ppmng Ku u specity o utes you w ]
Source and when you configure the authentication source. Policy Manager
zero or more supports the following authorization source types:
per service ) . .

e Microsoft Active Directory

e any LDAP compliant directory

o RSA orother RADIUS-based token servers

e SQL database, including the local user store.

C-Role Zero orone Policy Manager evaluates Requests against Role Mapping Policy

Mapping per service rules to match Clients to Role(s). All rules are evaluated and Policy

Policy Manager may return more than one Role. If no rules match, the
request takes the configured Default Role.

Some Services (for example, MAC-based Authentication) may handle

role mapping differently:

e For MAC-based Authentication Services, where role information is
not available from an authentication source, an Audit Server can
determine role by applying post-audit rules against the client
attributes gathered during the audit.

D - Internal Zero or more An Internal Posture Policy tests Requests against internal Posture

Posture per service rules to assess health. Posture rule conditions can contain attributes

Policies presentin vendor-specific posture dictionaries.

E - Posture Zero or more Posture servers evaluate client health based on specified vendor-

Servers per service specific posture credentials, typically posture credentials that cannot
be evaluated internally by Policy Manager (that is, not by internal
posture policies).

Currently, Policy Manager supports two forms of posture server

interfaces: RADIUS, and GAMEVZ2 posture servers.

F - Audit Zero or more Audit servers evaluate the health of clients that do not have an

Servers per service installed agent, or which cannot respond to Policy Manager
interactions. Audit servers typically operate in lieu of authentication
methods, authentication sources, internal posture policies and
posture server.

In addition to returning posture tokens, Audit Servers can contain

post-audit rules that map results from the auditinto Roles.

G- One per Policy Manager tests Posture Tokens, Roles, system time and other

Enforcement service contextual attributes against Enforcement Policy rules to return one or

Policy (mandatory) more matching Enforcement Policy Profiles (that define scope of
access for the client).

H- One or more Enforcement Policy Profiles contain attributes that define a client’s

Enforcement per service scope of access for the session. Policy Manager returns these

Profile Enforcement Profile attributes to the switch.

Viewing Existing Services

You can view all configured services in a list or drill down into individual services:
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e View and manipulate the list of current services.

In the menu panel, click Services to view a list of services that you can filter by phrase or sort by order.

Figure 29 List of services with sorting tool

Roles Posture Audit

Enforcement

Name: WIRELESS_SERVICE

Description: 802.1x Wireless service

[ Enable to meniter netwerk access control without enforcement
802.1x Wireless

Status: Enabled

Service Categorization Rule

Matches O ANY or &) ALL of the following conditions:

Monitor Mode:
Type:

Type Name Operator
l.lRadius:IETF NAS-Port-Type EQUALS
2.|Radius:IETF Service-Type BELONGS_TC

3./ Click to add...

Value
Wireless-802.11 (19) L

Login-User (1), Framed-User &
(2], Authenticate-Cnly (8)

e Drill down to view details for an individual service.

In the Services page, click the name of a Service to display its details.

Figure 30 Details for an individual service

m Service Authentication Roles Posture Audit Enforcement
Service: »,
MName: DOT1X_WIRED_SERVICE
Description: 802.1x Wired service
Monitor Mode: Disabled
Type: 802.1x Wired
Status: Enabled
Service Categorization Rule
Match ALL of the following conditions:
Type Name Operator Value
1.‘Rad\us:IETF NAS-Part-Type EQUALS Ethernet (15)
. it Ty Login-User (1), Framed-User
2.‘Rad\us‘IETF Service-Type BELONGS_TO (2), Authenticate-Only (3)
Authentication:
Methods: eTIPS_MSCHAP[MSCHAP]
Sources: eTIPS_Local_User_Repository[Local]
Strip Username Rules: -
O fiackto Services | Disatlo | Copy | Sove |

Adding and Removing Services

You can add to the list of services by working from a copy, importing from another configuration, or creating a service

from scratch:

o Create a template by copying an existing service.

In the Services page, click a service’s check box, then click Copy.

e Clone a service by import (of a previously exported named file from this or another configuration).

In the Services page, click a service’s check box, then click the Export a Service link and provide the output
filepath. Later, you can import this service by clicking Import a Service and providing the filepath.

o Create a new service that you will configure from scratch.

In the Services page, click Add a Service, then follow the configuration wizard from component to component by

clicking Next as you complete each tab.

e Remove a service.

In the Services page, fill the check box for a service, then click the Delete button. You can also disable/enable a
service from the service detail page by clicking Disable/Enable (lower right of page).

40
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Figure 31 Disable/Enable toggle for a Policy Manager Service

KD Back to Services

KD Back to Services

[Dssoe | com | swe ] coca |

Links to Use Cases and Configuration Instructions

For each of a Service’s policy components that you can configure, the following table references an illustrative Use
Case and detailed Configuration Instructions.

Table 18: Policy Component Use Cases and Configuration Instructions

Policy Component

lllustrative Use Cases

Configuration
Instructions

Service

"802.1x Wireless Use Case" on page 55
e "Aruba Web Based Authentication Use
Case "on page 63.
e "MAC Authentication Use Case " on page
69.

e "TACACS+ Use Case"on page 73.

"Adding Services " on
page 103

Authentication Method

"802.1x Wireless Use Case" on page 55
demonstrates the principle of multiple
authentication methods in a list. When Policy
Manager initiates the authentication
handshake, it tests the methods in priority
order until one is accepted by the client.
"Aruba Web Based Authentication Use Case "
on page 63 has only a single authentication
method, which is specifically designed for
authentication of the request attributes
received from the Aruba Web Portal.

"Adding and Modifying
Authentication Methods"
on page 111

Authentication Source

e "802.1x Wireless Use Case" on page 55
demonstrates the principle of multiple
authentication sources in a list. Policy
Manager tests the sources in priority order
until the client can be authenticated. In this
case Active Directory is listed first.

e "Aruba Web Based Authentication Use
Case "on page 63 uses the local Policy
Manager repository, as this is common
practice among administrators configuring
Guest Users.

e "MAC Authentication Use Case " on page
69 uses a Static Host List for authentication
of the MAC address sent by the switch as
the device’s username.

e "TACACS+ Use Case" on page 73 uses the

local Policy Manager repository. Other
authentication sources would also be fine.

"Adding and Modifying
Authentication Sources "
on page 128

Role Mapping

"802.1x Wireless Use Case" on page 55 has
an explicit Role Mapping Policy that tests
request attributes against a set of rules to
assign a role.

e "Adding and
Modifying Role
Mapping Policies " on
page 157

e "Adding and
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Policy Component

lllustrative Use Cases

Configuration
Instructions

Modifying Roles " on
page 160

e "Adding and
Modifying Local
Users "on page 161

e "Adding and
Modifying Guest
Users " on page 162

e "Adding and
Modifying Static Host
Lists " on page 167

Posture Policy

"Aruba Web Based Authentication Use Case "
on page 63 uses an internal posture policy that
evaluates the health of the originating client,
based on attributes submitted with the request
by the Aruba Web Portal, and returns a
corresponding posture token.

"Adding and Modifying
Posture Policies "on
page 171

Posture Server

"802.1x Wireless Use Case" on page 55
appends a third-party posture server to
evaluate health policies based on vendor-
specific posture credentials.

"Adding and Modifying
Posture Servers " on
page 197

Audit Server

"MAC Authentication Use Case " on page 69,
uses an Audit Server to provide port scanning
for health.

"Configuring Audit
Servers" on page 199

All Use Cases have an assigned Enforcement

e "Configuring

Enforcement Policy and

Profiles Enforcement Profiles "
on page 210

e "Configuring
Enforcement Policies
"on page 221

Policy and corresponding Enforcement Rules.

Policy Simulation

Once the policies have been set up, the Policy Simulation utility can be used to evaluate these policies - before
deployment. The Policy Simulation utility applies a set of request parameters as input against a given policy
component and displays the outcome, at: Configuration > Policy Simulation.

The following types of simulations are supported:

e Service Categorization - A service categorization simulation allows you to specify a set of attributes in the
RADIUS or Connection namespace and test which configured service the request will be categorized into. The
request attributes that you specify represent the attributes sent in the simulated request.

e Role Mapping - Given the service name (and associated role mapping policy), the authentication source and the
user name, the role mapping simulation maps the user into a role or set of roles. You can also use the role mapping
simulation to test whether the specified authentication source is reachable.

o Posture Validation - A posture validation simulation allows you to specify a set of posture attributes in the posture
namespace and test the posture status of the request. The posture attributes that you specify represent the attributes
sent in the simulated request.
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e Audit - An audit simulation allows you to specify an audit server (Nessus- or NMAP-based) and the IP address of
the device you want to audit. An audit simulation triggers an audit on the specified device and displays the results.

o Enforcement Poli

cy - Given the service name (and the associated enforcement policy), a role or a set of roles, the

system posture status, and an optional date and time, the enforcement policy simulation evaluates the rules in the
enforcement policy and displays the resulting enforcement profiles and their contents.

e Chained Simulation - Given the service name, authentication source, user name, and an optional date and time, the
chained simulation combines the results of role mapping, posture validation and enforcement policy simulations
and displays the corresponding results.

Figure 32 Policy Simulation

Configuration » Policy Simulation
Policy Simulation

Filter: Mame + contains

# Name 4

= Add Simulation Test
& Import Simulations
& Export Simulations

Clear Filter Show 10 = records

Type Description

Audit HP Laser Jet Printer
1P Phone Audit
Local user role mapping simulation

RMP Te:

oooooiE

1
2
3.
a
5 Role mapping simulation

Showing 1-5 of 5

Audit Printer Network Port Scan
Audit 1P Phone Network Port Scan
Role Mapping This is a local user role mapping simulation test

Role Mapping

Role Mapping This is a role mapping policy simulation

Table 19: Policy Simulation

Container Description

Add Simulation Opens the Add Simulation Test page.

Test

Import Opens the Import Simulations popup.

Simulations

Export Opens the Export Simulations popup.

Simulations

Filter Select the filter by which to constrain the display of simulation data.

Copy Make a copy the selected policy simulation. The copied simulation is renamed with a
prefix of Copy_Of_.

Export Opens the Export popup.

Delete Click to delete a selected (check box on left) Policy Simulation.

Add Simulation

Test

Navigate to Configuration > Policy Simulation and click on the Add Simulation link. Depending on the simulation

type selected the cont

ents of the Simulation tab changes.

Table 20: Add Policy Simulation (Simulation Tab)

Container

Description

Name/Description

Specify name and description (freeform).
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Container Description

Type
Service
Categorization.

Input (Simulation tab): Select Date and Time. (optional - use if you have time
based service rules)

Attributes Results

Name: | Service Categorization
Description: Service Categorization Simulation Test
Type: | Service Categorization [+]

October, 2012
Simulation Details

Test Date and Time: 2012/10/15 13:23.00 wk [Sun Mon Tue Wed Thu Fri Sat

39 1 2 3 4 5 6
40 7 8 9 10 11 12 13
41( 14 EI 16 17 18 19 20
42| 21 22 23 24 25 26 27
43| 28 29 30 31

Time: @@
Mon, Oct 15
e Input (Attributes tab): Use the Rules Editor to create a request with the attributes
you want to test. All namespaces relevant to service rules creation are loaded in
the Attributes editor.
o Returns (Results tab): Service Name (or status message in case of no match)
Type e Input (Simulation tab): Select Service (Role Mapping Policy is implicitly selected,
Role Mapping. because there is only one such policy associated with a service), Authentication
Source, User Name, and Date/Time.
Attributes Results
MName: |Role Mapping Simulation Test
Description: Role Mapping RADIUS Simulation
Type: Role Mapping [=]
Simulation Details
Service: | Radius Service El
Role Mapping Policy: =
Authentication Source: | Amigopod AD El
Username: | gabriel |
Test Date and Time: |2012/10/15 13:00:33 |
e Input (Attributes tab): Use the Rules Editor to create a request with the attributes
you want to test. All namespaces relevant for role mapping policies are loaded in
the attributes editor.
o Returns (Results tab): Role(s) - including authorization source attributes fetched
as roles.
Type e Input (Simulation tab): Select Service (Posture policies are implicitly selected by
Posture their association with the service).
Validation.
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Container Description

Attributes Results

Name: |Role Mapping Simulation Test |
Description: Role Mapping Posture Validation Simulation
Type: | Posture Validation [=]

Simulation Details

Service: | [Policy Manager Admin Network Login Service*Zl

e Input (Attributes tab): Use the Rules Editor to create a request with the attributes
you want to test. All namespaces relevant to posture evaluation (posture
dictionaries) are loaded in the attributes editor.

o Returns (Results tab): System Posture Status and Status Messages.

Type e Input (Simulation tab): Select the Audit Server and host to be Audited (IP address
Audit. or hostname)
ot

Name: | Test Audit Simulation

Description: Audit Simulation

Type: Audit [=]

Simulation Details

Audit Server: | [Mmap Audit] El

Audit Host TP Address: [192.168.34.32 |

o Returns (Results tab): Summary Posture Status, Audit Attributes and Status
NOTE: Note: Audit simulations can take a while; an AuditinProgress status is shown
until the audit completes.

Type e Input (Simulation tab): Select Service (Enforcement Policy is implicit by its
Enforcement association with the Service), Authentication Source (optional), User Name
Policy. (optional), Roles, Dynamic Roles (optional), System Posture Status, and

Date/Time (optional).
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Container Description

Results

Name:

Description:

Type:

Service:

Enforcement Policy:
Authentication Source:
Username:

Roles:

Dynamic Roles:

System Posture Status:

Test Date and Time:

Simulation Details

| Test Enforcement Policy

Enforcement Policy Simulation

| Enforcement Policy El

| [Policy Manager Admin Network Login Service*Zl

[Admin Network Login Policy]

| gabriel |
[Contractor] -

[Employee] =]

[Guest]

[Machine Authenticated]

[Other] -

| HEALTHY (0) [=]
[2012/10/08 13:46:29 |

o Input (Attributes tab): Use the Rules Editor to create a request with the attributes
you want to test. Connection and RADIUS namespaces are loaded in the

attributes editor.

o Returns (Results tab): Enforcement Profile(s) and the attributes sent to the

device.

NOTE: Authentication Source and User Name inputs are used to derive dynamic

values in the enforceme
inputs are optional.

NOTE: Dynamic Roles are attributes (that are enabled as a role) fetched from the

authorization source. Fo

"Generic LDAP or Active Directory " on page 129for more information.

nt profile that are fetched from authorization source. These

r an example of enabling attributes as a role, refer to

Type
Chained
Simulations.

e Input (Simulation tab): Select Service, Authentication Source, User Name, and

Date/Time.
Attributes Results
Name: | Test Chained Simulation
Description: Chained Simulation
Type: Chained Simulation [=]

Simulation Details

Service:
Authentication Source:
Username:

Test Date and Time:

‘ [Guest Operator Logins] El
‘ [Admin User Repository] El
| gabriel |
12012/10/08 13:57.08 |

o Input (Attributes tab): Use the Rules Editor to create a request with the attributes

you want to test. All n
context are loaded in

amespaces that are relevant in the Role Mapping Policy
the attributes editor.
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Container Description

o Returns (Results tab): Role(s), Post Status, Enforcement Profiles and Status
Messages.
Test Date/Time Use the calendar widget to specify date and time for simulation test.
Next Upon completion of your work in this tab, click Next to open the Attributes tab.
Start Test Run test. Outcome is displayed in the Results tab.
Save/Cancel Click Save to commit or Cancel to dismiss the popup.

In the Attributes tab, enter the attributes of the policy component to be tested. The namespaces loaded in the Type

column depend on the type of simulation (See above).

The Attributes tab will not display if you select the Audit Policy component in the Simulation tab.

Figure 33 Add Simulation (Attributes Tab)

Simulation n!ﬁ mg Results

Radius:Clavister
Radius: Cisco-VPN3000
Radius:Acc
Radius:Tropos
Radius:Cisco

Mare choices

( Back to Policy Simulation

Type Name Value i
1.|Connection Protocol = RADIUS i
2.|Radius:II:_|'F NAS-IP-Address = 192.168.5.233 i
3.|| =] © @
4_| Device

Host

LocallUser

Guestlser

Certificate

Authentication

Connection

Radius:IETF

In the Results tab, Policy Manager displays the outcome of applying the test request parameters against the specified
policy component(s). What is shown in the results tab again depends on the type of simulation.
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Figure 34 Add Simulation (Results Tab)

Simulation
Summary -

Audit Status AuditComplete
System Posture Status HEALTHY (0)
Audit Timeout 600 seconds

Audit Attributes -
Avenda:Audit: Audit-Status  AUDIT_SUCCESS

Avenda:Audit:Device-Type  print server
Avenda:Audit:Mac-Vendor  Hewlett-packard
Avenda:Audit:Network-Apps  ftp, http, http-mgmt, printer, ipp,
Avenda:Audit:0S-Info HP JetDirect J3110A print server
Avenda:Audit:Open-Ports 21, 80, 280, 515, 631,
Avenda:Audit:Output-Msgs

< Back to Policy Simulation Start Test

Import and Exporting Simulations
Import Simulations
Navigate to Configuration > Policy Simulation and select the Import Simulations link.

Figure 35 Import Simulations

Import from file o
Select File:

Enter secret for the file (if any):

[impor § Cancel

Table 21: Import Simulations

Container Description

Selectfile Browse to select name of simulations import file.

Import/Cancel Import to commit or Cancel to dismiss popup.

Export Simulations

Navigate to Configuration > Policy Simulation and select the Export Simulations link. This task exports all
simulations. Your browser will display its normal Save As dialog, in which to enter the name of the XML file to
contain the export.

Export

To export just one simulation, select it (using the check box at the left) and click Export. Your browser will display
its normal Save As dialog, in which to enter the name of the XML file to contain the export.
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Chapter 6

ClearPass Policy Manager Profile

Profile is a ClearPass Policy Manager module that automatically classifies endpoints using attributes obtained from
software components called Collectors. It can be used to implement “Bring Your Own Device” (BYOD) flows, where
access has to be controlled based on the type of the device and the identity of the user. While offering a more efficient
and accurate way to differentiate access by endpoint type (laptop versus tablet), ClearPass Profile associates an
endpoint with a specific user or location and secures access for devices like printers and IP cameras. Profile can be set
up in a network with minimal amount of configuration.

Device Profile

A device profile is a hierarchical model consisting of 3 elements - DeviceCategory, DeviceFamily, and DeviceName
derived by Profile from endpoint attributes.

e DeviceCategory - This is the broadest classification of a device. It denotes the type of the device. Examples include
Computer, Smartdevice, Printer, Access Point, etc.

e DeviceFamily - This element classifies devices into a category; this is organized based on the type of OS or type of
vendor. For example, Windows, Linux, and Mac OS X are some of the families when the category is Computer.
Apple, Android are examples of DeviceFamily when category is SmartDevice.

e DeviceName - Devices in a family are further organized based on more granular details such as version. For
example, Windows 7 and Windows 2008 server are device names under the Windows family.
This hierarchical model provides a structured view of all endpoints accessing the network.

In addition to the these, Profile also collects and stores the following:

e [P Address

e Hostname

e MAC Vendor

e Timestamp when the device was first discovered

e Timestamp when the device was last seen

Collectors

Collectors are network elements that provide data to profile endpoints. The following collectors send endpoint
attributes to Profile.

e DHCP

e ClearPass Onboard

e HTTP User Agent

e MAC OUI - Acquired via various authentication mechanisms such as 802.1X, MAC authentication, etc.
e ActiveSync plugin

e CPPM OnGuard

o SNMP

e Subnet Scanner
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DHCP

DHCEP attributes such as option55 (parameter request list), option60 (vendor class) and options list from DISCOVER
and REQUEST packets can uniquely fingerprint most devices that use the DHCP mechanism to acquire an IP address
on the network. Switches and controllers can be configured to forward DHCP packets such as DISCOVER, REQUEST
and INFORM to CPPM. These DHCP packets are decoded by CPPM to arrive at the device category, family, and name.
Apart from fingerprints, DHCP also provides hostname and IP address.

Sending DHCP Traffic to CPPM
Perform the following steps to configure your Aruba Controller and Cisco Switch to send DHCP Traffic to CPPM.

interface <vlan name>

ip address <ip addr> <netmask>

ip helper-address <dhcp server ip>
ip helper-address <cppm ip>end
end

Notice that multiple “ip helper-address” statements can be configured to send DHCP packets to servers other than
the DHCP server.

ClearPass Onboard

ClearPass Onboard collects rich and authentic device information from all devices during the onboarding process.
Onboard then posts this information to Profile via the Profile APL Because the information collected is definitive,
Profile can directly classify these devices into their Category, Family, and Name without having to rely on any other
fingerprinting information.

HTTP User-Agent

In some cases, DHCP fingerprint alone cannot fully classify a device. A common example is the Apple family of smart
devices; DHCP fingerprints cannot distinguish between an Apple iPad and an iPhone. In these scenarios, User-Agent
strings sent by browsers in the HTTP protocol are useful to further refine classification results.

User-Agent strings are collected from the following:

ClearPass Guest (Amigopod)
ClearPass Onboard
Aruba controller through [F-MAP interface (future)

Configuration

Navigate to the Administrator > Network Setup > ClearPass page to configure ClearPass Onboard and ClearPass
Guest to send HTTP User Agent string to Profile. The screenshot below shows how the CPPM publisher and Profile
nodes configured in ClearPass Guest.

MAC OuUI

MAC OUI can be useful in some cases to better classify endpoints. An example is android devices where DHCP
fingerprints can only classify a device as generic android, but it cannot provide more details regarding vendor.
Combining this information with MAC OUI, profiler can classify a device as HTC Android, Samsung Android,
Motorola Android etc. MAC OUI is also useful to profile devices like printers which may be configured with static IP
addresses.

ActiveSync Plugin

ActiveSync plugin is software provided by Aruba to be installed on Microsoft Exchange servers. When a device
communicates with exchange server using active sync protocol, it provides attributes like device-type and user-agent.
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These attributes are collected by the plugin software and is send to CPPM profiler. Profiler uses dictionaries to derive
profiles from these attributes.

CPPM OnGuard

ClearPass Onguard agents perform advanced endpoint posture assessment. It could collect and send OS details from
endpoints during authentication. Profiler uses os_type attribute from Onguard to derive a profile.

SNMP

Endpoint information obtained by reading SNMP MIBs of network devices is used to discover and profile static IP
devices in the network. The following information read via SNMP is used:

sysDescr information from RFC1213 MIB is used to profile the device. This is used both for profiling
switches/controllers/routers configured in CPPM, and for profiling printers and other static IP devices discovered
through SNMP or subnet scans.

cdpCacheTable information read from CDP (Cisco Discovery Protocol) capable devices is used to discover
neighbour devices connected to switch/controller configured in CPPM

lldpRemTable information read from LLDP (Link Layer Discovery Protocol) capable devices is used to discover
and profile neighbour devices connected to switch/controller configured in CPPM

ARPtable read from network devices is used as a means to discover endpoints in the network.
Note that the SNMP based mechanism is only capable of profiling devices if they respond to SNMP, or if the device

advertises its capability via LLDP. When performing SNMP reads for a device, CPPM uses SNMP Read credentials
configured in Network Devices, or defaults to using SNMP v2¢ with "public" community string.

Network Devices configured with SNMP Read enabled are polled periodically for updates based on the time interval
configured in Administration > Server Configuration > Service Parameters tab > ClearPass network services option >
Device Info Poll Interval.

The following additional settings have been introduced for Profile support:

Read ARP Table Info - Enable this setting if this is a Layer 3 device, and you want to use ARP table on this device
as a way to discover endpoints in the network. Static IP endpoints discovered this way are further probed via
SNMP to profile the device.

Force Read - Enable this setting to ensure that all CPPM nodes in the cluster read SNMP information from this
device regardless of trap configuration on the device. This option is especially useful when demonstrating static IP-
based device profiling because this does not require any trap configuration on the network device.

Figure 36 SNMP Read/Write Settings Tabs
SNMP Write Settings CLI Settings

Allow SNMP Read: Enable Policy Manager to perform SNMP read operations
SNMP Read Setting: SNMP v2 with community strings |Z|
Community String: sesssRsRRIRIRES Verify: |essssssssssssee
Force Read: Enable to read switch information forcibly

Read ARP Table Info: Enable to read ARP table from this switch

[0 ] coco

In large or geographically spread cluster deployments you do not want all CPPM nodes to probe all SNMP configured
devices. The default behaviour is for a CPPM node in the cluster to read network device information only for devices
configured to send traps to that CPPM node.
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Subnet Scan

A network subnet scan is used to discover IP addresses of devices in the network. The devices discovered this way are
further probed using SNMP to fingerprint and assign a Profile to the device.Network subnets to scan. Subnets to scan
are configured per CPPM Zone. This is particularly useful in deployments that are geographically distributed. In such
deployments, it is recommended that you assign the CPPM nodes in a cluster to multiple “Zones” (from Administration
> Server Configuration > Manage Policy Manager Zones) depending on the geographical area served by that node, and
enable Profile on at least one node per zone.

Figure 37 Configuration > Profile Settings

Configuration » Profile Settings

Profile Settings

The following additional Profile technigues may be configured, based on requirements.

Subnet Scans

Policy Manager Zone IP Subnet to Scan it
1.|default = 10.15.0.0/16,10.13.0.0/16,10.12.0.0/16 &
2.|Click to add...

.
Profiling

The Profile module uses a two-stage approach to classify endpoints using input attributes.
Stage 1

Stage 1 tries to derive device-profiles using static dictionary lookups. Based on the attributes available, it will lookup
dhcp, http, active_sync, MAC oui, and SNMP dictionaries and derives multiple matching profiles. When multiple
matches are returned, the priority of the source that provided the attribute is used to select the appropriate profile. The
following list shows the decreasing order of priority.

OnGuard/ActiveSync plugin

HTTP User-Agent

SNMP

DHCP

MAC OUI

Stage 2

CPPM comes with a built-in set of rules which evaluates to a device-profile. Rules engine uses all input attributes and
device profiles from Stage 1. The resulting rule evaluation may or may not result in a profile. Stage-2 is intended to
refine the results of profiling. Example:

Example

With DHCP options Stage-1 can identify that a device is Android. Stage-2 uses rules to combine this with MAC OUI
to further classify an android device as Samsung Android, HTC Android etc.

Post Profile Actions

After profiling an endpoint, profiler can be configured to perform CoA on the Network Device to which an endpoint is
connected. Post profile configurations are configured under Service. The administrator can select a set of categories and
a CoA profile to be applied when the profile matches one of the selected categories. CoA is triggered using the
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selected CoA profile. Any option from Endpoint Classification can be used to invoke CoA on a change of any one of
the fields (category, family, and name).

Figure 38 Services > Edit > Profilertab settings

Service Authentication Roles Enforcement Audit Summary
Endpoint Classification: Select the classification(s) after which an action must be triggered-
Home Audio/Video Equipment
Projectors
— Select— E
RADIUS CoA Action: [Aruba Terminate Session] B3|  view Details Modify Add new

Fingerprint Dictionaries

CPPM uses a set of dictionaries and built-in rules to perform device fingerprinting. The following dictionaries are used
by CPPM:

e DHCP

e HTTP User-Agent

e ActiveSync Attributes
e SNMP Attributes

e MAC QOUI

Refer to Fingerprints for more information.

Because these dictionaries can change frequently, CPPM provides a way to automatically update fingerprints from a
hosted portal. If external access is provided to CPPM, the fingerprints file can be downloaded and imported through
CPPM admin. Refer to Update Portal for more information.

The Profiler User Interface

CPPM provides admin interfaces to search and view profiled endpoints. It also provides basic statistics on the profiled
endpoints. The Cluster Status Dashboard widget shows basic distribution of device types. (See Policy Manager
Dashboard fore more information on Dashboard widgets.) In addition, the Monitoring and Reporting > Live
Monitoring > Endpoint Profiler page detailed device distribution information along with a list of endpoints. From this
page, you can also search for endpoint profiles based on category, family, name, etc. Refer to Endpoint Profiler for
more information.
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Chapter 7

802.1x Wireless Use Case

The basic Policy Manager Use Case configures a Policy Manager Service to identify and evaluate an 802.1X request
from a user logging into a Wireless Access Device. The following image illustrates the flow of control for this Service.

Figure 39 Flow of Control, Basic 802.1X Configuration Use Case

Service

Switch sends 802.1X
request; Policy
Manager evaluates
and refurns
connection control
attributes

SERVICE:
802.1X Wireless.

Policy Manager categorizes
reguest by Service Type

Authentication
Source l

AUTHENTICATION SOURCE:
2 sources specified; Policy Manager
authenticates reguests against the
sourcas in order of priorly

Validate client identity against
the specified source

Posture
Evaluation

POSTURE SERVER:
PS_NPS

Evaluate posture; return
“posture token” representing
health

Authentication
l Method
AUTHENTICATION METHOD:
4 methods specified. llustrating
principle of list from which methods:
are tested by Policy Manager in order
of pricrity

Initiate authentication
based on specified method

Enforcement
Profile

ENFORCEMENT PROFILES:
AllowAccess.
Denyfccess

Return connection attributes
(representing assigned
access) to the switch

Configuring the Service

i Role Mapping

ROLE MAPPING {using attributes
from AUTHORIZATION SOURCES ):
RMP_DEPARTMENT
{client:department mapping)

Map client identity to role

Enforcement
Policy

ENFORCEMENT POLICY:
Role_Based Allow_Access Policy

»
" Based on posture token, role,

and system time, map client
to an Enforcement Profile

Follow the steps below to configure this basic 802.1X service:

1. Create the Service

The following table provides the model for information presented in Use Cases, which assume the reader’s ability
to extrapolate from a sequence of navigational instructions (left column) and settings (in summary form in the right
column) at each step. Below the table, we call attention to any fields or functions that may not have an

immediately obvious meaning.

Policy Manager ships with fourteen preconfigured Services. In this Use Case, you select a Service that supports

802.1X wireless requests.
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Table 22: 802.1X - Create Service Navigation and Settings

Navigation Settings

Create a new Service:
o Services >
o Add Service (link) >

Name the Service and select a pre-

configured Service Type: e

e Service (tab) >

o Type (selector): 802.1X Wireless >

o Name/Description (freeform) >

e Upon completion, click Next (to
Authentication)

Configuration » Services - -
s i 9 Add Service
ervices & Import Services
&, Export Services
m Authentication Authorization Roles Posture Enforcement Audit Profiler ‘Summary
| 802 1X Wireless [=]
Name: [ |
Description: 802.1X Wireless Access Service
Monitor Mode: [Tl Enable to monitor network access without enforcement
More Options: Authorization Posture Compliance Audit End-hests Profile Endpoints
Service Rule
Matches © ANY or @ ALL of the following conditions:
Type Name Operator Value i
1.‘Rad\u5:ll:_|'F MAS-Port-Type EQUALS Wireless-802.11 (19) ]
. ~ Login-User (1), Framed-User (2), B
2. |Radius:IETF Service-Type BELONGS_TO Authenticate-Only (8) ]
3.|click to add...

The following fields deserve special mention:

= Monitor Mode: Optionally, check here to allow handshakes to occur (for monitoring purposes), but without

enforcement.

= Service Categorization Rule: For purposes of this Use Case, accept the preconfigured Service Categorization

Rules for this Type.

2. Configure Authentication.

Follow the instructions to select [EAP FAST], one of the pre-configured Policy Manager Authentication Methods,

and Active Directory Authentication Source (AD), an external Authentication Source within your existing

enterprise.

Policy Manager fetches attributes used for role mapping from the Authorization Sources (that are associated with the
authentication source). In this example, the authentication and authorization source are one and the same.
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Table 23: Configure Authentication Navigation and Settings

Navigation Settings

SeIeCt an AUthentication MethOd Authorization Roles Posture Enforcement Audit Profiler Summary
and an Active Directory server (that Authentication Mathods: | [ [EAP PEAP] ri— Add new Authentication Method
you have already configured in [EAPFAST] —
Policy Manager): AP TTL Remove
e Authentication (tab) > i
o Methods (Select a method from ST -

the drop_down IISt) Authentication Sources: - Move Up. Add new Authentication Source

Add > Wove Down
° ?;;rces (Select drop-down _
[Local User Repository] [Local —~Selectto Add-
SQL DB] Strip Username Rules: [C] Enable to specify a comma-separated list of rules to strip username prefixes or suffixes
[Guest User Repository] [Local
SQL DB] £ Badk to Services

[Guest Device Repository]
[Local SQL DB]
[Endpoints Repository] [Local
SQL DB]
[Onboard Devices Repository]
[Local SQL DB] >
[Admin User Repository] [Local
SQL DB]>
AmigoPod AD [Active
Directory>

e Add>
Upon completion, Next (to
configure Authorization)

The following field deserves special mention:

= Strip Username Rules: Optionally, check here to pre-process the user name (to remove prefixes and suffixes)
before sending it to the authentication source.

Q To view detailed setting information for any preconfigured policy component, select the item and click View Details.
NOTE

3. Configure Authorization.

Policy Manager fetches attributes for role mapping policy evaluation from the Authorization Sources. In this use
case, the Authentication Source and Authorization Source are one and the same.

Table 24: 802. 1X - Configure Authorization Navigation and Settings

Navigation Settings

o Configure Service level authorization Service | Authentication Roles  Posture  Enforcement  Audit  Profiler  Summary

source. In th is use case there is nothing Authorization Details:  Authorization sources from which role mapping attributes are fatched (for each authentication source)

. ication Source Atti Fetched From

to configure. Click the Next button. T e e YT ILocal User Repository] [Local QL 0B]

* Upon completion, click Next (to Role g athorgation srces o whi t fah ole-mappig aevss -
H - e Add new Authentication Source
Mapping). e
| oty
—Selectto Add- -
€ Back 1o Services

4. Apply a Role Mapping Policy
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Policy Manager tests client identity against role-mapping rules, appending any match (multiple roles acceptable) to
the request for use by the Enforcement Policy. In the event of role-mapping failure, Policy Manager assigns a

default role.

In this Use Case, create the role mapping policy RMP_ DEPARTMENT that distinguishes clients by department and
the corresponding roles ROLE ENGINEERING and ROLE FINANCE, to which it maps:

Table 25: Role Mapping Navigation and Settings

Navigation Settings

Create the new Role Mapping Policy:
e Roles (tab) >
e Add New Role Mapping Policy (link) >

Service Authentication

Enforcement | Audit profiler Summary

novoizoion [JERIRR] postue

Role Mapping Policy:

~Select- =] modity |

Add new Role Mapping Policy

Role Mapping Policy Details

Description:
Default Role:

Rules Evaluation Algorithm: -

C

< _Back to Services

[ Next> | save [ cancel

Add new Roles (names only):

o Policy (tab) >

o Policy Name (freeform): ROLE_
ENGINEER >

e Save (button) >
Repeat for ROLE_FINANCE >

e When you are finished working in the
Policy tab, click the Next button (in the
Rules Editor)

Configuration » Identity » Role Mappings » Add

Role Mappings

Summary

Policy Name:

Description:

Default Role:

Add New Role

( Bac]

Name:

Description:

Add New Role

[RMP_DEPARTMENT

[Guest] Add new Role

[#)] view Details [

[ROLE_FINANCE

[ROLE_ENGINEER]
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Settings

Create rules to map clientidentity to a

Role:

e Mapping Rules (tab) >

o Rules Evaluation Algorithm (radio
button): Select all matches >

Configuration » Identity » Role Mappings » Add

Role Mappings

Policy Mapping Rules Summary

Rules Evaluation Algorithm: O Select first match @ Select all matches

Role Mapping Rules:

Conditions

Role Name

Service:

e Backin Roles (tab) >

o Role Mapping Policy (selector): RMP_
DEPARTMENT >

e Upon completion, click Next (to
Posture)

o Add Rule (button opens popup) > |
1.|(Authorization: AD:department CONTAINS engineer) Role_Engineer
e AddRule (button) > 2.‘(Authorlzat\on:AD:department CONTAINS finance) ROLE_FINANCE
e Rules Editor (popup) > Move Up Move Down Edit Rule Remove Rule
* Conditions/ Actions: match
Conditions to Actions (drop-down list) e
> Matches @ ANY or O ALL of the following conditions:
o Upon completion of each rule, click Lues dame Opcraioy dalue
the save button ( |n the RU|eS Edltor) > 1.‘Authur\zat\un:AD department CONTAINS finance By @
2.‘Chck to add...
e When you are finished working in the
R | Role Name: [Contractor] :
Mapping Rules tab, click the Save
button (in the Mapping Rules tab) Gvisg ™ P psin
{(TJ:SACS AP Admin]
[TACACS Help Desk]
[TACACS Network Admin]
[TACACS Read-only Admin]
[TACACS Receptionist]
[TACACS Super Admin]
« Back to Role Mappings
Add the new RO|e Mapplng POIICy tO the Service Authentication Authorization m Posture Audit Enforcement Summary

Role Mapping Policy:

\BMP_DEPARTMENT. ... v

Role Mapping Policy Details

Add new Role Mapping Policy

Description: -
[Guest]

Rules Evaluation Algorithm:  evaluate-all

Default Role:

Conditions Role
1. (Authorization:AD:department CONTAINS engineer) Role_Engineer

2. (Authorization:AD:department CONTAINS finance) ROLE_FINANCE

( Back to Services

[Hoxi> [ sove | Coner |

5. Configure a Posture Server

here, the Posture Server

For purposes of posture evaluation, you can configure a Posture Policy (internal to Policy Manager), a Posture Server
(external), or an Audit Server (internal or external). Each of the first three use cases demonstrates one of these options;

Policy Manager can be configured for a third-party posture server, to evaluate client health based on vendor-specific
credentials, typically credentials that cannot be evaluated internally by Policy Manager (that is, not in the form of
internal posture policies). Currently, Policy Manager supports the following posture server interface: Microsoft NPS

(RADIUS).

Refer to the following table to add the external posture server of type Micrsoft NPS to the 802.1X service:
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Table 26: Posture Navigation and Settings

Navigation Setting

Add a new Posture Server:
o Posture (tab) >

o Add new Posture Server (button)
>

Service ion Roles Enforcement Audit Profiler Summary
Posture Policies:
Posture Policies: - Remove
_View Detais_|
Modify
~Selectto Add- [=]
Default Posture Token: UNKNOWN (100)
Remediate End-Hosts: Enable auto-remediation of non-compliant end-hosts
Remediation URL:
Posture Servers:
Posture Servers: - Fas
s Modify
~Selectto Add- [~

Configure Posture settings:

e Posture Server (tab) >

o Name (freeform): PS_NPS

e Server Type (radio button):
Microsoft NPS

o Default Posture Token (selector):
UNKOWN

e Next (to Primary Server)

Posture Server

Primary Server

Backup Server Summary

Name:

Description:

Server Type:

( Back to Services

Default Posture Token:

© Microsoft NPS

UNKNOWN (100) [=]

Next = Save m

Configure connection settings:

e Primary/ Backup Server (tabs):
Enter connection information for
the RADIUS posture server.

e Next (button): from Primary Server
to Backup Server.

o To complete your work in these
tabs, click the Save button.

Posture Server

RADIUS Server Name:

RADIUS Server Port:
Shared Secret:

Timeout:

( Back to Services

Backup Server Summary

(default is 1812)
Verify:

5 seconds

Add the new Posture Server to the

Service:

e Backin the Posture (tab) >

o Posture Servers (selector): PS_
NPS, then click the Add button.

o Click the Next button.

Service Authentication

Profiler

Roles m Enforcement Audit

Authorization Summary

Posture Policies:

Posture Policies:

Default Posture Token:
Remediate End-Hosts:
Remediation URL:
Posture Servers:

Posture Servers:

« _Back to Services

Remove Add new Posture Policy

View Details
Modify

~Select- [+] Add

UNKNOWN (100) [+]

[ Enable auto-remediation of non-compliant end-hosts

PS_NPS [RADIUS] Remove Add new Posture Server
View Details
Modify
—Select- [~] Add

m Save | Cancel

6. Assign an Enforcement Policy

Enforcement Policies contain dictionary-based rules for evaluation of Role, Posture Tokens, and System Time to
Evaluation Profiles. Policy Manager applies all matching Enforcement Profiles to the Request. In the case of no

match, Policy Manager assigns a default Enforcement Profile.
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Table 27: Enforcement Policy Navigation and Settings

Navigation Setting

Conflgure the Enforcement Service Authentication Roles Posture Audit Profiler Summary
Policy:

Use Cached Results:
e Enforcement (tab) >

Use cached Roles and Posture attributes from previous sessions

Enforcement Policy:

| [Sample Allow Access Policy] = Add new Enforcement Policy
e Enforcement Policy Enforcemant Policy Datails
(Selector) Role_Based_ Description: Sample policy to allow network access
A"ow Access Policy Default Profile: [Allow Access Profile]

Rules Evaluation Algorithm: evaluate-all

Conditions Enforcement Profiles

(S?Jizea:s)ay-uf-WeEk BELONGS_TO Monday, Tuesday, Wednesday, Thursday, Friday, Saturday, [Allow Access Profile]

< Back to Services

Next> § Save § Cancel

For instructions about how to build such an Enforcement Policy, refer to "Configuring Enforcement Policies " on
page 221.

7. Save the Service.

Click Save. The Service now appears at the bottom of the Services list.
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Chapter 8

Aruba Web Based Authentication Use Case

This Service supports known Guests with inadequate 802.1X supplicants or posture agents. The following figure
illustrates the overall flow of control for this Policy Manager Service.

Figure 40 Flow-of-Control of Web-Based Authentication for Guests

Reqguest from a dient
without adequate posture
agent or supplicant

Client is rediracted to Aruba
Web Portal to capture

username/password and
evaluale posture,

Policy Manager processes
request; returns access
control attributes to switch,

Authentication
Source

Posture
Evaluation

Enforcement
Profile

Service

SERVICE:
Aruba Web Based Authenticaiion

eTIPS categorizes request by
Service Type

AUTHENTICATION SOURCE:
Local_User Reposilory

NO AUTHENTICATION METHOD:
Policy Manager internal method
authenticates captured Avenda Web
Portal login

Validate client identity against
the specified source

|

POSTURE POLICY:
IPP_UNIVERSAL

Evaluate posture; return
“posture token” representing
health

ﬁ

ENFORCEMENT POLICY:
Guest_Limited
Guest_Full

Return connection attributes

l Role Mapping

ROLE MAPPING (using attributes
from AUTHORIZATION S30URCE or
using built-in Guest role)

Map client identity to role

Enforcement
Policy

ENFORCEMENT POLICY:
SNMP_POLICY

Based on posture token,
rolea, and system time, map
client to an Enforcement
Profile

(repr g g <
access) to the switch

Configuring the Service

Perform the following steps to configure Policy Manager for WebAuth-based Guest access.

1. Prepare the switch to pre-process WebAuth requests for the Policy Manager Aruba WebAuth service.

Refer to your Network Access Device documentation to configure the switch such that it redirects HTTP requests
to the Aruba Guest Portal , which captures username and password and optionally launches an agent that returns

posture data.

2. Create a WebAuth-based Service.
Table 28: Service Navigation and Settings

Navigation

Settings

Create a new Service:

o Services >
o Add Service >

Configuration » Services

Services

=* Add Service

& Import Services
&, Export Services
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Navigation Settings

Name the Service and
select a pre-configured
Service Type:

Services

Configuration » Services » Add

Authentication >

o Name/Description
(freeform) >

e Upon completion,

Monitor Mode:

More Ophions:

Service Rule

Authentication Authorization Roles Posture Enforcement Summary
i >
¢ Service (tab) Type: | Web-based Authentication =]
o Type (selector): Nome: | |
Aruba Web-Based —
Description: Web Based Authentication for Guests

[T] Enable to monitor network access without enforcement

Authorization Posture Compliance

click Next. Matches ©' ANY or @ ALL of the following conditions:
Type Name Operator Value 0
1.|H05t CheckType MATCHES_ANY Authentication b
2.|Cllck to add...

3. Set up the Authentication.

a. Method: The Policy Manager WebAuth service authenticates WebAuth clients internally.

b. Source: Administrators typically configure Guest Users in the local Policy Manager database.

4. Configure a Posture Policy.

For purposes of posture evaluation, you can configure a Posture Policy (internal to Policy Manager), a Posture Server
(external), or an Audit Server (internal or external). Each of the first three use cases demonstrates one of these options.

HNOTE This use case demonstrates the Posture Policy.
As of the current version, Policy Manager ships with five pre-configured posture plugins that evaluate the health of
the client and return a corresponding posture token.
To add the internal posture policy /PP UNIVERSAL XP, which (as you will configure it in this Use Case, checks
any Windows XP clients to verify the most current Service Pack).
Table 29: Local Policy Manager Database Navigation and Settings
avigation Settings
Select the local Policy Manager suthorization | Rotes | posture || Enforcement || summary
database: . ) Authentication Sources: “| oyeup | Addnew Authentication Source
e Authentication (tab) > . _
o Sources (Select drop-down list):
; 8
[Local User Repository] > — ol
e Add> Strip Username Rules: E‘r\ab\e to specify 3 comma-separated list of rules to strip username prefixes or suffixes
o Strip Username Rules (check box) > gm/m PR T e i it (0.4 wr )
Enter an example of preceding or o
following separators (if any), with the o canices [ Noxt> | save | Cancol |
phrase “user” representing the
username to be returned. For
authentication, Policy Manager strips
the specified separators and any
paths or domains beyond them.
e Upon completion, click Next (until you
reach Enforcement Policy).
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Table 30: Posture Policy Navigation and Settings

Navigation Setting

Create a Posture

Policy:

o Posture (tab) >

e Enable Validation
Check (check
box) >

o Add new Internal
Policy (link) >

Service Authentication Authorization

Roles Enforcement

Summary

Posture Policies:

Posture Policies: o~ Remove
View Details
A Modify
—Selectto Add- -

Default Posture Token: [ UNKNOWN (100) |

Remediate End-Hosts: Enable auto-remediation of non-compliant end-hosts

Add new Posture Policy

Remediation URL: [

Posture Servers:

Posture Servers: & Remove
View Details
e Modify
—Selectto Add-- -

( Back to Services

Add new Posture Serve

Name the Posture

Policy and specify a

general class of

operating system:

e Policy (tab) >

o Policy Name
(freeform): IPP_
UNIVERSAL >

e Host Operating
System (radio
buttons):
Windows >

e When finished
working in the
Policy tab, click
Next to open the
Posture Plugins
tab

Configuration » Posture » Posture Policies » Add

Posture Paolicies

Policy Posture Plugins Rules Summary

[IPP_UNIVERSAL |

Policy to check health of Windows XP
endpoints

Policy Mame:

Description:

Posture Agent: ) MAP Agent (& OnGuard Agent (Persistent or Dissolvable)

Host Operating System: @ windows O Linux Mac 05 X

( Back to Services

Next > J| Save m

Select a Validator:

e Posture Plugins
(tab) >

e Enable Windows
Health System
Validator >

e Configure
(button) >

Policy Posture Plugins Rules Summary

Select one/more plugins:

Status

Plugin Name Plugin Configuration
71| ClearPass windows Universal System Health Validator Configure | View ‘
Windows System Health Validator View
[0l| windows Security Health Validator Configure | View ‘

Not Configured

< Back to Services

Next> § Save | Cancel
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Navigation Setting

Configure the

Validator:
o Windows System

Client computers can connect to your network, subject to the following checks -

f i il
Health Validator ¥ windows 7
Windows 7 clients are allowed
(popup) > [F1 Restrict clients which have Service Pack less than l:l
[ ]
Evnagle a" Windows Vista
in OYVS Windows Vista clients are allowed
operating [ Restrict clients which have Service Pack less than| |
systems (check S —
bOX) > Windows XP clients are allowed

m

([ ] Enable Service [0 Restrict clients which have Service Pack less than I:l

PaCk |eVe|S for Windows Server 2008

Windows 7, Vista, Windows Server 2008 clients are allowed
XP Server 2008, [0 Restrict clients which have Service Pack less than I:l
Server 2008 R2; Windows Server 2008 R2
and Server 2003 Windows Server 2008 R2 clients are allowed
(CheCk bOXeS) > [71 restrict clients which have Service Pack less than I:l
] Save (button) > Windows Server 2003
'Y When finished Windows Server 2003 clients are allowed S

working in the
Posture Plugin
tab click Next to
move to the Rules
tab)

Set rUIeS to Correlate Policy Posture Plugins m Summary
validation results with

posture tokens:

Rules Evaluation Algorithm: First applicable

Conditions Posture Token
® Rules (ta b) > Passes all SHV checks -
s " HEALTHY
Windows System Health Validator
® Add Rule (buttOI’l 2 Fails one or more SHY checks - QUARANTINE
| Windows System Health Validator

>
Opens poPuP) Move Up ‘ Move Down | Edit Rule | Remove Rule ‘
¢ Rules Editor

(popup) >

o Conditions/ Conditions
Actions: match Select Plugin Checks: [ Passes all SHV checks ]

COI’]dItIOI"IS(Se|eCt Select Plugins: [ windows System Health Validator

Plugin/ Select
Plugin checks) to Posture Token: _HEALTHY (0) 7] ‘

Actions (Posture | cance |

Token)>
e Inthe Rules Back to Services Next > | Save @I
Editor, upon :
completion of
each rule, click
the Save button >
e When finished
working in the
Rules tab, click
the Next button.

ClearPass Policy Manager 6.1 | User Guide



Navigation Setting

Add the new POSt.U re Service Authentication Authorization Roles Enforcement Summary
Policy to the Service:
. Post Policies:
Back in Posture (tab) S
- osture Policies: Add new Posture Policy
. . Vlew Details
Internal Policies
(selector): IPP_ elect. P L
UNIVERSAL—XP’ Default Posture Token: | UNKNOWN (100) El
then click the Add
Remediate End-Hosts: [0 Enable auto-remediation of non-compliant end-hosts
button ;
Remediation URL: [ |
Posture Servers:
Posture Servers: Remove Add new Posture Server
View Details
Modify
~Select- - Add |

The following fields deserve special mention:
= Default Posture Token. Value of the posture token to use if health status is not available.

= Remediate End-Hosts. When a client does not pass posture evaluation, redirect to the indicated server for
remediation.

= Remediation URL. URL of remediation server.
5. Create an Enforcement Policy.

Because this Use Case assumes the Guest role, and the Aruba Web Portal agent has returned a posture token, it
does not require configuration of Role Mapping or Posture Evaluation.

| é The SNMP_POLICY selected in this step provides full guest access to a Role of [Guest] with a Posture of Healthy, and

limited guest access.
NOTE

Table 31: Enforcement Policy Navigation and Settings

Navigation Setting

Add anew Enforcement Service Authentication Authorization Roles Posture Summary
POIIcy' Use Cached Results: Use cached Roles and Posture attributes from previous sessions
° Enforcement (ta b) > Enforcement Policy: SNMP Policy |z| Add new Enforcement Policy

e Enforcement Policy

Enforcement Policy Details

(selector): SNMP_ Description: R
Po LICY Default Profile: Restricted SNMP VLAN
PY Upon comp|etion c"Ck Rules Evaluation Algorithm: evaluate-all
’
SaVe. Conditions Enforcement Profiles
(Tips:Role EQUALS Guest)
" AND (Tips:Posture EQUALS HEALTHY (0)) Restricted SNMP VLAN

6. Save the Service.

Click Save. The Service now appears at the bottom of the Services list.
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Chapter 9

MAC Authentication Use Case

This Service supports Network Devices, such as printers or handhelds. The following image illustrates the overall flow
of control for this Policy Manager Service. In this service, an audit is initiated on receiving the first MAC
Authentication request. A subsequent MAC Authentication request (forcefully triggered after the audit, or triggered
after a short session timeout) uses the cached results from the audit to determine posture and role(s) for the device

Figure 41 Flow-of-Control of MAC Authentication for Network Devices

Note regarding color coding: This service (optionally) gathers information via Audit Server on the first pass, then re-
authenticates the client after a short session timeout; on the second pass, it re-authenticates, allowing Policy Manager 1o
use Role and Posture information from cache to perform Enforcement.
Service
Authentication
SERVICE: Method
Switch falls back to MAC 1— Mac Auth Bypass
authentication request (on
BDZ.1X failure} o Policy Policy Manager categorizes 1
Manager with MAC address request by Service Type B
@ usarmame. B > AUTHENTICATION METHOD:
MACAuth
b ~
1 Initiate authentication
Authentication 2 based on specified method
Source ,l,
AUTHENTICATION SOURCE: Role Mapping
For MAC Bypass, one option is 8
Static Hosts List (SHL), or can be
any other supported
authentication source ROLE MAFFING (optional):

Validate client identity against Role information found i cache on

second pass; on first pass, Role Mapping

the specified source : optional (otherwise, skip to audit server)
' '
: |
] i
H H 1
vy v l Audit Server
POSTURE: AUDIT SERVER (optional):
Pasture information found in cache on i Nessus or NMAP audit with post-audit
second pass, if audit performed by — rules; cache the results.
NESSUS server; on first pass, skip to ©On second pass, after Authentication,
Audit Server. skip lo Enforcement. -
Test Posture; Evaluate Role
Enforcement l
ENFORCEMENT POLICY:
Profile Role_Based_Access_Policy
ENFORCEMENT PROFILE: Based on posture token, -
VLAN_ENFORCEMENT_QUARANTINE roles, and system time, map
WLAN_ENFORCEMENT FULL_ACCESS o
Return connection attributes Profile
(representing assigned
access) to the switch Enforcement

Policy

Configuring the Service

Follow these steps to configure Policy Manager for MAC-based Network Device access.

1. Create a MAC Authentication Service.
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Table 32: MAC Authentication Service Navigation and Settings

Navigation Settings

Create a new Service:
o Services >
e Add Service (link) >

Configuration » Services

Services

" Add Service

&= Import Services
& Export Services

Name the Service and select

Configuration » Services » Add

a pre-configured Service Services
Type A henticati horizati Roles Enforcement Audit Profiler Summary
© Sewlce (tab) > Type: | MAC Authentication
e Type (selector): MAC o [ |
Authentication > Description: MAC-based Authentication service
o Name/Description
(freeform) > Monitor Mode: [J Enable to monitor network access without enforcement
More Options: Authorization Audit End-hosts profile Endpoints
e Upon completion, click
Next to config ure Matches O ANY or @ ALL of the following conditions:
Authentication VS Name Cesetoy Value e
1.‘Rad|us:IEFF NAS-Port-Type BELONGS_TO :gge;nle(tg)s), e b
2.‘Radiu5:ll:_rF Service-Type EQUALS Call-Check (10) L
3.‘Cnnnectmn Client-Mac-Address EQUALS %{Radius:IETF:User-Name} o
4.|Click to add...

<« Back to Services

2. Set up Authentication

Note that you can select any type of authentication/authorization source for a MAC Authentication service. Only a
Static Host list of type MAC Address List or MAC Address Regular Expression shows up in the list of
authentication sources (of type Static Host List). Refer to "Adding and Modifying Static Host Lists " on page 167

for more information. You can also select any other supported type of authentication source.

Table 33: Authentication Method Navigation and Settings

Navigation Settings

Select an Authentication Method and

two authentication sources - one of

type Static Host List and the other of

type Generic LDAP server (that you

have already configured in Policy

Manager):

o Authentication (tab) >

o Methods (This method is
automatically selected for this type
of service): [MAC AUTH] >

e Add>

o Sources (Select drop-down list):
Handhelds [Static Host List] and
Policy Manager Clients White List
[Generic LDAP] >

e Add>

e Upon completion, Next (to Audit)

Service Authentication Authorization Roles

Authentication Methods:

Authentication Sources:

Strip Username Rules:

<€ Back to Services

Enforcement  Audit  Profiler | Summary

[MAC-AUTH] Move Up Add new Authentication Method

Move Down

Remove

View Details
Modify

~Select- Add

yoweup | Add new Authentication Source
Move Down

~Select- Aad

[ Enable to specify a comma-separated list of rules to strip username prefixes or suffixes

Next > Save J Cancel

3. Configure an Audit Server.

This step is optional if no Role Mapping Policy is provided, or if you want to establish health or roles using an
audit. An audit server determines health by performing a detailed system and health vulnerability analysis
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(NESSUS). You can also configure the audit server NMAP or NESSUS) with post-audit rules that enable Policy
Manager to determine client identity.

Table 34: Audit Server Navigation and Settings

Navigation Settings

Configure the Audit Server: === = e e
° Audit (tab) > it sarvar dd non At Servr
Audit End Hosts (enable) > Audit Trigger Conditions:  © Always

hen pesture is not available
or MAC authentication request
) For known end-hosts only

r unknown end-hosts only
r all end-hosts

o
e Audit Server (selector): NMAP
e Trigger Conditions (radio

button): For MAC Action after audi: o Action
authentication requests O T
o Reauthenticate client (check
bOX)I Enable < Back to Services

Upon completion of the audit, Policy Manager caches Role (NMAP and NESSUS) and Posture (NESSUS), then
resets the connection (or the switch reauthenticates after a short session timeout), triggering a new request, which
follows the same path until it reaches Role Mapping/Posture/Audit; this appends cached information for this client
to the request for passing to Enforcement. Select an Enforcement Policy.

4. Select the Enforcement Policy Sample_Allow_Access _Policy:

Table 35: Enforcement Policy Navigation and Settings

Navigation Setting

Select the Enforcement Policy: Service |_Authentication | _Authorization | _Roles audit|_protier,||_summary
[ ] Enforcement (ta b) > Use Cached Results: vl Use cached Roles and Posture attributes from previous sessions
° Use Cached Results (CheCk Enforcement Policy: Add new Enforcement Policy
box): Select Use cached Roles
. Description: Enforcement Policy for Unmanaged Clients
and Posture attributes from e
previous Sessions > Rules Evaluation Algorithm: first-applicable
o Enforcement Policy (selector): Conditions Enforcement Profiles
. . 1. (Tips:Role EQUALS Printers) WIRELESS_EMPLOYEE_NETWORK
UnmanagedC“eI:]tPOIICy. 2. (Tips:Role EQUALS IP Phones) WIRELESS_EMPLOYEE_NETWORK
e When you are finished with your 3. (Tips:Role EQUALS Handhelds) WIRELESS_GUEST_NETWORK
work in thlS tab C”Ck SaVe. 4. (Tips:Role EQUALS Role_Engineer) WIRELESS_EMPLOYEE_NETWORK
’ 5. (Tips:Role EQUALS eTIPS_Guest) WIRELESS_GUEST_NETWORK
6. (Tips:Role EQUALS Unknown Client) WIRELESS_CAPTIVE_NETWORK
«€ Back to Services | Cance |

Unlike the 802.1X Service, which uses the same Enforcement Policy (but uses an explicit Role Mapping Policy to
assess Role), in this use case Policy Manager applies post-audit rules against attributes captured by the Audit Server
to infer Role(s).

5. Save the Service.

Click Save. The Service now appears at the bottom of the Services list.
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Chapter 10

TACACS+ Use Case

This Service supports Administrator connections to Network Access Devices via TACACS+. The following image
illustrates the overall flow of control for this Policy Manager Service.

Figure 42 Administrator connections to Network Access Devices via TACACS+

Service

SERVICE:
[Admin Network Login Service]

Switch sends TACACS+
request,

Policy Manager categorizes
request by Service Type NO AUTHENTICATION METHOD:
For TACACS, authentication method
is intermal 1o the Service.

Authentication
Source
AUTHENTICATION SOURCE: Role Mapping

For TACACS+, option to use
Agtive Directory

Validate client idenfity against ROLE MAPPING {opticnal):

the specified source Using atirlbutes from
AUTHORIZATION SOURCE.

Map client identity to role
NO POSTURE:
TACACS+ login intended to authenticate NO AUDIT SERVER:
user identily, nat a device. TACACS+ login intended to authenticate:
uger identity, not a device.
Enforcement
Profile Enforcement

Policy

E'“‘}'Z‘é?gg‘;ﬂfgf ILE: ENFORCEMENT POLICY:
[TACAGS Netwark Admin] _— [Admin Network Login Folicy]

[TACACS Receptionist]
[TACAGS Super Admin]

Based on posture token, role,
and system time, map client
Return connection attributes to an Enforcement Profile
(representing assigned
access) to the switch

Configuring the Service
Perform the following steps to configure Policy Manager for TACACS+-based access:

1. Create a TACACS+ Service.
Table 36: TACACS+ Navigation and Settings

Navigation Settings

Create a new Service: Configuration » Services -

e Services > Services & Import Services
e Add Service (I|nk) > &, Export Services
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Navigation

Settings

Name the Service and select a pre- Confaurston » Sevicss > A3 _
. Services - Device Authorization Service
configured Service Type: :
) oles S
[ ] Se rvice (ta b) > Type: [ TACAC: [=]
N H H Name: |Device Service ]
i Type (SeIeCt(? r)' [POIIcy Manager Admln Description: Service to authorize 1QS Device
Network Login Service] > ‘
° Na me/ Descriptlon (fre efo rm) > :::‘::;::::: :i:i:t::mmr network access without enforcement
e Upon completion, click Next (to T
. . Matches @ ANY or O ALL of the following conditions:
Authentication) = i — o .
1.[click to add
< Backto Services

2. Set up the Authentication

a. Method: The Policy Manager TACACS+ service authenticates TACACS+ requests internally.

b. Source: For purposes of this use case, Network Access Devices authentication data will be stored in the Active

Directory.
Table 37: Active Directory Navigation and Settings

Navigation

Settings

Select an Active Directory server (that you have
already configured in Policy Manager):
e Authentication (tab) >
e Add>
o Sources (Select drop-down list): AD (Active
Directory) >
Add >

putsorimion | _otes|_estorcament _|_summaey
Authentication Sources: AD [Active Directory] MoveUp | Add new Authdntication Source
Wove Down
Remove
View Details
Modify
~Select- Add

[ Enable to specify a comma-separated list of rules to strip username prefijes or suffixes

Strip Username Rules:

<« Back to Services

Upon completion, click Next (to Enforcement
Policy)

3. Select an Enforcement Policy.

Select the Enforcement Policy [Admin Network Login Policy] that distinguishes the two allowed roles (Net

Admin Limited and Device SuperAdmin.

Table 38: Enforcement Policy Navigation and Settings

Navigation Setting

Select the Enforcement Policy: .

Authentication

Authorization

e S

o Enforcement (tab) >

o Enforcement Policy (selector):
Device Command
Authorization Policy

e When you are finished with
your work in this tab, click Save.

Use Cached Results:

Enforcement Policy:

Enforcement Policy Details

Description:
Default Profile:

Conditions

Rules Evaluation Algorithm:

Use cached Roles and Posture attributes from previous sessions

Device Command Authorizatifi] NModify

Add new Enforcement Policy

Policy for device command authorization
[TACACS Deny Profile]
first-applicable

Enforcement Profiles

sunday)

(Tips:Role EQUALS Net Admin Limited)
1. AND (Date:Day-of-Week NOT_BELONGS_TO Saturday,

2. (Tips:Role EQUALS Device SuperAdmin)

DenyPrevilegedCommands

Access Switches Control

< Back to Services

4. Save the Service.

Click Save. The Service now appears at the bottom of the Services list.
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Chapter 11

Single Port Use Case

This Service supports all three types of connections on a single port.

The following figure illustrates both the overall flow of control for this hybrid service, in which complementary switch
and Policy Manager configurations allow all three types of connections on a single port:

Figure 43 Flow of the Multiple Protocol Per Port Case

Switch
Yes: Switch sends request
Switch port to Policy Manager as 802.1X/
configured to do EAP; Policy Manager
802.1X based port processes using 802.1X
control; fallback is Sandoa
MAC Authentication

NO: Switch sends request to Policy Manager as MAC Bypass;

Policy Manager attempts to process using MAC Authentication
Service

Policy
Manager

Paolfey Manager
Enforcement Policy

Authenticates Yes: Policy Manager

assigns against SHL or MAC Authentication
VLAN_QUARANTINE to other Enforcement Policy
MAC Authentication q g ESEigI‘IE
requests that do not authentication VLAN_Full_Access
authenticate source?

No: Policy Manager assigns VLAN_Guest

Switch
Switch launches Aruba
Switch configured to Web Portal and passes Policy Manager processes
f‘:’gﬁ;:g’fﬂf request attributes to  |———  using Aruba WebAuth
VLAN GUEST clients Policy Manager as Service
to WebAuth Portal WebAuth.
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Chapter 12

Services

The Policy Manager policy model groups policy components that serve a particular type of request into Services,
which sit at the top of the policy hierarchy. Aruba Networksoffers the following default services:

o 802.1X Wireless

o 802.1X Wired

e MAC Authentication

e Web-based Authentication

e Web based Health Check Only

e Web-based Open Network Access
e 802.1X Wireless - Identity Only

e 802.1X Wired - Identity Only

e RADIUS Enforcement (Generic)

e RADIUS Proxy

o TACACS+ Enforcement

e Aruba Application Authentication
e Aruba Application Authorization

e Cisco Web Authentication Proxy
Refer to the following sections for more detailed information:

e "Architecture and Flow " on page 77
e "Start Here Page " on page 78
e '"Policy Manager Service Types" on page 80
e "Services " on page 102
m  "Adding Services " on page 103
= "Modifying Services " on page 105

m  "Reordering Services " on page 107

Architecture and Flow
Architecturally, Policy Manager Services are:

o Parents of their policy components, which they wrap (hierarchically) and coordinate in processing requests.

o Siblings of other Policy Manager Services, within an ordered priority that determines the sequence in which they
are tested against requests.

e Children of Policy Manager, which tests requests against their Rules, to find a matching Service for each request.
The flow-of-control for requests parallels this hierarchy:

e Policy Manager tests for the first Request-to-Service-Rule match

e The matching Service coordinates execution of its policy components

e Those policy components process the request to return Enforcement Profiles to the network access device, and,
optionally, posture results to the client.

There are two approaches to creating a new Service in Policy Manager:
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e Bottom-Up Approach - Create all policy components (Authentication Method, Authentication Source, Role

Mapping Policy, Posture Policy, Posture Servers, Audit Servers, Enforcement Profiles, Enforcement Policy) first, as
needed, and then create the Service from using Service creation Wizard.

e Top-Down Approach - Start with the Service creation wizard, and create the associated policy components as and
when you need them, all in the same flow.

To help you get started, Policy Manager comes pre-configured with 14 different Service types or templates. If these
service types do not suit your needs, you can roll your own service with custom service rules.

From the Configuration > Start Here page, you can create a new service by clicking on any of the pre-configured

Policy Manager Service Types.

Each of the service types is listed in a graphical list, with a description of each type:

Figure 44 Start Here page

Configuration » Start Here

Choose a deployment type to start configuring network policy

Aruba 802.1X Wireless

For wireless end-hosts connecting through an Aruba 802.11 wireless access device or controller, with authentication via
IEEE 802.1X (Service rules customized for Aruba WLAN Mobility Controllers).

802.1X Wireless

For wireless end-hosts connecting through an 802.11 wireless access device or controller, with authentication via IEEE
802.1X. Allows configuring both identity and posture based policies.

802.1X Wired

For end-hosts connecting through an Ethernet LAN, with authentication via IEEE 802.1X. Allows configuring both identity
and posture based policies.

MAC Authentication

MAC-based authentication bypass service, for end-hosts without an 802.1X supplicant or a posture agent (printers, other
embedded devices, and computers owned by guests or contractors). Authentication is based on the MAC-address of the
end-host being present in a white list or black list.

Web-based Authentication

Web-based authentication service for guests or agentless hosts, via the Policy Manager Portal. The user is redirected to the
Policy Manager captive portal by the network device, or by a DNS server that is set up to redirect traffic on a subnet to a
specific URL. The web page collects username and password, and also optionally collects health information.

Web-based Health Check Only

Web-based authentication service for guests or agentless hosts, via the Policy Manager Portal. Health-Check only.

After you select a service type, the associated service wizard is displayed with a clickable diagram that shows on top
of the wizard. The following image displays the flow with all available configuration options for 802.1X Wireless:
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Figure 45 Service Wizard with Clickable Flow

Services

Service

Configuration » Services » Add

TR T EEE

Authentication Authorization Roles Posture Enforcement Audit Profiler Summary

it Profler

Type:
Name:

Description:

Monitor Mode:

More Options:

Service Rule

Matches © ANY or @ ALL of the following conditions:

‘ 802 1X Wireless El

802.1X Wireless Access Service

[T Enable to monitor network access without enforcement

Authorization Posture Compliance Audit End-hosts Profile Endpoints

Type Name Operator Value
1.‘Rad\u5:1l:_rF NAS-Port-Type EQUALS Wireless-
. Login-Usg
2.‘Rad\u5.1l:_ﬂ: Service-Type BELONGS_TO Authentid

3.‘Chck to add...

The rest of the service configuration flow

is as described in Policy Manager Service Types.

ClearPass Policy Manager 6.1 | User Guide

79



Policy Manager Service Types
The following service types come preconfigured on Policy Manager:

Table 39: Policy Manager Service Types

Service Type Description/ Available Policy Components (in tabs)/ Service Rule (in Rules

Editor)/ Service-specific policy components (called out with legend below)

Template for wireless hosts connecting through an Aruba 802.11 wireless access
device or controller, with authentication via IEEE 802.1X. Service rules are customized
for a typical Aruba WLAN Mobility Controller deployment.

Refer to the "802.1X Wireless " on page 80 service type for a description of the different
Aruba 802.1X | {aps.

Wireless

()
A oA

metworks

z For wireless clients connecting through an 802.11 wireless access device or controller,

i with authentication via IEEE 802.1X. By default, the template displays with the Service,
¥ Authentication, Roles, Enforcement, and Summary tabs. In the More Options section,
click on Authorization, Posture Compliance, Audit End Hosts, or Profile Endpoints to
enable additional tabs.

802.1X
Wireless

Enforcement Summary

Type:
Name:

Description:

| 8021 Wireless

=]

802.1X Wireless Access Service

Monitor Mode: [l Enable to menitor network access without enforcement

More Options: [ Authorization [ Posture Compliance [ Audit End-hests [ Profile Endpoints

Service Rule

Matches ©) ANY or @ ALL of the following conditions:
Type Name Operator \'Z
1.|REd\us:[l:_rF

NAS-Port-Type EQUALS Wir

2.|Radius:IETF Service-Type BELONGS_TO ;uugt

3.|Click to add...

To configure authentication methods and authentication source, click on the
Authentication tab.

The Authentication methods used for this service depend on the 802.1X supplicants
and the type of authentication methods you choose to deploy. The common types are
PEAP, EAP-TLS, EAP-FAST or EAP-TTLS (These methods are automatically selected).
Non-tunneled EAP methods such as EAP-MDS5 can also be used as authentication
methods.

The Authentication sources used for this type of service can be one or more instances
of the following: Active Directory, LDAP Directory, SQL DB, Token Server or the Policy
Manager local DB. For more information on configuring authentication sources, refer to
"Adding and Modifying Authentication Sources " on page 128.

You can enable Strip Username Rules to, optionally, pre-process the user name (to
remove prefixes and suffixes) before authenticating and authorizing against the
authentication source.

Service Authentication Roles

Enforcement

Summary

Authentication Methods:

Authentication Sources:

Strip Username Rules:

[EAP PEAP]
[EAP FAST]
[EAP TLS]

[EAP TTLS]

WMove Up

Move Down

Remove

View Details

Modify

—Selectto Add—

WMove Up

Move Down

Remove

View Details

Modify

—Selectto Add—

[ enable to specify a comma-separated list of rules to strip username prefixes or suffixes

=

=
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Service Type Description/ Available Policy Components (in tabs)/ Service Rule (in Rules

Editor)/ Service-specific policy components (called out with legend below)

To create an authorization source for this service click on the Authorization tab. This tab
is not visible by default. To enable Authorization for this service select the Authorization
check box on the Service tab. Policy Manager fetches role mapping attributes from the
authorization sources associated with service, regardless of which authentication
source was used to authenticate the user. For a given service, role mapping attributes
are fetched from the following authorization sources:

The authorization sources associated with the service. For more information on

configuring authorization sources, refer to "Adding and Modifying Authentication
Methods" on page 111.

Service Authentication Authorization Roles Enforcement Summary

Authorization Details:

Authorization sources from which role mapping attributes are fetched (for each authentication source)

Authentication Source Attributes Fetched From

Additional authorization sources from which to fetch role-mapping attributes -

Remove
View Details
8 Modify

~Selectio Add— =

To associate a role mapping policy with this service click on the Roles tab. For

information on configuring role mapping policies, refer to "Configuring a Role Mapping
Policy "on page 157.

Configuration » Services » Add

Services
Service Authentication m Enforcement Summary
Role Mapping Policy: —Select- E Modify Add new Role Mapping Policy

Role Mapping Policy Details

Description:
Default Role:

Rules Evaluation Algorithm: -

Conditions Role

By default, this type of service does not have Posture checking enabled. To enable
posture checking for this service select the Posture Compliance check box on the
Service tab. You can enable posture checking for this kind of service if you are
deploying Policy Manager in a Microsoft NAP or Cisco NAC framework environment, or
if you are deploying an Aruba hosted captive portal that does posture checks through a
dissolvable agent. You can also choose to Enable auto-remediation of non-compliant
end-hosts and enter the Remediation URL of a server resource that can perform
remediation action (when a clientis quarantined).

For more information on configuring Posture Polices and Posture Servers refer to
topics: "Adding and Modifying Posture Policies " on page 171 and "Adding and
Modifying Posture Servers " on page 197.
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Service Type Description/ Available Policy Components (in tabs)/ Service Rule (in Rules

Editor)/ Service-specific policy components (called out with legend below)

Service Authentication Authorization Roles m Enforcement Audit Summary

Posture Policies:

Posture Policies: i Remove

View Details
N Modify

—Selectto Add— =
Default Posture Token: UNKNOWN (100)
Remediate End-Hosts: Enable auto-remediation of non-compliant end-hosts
Remediation URL:
Posture Servers:
Posture Servers: = Remove
_View Details |
Modify
~Selectto Add— =]

By default, this type of service does not have Audit checking enabled. To enable
posture checking for this service select the Audit End-hosts check box on the Service
tab.

Service Authentication Authorization Roles Posture Enforcement m Summary

Audit Server: —Seleck- [=]_ view Details | Modify |

Audit Trigger Conditions: @ Always
) When posture is not available
© For MAC authentication request

Action after audit: @ No Action
©) Do SNMP bounce
) Trigger RADIUS CoA action

Select an Audit Server - either built-in or customized. Refer to "Configuring Audit

Servers" on page 199 for audit server configuration steps.

You can specify to trigger an audit always, when posture is not available, or for MAC

authentication requests. If For MAC authentication requests is specified, then you can

perform an audit For known end-hosts only or For unknown end hosts only, or For all
end hosts. Known end hosts are defined as those clients that are found in the
authentication source(s) associated with this service. Performing audit on a clientis an
asynchronous task, which means the audit can be performed only after the MAC
authentication request has been completed and the client has acquired an IP address
through DHCP. Once the audit results are available,there should be a way for Policy

Manager to re-apply policies on the network device. This can be accomplished in one

of the following ways:

o No Action: The audit will not apply policies on the network device after this audit.

o Do SNMP bounce: This option will bounce the switch port or to force an 802.1X
reauthentication (both done via SNMP).Note: Bouncing the port triggers a new
802.1X/MAC authentication request by the client. If the audit server already has the
posture token and attributes associated with this clientin its cache, it returns the
token and the attributes to Policy Manager.

o Trigger RADIUS CoA action: This option sends a RADIUS Change of Authorization
command to the network device by Policy Manager.

You must select an enforcement policy (see "Configuring Enforcement Policies " on

page 221) for a service.
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Service Type Description/ Available Policy Components (in tabs)/ Service Rule (in Rules

Editor)/ Service-specific policy components (called out with legend below)

Service Authentication Roles Summary

Use Cached Results:

[[J use cached Roles and Posture attributes from previous sessions

| [Sample Allow Access Policy] B woary |

Enforcement Policy:

Enforcement Policy Details

Description:

Sample policy to allow network access
Default Profile: [Allow Access Profile]

Rules Evaluation Algorithm: evaluate-all

Conditions Enforcement Profiles

(Date:Day-of-Week BELONGS_TO Monday, Tuesday, Wednesday, Thursday, Friday,
Saturday, Sunday)

[Allow Access Profile]

Optionally configure Profiler settings. Select one or more Endpoint Classification items
from the drop down list, then select the RADIUS CoA action. You can also create a new
action by selecting the Add new RADIUS CoA Action link.

Service Authentication Roles Enforcement Audit Summary
Endpoint Classification:

Select the classification(s) after which an action must be triggered-

Home Audio/Video Equipment
Projectars ‘
—-Select—- —

RADIUS CoA Action:

| [Aruba Terminate Session]

[B] view Details Modify Add new

To create an authorization source for this service click on the Authorization tab. This tab
is not visible by default. To enable Authorization for this service select the Authorization
check box on the Service tab. Policy Manager fetches role mapping attributes from the
authorization sources associated with service, regardless of which authentication
source was used to authenticate the user. For a given service, role mapping attributes
are fetched from the following authorization sources:
o The authorization sources associated with the authentication source

The authorization sources associated with the service. For more information on

configuring authorization sources, refer to "Adding and Modifying Authentication
Methods" on page 111.

Service Authentication Authorization Roles Enforcement Summary

Authorization Details:

Authorization sources from which role mapping attributes are fetched (for each authentication source)
Authentication Source Attributes Fetched From

Additional authorization sources from which to fetch role-mapping attributes -

Remove
View Details
8 Modify

—Selectto Add-

To associate a role mapping policy with this service click on the Roles tab. For

information on configuring role mapping policies, refer to "Configuring a Role Mapping
Policy " on page 157.

Configuration » Services » Add

Services

Service Authentication m Enforcement Summary

Role Mapping Policy:

|—Se|ec1.— |z| Modify | Add new Role Mapping Policy

Role Mapping Policy Details

Description:
Default Role:

Rules Evaluation Algorithm: -

Conditions Role
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Service Type Description/ Available Policy Components (in tabs)/ Service Rule (in Rules

Editor)/ Service-specific policy components (called out with legend below)

By default, this type of service does not have Posture checking enabled. To enable
posture checking for this service select the Posture Compliance check box on the
Service tab.

Service Authentication Authorization Roles Enforcement Audit Summary

Posture Policies:

Posture Policies: b Remove

View Details
k Modify

~Selectto Add- =]
Default Posture Token: UNKNOWN (100)
Remediate End-Hosts: Enable auto-remediation of non-compliant end-hosts
Remediation URL:
Posture Servers:
Posture Servers: n Remove
_View Detaits_|
I Modify
~Selectto Add— [=]

You can enable posture checking for this kind of service if you are deploying Policy
Manager in a Microsoft NAP or Cisco NAC framework environment, or if you are
deploying an Aruba hosted captive portal that does posture checks through a
dissolvable agent. You can also choose to Enable auto-remediation of non-compliant
end-hosts and enter the Remediation URL of a server resource that can perform
remediation action (when a client is quarantined).

For more information on configuring Posture Polices and Posture Servers refer to
topics: "Adding and Modifying Posture Policies " on page 171 and "Adding and
Modifying Posture Servers " on page 197.

By default, this type of service does not have Audit checking enabled. To enable
posture checking for this service select the Audit End-hosts check box on the Service
tab.

Service Authentication Authorization Roles Posture Enforcement Summary

Audit Server: “Select- [z]_ ViewDetails | Modity |

Audit Trigger Conditions: © Always
) When posture is not available
© For MAC authentication request

Action after audit: @ No Action
©) Do SNMP bounce
) Trigger RADIUS CoA action

Select an Audit Server - either built-in or customized. Refer to "Configuring Audit

Servers" on page 199 for audit server configuration steps.

You can specify to trigger an audit always, when posture is not available, or for MAC

authentication requests. If For MAC authentication requests is specified, then you can

perform an audit For known end-hosts only or For unknown end hosts only, or For all
end hosts. Known end hosts are defined as those clients that are found in the
authentication source(s) associated with this service. Performing audit on a clientis an
asynchronous task, which means the audit can be performed only after the MAC
authentication request has been completed and the client has acquired an IP address
through DHCP. Once the audit results are available, there should be a way for Policy

Manager to re-apply policies on the network device. This can be accomplished in one

of the following ways:

o No Action: The audit will not apply policies on the network device after this audit.

o Do SNMP bounce: This option will bounce the switch port or to force an 802.1X
reauthentication (both done via SNMP).Note: Bouncing the port triggers a new
802.1X/MAC authentication request by the client. If the audit server already has the
posture token and attributes associated with this client in its cache, it returns the
token and the attributes to Policy Manager.

o Trigger RADIUS CoA action: This option sends a RADIUS Change of Authorization
command to the network device by Policy Manager.
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Service Type Description/ Available Policy Components (in tabs)/ Service Rule (in Rules

Editor)/ Service-specific policy components (called out with legend below)

You must select an enforcement policy (see "Configuring Enforcement Policies " on
page 221) for a service.

e o

[[] use cached Roles and Posture attributes from previous sessions

(=] I ad

Service Authentication

Use Cached Results:

Enforcement Policy: | [5ample Allow Access Policy]

Enforcement Policy Details

Description: Sample policy to allow network access

Default Profile: [Allow Access Profile]

Rules Evaluation Algorithm: evaluate-all

Conditions

N (Date:Day-of-Week BELONGS_TO Meonday, Tuesday, Wednesday, Thursday, Friday,
*  Saturday, Sunday)

Enforcement Profiles

[Allow Access Profile]

Optionally configure Profiler settings. Select one or more Endpoint Classification items
from the drop down list, then select the RADIUS CoA action. You can also create a new
action by selecting the Add new RADIUS CoA Action link.

Service Authentication Roles Enforcement

Audit Summary

Endpoint Classification:

RADIUS CoA Action:

Select the classification(s) after which an action must be triggered-

Home Audio/Video Equipment
Projectors
—Select— =

| [Aruba Terminate Session]

|z| View Details Modify Add new

802.1X Wired

For clients connecting through an Ethernet LAN, with authentication via IEEE 802.1X.

m Authentication Roles

Monitor Mode:

Enforcement Summary
Type: | 802.1X Wired =]
Name: ‘ ‘
Description: 802.1X Wired Access Service

[C1 Enable to monitor network access without enforcement

More Options: [Tl authorization [l Posture Compliance [l Audit End-hosts [l Profile Endpoints

Service Rule

Matches ©) ANY or @ ALL of the following conditions:
Type Name

Operator Value

1.|Radius:1!:_FF NAS-Port-Type EQUALS Etherng
S Login- U
2.|Rad|us.1!:_FF Service-Type BELONGS_TO Authen

3.|Chck to add...

Except for the service rules shown above, configuration for the rest of the tabs is similar
to the 802.1X Wireless Service.

NOTE: If you want to administer the same set of policies for wired and wireless access,
you can combine the service rule to define one single service. The other option is to
keep two services for wired and wireless access, but re-use the policy components
(authentication methods, authentication source, authorization source, role mapping
policies, posture policies, and enforcement policies) in both services.

Refer to the "802.1X Wireless " on page 80 service type for a description of the different
tabs.

MAC
Authentication

MAC-based authentication service, for clients without an 802.1X supplicant or a posture
agent (printers, other embedded devices, and computers owned by guests or
contractors). The network access device sends a MAC authentication request to Policy
Manager. Policy Manager can look up the clientin a white list or a black list,
authenticate and authorize the client against an external authentication/authorization
source, and optionally perform an audit on the client.
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Service Type

Description/ Available Policy Components (in tabs)/ Service Rule (in Rules

Editor)/ Service-specific policy components (called out with legend below)

Authentication Roles Enforcement Summary
Type: | MAC Authentication
Name: \ |
Description: MAC-based Authentication Service

Monitor Mode:

More Options:

[71 Enable to monitor network access without enforcement

[T authorization [ Audit End-hosts  [] Profile Endpoints

Matches ©) ANY or @ ALL of the following conditions:

Type Name Operator Value
1.|Radius:IETF NAS-Port-Type BELONGS_TO Etherne
2.|Radius:IETF Service-Type BELONGS_TO Login-U
2.|Connection Client-Mac-Address EQUALS %{Radi
4.|Click to add...

The default Authentication method used for this type of service is [MAC AUTH], which is
a special type of method called MAC-AUTH. When this authentication method is
selected, Policy Manager does stricter checking of the MAC Address of the client. This
type of service can use either a built-in static host list (refer to "Adding and Modifying
Static Host Lists " on page 167), or any other authentication source for the purpose of
white-listing or black-listing the client. You can also specify the role mapping policy,
based on categorization of the MAC addresses in the authorization sources.

Service Authentication Roles Enforcement Summary
Authentication Methods: -
[MAC AUTH] T Add
Move Down
Remove
View Details
Modify
—Selectto Add— hd
Authentication Sources:
[Endpoints Repository] [Local SQL DE] Ty Adf
Move Down
Remove
View Details
Modify
—Selectto Add— hd
Strip Username Rules: [C] Enable to specify a comma-separated list of rules to strip username prefixes or suffixes

NOTE: You cannot configure Posture for this type of service.

Audit can optionally be enabled for this type of service by checking the Audit End-hosts

check box on the Service tab.

When posture is not available
or MAC authentication request
For known end-hosts only
For unknown end-hosts only
© For all end-hosts

Action after audit: (;I‘ No Action
) Da SNMP bounce
@ Trigger RADIUS CoA action

| [Aruba Terminate Session]

Service Authentication Roles Enforcement Summary
Audit Server: —~Selact- m View Details Modify \
Audit Trigger Conditions: O Always

B view Details Modify
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Service Type Description/ Available Policy Components (in tabs)/ Service Rule (in Rules

Editor)/ Service-specific policy components (called out with legend below)

You can perform audit For known end-hosts only or For unknown end hosts only or For
all end hosts. Known end hosts are defined as those clients that are found in the
authentication source(s) associated with this service. Performing audit on a clientis an
asynchronous task, which means the audit can be performed only after the MAC
authentication request has been completed and the client has acquired an IP address
through DHCP. Once the audit results are available, there should be a way for Policy
Manager to re-apply policies on the network device. This can be accomplished in one
of the following ways:

o No Action: The audit will not apply policies on the network device after this audit.

o Do SNMP bounce: This option will bounce the switch port or to force an 802.1X
reauthentication (both done via SNMP).Note: Bouncing the port triggers a new
802.1X/MAC authentication request by the client. If the audit server already has the
posture token and attributes associated with this clientin its cache, it returns the
token and the attributes to Policy Manager.

o Trigger RADIUS CoA action: This option sends a RADIUS Change of Authorization
command to the network device by Policy Manager.

Refer to the "802.1X Wireless " on page 80 service type for a description of the other

tabs.

Portal. The user is redirected to the Aruba captive portal by the network device, or by a
DNS server that is set up to redirect traffic on a subnet to a specific URL. The web page
collects username and password, and also optionally collects health information (on
Windows 7, Vista, Windows XP, Windows Server 2008, Windows 2000, Windows
Web-based . . . .
Authentication Server 2003, popular Linux systems). There is an internal service rule
(Connection:Protocol EQUALS WebAuth) that categorizes request into this type of
service. You can add other rules, if needed.

m Authentication Roles Enforcement Summary

@L Web-based authentication service for guests or agentless hosts, via the Aruba built-in

Type: Web-based Authentication [=]

Name:

Description:

Monitor Mode: [C] Enable to monitor network access without enforcement
More Options: [[] authorization [ Posture Compliance

Service Rule

Matches O ANY or @ ALL of the following conditions:
Type Name Operator va
1.‘Host CheckType MATCHES_ANY Autl
2.‘Chck to add...

There is no authentication method associated with this type of service (Authentication
methods are only relevant for RADIUS requests). You can select any type of
authentication source with this type of service.

Service Authentication Roles Enforcement Summary

Authentication Sources:

4

Move Up
Move Down
Remove
View Details
Modify

—Selectto Add— =

Strip Username Rules: [T] Enable to specify a comma-separated list of rules to strip username prefixes or suffixes

Note that when you configure posture policies, only those that are configured for the
OnGuard Agent are shown in list of posture policies. Refer to the "802.1X Wireless " on
page 80 service type for a description of the other tabs.
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Service Type

Web-based
Health Check
Only

Description/ Available Policy Components (in tabs)/ Service Rule (in Rules

Editor)/ Service-specific policy components (called out with legend below)

This type of service is the same as the Web-based Authentication service, except that
there is no authentication performed; only health checking is done. There is an internal
service rule (Connection:Protocol EQUALS WebAuth) that categorizes request into this
type of service. There is also an external service rule thatis automatically added when
you select this type of service: Host:CheckType EQUALS Health.

@

Web-based
Open Network
Access

This type of service is similar to other Web-based services, except that authentication
and health checking are not performed on the endpoint. A Terms of Service page (as
configured on the Guest Portal page) is presented to the user. Network access is
granted when the user click on the submit action on the page.

U
802.1X

Wireless -
Identity Only

This type of service is the same as regular 802.1X Wireless Service, except that posture
and audit policies are not configurable when you use this template.

%_.

802.1X Wired -
Identity Only

This type of service is the same as regular 802.1X Wired Service, except that posture
and audit policies are not configurable when you use this template.

i

RADIUS
Enforcement
[Generic]

Template for any kind of RADIUS request. Rules can be added to handle RADIUS
requests that sends any type of standard or vendor-specific attributes.

m Authentication Roles Enforcement Summary

Type: RADIUS Enforcement (Generic) E

Name:

Description:

Monitor Mode: [T] Enable to monitor network access without enforcement

More Options: [[] authorization [ posture Compliance [ Audit End-hosts [ Profile Endpoints

Service Rule

Matches ©) ANY or @ ALL of the following conditions:
Type Name Operator V4
1.‘Chck to add...

NOTE: No default rule associated with this service type. Rules can be added to handle
any type of standard or vendor-specific RADIUS attributes (any attribute that is loaded
through the pre-packaged vendor-specific or standard RADIUS dictionaries, or through
other dictionaries imported into Policy Manager).

You can click on the Authorization, Posture Compliance, Audit End-hosts and Profile
Endpoints options to enable additional tabs. Refer to the "802.1X Wireless " on page 80
service type for a description of the other tabs.
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Service Type

NS
> 2

RADIUS Proxy

Description/ Available Policy Components (in tabs)/ Service Rule (in Rules

Editor)/ Service-specific policy components (called out with legend below)

Template for any kind of RADIUS request that needs to be proxied to another RADIUS
server (a Proxy Target).

Roles Proxy Targets Enforcement Summary

Type: | RADIUS Proxy [=]

Name: | |

Description:

Monitor Mode: [C] Enable to monitor network access without enforcement

More Options:

Service Rule

Matches ©) ANY or @ ALL of the following conditions:

Type Name Operator Va|
1.|Chck to add...

NOTE: No default rule is associated with this service type. Rules can be added to
handle any type of standard or vendor-specific RADIUS attributes. Typically, proxying is
based on a realm or domain of the user trying to access the network.

NOTE: Authentication, Posture, and Audit tabs are not available for this service type.
Role mapping rules can be created based on the RADIUS attributes that are returned
by the proxy target (using standard or vendor-specific RADIUS attributes).

Service Roles Proxy Targets Enforcement Summary
Proxying Scheme: @ Load Balance © Failover
Proxy Targets: BRANCH OFFICE PROXY - Move Up Add new Proxy Target
Move Down
) Wodify
—Select- A Add ‘

RADIUS attributes to be removed from remote server

(proxy target) reply

Type Name

i
1.‘Radius:l|:_rF Tunnel-Medium-Type b
2.‘Radius:[|:_FF Tunnel-Private-Group-Id o
3.‘Radiu5:[|:_rF Tunnel-Type L
4.‘Rad|u5:[|:_FF Session-Timeout i
5. Click to add...

Accounting Requests: [ Enable proxy for accounting requests

The servers to which requests are proxied are called Proxy Targets. Requests can be
dispatched to the proxy targets randomly; over time these requests are Load Balanced.
Instead, in the Failover mode, requests can be dispatched to the first proxy target in the
ordered list of targets, and then subsequently to the other proxy targets, sequentially, if
the prior requests failed. When you Enable proxy for accounting requests accounting
requests are also sent to the proxy targets.

TACACS+
Enforcement

Template for any kind of TACACS+ request.
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Service Type

Description/ Available Policy Components (in tabs)/ Service Rule (in Rules

Editor)/ Service-specific policy components (called out with legend below)

Authentication Roles Enforcement Summary

Type: | TACACS~ Enforcement [=]

Name: \ |

Description:

Monitor Mode: Enable to monitor network access without enforcement
More Options: [C] authorization

Service Rule

Matches ) ANY or @ ALL of the following conditions:
Type Name Operator Valug
1.|Chck to add...

NOTE: No default rule is associated with this service type. Rules can be added to filter
the request based on the Date and Connection namespaces. See "Rules Editing and
Namespaces" on page 329 for more information.

TACACS+ users can be authenticated against any of the supported authentication
source types: Local DB, SQL DB, Active Directory, LDAP Directory or Token Servers
with a RADIUS interface. Similarly, service level authorization sources can be specified
from the Authorization tab. Note that this tab is not enabled by default. Select the
Authorization check box on the Service tab to enable this feature.

A role mapping policy can be associated with this service from the Roles tab.

The result of evaluating a TACACS+ enforcement policy is one or more TACACS+
enforcement profiles. For more information on TACACS+ enforcement profiles, see
"TACACS+ Enforcement Profiles " on page 216 for more information.

Service Authentication Roles Summary

Use Cached Results: Use cached Roles and Posture attributes from previous sessions

Enforcement Policy: | [Admin Network Login Policy] Bl wosiy ] A
Description: Enforcement pelicy controlling access to Policy Manager Admin

Default Profile: [TACACS Deny Profile]

Rules Evaluation Algorithm: evaluate-all

Conditions Enforcement Profiles
1. (Tips:Role MATCHES_ANY [TACACS Help Desk]) [TACACS Help Desk]
2. (Tips:Role MATCHES_ANY [TACACS Network Admin]) [TACACS Network Admin]
3. (Tips:Role MATCHES_ANY [TACACS Receptionist]) [TACACS Receptionist]
4.  (Tips:Role MATCHES_ANY [TACACS Super Admin]) [TACACS Super Admin]

e_e

~
J

S

Aruba
Application
Authentication

This type of service provides authentication and authorization to users of Aruba
applications: GuestConnect and Insight. Application Enforcement Profiles can be sent
to these or other generic applications for authorizing the users.

m Authentication Authorization Roles Enforcement Summary

Type: | Amba [+]

Name: [ ]

Description: Authentication Service for Applications

Monitor Mode: [71 Enable to monitor network access without enforcement

More Options: Authorization

Service Rule

Matches ) ANY or @ ALL of the following conditions:
Type Name Operator Value
1.‘Apphcatmn Name EQUALS Enter App Name
2.‘5\\ck to add...

Web-based authentication service for guests or agentless hosts. The Cisco switch hosts
a captive portal; the portal web page collects username and password. The switch then
sends a RADIUS request in the form of a PAP authentication request to Policy Manager.
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Description/ Available Policy Components (in tabs)/ Service Rule (in Rules

Service Type ; : e / :
yp Editor)/ Service-specific policy components (called out with legend below)
Cisco Web-
Authentication Authentication Authorization Roles Enforcement Audit Summary
Proxy Type: | Cisco Web Authentication Proxy EI
Mame: \ ‘
Description:
Monitor Mode: [CJ Enable to monitor network access without enforcement
More Options: Authorization Audit End-hosts

Matches © ANY or @ ALL of the following conditions:

Type Name Operator
1.|Radius:IETF NAS-Port-Type BELONGS_TO
2.|Radius:IETF Service-Type EQUALS
3.|Click to add...

By default, this service uses the Authentication Method [PAP] [PAP]

You can click on the Authorization and Audit End-hosts options to enable additional
tabs. Refer to the "802.1X Wireless " on page 80 service type for a description of these
tabs.

Service Templates

ClearPass Policy Manager Provides the ability to create templates for services where you can define baseline policies
and require specific data when you create services. Service templates are for creating services and other components
such as role-mapping policies, enforcement policies, and network devices with a fill in the blanks approach. You fill in
various fields and Policy Manager creates all the different configuration elements that are needed for the service.These

various configuration elements are added back to the service when it is created.

The services templates include

802.1X Wired, 802.1X Wireless, and Aruba 802.1X Wireless
ClearPass Admin Access

ClearPass Admin SSO Login

EDUROAM

Guest Access - Web Login Pre-Auth

Guest Access

Guest MAC Authentication

Onboard Authorization
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Figure 46 Service Templates home page

Configuration » Service Templates

Service Templates

802.1X Wired
802.1X Wired Access Service

Select Template Category: All Templates

: 802.1X Wireless
® l 802.1X Wireless Access Service

Aruba 802.1X Wireless
Aruba 802.1X Wireless Access Service

ClearPass Admin Access
ClearPass Admin Access Description

€' Guest

ClearPass Admin SSO Login

i)
’U' Guest Application service that allows SAML-based Single Sign-On (55S0) authenticated users to access the application.

EDUROAM service

i)
’U’ Guest EDUROAM service

oG Guest Access - Web Login Pre-Auth
g uest Service for login authentication check at the Guest captive portal (RADIUS pre-auth)

Guest Access

Service for guest access via captive portal (non-802.1x)

! Guest

e G Guest MAC Authentication
£ uest Service performing authentication for cached MAC entries for guest accounts

Onboard Authorization

Service controling whether a users device may be provisioned using Onboard

! Guest

The following sections describe how to create a template.

802.1X Wired, 802.1X Wireless, and Aruba 802.1X Wireless

The 902.1X Wired template is designed for end-hosts connecting through an Ethernet LAN, with authen-
tication via I[EEE 802.1X. It allows configuring both identity and posture based policies. The 902.1X
Wireless template is intended for wireless end-hosts connecting through an 802.11 wireless access device
or controller, with authentication via IEEE 802.1X. It allows configuring both identity and posture based
policies. The Aruba 802.1X Wireless template is designed for wireless end-hosts connecting through an
Aruba 802.11 wireless access device or controller, with authentication via IEEE 802.1X (Service rules
customized for Aruba WLAN Mobility Controllers).All three templates are configured using identical

parameters.

Figure 47 802.1X Wired, 902.1X Wireless, and Aruba 802.1X Wireless Service Template

Name Prefix:
Authentication
AD Name™:

Description:

Server*:
Identity*:
NETBIOS™:
Base DN*:
Password*:
Port=:
Enforcement Details
Attribute Name Attribute Value VLAN ID
Department -
Department -
Department -
Default VLAN 1D
Wireless Network Settings
Wireless controller name:
Controller IP Address:
Vendor Name: Aruba -
RADIUS Shared Secret:
Enable RADIUS CoA: ]
RADIUS CoA Port:

Add Service Cancel
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Table 40: 802. 1X Wired ,802. 1X Wireless, and Aruba 802. 1X Wireless Service Template Parameters

Parameter Description

Enter an optional prefix that will be prepended to services using this template. Use this

Name Prefix to identify services that use templates.

Authentication

AD Name Enter your active directory name.

Description Enter a description that will help you identify the characteristics of this template.
Server Enter the hostname or the IP address of the Active Directory server.

Identity Enter the Distinguished Name of the administrator account

NETBIOS Enter the server Active Directory domain name.

Base DN .Enter DN of the node in your directory tree from which to start searching for records.
Password Enter the account password.

Port Enter the TCP port where the server is listening for connection.

Enforcement Details

Attribute Name The active directory attribute name

Attribute Value The active directory attribute value.

VLAN ID Standard RADIUS-IETF VLAN ID.

Wireless Network Settings

Wireless

The name given to the Wireless Controller.
controller name

Controller . .

IP Address The wireless controller's IP address.

Vendor Name Select the manufacturer of the wireless controller.

RADIUS Enter the shared secret that is configured on the controller and inside Policy Manager

Shared Secret to send and receive RADIUS requests.

Enable

RADIUS CoA Select to enable Radius - Initiated Change of Authorization on the network device.

RADIUS CoA By default this is port 3799 if Radius CoA is enabled. Change this value only if you
Port defined a custom port on the network device..

ClearPass Admin Access

This template is designed for TACACS+ service that authenticates users against Active Directory (AD)
and uses AD attributes to determine appropriate privilege level for ClearPass Policy Manager admin
access.
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Figure 48 ClearPass Admin Access Service Template

Configuration » Service Templates

Service Templates - ClearPass Admin Access

admin access.

TACACS+ service that authenticates users against Active Directory (AD) and uses AD attributes to determine appropriate privilege level for ClearPass Policy Manager

Name Prefix: [

AD Name*:

Description:

Server*:
Identity*:
NETBIOS*:
Base DN*:
Password*:

port*:

- Role Mapping

Attribute Name™: Department

Attribute Name™: Deparment

Attribute Name™: Department

o .

Description: ‘ A

Super Admin Condition™; || ox : onter Ad group name for super admin users
Read Only Admin

Condition™ [ ] ex: enter ad group name for read only users
LD ET Y [ ex: enter Ad group name for help desk users

Add Service Cancel

Table 41: ClearPass Admin Access Service Template Parameters

Parameter Description

Name Prefix

Enter an optional prefix that will be prepended to services using this template. Use
this to identify services that use templates.

Authentication

AD Name Enter the hostname or the IP address of the Active Directory server.

Description Enter a description that will help you identify the characteristics of this template.
Server Enter the hostname or the IP address of the Active Directory server.

Identity Enter the Distinguished Name of the administrator account

NETBIOS Enter the server Active Directory domain name.

Base DN Enter the Distinguished Name of the administrator account.

Password Enter the account password.

Port Enter the TCP port where the server is listening for connection.

Role Mapping

Name/Description

Enter a free-form name and description here.

Attribute Name

Select the active directory attribute.

Super Admin
Condition

Read Only Admin
Condition

Help Desk
Condition

Defines the privilege levels.
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ClearPass Admin SSO Login

This template is designed for application service that allows SAML-based Single Sign-On (SSO) authen-
ticated users to access the application

Figure 49 ClearPass Admin SSO Login Service Template

Name Prefix:

Application™:

Configuration » Service Templates

Service Templates - ClearPass Admin SSO Login

Service Rule

PolicyManager -

Add Service Cancel

Table 42: ClearPass Admin SSO Login Service Template Parameters

Parameter Description

Enter an optional prefix that will be prepended to services using this template. Use this to
Name Prefix | . . -
identify services that use templates.
Service Rule
Aoplicati Select the application that single-sign-on-authenticated administrative users will be able to
pplication
access.
EDUROAM

This template is designed for three types of situations:

e Med Center users connecting to eduroam within the Med Center wireless network.

e Roaming users from other campuses connecting to the Med Center wireless network.

e Roaming Med Center users connecting from UCLA Campus or other campuses that are part of the eduroam

federation.
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Figure 50 EDUROAM Service Template

Configuration » Service Templates

Service Templates - EDUROAM service

Name Prefix: | |

— Service Rule

Enter domain details™*: | | ex : @edunet.ucla.com

Select Vendor™: Aruba -

— Authentication

AD MName™: |

Description: -

Server®:

Identity™:

Base DN*:

Password™®:

| |
| |
MNETBIOS*: | |
| |
| |
Port™: | |

— Wireless Network Settings

Wireless controller name: | |

Controller IP Address: | |

Vendor Name: Aruba -

RADIUS Shared Secret: | |

Enable RADIUS CoA:
RADIUS CoA Port: |3_?gg |
|~ FLRs

Host Name™: | |

Vendor Name™®: Aruba -

RADIUS Shared Secret™: | |

Enable RADIUS CoA™:
RADIUS CoA Port™: 3799
RADIUS Authentication

Port™®: 1812

RADIUS Accounting Port *: 1813

Add Service Cancel

Table 43: EDUROAM Service Template Parameters

Parameter Description

Enter an optional prefix that will be prepended to services using this template. Use

Name Prefix this to identify services that use templates.

Service Rule Service Rule

Enter domain

. Enter the domain name of the network.
details

Select Vendor Select the vendor of the network device.
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Parameter Description

Authentication

AD Name Enter the hostname or the IP address of the Active Directory server.

Description Enter a description that will help you identify the characteristics of this template.
Server Enter the hostname or the IP address of the Active Directory server.

Identity Enter the Distinguished Name of the administrator account

NETBIOS Enter the server Active Directory domain name.

Base DN Enter the Distinguished Name of the administrator account.

Password Enter the account password.

Port Enter the TCP port where the server is listening for connection.

Wireless Network Settings

Wireless controller
name

The name given to the Wireless Controller.

Controller
IP Address

The wireless controller's IP address.

Vendor Name

Select the manufacturer of the wireless controller.

RADIUS Shared
Secret

Enter the shared secret that is configured on the controller and inside Policy
Manager to send and receive RADIUS requests.

Enable
RADIUS CoA

Select to enable Radius - Initiated Change of Authorization on the network device.

RADIUS CoA Port

By default this is port 3799 if Radius CoA is enabled. Change this value only if you
defined a custom port on the network device..

FLRs

Host Name

The hostname of the federation RADIUS server.

Vendor Name

Select the manufacturer of the wireless controller.

RADIUS Shared
Secret

Enter the shared secret that is configured on the controller and inside Policy
Manager to send and receive RADIUS requests.

Enable
RADIUS CoA

Select to enable Radius - Initiated Change of Authorization on the network device.

RADIUS CoA Port

By default this is port 3799 if Radius CoA is enabled. Change this value only if you
defined a custom port on the network device..

RADIUS
Authentication Port

Enter a port number here.

RADIUS Accounting
Port

Enter a port number here.
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Guest Access - Web Login Pre-Auth
Figure 51 Web Login Pre-Auth Service Template

Configuration » Service Templates

Service Templates - Guest Access - Web Login Pre-Auth

Name Prefix:
Wireless Network Settings
Wireless controller name:
Controller TP Address:
Vendor Name: Aruba -
RADIUS Shared Secret:
Enable RADIUS CoA: =]
RADIUS CoA Port:

Guest Access Restrictions

Days allowed for access™: [@Monday @ Tuesday [wednesday [@Thursday [@Friday [@Saturday [ Sunday

Add Service Cancel

Table 44: Web Login Pre-Auth Service Template Paramters

Parameter Description

Enter an optional prefix that will be prepended to services using this template. Use this

Name Prefix to identify services that use templates.

Wireless Network Settings

Wireless

The name given to the Wireless Controller.
controller name

Controller . ,

IP Address The wireless controller's IP address.

Vendor Name Select the manufacturer of the wireless controller.

RADIUS Enter the shared secret that is configured on the controller and inside Policy Manager

Shared Secret to send and receive RADIUS requests.

Enable

RADIUS CoA Select to enable Radius - Initiated Change of Authorization on the network device.

RADIUS CoA By default this is port 3799 if Radius CoA is enabled. Change this value only if you
Port defined a custom port on the network device..

Guest Access Restrictions

Days allowed

f Select the days on which access is allowed.
or access

Guest Access

This template is designed for authenticating guest users who login via captive portal. Guests must re-
authenticate after session expiry.Guest Access can be restricted based on day of the week, bandwidth
limit and number of unique devices used by the guest user.
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Figure 52 Guest Access Service Template

Configuration » Service Templates

Service Templates - Guest Access

Name Prefix:

Wireless Network Settings

Wireless SSID for Guest
access™:

Wireless controller name:

Controller IP Address:

Vendor Name: Aruba -
RADIUS Shared Secret:

Enable RADIUS CoA: (=]

RADIUS CoA Port:

Guest Access Restrictions

Days allowed for access™: [#Monday [ Tuesday [¥]wednesday [#Thursday [@Friday [#Saturday [¥]Sunday

m bandwidth
am";ﬂ,;ﬂséf*: 0 MB (Unlimited, if not specified)

Add Service Cancel

Table 45: Guest Access Service Template Parameters

Parameter Description

Enter an optional prefix that will be prepended to services using this template. Use

Name Prefix this to identify services that use templates.

Wireless Network Settings

Wireless SSID for

Enter the SSID value here.
Guest access

Wireless controller . .
The name given to the Wireless Controller.

name

Controller The wireless controller's IP address

IP Address ’

Vendor Name Select the manufacturer of the wireless controller.

RADIUS Shared Enter the shared secret that is configured on the controller and inside Policy
Secret Manager to send and receive RADIUS requests.

Enable Select to enable Radius - Initiated Change of Authorization on the network device
RADIUS CoA 9 :

RADIUS CoA Port By f:lefaultthls is port 3799 if Radius CoA is enabled. Change this value only if you
defined a custom port on the network device..

Guest Access Restrictions

Days allowed for Select the days on which access is allowed.

access

Maxmgm Enter a number to set an upper limit for the amount of data, in megabytes, a user is
bandwidth allowed .

per user allowed per day. A value of 0 (zero). the default, means no limit is set.

Guest MAC Authentication

This template is designed for authenticating guest accounts based on the cached MAC Addresses used
during authentication. A guest can belong to a specific role, such as Contractor, Guest, or Employee, and
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each role can have different lifetime for the cached MAC Address.

Figure 53 Guest MAC Authentication Service Template

Configuration » Service Templates

Service Templates - Guest MAC Authentication

Name Prefix: [ |

Wireless Network Settings.

- 1
access™:

Wireless controller name: I:l
Vendor Name: Aruba -
Enable RADIUS CoA: ]

RADIUS CoA Port: 3799

MAC Caching Settings

Cache duration for Guest

role: days

Cache duration for

Employee role: days

Cache duration for

Contractor role: days

Guest Access Restrictions

Days allowed for access™: [@ImMonday ¥ Tuesday [VIwednesday [¥IThursday [IFriday [ saturday [ Sunday
e e L 1

devices allowed per user™:

Maximum bandwidth 0

allowed per user™: MB (for unlimited set to 0)

Add Service Cancel

Table 46: Guest MAC Authentication Service Template Parameters.

Parameter Description

Name Prefix Use this to identify services that use templates.

Enter an optional prefix that will be prepended to services using this template.

Wireless Network

Settings Wireless Network Settings

Wireless SSID for

Enter the SSID name of your network.
Guest access

Wireless controller

name

The name given to the Wireless Controller.

Controller IP Address

The wireless controller's IP address.

Vendor Name

Select the manufacturer of the wireless controller.

RADIUS Shared
Secret

Enter the shared secret that is configured on the controller and inside Policy
Manager to send and receive RADIUS requests.

Enable RADIUS CoA

Select to enable Radius - Initiated Change of Authorization on the network
device.

RADIUS CoA Port

By default this is port 3799 if Radius CoA is enabled. Change this value only if
you defined a custom port on the network device..

MAC Caching Settings

Cache duration for
Guest Role

Enter the number of days the MAC account will remain valid for Guest Role. After
this the guest will need to re-authenticate via captive portal.

100

ClearPass Policy Manager 6.1 | User Guide




Parameter Description

Cache duration for Enter the number of days the MAC account will remain valid for Employee Role.
Employee role After this the guest will need to re-authenticate via captive portal.
Cache duration for Enter the number of days the MAC account will remain valid for Contractor Role.
Contractor role After this the guest will need to re-authenticate via captive portal.

Guest Access Restrictions

Days allowed for

Select the days on which access is allowed.
access

Maximum number of

devices allowed per Enter a number to define how many devices users can connect to the network.
user

Maximum bandwidth Enter a number to set an upper limit for the amount of data, in megabytes, a user
allowed per user is allowed per day. A value of 0 (zero). the default, means no limit is set.

Onboard Authorization

This template is designed for configuration that allows checks to be performed before allowing Onboard

provisioning for BYOD use-cases.

Figure 54 Onboard Authorization Service Template

Configuration » Service Templates

Service Templates - Onboard Authorization

Name Prefix: ‘ ‘
— Wireless Network

wireless controller name: /1

Vendor Name: Aruba -

Enable RADIUS CoA: (=]

Guest Access Restrictions

Days allowed for access™: [WIMonday M Tuesday [lwednesday [ Thursday [MFriday [Isaturday [ sunday
— Provisioning Wireless Network g:

Wireless SSID for Onboard l:l

Provisioning™:

Add Service Cancel

Table 47: Onboard Authorization Service Template Parameters

Parameter Description

Enter an optional prefix that will be prepended to services using this template.

Name Prefix Use this to identify services that use templates.

Wireless Network Settings

Wireless controller . -
The name given to the Wireless Controller.

name
Controller IP Address The wireless controller's IP address.
Vendor Name Select the manufacturer of the wireless controller.
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Parameter Description

RADIUS Shared Secret Manager to send and receive RADIUS requests.

Enter the shared secret that is configured on the controller and inside Policy

Enable RADIUS CoA ;
device.

Select to enable Radius - Initiated Change of Authorization on the network

RADIUS CoA Port you defined a custom port on the network device..

By default this is port 3799 if Radius CoA is enabled. Change this value only if

Guest Access Restrictions

Days allowed for

Select the days on which access is allowed.
access

Provisioning Wireless Network Settings

Wireless SSID for

Onboard Provisioning Enter the SSID of your network.

Services

You can use these service types as configured, or you can edit their settings.

Figure 55 Service Listing Page

Services =" Add Service
2 Import Services
& Export Services
Fite: Name  []contains | o | ClearFitler show records
# [ oOrderA Name Type Status
1@ 1 [Policy Manager Admin Network Login Service] TACACS TACACS+ Enforcement ®
2.0 2 [Guest Operator Logins] Application  Aruba Application Authentication ]
3.0 3 Radius Service RADIUS RADIUS Enforcement (Generic) =]
Showing 1-3 of 3 Copy | Export | Delete

The Services page includes the following fields.

Table 48: Services page

Label Description

Add Add a service

Service

Import Import previously exported services

Services

Export Export all currently defined services, including all associated policies

Service

Filter Filter the service listing by specifying values for different listing fields (Name, Type, Template,
Status)

Status The status displays in the last column of the table. A green/red icon indicates
enabled/disabled state. Clicking on the icon allows you to toggle the status of a Service
between Enabled and Disabled. Note that when a service is in Monitor Mode, an [m] indicator
is displayed next to the status icon.
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Label Description

Reorder | The Reorder button below the table is used for reorder services.

Copy Create a copy of the service. An instance of the name prefixed with Copy_of_ is created
Export Export the selected services

Delete Delete the selected services

For additional information, refer to the following sections:

e "Adding Services " on page 103

e "Modifying Services " on page 105

e '"Reordering Services " on page 107

Adding Services

From the Services page (Configuration > Services) or from the Start Here page (Configuration > Start Here), you
can create a new service using the Add Service option.

Click on Add Service in the upper-right corner to add a new service.

Figure 56 Add Service Page

Services

m Authentication Authorization Roles Posture Enforcement Audit Profiler Summary

Type:
Name:

Description:

Monitor Mode:
More Options:

Service Rule

Matches © ANY or @ ALL of the following conditions:

| Aruba 802.1X Wireless [=]
[ ]

Aruba 802.1X Wireless Access Service

[7] Enable to monitor network access without enforcement

¥ authorization Posture Compliance ] Audit End-hosts profile Endpoints

s.|click to add..

Type Name Operator Value &
1.|radius:TETF NAS-Port-Type EQUALS Wireless-802.11 (19) @
) § Login-User (1), Frame-User (2),
.|Radius:IETF Service-Type BELONGS_TO ahentiento-Only (6) By o
3.|REd\uE:AI’\JbE Aruba-Location-Id EXISTS By i
4.|Radius:Aruba Aruba-Essid-Name EXISTS By @

The Add Service tab includes the following fields.

Table 49: Service Page (General Parameters)

Label Description

Type

Select the desired service type from the drop down menu. When working with service rules,

you can select from the following namespace dictionaries:

o Application: The type of application for this service.

o Authentication: The Authentication method to be used for this service.

e Connection: Originator address (Src-IP-Address, Src-Port), Destination address (Dest-
IP-Address, Dest-Port), and Protocol

o Device: Filter the service based on a specific device type, vendor, operating system
location, or controller ID.
Date: Time-of-Day, Day-of-Week, or Date-of-Year

o Endpoint: Filter based on endpoint information, such as enabled/disabled, device, OS,
location, and more.

o Host: Filter based on host Name, OSType, FQDN, UserAgent, CheckType, UniquelD,
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Label Description

Agent-Type, and InstalledSHAs,

o RADIUS: Policy Manager ships with a number of vendor-specific namespace
dictionaries and distinguishes vendor-specific RADIUS namespaces with the notation
RADIUS:vendor (sometimes with an additional suffix for a particular device). To add a
dictionary for a vendor-specific RADIUS namespace, navigate to Administration >
Dictionaries > Radius > Import Dictionary (link).

The notation RADIUS:IETF refers to the RADIUS atiributes defined in RFC 2865 and
associated RFCs. As the name suggests, RADIUS namespace is only available when
the request type is RADIUS.

o Any other supported namespace. See "Namespaces" on page 329 for an exhaustive list
of namespaces and their descriptions.

To create new Services, you can copy or import other Services for use as is or as

templates, or you can create a new Service from scratch.

Name Label for a Service.

Description | Description for a Service (optional).

Monitor Optionally check the Enable to monitor network access without enforcement to allow
Mode authentication and health validation exchanges to take place between endpoint and Policy
Manager, but without enforcement. In monitor mode, no enforcement profiles (and
associated attributes) are sent to the network device.

Policy Manager also allows Policy Simulation (Monitoring > Policy Simulation) where the
administrator can test for the results of a particular configuration of policy components.

More Select any of the available check boxes to enable the configuration tabs for those options.
Options The available check boxes varies based on the type of service that is selected and may
include one or more of the following:

o Authorization: Select an authorization source from the drop down menu to add the
source or select the Add new Authentication Source link to create a new source.

o Posture Compliance: Select a Posture Policy from the drop down menu to add the
policy or create a new policy by clicking the link. Select the default Posture token.
Specify whether to enable auto-remediation of non-compliant end hosts. If this is
enabled, then enter the Remediation URL. Finally, specify the Posture Server from the
drop down menu or add a new server by clicking the Add new Posture Server link.

Services

Service Authentication Authorization Roles Posture Enforcement Audit Profiler Summary

Authorization Details: Authorization sources from which rele mapping attributes are fetched (for each authentication sour

Authentication Source Attributes Fetched From

Additional authorization sources from which to fetch role-mapping attributes -
Local User Repository] [Local SQL DE] - Add new
[Endpoints Repository] [Local SAL DB]
PTDOMAIN AD [Active Directory] V‘e:: T_r"f':"s
b Mo

—Selectto Add-

o Audit End-hosts: Select an Audit Server - either built-in or customized. Refer to
"Configuring Audit Servers" on page 199 for audit server configuration steps. For this
type of service you can perform audit Always, When posture is not available, or For
MAC authentication requests.

104 ClearPass Policy Manager 6.1 | User Guide



Label Description

Service Authentication Authorization Roles Posture Enforcement Summary

Audit Server: —Select- [=]_ View Details | Modify ‘

Audit Trigger Conditions: @ Always
) when posture is not available
©) For MAC authentication request

Action after audit: @ No Action

© Do SNMP bounce
@ Trigger RADIUS CoA action

You can specify to trigger an audit always, when posture is not available, or for MAC

authentication requests. If For MAC authentication requests is specified, then you can

perform an audit For known end-hosts only or For unknown end hosts only, or For all

end hosts. Known end hosts are defined as those clients that are found in the

authentication source(s) associated with this service. Performing audit on a clientis an

asynchronous task, which means the audit can be performed only after the MAC

authentication request has been completed and the client has acquired an IP address

through DHCP. Once the audit results are available, there should be a way for Policy

Manager to re-apply policies on the network device. This can be accomplished in one

of the following ways:

= No Action: The audit will not apply policies on the network device after this audit.

= Do SNMP bounce: This option will bounce the switch port or to force an 802.1X
reauthentication (both done via SNMP).Note: Bouncing the port triggers a new
802.1X/MAC authentication request by the client. If the audit server already has the
posture token and attributes associated with this clientin its cache, it returns the
token and the attributes to Policy Manager.

= Trigger RADIUS CoA action: This option sends a RADIUS Change of Authorization
command to the network device by Policy Manager.

e Optionally configure Profiler settings. Select one or more Endpoint Classification items
from the drop down list, then select the RADIUS CoA action. You can also create a new
action by selecting the Add new RADIUS CoA Action link.

Service Authentication Roles Enforcement Audit m Summary
Endpoint Classification: Select the classification(s) after which an action must be triggered-
.
Home Audio/Video Equipment
Projectors -
- Select—-
RADIUS Con Action: {Ariba Tominate Session Add nen

Modifying Services

Navigate to the Configuration > Services page to view available services. You can use these service types as
configured, or you can edit their settings.

Figure 57 Service Listing Page

Services “ Add Service
& Import Services
& Export Services

eaver: s lcontains show 10 <] recards

# [ ordera Name Type Template Status

i, ‘ 8 1 [Policy Manager Admin Network Login Service] TACACS TACACS+ Enforcement @

2. ‘ 0 2 [Guest Operator Logins] Application  Aruba Application Authentication @

3.‘E| 3 Radius Service RADIUS RADIUS Enforcement (Generic) @

Showing 1-3 of 3 Copy | Export | Delete

To modify an existing service, click on its name in the Configuration > Services page. This opens the Services > Edit
- <service_name> form. Select the Service tab on this form to edit the service information.
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Figure 58 Services Configuration
summory | ventcoion ol

Name: |[Policy Manager Admin Network Login Service] |

Description: Service for access to Policy Manager
ork users

Admin for network

Type: TACACS+ Enforcement t
Status: Enabled
Monitor Mode: Enable to monitor network access without enforcement

More Options: [0 Authorization

Service Rule

Matches © ANY or © ALL of the following conditions:

Type Name Operator value @
1.‘CUHHECUUH NAD-IP-Address EQUALS 127.0.0.1 By o
2.|click to add.

< ko senics (oo o ] e L o

The following fields are available on the Service tab.

Table 50: Service Page (General Parameters)

Label Description

Name Enter or modify the label for a service.

Description | Enter or modify the service description (optional).

Type This is a non-editable label that shows the type of service as it was originally configured.

Status This non-editable label indicates whether the service is enabled or disabled.
NOTE: You can disable a service by clicking the Disable button on the bottom-right corner
of the form.This button will toggle between Enable and Disable depending on the Service's

current status.
Monitor This non-editable check box indicates whether authentication and health validation
Mode exchanges will take place between endpoint and Policy Manager, but without enforcement.

In monitor mode, no enforcement profiles (and associated attributes) are sent to the
network device.

More Select the available check box(es) to view additional configuration tab(s). The options that
Options are available depend on the type of service currently being modified. TACACS+ Service,
for example, allows for authorization configuration.RADIUS Service allows for configuration
of posture compliance, end hosts, profile endpoints, and authorization.

On the lower half of the form, select an available rule within the Service Rule table. The following fields are
available.

Table 51: Service Page (Rules Editor)

Label Description

Type The rules editor appears throughout the Policy Manager interface. It exposes different

namespace dictionaries depending on Service type. When working with service rules, you

can select from the following namespace dictionaries:

o Application: The type of application for this service.

o Authentication: The Authentication method to be used for this service.

e Connection: Originator address (Src-IP-Address, Src-Port), Destination address (Dest-IP-
Address, Dest-Port), and Protocol

o Device: Filter the service based on a specific device type, vendor, operating system
location, or controller ID.

o Date: Time-of-Day, Day-of-Week, or Date-of-Year
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Label Description

e Endpoint: Filter based on endpointinformation, such as enabled/disabled, device, OS,
location, and more.

o Host: Filter based on host Name, OSType, FQDN, UserAgent, CheckType, UniquelD,
Agent-Type, and InstalledSHAs,

o RADIUS: Policy Manager ships with a number of vendor-specific namespace dictionaries
and distinguishes vendor-specific RADIUS namespaces with the notation RADIUS:vendor
(sometimes with an additional suffix for a particular device). To add a dictionary for a
vendor-specific RADIUS namespace, navigate to Administration > Dictionaries > Radius
> Import Dictionary (link).

The notation RADIUS:IETF refers to the RADIUS attributes defined in RFC 2865 and
associated RFCs. As the name suggests, RADIUS namespace is only available when the
request type is RADIUS.

e Any other supported namespace. See "Namespaces" on page 329 for an exhaustive list of
namespaces and their descriptions.

Name Drop-down list of attributes present in the selected namespace.
(of
attribute)

Operator | Drop-down list of context-appropriate (with respect to the attribute) operators. See "Operators”
on page 335 for an exhaustive list of operators and their descriptions.

Value of | Depending on attribute data type, this can be a free-form (one or many lines) edit box, a drop-
attribute down list, or a time/date widget.

Reordering Services

Policy Manager evaluates requests against the service rules of each service that is configured, in the order in which
these services are defined. The service associated with the first matching service rule is then associated with this
request. To change the order in which service rules are processed, you can change the order of services.

1. To reorder services, navigate to the Configuration > Services page. The following page displays.

Figure 59 Service Reorder Button

Configuration » Services
Services " Add Service
& Import Services
& Export Services

Filter:| Name [=] contains Show [ 10 [=] records
# [ ordera Name Type Template Status
1. ‘ B 1 [Policy Manager Admin Network Login Service] TACACS TACACS+ Enforcement e
2 ‘D 2 [Guest Operator Logins] Application Aruba Application Authentication @
3. ‘ o 3 Radius Service RADIUS RADIUS Enforcement (Generic) @
Showing 1-3 of 3 Copy | Export | Delete

2. Click the Reorder button located on the lower-right portion of the page to open the Reordering Services form.
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Figure 60 Reordering Services

Configuration » Services » Reorder

Reorder Services

order
1

Name Service Details:

[Palicy Manager Admin Network Login Service] Name:

[Policy Manager Admin Network Login Service]

2 [Guest Operator Logins] Template: TACACS+ Enforcement

3 Radius Service Type: TACACS
Description: Service for access to Policy Manager Admin for network users
Status:

Enabled

( (Connection: NAD-IP- Address EQUALS 127.0.0.1) )
AND (Connection:Protocol EQUALS TACACS)

€ Back to services

Save § Cancel

Table 52: Reordering Services

Description

Move Up/Move Down Select a service from the list and move it up or down

Save

Save the reorder operation

Cancel

Cancel the reorder operation
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Chapter 13

Authentication and Authorization

As the first step in Service-based processing, Policy Manager uses an Authentication Method to authenticate the user
or device against an Authentication Source. Once the user or device is authenticated, Policy Manager fetches attributes
for role mapping policies from the Authorization Sources associated with this Authentication Source.

Architecture and Flow
Policy Manager divides the architecture of authentication and authorization into three components:

e Authentication Method. Policy Manager initiates the authentication handshake by sending available methods, in
priority order, until the client accepts a methods or until it NAKSs the last method, with the following possible
outcomes:

= Successful negotiation returns a method, for use in authenticating the client against the Authentication Source.

= Where no method is specified (for example, for unmanageable devices), Policy Manager passes the request to the
next configured policy component for this Service.

= Policy Manager rejects the connection.

An Authentication Method is only configurable for some service types (Refer to "Policy Manager Service Types" on page
80). All 802.1X services (wired and wireless) have an associated Authentication Method. An authentication method (of
NOTE type MAC_AUTH) can be associated with MAC authentication service type.

e Authentication Source. In Policy Manager, an authentication source is the identity store (Active Directory, LDAP
directory, SQL DB, token server) against which users and devices are authenticated. Policy Manager first tests
whether the connecting entity - device or user - is present in the ordered list of configured Authentication Sources.
Policy Manager looks for the device or user by executing the first Filter associated with the authentication source.
Once the device or user is found, Policy Manager then authenticates this entity against this authentication source.
The flow is outlined below:

= On successful authentication, Policy Manager moves on to the next stage of policy evaluation, which is to
collect role mapping attributes from the authorization sources.

= Where no authentication source is specified (for example, for unmanageable devices), Policy Manager passes the
request to the next configured policy component for this Service.

= If Policy Manager does not find the connecting entity in any of the configured authentication sources, it rejects
the request.

= Once Policy Manager successfully authenticates the user or device against an authentication source, it retrieves
role mapping attributes from each of the authorization sources configured for that authentication source. It also,
optionally, can retrieve attributes from authorization sources configured for the Service.

The flow of control for authentication takes these components in sequence:
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Figure 61 Authentication and Authorization Flow of Control

Authentication
Service uses
MethOd Authentication
Method?
Extract role mapging
ves attributes from
i Authorization
Policy Manager sends
Authentication Methods Source(s)
Cllent specified far this service, in Palicy Manager initiates
en order of prionty, watl client authentication handshake with client
accepts a method or rejects
the last.
= Role
Mapping
. Request Handshake
rejected to successful?
|
Yes
~ — s
( Authentication
Policy Manager collects credentials and
source authenticates against Authentication
Source(s), in order
Mot Request
sccapted rejected
Authentication
slalus?
Switch
\ Accepted

AN

¥

( Authorization

Attributes configured 1o be
Source retrigved from
Authorization Source(s)
Role
Mapping | o

A

Policy Manager extracts attributes associated with device or

user from

«  the Authorization Sources configured for the
Authentication Source

«  the Authorization Sources configured for the Service

Configuring Authentication Components

The following summarizes the methods for configuring authentication:

e For an existing Service, you can add or modify authentication method or source, by opening the Service

(Configuration > Services, then select), then opening the Authentication tab.

e For a new Service, the Policy Manager wizard automatically opens the Authentication tab for configuration.

e Outside of the context of a particular Service, you can open an authentication method or source by itself:
Configuration > Authentication > Methods or Configuration > Authentication > Sources.
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Figure 62 Authentication Components

Configuration » Services » Edit - a802.1X Wireless Service
Services - a802.1X Wireless Service
Authentication Methods: eTIPS_EAP_PEAP [EAP-PEAP] +]_ moveup Add new Authentication
eTIPS_EAP_FAST [EAP-FAST] Move Down Method
Remove
View Details
- Modify
-Select- - Add
Authentication Sources: Avenda_eTIPS_Local User_Repository [Loce - Move Up Add new Authentication
Avenda AD [Active Directory] Move Down Source
Remove
View Details
- Modify
-Select- - Add
Strip Username Rules: [Z] Enable to specify a comma-separated list of rules to strip username prefixes or suffixes

From the Authentication tab of a service, you can configure three features of authentication:

Table 53: Authentication Features at the Service Level

Configurable

Gomponnnt Configuration Steps

—_

Sequence of Select a Method, then select Move Up, Move Down, or Remove.
Authentication Select View Details to view the details of the selected method.
Methods 3. Select Modify to modify the selected authentication method. (This launches a popup with
the edit widgets for the select authentication method.)
= To add a previously configured Authentication Method, select from the Select drop
down list, then click Add.
= To configure a new Method, click the Add New Authentication Method link. Refer to
"Adding and Modifying Authentication Methods" on page 11 1for information about
Authentication Methods.
Note that an Authentication Method is only configurable for some service types. Refer to
"Policy Manager Service Types" on page 80 for more information.

N

—_

Sequence of Select a Source, then Move Up, Move Down, or Remove.

Authentication 2. Select View Details to view the details of the selected authentication source.

Sources 3. Select Madify to modify the selected authentication source. (This launches the

authentication source configuration wizard for the selected authentication source.

= To add a previously configured Authentication Source, select from the Select drop
down list, then click Add.

= To configure a new Authentication Source, click the Add New Authentication Source
link. Refer to "Adding and Modifying Authentication Sources " on page 128 for
additional information about Authentication Sources.

Whether to Select the Enable to specify a comma-separated list of rules to strip usernames check box to
standardize the form pre-process the user name (and to remove prefixes and suffixes) before authenticating it to

in which usernames the authentication source.

are present

Adding and Modifying Authentication Methods

Policy Manager supports specific EAP and non-EAP, tunneled and non-tunneled, methods.
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Table 54: Policy Manager Supported Authentication Methods

Tunneled

EAP

EAP Protected
EAP (EAP-PEAP)
EAP Flexible
Authentication
Secure Tunnel
(EAP-FAST)
EAP Transport
Layer Security
(EAP-TLS)

EAP Tunneled
TLS (EAP-TTLS)

Non-EAP

Non-
Tunneled

EAP Message
Digest 5 (EAP-
MD5)

EAP Microsoft
Challenge
Handshake
Authentication
Protocol version 2
(EAP-
MSCHAPV2)

EAP Generic
Token Card (EAP-
GTC)

Challenge Handshake Authentication Protocol (CHAP)
Password Authentication Protocol (PAP)

Microsoft CHAP version 1 and version 2

MAC Authentication Method (MAC-AUTH)

MAC-AUTH must be used exclusively in a MAC-based
Authentication Service. When the MAC_AUTH method is
selected, Policy Manager makes internal checks to verify that
the request is indeed a MAC_Authentication request (and not
a spoofed request).

In tunneled EAP methods, authentication and posture credential exchanges occur inside of a protected outer tunnel.

The Authorize authentication method does not fitinto any of these categories.

From the Services page (Configuration > Service), you can configure authentication for a new service (as part of the
flow of the Add Service wizard), or modify an existing authentication method directly (Configuration >
Authentication > Methods, then click on its name in the Authentication Methods listing).

When you click Add New Authentication Method from any of these locations, Policy Manager displays the Add
Authentication Method popup.
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Figure 63 Add Authentication Method dialog box

Add Authentication Method o

MName:

Description:

Type: Select Authentication type... |~

Select Authentication type...
Authorize

CHAP
EAP-FAST
EAP-GTC
EAP-MDA
EAP-MSCHAPv2
EAP-PEAP
EAP-TLS
EAP-TTLS
MAC-AUTH
MSCHAP

PAP

Depending on the Type selected, different tabs and fields appear. Refer to the following:
e "PAP " on page 113

e "MSCHAP " on page 114

e "EAP-MSCHAP v2 " on page 115

e "EAP-GTC " on page 115

e "EAP-TLS " on page 116

e "EAP-TTLS " on page 118

e "EAP-PEAP " on page 119

e "EAP-FAST " on page 121

e "MAC-AUTH " on page 126

e "CHAP and EAP-MDS5 " on page 126

e Authorize
PAP
The PAP method contains one tab.

General Tab

The General tab labels the method and defines session details.
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Figure 64 PAP General Tab

Add Authentication Method o

Name: | |
Description: -
Type: PAP -

Method Details

Encryption Scheme:

Save Cancel

Table 55: PAP General Tab

Parameter Description

Name/Description Freeform label and description.
Type In this context, always PAP.
Encryption Select the PAP authentication encryption scheme. Supported schemes are: Clear,
Scheme Crypt, MD5 SHA1 or Aruba-SSO.
MSCHAP

The MSCHAP method contains one tab.

General Tab

The General tab labels the method and defines session details.

Figure 65 MSCHAP General Tab

Add Authentication Method o

Name:

Description:

Type: MSCHAP v|

Save J Cancel
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Table 56: MSCHAP General Tab

Parameter Description

Name/Description Freeform label and description.

Type In this context, always MSCHAP.

EAP-MSCHAP v2
The EAP-MSCHAPv2 method contains one tab.

General Tab

The General tab labels the method and defines session details.

Figure 66 EAP-MSCHAPv2 General Tab

Edit Authentication Method

General

MName:

Description:

Type: EAP-MSCHAPv2

Save Cancel

Table 57: EAP-MSCHAPVZ2 General Tab

Parameter Description

Name/Description Freeform label and description.
Type In this context, always EAP-MSCHAPV2.
EAP-GTC

The EAP-GTC method contains one tab.

General Tab

The General tab labels the method and defines session details.
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Figure 67 EAP-GTC General Tab

Edit Authentication Method o

General

Name:

Description:

Type:

Challenge:

EAP-GTC

| Password:

Save Cancel

Table 58: EAP-GTCGeneral Tab

Parameter Description

Name/Description

Freeform label and description.

Type In this context, always EAP-GTC.
Challenge Specify an optional password.
EAP-TLS

The EAP-TLS method contains one tab.

General Tab

The General tab labels the method and defines session details.
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Figure 68 EAP_TLS General Tab

Edit Authentication Method o

Mame: [EAP TLS]

Description: Default settings for EAP-TLS
Type: EAP-TLS

Method Details

Session Resumption: Enable

Session Timeout: 6 hours
Authorization Required: Enable

Certificate Comparison: Do notcompare

Verify Certificate using OCSP: Mane

[ =]

Override OCSP URL from Client: [C] Enable
OCSP URL:

Save Cancel

Table 59: EAP_TLS General Tab

Parameter Description

Name/Description | Freeform label and description.

Type In this context, always EAP_TLS.

Session Caches EAP-TLS sessions on Policy Manager for reuse if the user/client reconnects
Resumption to Policy Manager within the session timeout interval.

Session Timeout How long (in hours) to retain cached EAP-TLS sessions.

Authorization Specify whether to perform an authorization check.

Required

Certificate Type of certificate comparison (identity matching) upon presenting Policy Manager
Comparison with a client certificate:

e To skip the certificate comparison, choose Do not compare.

o To compare specific attributes, choose Compare Common Name (CN), Compare
Subject Alternate Name (SAN), or Compare CN or SAN.

e To perform a binary comparison of the stored (in the client record in Active
Directory or another LDAP-compliant directory) and presented certificates,
choose Compare Binary.

Verify Certificate Select Optional or Required if the certificate should be verified by the Online
using OCSP Certificate Status Protocol (OCSP). Select None to not verify the certificate.
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Parameter Description

Override OCSP Select this option if you want to use a different URL for OCSP. After this is enabled,
URL from the you can enter a new URL in the OCSP URL field.
Client
OCSP URL If Override OCSP URL from the Clientis enabled, then enter the replacement
URL here.
EAP-TTLS

The EAP-TTLS method contains two tabs.

General Tab
The General tab labels the method and defines session details.

Figure 69 EAP-TTLS General Tab

Add Authentication Method o
m Inner Methods

Mame: |

Description:

Type: {EAP-TTLS v

Session Resumption: Enable
Session Timeout: 6 |hours

Table 60: EAP-TTLS General Tab

Parameter Description

Name/Description | Freeform label and description.

Type In this context, always EAP-TTLS.

Session Caches EAP-TTLS sessions on Policy Manager for reuse if the user/client
Resumption reconnects to Policy Manager within the session timeout interval.

Session Timeout How long (in hours) to retain cached EAP-TTLS sessions.
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Inner Methods Tab
The Inner Methods tab controls the inner methods for the EAP-TTLS method:

Figure 70 EAP_TTLS Inner Methods Tab

Specify inner authentication methods in the preferred order:

[EAP MSCHAPvZ] -

[EAP TLS]

[EAP GTC] Default
[PAP] Remove
Selecta method... |z|

To set preference for a specific method, use Default button

Select any method available in the current context from the drop-down list. Functions available in this tab include:

e To append an inner method to the displayed list, select it from the drop-down list, then click Add. The list can
contain multiple inner methods, which Policy Manager will send, in priority order, until negotiation succeeds.

e To remove an inner method from the displayed list, select the method and click Remove.

e To set an inner method as the default (the method tried first), select it and click Default.

EAP-PEAP
The EAP-PEAP method contains two tabs:

General Tab
The General tab labels the method and defines session details.

Figure 71 EAP-PEAP General Tab

Add Authentication Method o
Inner Methods

Name:

Description:

Type: EAP-PEAP A

Method Details

Session Resumption: Enable
Session Timeout: 6 hours
Fast Reconnect: Enable
EAPoUDP Support: [C] Enable
Microsoft NAP Support: Enable
Enforce Cryptobinding: [C] Enable
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Table 61: EAP-PEAP General Tab

Parameter Description

Name/Description

Freeform label and description.

Type In this context, always EAP-PEAP.
Session Caches EAP-PEAP sessions on Policy Manager for reuse if the user/client
Resumption reconnects to Policy Manager within the session timeout interval.

Session Timeout

Caches EAP-PEAP sessions on Policy Manager for reuse if the user/client
reconnects to Policy Manager within the session timeout interval. If session timeout
value is setto 0, the cached sessions are not purged.

Fast Reconnect

Enable this check box to allow fast reconnect; when fast reconnect is enabled, the
inner method that happens inside the server authenticated outer tunnel is also
bypassed. This makes the process of re-authentication faster. For fast reconnect to
work, session resumption must be enabled.

EAPoUDP
Support

Enable EAPoUDP support. When EAPoUDP supportis enabled Policy Manager
does not expect user authentication to happen within the protected tunnel.

Microsoft NAP

Enable while Policy Manager establishes the protected PEAP tunnel with a Microsoft

Cryptobinding

Support NAP-enabled client. When enabled, Policy Manager prompts the client for Microsoft
Statement of Health (SoH) credentials.
Enforce Enabling the cryptobinding setting ensures an extra level of protection for PEAPvO

exchanges. It ensures that the PEAP client and PEAP server (Policy Manager)
participated in both the outer and inner handshakes. This is currently valid only for
the client PEAP implementations in Windows 7, Windows Vista and Windows XP
SP3.

Inner Methods Tab

The Inner Methods Tab controls the inner methods for the EAP-PEAP method:
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Figure 72 EAP-PEAP Inner Methods Tab

Add Authentication Method o

Specify the inner authentication methods in preferred arder:

ellPS _EAP TLS [EAP-TLS](Default)

Select a method ..

To set preference for a specific method, use Default button

S

Select any method available in the current context from the drop-down list. Functions available in this tab include:

e To append an inner method to the displayed list, select it from the drop-down list, then click Add. The list can
contain multiple inner methods, which Policy Manager will send, in priority order, until negotiation succeeds.

e To remove an inner method from the displayed list, select the method and click Remove.

e To set an inner method as the default (the method tried first), select it and click Default.

EAP-FAST
The EAP-FAST method contains four tabs:

General Tab

The General tab labels the method and defines session details.
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Figure 73 EAP-FAST General Tab

Add Authentication Method L
m Inner Methods PACs PAC Provisioning

MName:

Description:

Type: EAP-FAST i
Session Resumption: Enable

Session Timeout: B haurs

Client Authentication: | sing PACs w
Certificate Comparision: || Do not compare w

Save

Table 62: EAP_FAST General Tab

Parameter Description

Name/Description | Freeform label and description.

Type In this context, always EAP_FAST.
Session Caches EAP-FAST sessions on Policy Manager for reuse if the user/end-host
Resumption reconnects to Policy Manager within the session timeout interval.

Session Timeout Caches EAP-FAST sessions on Policy Manager for reuse if the user/end-host
reconnects to Policy Manager within the session timeout interval. If session timeout
value is setto 0, the cached sessions are not purged.

Fast Reconnect Enable to allow fast reconnect. When enabled, the inner method of the server-
authenticated outer tunnel is also bypassed. This makes the process of re-
authentication faster. For fast reconnect to work, session resumption must be

enabled.
End-Host Refers to establishing the EAP-Fast Phase 1 Outer tunnel:
Authentication e Choose Using PACs to use a strong shared secret.

e Choose Using Client Certificate to use a certificate.

Certificate Type of certificate comparison (identity matching) upon presenting Policy Manager

Comparison with a client certificate:

e To skip the certificate comparison, choose Do not compare.

e To compare specific attributes, choose Compare Common Name (CN), Compare
Subject Alternate Name (SAN), or Compare CN or SAN.

o To perform a binary comparison of the stored (in the end-host record in Active
Directory or another LDAP-compliant directory) and presented certificates,
choose Compare Binary.

122 ClearPass Policy Manager 6.1 | User Guide



Inner Methods Tab
The Inner Methods tab controls the inner methods for the EAP-FAST method:

Figure 74 Inner Methods Tab

Add Authentication Method e
General Inner Methods PACs PAC Provisioning

Specify the inner authentication methods in preferred arder:

Default

ellPS _EAP TLS [EAP-TLS](Default)

Select a method ..

To set preference for a specific method, use Default button

Sove

e To append an inner method to the displayed list, select it from the drop-down list, then click Add. The list can
contain multiple inner methods, which Policy Manager will send, in priority order, until negotiation succeeds.

e To remove an inner method from the displayed list, select the method and click Remove.

e To set an inner method as the default (the method tried first), select it and click Default.

PACs Tab
The PACs tab enables/disables PAC types:
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Figure 75 EAP_FAST PACs Tab

Add Authentication Method o

PAC Provisioning

General Inner Methods

Tunnel PAC Expire Time: 1 days hd

Machine PAC

Machine PAC Expire Time: 1 days w
Authorization PAC
Authorization PAC Expire Time: 1 days w

Posture PAC

Posture PAC Expire Time: i days w

S

e To provision a Tunnel PAC on the end-host after initial successful machine authentication, specify the Tunnel
PAC Expire Time (the time until the PAC expires and must be replaced by automatic or manual provisioning) in
hours, days, weeks, months, or years.. During authentication, Policy Manager can use the Tunnel PAC shared secret
to create the outer EAP-FAST tunnel.

e To provision a Machine PAC on the end-host after initial successful machine authentication, select the Machine
PAC check box. During authentication, Policy Manager can use the Machine PAC shared secret to create the outer
EAP-FAST tunnel. Specify the Machine PAC Expire Time (the time until the PAC expires and must be replaced,
by automatic or manual provisioning) in hours, days, weeks, months, or years. This can be a long-lived PAC
(specified in months and years).

e To provision an authorization PAC upon successful user authentication, select the Authorization PAC check box.
Authorization PAC results from a prior user authentication and authorization. When presented with a valid
Authorization PAC, Policy Manager skips the inner user authentication handshake within EAP-FAST. Specify the
Authorization PAC Expire Time (the time until the PAC expires and must be replaced, by automatic or manual
provisioning) in hours, days, weeks, months, or years. This is typically a short-lived PAC (specified in hours, rather
than months and years).

e To provision a posture PAC upon successful posture validation, select the Posture PAC check box. Posture PACs
result from prior posture evaluation. When presented with a valid Posture PAC, Policy Manager skips the posture
validation handshake within the EAP-FAST protected tunnel; the prior result is used to ascertain end-host health.
Specify the Authorization PAC Expire Time (the time until the PAC expires and must be replaced, by automatic
or manual provisioning) in hours, days, weeks, months, or years. This is typically a short-lived PAC (specified in
hours, rather than months and years).

PAC Provisioning Tab

The PAC Provisioning tab controls anonymous and authenticated modes:
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Figure 76 EAP_FAST PAC Provisioning tab

Add Authentication Method o

General Inner Methods PACs

In-Band PAC Provisioning

Allow anonymous mode (requires no server certificate)
Allow authenticated mode (requires server certificate)
Accept end-host after authenticated provisioning

[C] rRequire end-host certificate for provisioning

Table 63: EAP_FAST PAC Provisioning Tab

Parameter Description Considerations

Allow When in anonymous mode, phase 0 of EAP_ Authenticated mode is more secure

Anonymous FAST provisioning establishes an outer tunnel than anonymous provisioning mode.

Mode without end-host/Policy Manager authentication | Once the server is authenticated, the
(not as secure as the authenticated mode). phase 0 tunnel is established, the
Once the tunnel is established, end-host and end-host and Policy Manager
Policy Manager perform mutual authentication perform mutual authentication, and
using MSCHAPV2, then Policy Manager Policy Manager provisions the end-
provisions the end-host with an appropriate host with an appropriate PAC (tunnel
PAC (tunnel or machine). or machine):

e [fboth anonymous and
authenticated provisioning
modes are enabled, and the end-
host sends a cipher suite that
supports server authentication,

Allow Enable to allow authenticated mode ; ;
Authenticated | provisioning. When in Allow Authenticated Policy Manager picks the
Mode Mode phase 0, Policy Manager establishes the authenticated provisioning mode.
outer tunnel inside of a server-authenticated o .
tunnel. The end-host authenticates the server ¢ Otherwise, if the appropriate
by validating the Policy Manager certificate. cipher suite is supported by the
end-host, Policy Manager
performs anonymous
provisioning.
Accept end- Once the authenticated provisioning mode is
host after complete and the end-host is provisioned with
authenticated | a PAC, Policy Manager rejects end-host
provisioning authentication; the end-host subsequently

reauthenticates using the newly provisioned
PAC. When enabled, Policy Manager accepts
the end-host authentication in the provisioning
mode itself; the end-host does not have to re-
authenticate.
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Parameter Description Considerations
Required In authenticated provisioning mode, the end-
end-host host authenticates the server by validating the
certificate for server certificate, resulting in a protected outer
provisioning tunnel; the end-host is authenticated by the
server inside this tunnel. When enabled, the
server can require the end-host to send a
certificate inside the tunnel for the purpose of
authenticating the end-host.
MAC-AUTH

The MAC-AUTH method contains one tab.

General Tab

The General tab labels the method and defines session details.

Figure 77 MAC-AUTH General Tab

Add Authentication Method

General

Name:

Description:

Type: | MAC-AUTH -

Method Details

[ Enable |

Save J Cancel

Allow Unknown End-Hosts:

Table 64: MAC-Auth General Tab

Parameter Description

Name/Description

Freeform label and description.

Type

In this context, always MAC-AUTH.

Allow Unknown
End-Hosts

Enables further policy processing of MAC authentication requests of unknown

clients.

If this is not enabled, Policy Manager automatically rejects a request whose MAC
address is not in a configured authentication source. This setting is enabled, for
example, when you want Policy Manager to trigger an audit for an unknown client.
By turning on this check box and enabling audit (See "Configuring Audit Servers" on
page 199), you can trigger an audit of an unknown client.

CHAP and EAP-MD5

In addition the methods listed above, Policy Manager also comes packaged with CHAP and EAP-MD5 methods. These
are named [CHAP] and [EAP-MDS5], respectively. You can add methods of this type with a custom name. These
methods can also be associated to a Service as authentication methods.
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Figure 78 CHAP General Tab

Add Authentication Method o

MName:
Description: -
Type: CHAP -

Cancel

Figure 79 EAP-MD5 General Tab

Add Authentication Method o

Name:
Description: -
Type: EAP-MDS -
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Table 65: CHAP and EAP-MD5 General Tab Parameters

Parameter Description
Name/Description Freeform label and description.
Type In this context, always CHAP or EAP-MD5.

Authorize

This is an authorization-only method that you can add with a custom name.

Figure 80 Authorize General Tab

Add Authentication Method

I|

General
Name: | |
Description: -
Type: Authorize -

Cancel

Table 66: Authorize General Tab Parameters

Parameter Description
Name/Description Freeform label and description.
Type In this context, always Authorize.

Adding and Modifying Authentication Sources
Policy Manager supports the following Authentication Sources:

e "Generic LDAP or Active Directory " on page 129
e "Generic SQL DB (Open Data Base Connectivity (ODBC) compliant SQL Databases) " on page 139
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e "HTTP" on page 143

e '"Kerberos " on page 146

e "Okta" on page 148

e '"Static Host List " on page 150
e "Token Server " on page 151

From the Services page (Configuration > Service), you can configure authentication source for a new service (as part
of the flow of the Add Service wizard), or modify an existing authentication source directly (Configuration >
Authentication > Sources, then click on its name in the listing page).

Figure 81 Authentication Sources Listing Page

Configuration » Authentication » Sources

Authentication Sources =" Add Authentication Source
& Import Authentication Sources
& Export Authentication Sources

Filter:| Name Ecuntains m Clear Filter Show |10 E| records
# [ Namead Type Description
1.|E  [Admin User Repository] Local S0L BB Authenticate users against Policy Manager admin user
database
2.|E  [Endpoints Repository] Local SQL DB Authenticate endpoints against Policy Manager local
database
3|0 [Guest Device Repository] Local SOL DB Authenticate guest devices against Policy Manager local
database
4.|F)  [Gusst User Repository] Local SQL 0B Authenticate guest users against Policy Manager local
database
5./ [Local User Repository] Local SOL DB Authenticate users against Policy Manager local user
database
6.|  [onboard Devices Repository] Local SQL 0B Authenticate Onboard devices against Policy Manager
local database
Showing 1-6 of 5 _Copy | Export | Delete |

When you click Add New Authentication Source from any of these locations, Policy Manager displays the Add page.

Figure 82 Add Authentication Source Page

Configuration » Authentication » Sources » Add
Authentication Sources
MName: Generic SQL DB
Description: Generic LDAP
P . Active Directory
Kerberos
Token Server
Type: - - . » Static Host List
Select HTTR
Use for Authorization: Enable to use this authentication source to also fetch role mapping attributes
Authorization Sources: -
Remove
View Details
I
“. Back to Authentication Sources Next =

Depending on the Authentication Source selected, different tabs and fields appear.

Generic LDAP or Active Directory

Policy Manager can perform NTLM/MSCHAPv2, PAP/GTC and certificate-based authentications against Microsoft
Active Directory and against any LDAP-compliant directory (for example, Novell eDirectory, OpenLDAP, or Sun
Directory Server). Both LDAP and Active Directory based server configurations are similar. You retrieve role mapping
attributes by using filters. See "Adding and Modifying Role Mapping Policies " on page 157

At the top level, there are buttons to:

= Clear Cache: Clears the attributes cached by Policy Manager for all entities that authorize against this server.

= Copy: Creates a copy of this authentication/authorization source.

You configure Generic LDAP and Active Directory authentication sources on the following tabs:
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e General Tab
e Primary Tab
e Attributes Tab

General Tab

The General tab labels the authentication source and defines session details.

Figure 83 Generic LDAP or Active Directory (General Tab)

Configuration » Authentication » Sources » Add

Authentication Sources

Primary Attributes Summary

Name:

Description:

Type: Active Directory [=]
Use for Authorization: Enable to use this authentication source to also fetch role mapping attributes
Authorization Sources: -
Remove
View Details
- Select- |z|
Server Timeout: 10 seconds
Cache Timeout: 36000 | seconds
Backup Servers Priority: - Move Up
ie Move Down

Add Backup Remove

( Back to Authentication Sources
Table 67: Generic LDAP or Active Directory (General Tab)

Parameter Description

Name/Description | Freeform label and description.

Type In this context, General LDAP or Active Directory.
Use for This check box instructs Policy Manager to fetch role mapping attributes (or
Authorization authorization attributes) from this authentication source. If a user or device

successfully authenticates against this authentication source, then Policy Manager
also fetches role mapping attributes from the same source (if this setting is enabled).
This box is checked (enabled) by default

Authorization You can specify additional sources from which to fetch role mapping attributes.

Sources Select a previously configured authentication source from the drop down list, and
click Add to add it to the list of authorization sources. Click Remove to remove it from
the list.

If Policy Manager authenticates the user or device from this authentication source,
then it also fetches role mapping attributes from these additional authorization
sources.

NOTE: As described in “,” additional authorization sources can be specified at the
Service level. Policy Manager fetches role mapping attributes regardless of which
authentication source the user or device was authenticated against.

Server Timeout The number of seconds that Policy Manager waits before considering this server
unreachable. If multiple backup servers are available, then this value indicates the
number of seconds that Policy Manager waits before attempting to fail over from the
primary to the backup servers in the order in which they are configured.
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Parameter Description

Cache Timeout

Policy Manager caches attributes fetched for an authenticating entity. This parameter
controls the number of seconds for which the attributes are cached.

Backup Servers
Priority

To add a backup server, click Add Backup. When the Backup 1 tab appears, you can
specify connection details for a backup server (same fields as for primary server,
specified below).

To remove a backup server, select the server name and click Remove. Select Move
Up or Move Down to change the server priority of the backup servers. This is the
order in which Policy Manager attempts to connect to the backup servers if the
primary server is unreachable.

Primary Tab

The Primary tab defines the settings for the primary server.

Figure 84 Generic LDAP or Active Directory (Primary Tab)

Configuration » Authentication » Sources » Add
Authentication Sources

General

Attributes Summary

Connection Det:

Hostname:

Connection Security:
Port:

Verify Server Certificate:
Bind DN:

Bind Password:

Base DN:

Search Scope:
LDAP Referrals:
Bind User:
Password Attribute:
Password Type:
Password Header:

User Certificate :

MNone -

389

¥ Enable to verify Server Certificate for secure connection

‘ |Search Base Dn

SubTree Search -
™ Follow referrals

™ allow bind using user password

‘userpassword ‘

Cleartext A

‘userCemﬁcate ‘

<« Back to Authentication Sources
Table 68: Generic LDAP or active Directory (Primary Tab)

Parameter Description

Host Name/Port

e Hostname or IP address of the LDAP or Active Directory server.
TCP port at which the LDAP or Active Directory Server is listening for
connections. (The default TCP port for LDAP connections is 389. The default
port for LDAP over SSL is 636).

Connection Security | e Select None for default non-secure connection (usually port 389)

o SelectStartTLS for secure connection that is negotiated over the standard
LDAP port. This is the preferred way to connect to an LDAP directory securely.

o Select LDAP over SSL or AD over SSL to choose the legacy way of securely
connecting to an LDAP directory. Port 636 must be used for this type of
connection.

Bind DN/Password Distinguished Name (DN) of the administrator account. Policy Manager uses this

account to access all other records in the directory.
NOTE: For Active Directory, the bind DN can also be in the
administrator@domain format (e.g., administrator@acme.com).
Password for the administrator DN entered in the Bind DN field.
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Parameter Description

NetBIOS Domain The AD domain name for this server. Policy Manager prepends this name to the
Name user ID to authenticate users found in this Active Directory.
NOTE: This setting is only available for Active Directory.

Verify Server Select this checkbox if you want to verify the Server Certificate as part of the

Certificate authentication.

Base DN Enter DN of the node in your directory tree from which to start searching for
records.

After you have entered values for the fields described above, click on Search
Base DN to browse the directory hierarchy. The LDAP Browser is popped up. You
can navigate to the DN that you want to use as the Base DN.

LDAP Browser

Base DN: CMN=ForeignSecurityPrincipals,
-1}, dc=us,dc=avendasys,dc=com
+-11 CN=Builtin
+-|fy CN=Computers
-1}, OU=Domain Controllers
<1y CN=JUPITER
+1 1) CN=NEPTUNE
=B
£ CN=Infrastructure
42 CN=LostAndFound
43 CN=NTDS Quotas
+ |y CN=Program Data
+-|) CN=5ystem
+-lin CN=Users

[sove ] o |

Click on any node in the tree structure that is displayed to select it as a Base DN.
Note that the Base DN is displayed at the top of the LDAP Browser.

NOTE: This is also one way to test the connectivity to your LDAP or AD directory.
If the values entered for the primary server attributes are correct, you should be
able to browse the directory hierarchy by clicking on Search Base DN

Search Scope Scope of the search you want to perform, starting at the Base DN.

o Base Object Search allows you to search at the level specified by the base
DN.

o Subtree Search allows you to search the entire subtree under the base DN
(including at the base DN level).

e One Level Search allows you to search up to one level below (immediate
children of) the base DN.

LDAP Referral Enable this check box to automatically follow referrals returned by your directory
server in search results. Refer to your directory documentation for more
information on referrals.

Bind User Enable to authenticate users by performing a bind operation on the directory
using the credentials (user name and password) obtained during authentication.
For clients to be authenticated by using the LDAP bind method, Policy Manager
must receive the password in cleartext.
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Parameter Description

Password Attribute Enter the name of the attribute in the user record from which user password can
(Available only for be retrieved. This is not available for Active Directory.

Generic LDAP

directory)

Password Header Oracle's LDAP implementation prepends a header to a hashed password string.

When using Oracle LDAP, enter the header in this field so the hashed password
can be correctly identified and read.

User Certificate Enter the name of the attribute in the user record from which user certificate can
be retrieved.

Attributes Tab

The Attributes tab defines the Active Directory or LDAP Directory query filters and the attributes to be fetched by
using those filters.

Figure 85 Active Directory Attributes Tab (with default data)

General Primary n!izg Summary
Specify filter queries used to fetch authentication and authorization attributes
Filter Name Attribute Name Alias Name Enabled As i
1.|Authentication dn UserDN - [ W
department Department Attribute
title Title Attribute
company company
memberOf memberOf
telephoneNumber Phone Attribute
mail Email Attribute
displayName Name Attribute
2./Group cn Groups Attribute B o
3.[Machine dNSHostName HostName Attribute L
operatingSystem OperatingSystem Attribute
operatingSystemServicePack 0OSServicePack Attribute
4./0Onboard Device Owner memberOf Onboard memberOf = B T
5./Onboard Device Owner Group cp Onboard Groups Attribute B o

Figure 86 Generic LDAP Directory Attributes Tab

General Primary Summary

Specify filters used to query for authentication and authorization attributes

Filter Name Attribute Name Alias Name Enable as role i
1.|Authentication dn UserDM false B T
2.|G|'0UD cn groupName false B

( Back to Authentication Sources

Table 69: AD/LDAP Attributes Tab (Filter Listing Screen)
Tab Parameter/Description

Filter Name / Attribute Listing column descriptions:

Name / Alias Name / o Filter Name: Name of the filter.

Enable as Role o Attribute Name: Name of the LDAP/AD attributes defined for this filter.

o Alias Name: For each attribute name selected for the filter, you can specify an
alias name.

ClearPass Policy Manager 6.1 | User Guide 133



Tab Parameter/Description

o Enabled As: Specify whether value is to be used directly as a role or attribute
in an Enforcement Policy. This bypasses the step of having to assign a role in
Policy Manager through a Role Mapping Policy.

Add More Filters Brings up the filter creation popup. This is described in the nextimage.

The following table describes the available directories.

Table 70: AD/LDAP Default Filters Explained

Directory Default Filters

Active o Authentication: This is the filter used for authentication. The query searches in
Directory objectClass of type user. This query finds both user and machine accounts in Active
Directory:

(& (objectClass=user) (sAMAccountName=%{Authentication:Username}))
When a request arrives, Policy Manager populates %{Authentication:Username} with the
authenticating user or machine. This filter is also set up to fetch the following attributes
based on this filter query:

= dn (aliased to UserDN): This is an internal attribute that is populated with the user or
machine record’s Distinguished Name (DN)

department

title

company

memberOf: In Active Directory, this attribute is populated with the groups that the user
or machine belongs to. This is a multi-valued attribute.

= telephoneNumber

=  mail

= displayName

e Group: This is filter used for retrieving the name of the groups a user or machine belongs
to.
(distinguishedName=%{memberOf})
This query fetches all group records, where the distinguished name is the value returned
by the memberOf variable. The values for the memberOf attribute are fetched by the first
filter (Authentication) described above. The attribute fetched with this filter query is cn,
which is the name of the group

e Machine: This query fetches the machine record in Active Directory.
(& (objectClass=computer) (sAMAccountName=%{Host:Name}$))

%{Host:Name} is populated by Policy Manager with name of the connecting host (if
available). INSHostName, operatingSystem and operatingSystemServicePack attributes
are fetched with this filter query.

e Onboard Device Owner:

o Onboard Device Owner Group:

Generic Authentication: This is the filter used for authentication.
LDAP (& (objectClass=*) (uid=%{Authentication:Username}))
Directory

When a request arrives, Policy Manager populates %{Authentication:Username} with the
authenticating user or machine. This filter is also set up to fetch the following attributes
based on this filter query:

= dn (aliased to UserDN): This is an internal attribute that is populated with the user
record’s Distinguished Name (DN)
Group: This is filter used for retrieving the name of the groups a user belongs to.
(& (objectClass=groupOfNames) (member=%{UserDn}))

= This query fetches all group records (of objectClass groupOfNames), where member
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Directory Default Filters

field contains the DN of the user record (UserDN, which is populated after the
Authentication filter query is executed. The attribute fetched with this filter query is cn,
which is the name of the group (this is aliased to a more readable name: groupName)

The Filter Creation popup displays when you click the Add More Filters button on the Authentication Sources >
Add page. With this popup, you can define a filter query and the related attributes to be fetched.

AD/LDAP Configure Filter Browse tab

The Browse tab shows an LDAP Browser from which you can browse the nodes in the LDAP or AD directory, starting
at the base DN. This is presented in read-only mode. Selecting a leaf node - a node that has no children - brings up the
attributes associated with that node

Figure 87 AD/LDAP Configure Filter (Browse Tab)

Filter Attributes Configuration

Find Mode: CN=Alice W,CN=Users,[" - Go
ST e -
£ CN=ADMIN-PC2 il primaryGroupID 513 b
£k CN=atlas pwdLastSet 128746230430312500
£ CN=AV-NPS64 | sAMAccountMame alice
{3 CN=AV-TESTLAB-XP sAMAccountType 805306368
+-|{y OU=Domain Controllers
<[y CN=ForeignSecurityPrincipals =n w
{3 CN=Infrastructure title Co-ordinator
1 CN=LostAndFound uSNChanged 234508
ﬁ CN=NTDS Quotas uSNCreated 13973
—}Hli CN=Program Data ®  UserAccountControl 512
£k CN=Microsoft userCertificate [B@7ba83821
i 'f E:ii::::m userParameters m: d
£¥CN=_ vmware__ userPrincipalName alice@us.avendasys.com
{3 CN=__vmware_user__ whenChanged 20081224201043.0Z2
i} CN=Administrator whenCreated 20070405181039.0Z2 L
o] C—alice w| B | '

Table 71: AD/LDAP Configure Filter Popup (Browse Tab)

Navigation Description

Find Node / Go directly to a given node by entering its Distinguished Name (DN) and clicking on the
Go Go button.

AD/LDAP Configure Filter, Filter Tab

The Filter tab provides an LDAP browser interface to define the filter search query. Through this interface you can
define the attributes used in the filter query.
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Figure 88 AD/LDAP Create Filter Popup (Filter Tab)

Configure Filter L

Browse .H ﬂ Attributes Configuration
Find Node: CN=Alice W.CN=Users peendne, “
= 0 [ o=
+ 1) CN=ForeignsecurityPrincipals ~ objectSid [ &0 & o oL & SoUPwbeollioes o
£ CN=Infrastructure primaryGroupID 513
4} CM=LostAandFound pwdlLastSet 128746230430312500
{3 CN=NTDS Quotas | sAMAccountName alice
-l CN=Program Data sAMAccountType 805306368
+-|fy CN=System
sn w
=), CN=Users s 7
£3 CN=__vmware__ title Co-ordinator H
{3 CN=__vmware_user, usNChanged 234698
£ CN=Administrator uSNCreated 13973 i
bod Cri=nlice W - M v
Selected attributes for filter:
Name Value i
1.‘ sAMAccountMame = thhenticat\on:Username} \ hd ‘ M @
2 ‘Click to add %%{ Authentication:Username}

Policy Manager comes pre-populated with filters and selected attributes for Active Directory and generic LDAP directory.
New filters need to be created only if you need Policy Manager to fetch role mapping attributes from a new type of record

A

o
-
m

Records of different types can be fetched by specifying multiple filters that use different dynamic session attributes. For
example, for a given request Policy Manager can fetch the user record associated with %{Authentication:Username},
aTE and a machine record associated with %{RADIUS:IETF:Calling-Station-ID}.

il

Table 72: Configure Filter Popup (Filter Tab)

Parameter Description

Find Node /| Go directly to a given node by entering its Distinguished Name (DN) and clicking on the Go
Go button.

Select the This table has a name and value column. There are two ways to enter the attribute name
attributes o By going to a node of interest, inspecting the attributes, and then manually entering the
for filter attribute name by clicking on Click to add... in the table row.

e By clicking on an attribute on the right hand side of the LDAP browser. The attribute
name and value are automatically populated in the table.

The attribute value field can be a value that has been automatically populated by selecting

an attribute from the browser, or it can be manually populated. To aid in populating the

value with dynamic session attribute values, a drop down with the commonly used

namespace and attribute names is presented (See image below).
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Parameter Description

Browse la'ﬂ Attributes Configuration

Find Node: CN=Alice W ,CM=Users,DC=us,DC=avendasys.DC=com Go

* Mamao Walug)

+ CN=ForeignSecurityPrincipals
w g ty! P %l Authentication:Full-Username}

ﬁ CN=Infrastructure %[ Authentication:InnerbAethod} £
£¥ CN=LostAndFound Y Authentication:MacAuth} L
ﬁ CN=NTDS Quotas | H{Authentication: OuterMethod)
%[ Authentication:Phasel PAC}
e Authentication:Phase2 PAC}
+-jfy CN=System %[ Authentication:Posture}
-, CN=Users %t Authentication:Source}
£ CN=__vmware__ % Authentication:Status}
%[ Authentication:Username}

£ CN=__vmware_user__
_ .. %[ Connection:Client-Mac-Address}
ﬁ CN=Administrator %[ Connection:Dest-IP-Address}

ted CN=Alice W %{ Connection:Dest-Port} "

Selected attributes for filter: % Connection:NAD-IP-Address}
%[ Connection:Protocol}

+-|fy CN=Program Data

m

1

Name Y More choices
1.‘ sAMAcCcountName E |"-‘,-’u{C0nnecti0n:Src—[P—Au |v|
2. Click to add...

The following tables describes the steps used in creating a filter.

Table 73: Filter Creation Steps

Step Description

hand side, you see attributes associated with that user.

Step 1 The goal of filter creation is to help Policy Manager understand how to find a user or device
Select connecting to the network in LDAP or Active Directory. From the Filter tab, click on a node
filter that you want to extract user or device information from. For example, browse to the Users
node container in Active Directory and select the node for a user (Alice, for example). On the right

Alice’s record as a sample user node).

Step 2 Click on attributes that will help Policy Manager to uniquely identify the user or device. For
Select example, in Active Directory, an attribute called sAMAccountName stores the user ID. The
attribute attributes that you select are automatically populated in the filter table displayed below the

browser section (along with their values). In this example, if you select sAMAccountName,
the row in the filter table will show this attribute with a value of alice (assuming you picked

ID of the user connecting to the network.

Step 3 After Step 3, you have values for a specific record (Alice’s record, in this case). Change the
Enter value to a dynamic session attribute that will help Policy Manager to associate a session with
value a specific record in LDAP/AD. For example, if you selected the sAMAccountName attribute in

(optional) | AD, click on the value field and select %{Authentication:Username}. When Policy Manager
processes an authentication request %{Authentication:Username} is populated with the user

Step 4 Add more attributes from the node of interest and continue with Step 2.

AD/LDAP Configure Filter Attributes Tab

The Attributes tab defines the attributes to be fetched from Active Directory or LDAP directory. Each attribute can
also be “Enabled as Role,” which means the value fetched for this attribute can be used directly in Enforcement

Policies (See "Configuring Enforcement Policies " on page 221.)
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Figure 89 AD/LDAP Configure Filter Attributes Tab

Configure Filter L

Browse Filter n:ﬁza Configuration

Execute filter query to select attributes for role mapping:
Filter Query:

Please enter the values for the parameters before executing the query:
%{Authentication:Username’} =*

CN=__vmware_user__,CN=Users -
CN=ADMIN-PC2,CN=Computers [g] 9. department
CN=Administrator, CN=Users W

T S O O T O e O U G e

(&(sAMAccountName=%{Authentication:Username}){objectClass=user))

[
HR

>

CN=Alice W,CN=Users

CN=Alice_1 A ,CN=Users
CN=aAlice_2 A,CN=Users
CN=Alice_3 A,CN=Users
CN=alice_4 A,CN=Users
CN=Alice_5 A,CN=Users
CN=Alice_6& A ,CN=Users
CN=atlas,CN=Computers

Name

1. ‘countrycade

a etk to add

CN=AV-NPS554,CN=Computers

s ‘msNPAIIUleaIm

2 ‘userprincipawame

10. displayName Alice W

11. distinguishedName CN=Alice W,CN=Users,DC=us,DC=a"

12. givenName Alice =

13, instanceType 4

14. lastLogoff 0

15. lastLogon 128353985513750000 \El
- ] i | v
Alias Name Enabled As s
countryCode = = i
msNPAllowDialin = - i
userPrincipalName = - i

Table 74: AD/LDAP Configure Filter Popup (Attributes Tab)

Parameter Description

Enter Policy Manager parses the filter query (created in the Filter tab and shown at the top of the

values for Attributes tab) and prompts to enter the values for all dynamic session parameters in the

parameters | query. For example, if you have %{Authentication:Username} in the filter query, you are
prompted to enter the value for it. You can enter wildcard character (*) here to match all
entries.
NOTE: If there are thousands of entries in the directory, entering the wildcard character (*)
can take a while to fetch all matching entries.

Execute Once you have entered the values for all dynamic parameters, click on Execute to execute
the filter query. You see all entries that match the filter query. Click on one of the entries
(nodes) and you see the list of attributes for that node. You can now click on the attribute
names that you want to use as role mapping attributes.

Name / Name: This is the name of the attribute

Alias Name | Alias Name: A friendly name for the attribute. By default, this is the same as the atiribute

/Enable as name.

Role Enabled As: Click here to enable this attribute value to be used directly as a role in an
Enforcement Policy. This bypasses the step of having to assign a role in Policy Manager
through a Role Mapping Policy.

AD/LDAP Configure Filter Configuration Tab

The Configuration tab shows the filter and attributes configured in the Filter and Attributes tabs, respectively. From

this tab, you can also manually edit the filter query and attributes to be fetched.
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Figure 90 Configure Filter Popup (Configuration Tab)
e —————

Browse Filter Attributes
Filter Name:
Filter Query: (& (sAMAccountName=3{Authentication:Username}} (gbjectClass=user))
Name Alias Name Data type Enabled As b}
1. ‘countrycade countryCode String bl
2. ‘msNPAHulealm msMNPAllowDialin Boolean il
3. ‘userPrmcipa\Name userPrincipalName String bl
4.|lick to add...

Modify Default Filters

When you add a new authentication source of type Active Directory or LDAP, a few default filters and attributes are
pre-populated. You can modify these pre-defined filters by selecting a filter on the Authentication > Sources
> Attributes tab. This opens the Configure Filter page for the specified filter.

At least one filter must be specified for the LDAP and Active Directory authentication source. This filter is used by Policy
Manager to search for the user or device record. If not specified, authentication requests will be rejected.

Figure 91 Modify Default Filters

Configure Filter o
Configuration Attributes Browse Filter

Filter Name: Authentication

Filter Query: (& (sAMBcoountlame=%{Authentication:Usernamel) (gbjegtClags—user) )

Name Alias Name Data type Enabled As i
1.|dn UserDN String = T
2.| department ‘Department |‘ ‘ ‘Stnng |" [ role Attribute [ @
3. [title Title String Attribute @
5 Integer P

.|company company AT
5.|memberof memberOf Boolean T
6.|telephoneNumber Phone String Attribute T
7.|mail Email String Attribute T
8.|displayName Name String Attribute T
9.|Click to add...

The attributes that are defined for the authentication source show up as attributes in role mapping policy rules editor
under the authorization source namespace. Then, on the Role Mappings Rules Editor page, the Operator values that
display are based on the Data type specified here. If, for example, you modify the Active Directory department to be
an Integer rather than a String, then the list of Operator values will populate with values that are specific to Integers.

At least one This functionality that allows you to modify the Data type exists for Generic SQL DB, Generic LDAP, Active
Directory, and HTTP authentication source types.

When you are finished editing a filter, click Save.

Generic SQL DB (Open Data Base Connectivity (ODBC) compliant SQL Databases)

Policy Manager can perform MSCHAPv2 and PAP/GTC authentication against any ODBC-compliant database (for
example, Microsoft SQL Server, Oracle, MySQL, or PostgrSQL). You specify a stored procedure to query the relevant
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tables and retrieve role mapping attributes by using filters.

You configure the primary and backup servers, session details, and the filter query and role mapping attributes to fetch

of Generic SQL authentication sources on the following tabs:
e General Tab

e Primary Tab

e Attributes Tab

For a configured Generic SQL DB authentication source, buttons on the main page enable you to:

e Clear Cache: Clears the attributes cached by Policy Manager for all entities that authorize against this server.

e Copy: Creates a copy of this authentication/authorization source.

General Tab

The General tab labels the authentication source and defines session details, authorization sources, and backup server

details.

Figure 92 Generic SQL DB (General Tab)

Authentication Sources

Primary Attributes Summary

Name:

Description:

Type: Generic SOL DB [=]

Use for Authorization: Enable to use this authentication source to also fetch role mapping attributes
Authorization Sources: -

Remove
View Details

- Select— El

Cache Timeout: 36000 | seconds

Backup Servers Priority: i Move Up

Add Backup Remove

( Back to Authentication Sources

Next> § Save § Cancel

Table 75: General SQL DB (General Tab)

Parameter Description

Name/Description | Freeform label and description.

This check box is enabled by default

Type In this context, Generic SQL DB.
Use for This check box instructs Policy Manager to fetch role mapping attributes (or
Authorization authorization attributes) from this authentication source. If a user or device

successfully authenticates against this authentication source, then Policy Manager
also fetches role mapping attributes from the same source (if this setting is enabled).

the list.

Authorization You can specify additional sources from which to fetch role mapping attributes.
Sources Select a previously configured authentication source from the drop down list, and
click Add to add it to the list of authorization sources. Click Remove to remove it from
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Parameter Description

If Policy Manager authenticates the user or device from this authentication source,
then it also fetches role mapping attributes from these additional authorization
sources.

NOTE: As described in “Services,” additional authorization sources can be specified
atthe Service level. Policy Manager fetches role mapping attributes regardless of
which authentication source the user or device was authenticated against.

Backup Servers

To add a backup server, click Add Backup. When the Backup 1 tab appears, you can
specify connection details for a backup server (same fields as for primary server,
specified below).

To remove a backup server, select the server name and click Remove. Select Move
Up or Move Down to change the server priority of the backup servers. This is the
order in which Policy Manager attempts to connect to the backup servers.

Cache Timeout

Policy Manager caches attributes fetched for an authenticating entity. This parameter
controls the time period for which the attributes are cached.

Primary Tab

The Primary tab defines the settings for the primary server.

Figure 93 General SQL DB (Primary Tab)

Authentication Sources
General lm Attributes Summary
Connection Details
Server Name: \ |
Port (Optional): l:l (Specify only if you want to override the default value)
Database Name: [ |
Login Username: \ |
Login Password: [ ]
Timeout: seconds
ODBC Driver: \ MySQL E|
<« Back to Authentication Sources m m

Table 76: Generic SQL DB (Primary Tab)

Parameter Description

Server Name

Enter the hostname or IP address of the database server.

Port (Optional)

Specify a port value if you want to override the default port.

Database Name

Enter the name of the database to retrieve records from.

Login
Username/Password

Enter the name of the user used to log into the database. This account should
have read access to all the attributes that need to be retrieved by the specified
filters.

Enter the password for the user account entered in the field above.
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Parameter Description

Timeout Enter the time in seconds that Policy Manager waits before attempting to fail over
from primary to the backup servers (in the order in which they are configured).
ODBC Driver Select the ODBC driver (Postgres or MSSQL in this release) to connect to
database.
Attributes Tab

The Attributes tab defines the SQL DB query filters and the attributes to be fetched by using those filters.

Figure 94 Generic SQL DB (Attributes Tab)

General Primary n!ﬂma Summary

Specify filters used to query for authentication and authorization attributes

Filter Name Attribute Name Alias Name Enabled As ]

1_|Authenticat\on

department department Attribute B

Add More Filters

‘ Back to Authentication Sources

Table 77: Generic SQL DB Attributes Tab (Filter List)

Tab

Filter Name / Attribute Name /
Alias Name / Enabled As

Parameter/Description

Listing column descriptions:

Filter Name: Name of the filter.

Attribute Name: Name of the SQL DB atiributes defined for this
filter.

Alias Name: For each attribute name selected for the filter, you
can specify an alias name.

Enabled As: Indicates whether the filter is enabled as a role or
attribute type. Note that this can also be blank.

Add More Filters

Brings up the filter creation popup.

Configure Filter Popup

The Configure Filter popup defines a filter query and the related attributes to be fetched from the SQL DB store.

Figure 95 Generic SQL DB Filter Configure Popup
ot ey

Configuration
Filter Name: Authentication
Filter Query: SELECT user_credential (password) RS User_Password, -
CASE WHEN enabled = FALSE THEN 225
WHEN ((start_time > now(}) OR ((expire time is not null) AND -
(expire_time <= now())}) THEN 22§

Name Alias Name Data type Enabled As i
1.|sponsor_name Owner String = i
2.iClick to add...|

sove | oo
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Table 78: Generic SQL DB Configure Filter Popup

Parameter Description

Filter Name Name of the filter

Filter Query A SQL query to fetch the attributes from the user or device record in DB

Name / Alias Name: This is the name of the atiribute

Name /Data Alias Name: A friendly name for the attribute. By default, this is the same as the

Type/ Enabled attribute name.

As Data Type: Specify the data type for this attribute, such as String, Integer, Boolean,
etc.
Enabled As: Specify whether this value is to be used directly as a role or attribute in
an Enforcement Policy. This bypasses the step of having to assign a role in Policy
Manager through a Role Mapping Policy.

HTTP

The HTTP authentication source relies on the GET method to retrieve information. The client submits a request, and
then the server returns a response. All request parameters are included in the URL. For example:

URL: https//hostname/webservice/.../%{Auth:Usemame}?param1=%7{...} &param2=value2

HTTP relies on the assumption that the connection between the client and server computers is secure and can be
trusted.

You configure primary and backup servers, session details, and the filter query and role mapping attributes to fetch of
Generic SQL authentication sources on the following tab:

e General Tab
e Primary Tab
e Attributes Tab

General Tab

The General tab labels the authentication source and defines session details, authorization sources, and backup server
details.

Figure 96 HTTP (General Tab)

Configuration » Authentication » Sources » Add
Authentication Sources
Primary Attributes Summary
Name:
Description:
Type: HTTP =]
Use for Authorization: Enable to use this authentication source to also fetch role mapping attributes
Authorization Sources: -
Remove
View Details
—Select— i
Backup Servers Priority: - Move Up
|  Move Down
Remare
< Back to Authentication Sources
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Table 79: HTTP (General Tab)

Parameter Description

Name/Description

Freeform label and description.

Type In this context, HTTP.

Use for This check box instructs Policy Manager to fetch role mapping attributes (or

Authorization authorization attributes) from this authentication source. If a user or device
successfully authenticates against this authentication source, then Policy Manager
also fetches role mapping attributes from the same source (if this setting is enabled).
This check box is enabled by default.

Authorization You can specify additional sources from which to fetch role mapping attributes.

Sources Select a previously configured authentication source from the drop down list, and

click Add to add it to the list of authorization sources. Click Remove to remove it from
the list.

If Policy Manager authenticates the user or device from this authentication source,
then it also fetches role mapping attributes from these additional authorization
sources.

NOTE: As described in “Services,” additional authorization sources can be specified
at the Service level. Policy Manager fetches role mapping attributes regardless of
which authentication source the user or device was authenticated against.

Backup Servers

To add a backup server, click Add Backup. When the Backup 1 tab appears, you can
specify connection details for a backup server (same fields as for primary server,
specified below).

To remove a backup server, select the server name and click Remove. Select Move
Up or Move Down to change the server priority of the backup servers. This is the
order in which Policy Manager attempts to connect to the backup servers.

Primary Tab

The Primary tab defines the settings for the primary server.

Figure 97 HTTP (Primary Tab)

Configuration » Authentication » Sources » Add

Authentication Sources

General lm Attributes Summary

Connection Details

Server Name: |

Login Username: [

Login Password: [

( Back to Authentication Sources

Table 80: HTTP (Primary Tab)

Parameter

Server Name

Description

Enter the hostname or IP address of the database server.
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Parameter Description

Login Enter the name of the user used to log into the database. This account should
Username/Password | have read access to all the attributes that need to be retrieved by the specified

filters.

Enter the password for the user account entered in the field above.

Attributes Tab

The Attributes tab defines the HTTP query filters and the attributes to be fetched by using those filters.

Figure 98 HTTP (Attributes Tab)

General Primary n!ﬁma Summary

Filter Name Attribute Name

Specify filters used to guery for authentication and authorization attributes

Alias Name Enabled As ir

1_|Authent|cat\cn department

department Attribute B

Add More Filters

( Back to Authentication Sources
Table 81: HTTP Attributes Tab (Filter List)
Tab Parameter/Description

Filter Name / Attribute Name / Alias
Name / Enabled As

Listing column descriptions:

o Filter Name: Name of the filter.

o Attribute Name: Name of the SQL DB attributes defined for
this filter.

o Alias Name: For each attribute name selected for the filter,
you can specify an alias name.

o Enabled As: Indicates whether an attribute has been
enabled as a role.

Add More Filters

Brings up the filter creation popup.

Configure Filter Popup

The Configure Filter popup defines a filter query and the related attributes to be fetched from the SQL DB store.

Figure 99 HTTP Filter Configure Popup

Configure Filter L]
Configuration

Filter Name: Authentication
Filter Query: SELECT user_credential (password) AS User_Password, -
CASE WHEN enabled = FALSE THEN 225
WHEN ((start_time > now(}) OR ((expire time 1s not null) AND o
(expire_time <= now()))) THEN 226
Name Alias Name Data type Enabled As b
1

.|sponsor_name Owner String o i
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Table 82: HTTP Configure Filter Popup

Parameter Description

Filter Name Name of the filter

Filter Query A SQL query to fetch the attributes from the user or device record in DB

Name / Alias Name: This is the name of the attribute

Name / Data Alias Name: A friendly name for the atiribute. By default, this is the same as the

Type / Enabled attribute name.

As Data Type: Specify the data type for this attribute, such as String, Integer, Boolean,
etc.
Enabled As: Specify whether value is to be used directly as a role or attribute in an
Enforcement Policy. This bypasses the step of having to assign a role in Policy
Manager through a Role Mapping Policy.

Kerberos

Policy Manager can perform standard PAP/GTC or tunneled PAP/GTC (for example, EAP-PEAP[EAP-GTC])
authentication against any Kerberos 5 compliant server such as the Microsoft Active Directory server. It is mandatory
to pair this Source type with an authorization source (identity store) containing user records.

You configure Kerberos authentication sources on the following tabs:
e General Tab
e Primary Tab

General Tab

The General tab labels the authentication source and defines session details, authorization sources, and backup server
details.

Figure 100 Kerberos General Tab

Authentication Sources

s

MName: |

Description:

Type: Kerberos =]

Use for Authorization: Enable to use this authentication source to also fetch role mapping attributes

Remove
View Details

Authorization Sources: -

- Select— -

Backup Servers Priority: i Move Up

Add Backup Remove

{ Back to Authentication Sources m
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Table 83: Kerberos (General Tab)

Parameter Description

Name/Description

Freeform label and description.

Type In this context, Kerberos

Use for Disabled in this context.

Authorization

Authorization You must specify one or more authorization sources from which to fetch role
Sources mapping attributes. Select a previously configured authentication source from the

drop down list, and click Add to add it to the list of authorization sources. Click
Remove to remove it from the list.

NOTE: As described in “Services,” additional authorization sources can be specified
at the Service level. Policy Manager fetches role mapping attributes regardless of
which authentication source the user or device was authenticated against.

Backup Servers To add a backup kerberos server, click Add Backup. When the Backup 1 tab
appears, you can specify connection details for a backup server (same fields as for
primary server, specified below).

To remove a backup server, select the server name and click Remove. Select Move
Up or Move Down to change the server priority of the backup servers. This is the

order in which Policy Manager attempts to connect to the backup servers.

Primary Tab

The Primary tab defines the settings for the primary server.

Figure 101 Kerberos (Primary Tab)

Configuration » Authentication » Sources » Add

Authentication Sources

General

Connection Details

Hostname: [ |

Port:

Realm: [ |

Service Principal: | |

Service Principal Password: | |

( Back to Authentication Sources

Table 84: Kerberos (Primary Tab)

Parameter Description

Hostname/Port Host name or IP address of the kerberos server, and the port at which the token server
listens for kerberos connections. The default port is 88.
Realm The domain of authentication. In the case of Active Directory, this is the AD domain.
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Parameter Description

Principal Name

Service The identity of the service principal as configured in the Kerberos server.

Service Password for the service principal.
Principal
Password

Okta

Okta can be used as an authentication source only for servers of the type Aruba Application Authentic-

ation. Y ou configure Okta authentication sources on the following tabs:

e General Tab
e Primary Tab
e Attributes Tab

General Tab

Figure 102 Okta General Tab

Configuration » Authentication » Sources » Add

Authentication Sources

General Primary Attributes Summary
Name: | ‘
Description: ‘ P
EhEs Okta -

Use for Authorization: Enable to use this authentication source to also fetch role mapping attributes

Authorization Sources:
— Select —- v
Server Timeout: seconds
Cache Timeout: 36000 | seconds
Backup Servers Priority: Move Up

( Back to Authentication Sources

Okta (General Tab)

Parameter Description

Name/Description | Freeform label and description.

Type In this context, Okta

Use for
Authorization

This check box is enabled by default.

This check box instructs Policy Manager to fetch role mapping attributes (or
authorization attributes) from this authentication source. If a user or device
successfully authenticates against this authentication source, then Policy Manager
also fetches role mapping attributes from the same source (if this setting is enabled).
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Parameter Description

Server Timeout

The number of seconds that Policy Manager waits before considering this server
unreachable. If multiple backup servers are available, then this value indicates the
number of seconds that Policy Manager waits before attempting to fail over from the
primary to the backup servers in the order in which they are configured.

Cache Timeout

Policy Manager caches attributes fetched for an authenticating entity. This parameter
controls the number of seconds for which the attributes are cached.

Backup Servers

To add a backup server, click Add Backup. When the Backup 1 tab appears, you can
specify connection details for a backup server (same fields as for primary server,
specified below).

Priority To remove a backup server, select the server name and click Remove. Select Move
Up or Move Down to change the server priority of the backup servers. This is the
order in which Policy Manager attempts to connect to the backup servers.

Primary Tab

Figure 103 Okta Primary Tab

Configuration » Authentication

» Sources » Add

Authentication Sources

Attributes Summary

Connection Detal

URL: |

Authorization Token: |

( Back to Authentication Sources ~
Next = Save Cancel

Table 85: Okta (Primary Tab)

Parameter Description

URL

Enter the address of the OKTA server

Authorization Token

Enter the authorization token as provided by Okta support.

Attributes Tab

Figure 104 Okta Attribu tes Tab

Configuration » Authentication » Sources » Add

Authentication Sources

General Primary Summary
Specify filter queries used to fetch authentication and authorization attributes
Filter Name Attribute Name Alias Name Enabled As b
1-|GWUF’ name Groups - 2 @
Add More Filters
( Back to Authentication Sources =
Next > Save Cancel
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Table 86: Okta (Attributes Tab)
Tab Parameter/Description

Filter Name / Attribute Listing column descriptions:

Name / Alias Name / o Filter Name: Name of the filter. (Only Group can be configured for Okta.)

Enable as Role o Attribute Name: Name of the LDAP/AD attributes defined for this filter.

o Alias Name: For each attribute name selected for the filter, you can specify an
alias name.

o Enabled As: Specify whether value is to be used directly as a role or attribute
in an Enforcement Policy. This bypasses the step of having to assign a role in
Policy Manager through a Role Mapping Policy.

Add More Filters Brings up the filter creation popup. This is described in the next image.

Static Host List

An internal relational database stores Policy Manager configuration data and locally configured user and device
accounts. Three pre-defined authentication sources, [Local User Repository] , [Guest User Repository], and [Guest
Device Repository], represent the three databases used to store local users, guest users and registered devices,
respectively.

While regular users typically reside in an authentication source such as Active Directory (or in other LDAP-compliant
stores), temporary users, including guest users can be configured in the Policy Manager local repositories. For a user
account created in the local database, the role is statically assigned to that account, which means a role mapping
policy need not be specified for user accounts in the local database. However, if new custom attributes are assigned to
a user (local or guest) account in the local database, these can be used in role mapping policies.

The local user database is pre-configured with a filter to retrieve the password and the expiry time for the account.
Policy Manager can perform MSCHAPv2 and PAP/GTC authentication against the local database.

You configure primary and backup servers, session details, and the list of static hosts for Static Host List
authentication sources on the following tab:

e General Tab
e Static Host ListsTab
General Tab

The General Tab labels the authentication source.

Figure 105 Static Host List (General Tab)

Configuration » Authentication » Sources » Add

Authentication Sources

Static Host Lists Summary

Name:

Description:
Type: Static Host List -
Use for Authorization: Enable to use this authentication source to also fetch role mapping attributes
Authorization Sources: -
Remove
View Details

< Back to Authentication Sources
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Table 87: Static Host List (General Tab)

Parameter Description

Name/ Description Freeform label
Type Static Host List, in this context.
Use for Authorization/Authorization Sources Not configurable

Static Host ListsTab

The Static Hosts List tab defines the list of static hosts to be included as part of the authorization source.

Figure 106 Static Host List (Static Host Lists Tab)

General Static Host Lists [ESTERY
Host List: Handhelds -~ Add new Static Host List
View Details
i Modify
—Select- - Add |
« Back to Authentication Sources

Table 88: Static Hosts List (Static Host Lists Tab)

Parameter Description

Host List Select a Static Host List from the drop down and Add to add it to the list.Click on Remove to
remove the selected static host list. Click on View Details to view the contents of the
selected static host list. Click on Modify to modify the selected static host list.

Only Static Host Lists of type MAC Address List or MAC Address Regular Expression can be configured as
authentication sources. Refer to "Adding and Modifying Static Host Lists " on page 167for more information.

Token Server

Policy Manager can perform GTC authentication against any token server than can authenticate users by acting as a
RADIUS server (e.g., RSA SecurlD Token Server) and can authenticate users against a token server and fetch role
mapping attributes from any other configured Authorization Source.

Pair this Source type with an authorization source (identity store) containing user records. When using a token server
as an authentication source, use the administrative interface to optionally configure a separate authorization server.
Policy Manager can also use the RADIUS attributes returned from a token server to create role mapping policies. See
"Namespaces" on page 329.

You configure primary and backup servers, session details, and the filter query and role mapping attributes to fetch for
Token Server authentication sources on the following tabs:

e General Tab

e Primary Tab
e Attributes Tab
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General Tab

The General tab labels the authentication source and defines session details, authorization sources, and backup server

details.

Figure 107 Token Server (General Tab)

Configuration » Authentication » Sources » Add

Authentication Sources

-

Attributes Summary

Name:

Description:

Type: Token Server

Use for Authorization:

Authorization Sources:

—Select—
Server Timeout: 10 seconds

Backup Servers Priority:

< Back to Authentication Sources

=]

Enable to use this authentication source to also fetch role mapping attributes

Remove
View Details

[=]

1 Move Up
il Move Down

Add Backup Remove

Table 89: Token Server General Tab

Parameter Description

Name/Description

Freeform label and description.

Type In this context, Token Server

Use for This check box instructs Policy Manager to fetch role mapping attributes (or

Authorization authorization attributes) from this authentication source. If a user or device
successfully authenticates against this authentication source, then Policy Manager
also fetches role mapping attributes from the same source (if this setting is enabled).
This check box is enabled by default

Authorization You can specify additional sources from which to fetch role mapping attributes.

Sources Select a previously configured authentication source from the drop down list, and

click Add to add it to the list of authorization sources. Click Remove to remove it from
the list.

If Policy Manager authenticates the user or device from this authentication source,
then it also fetches role mapping attributes from these additional authorization
sources.

NOTE: Note: As described in “Services,” additional authorization sources can be
specified at the Service level. Policy Manager fetches role mapping attributes
regardless of which authentication source the user or device was authenticated
against.

Server Timeout

This is the time in seconds that Policy Manager waits before attempting to fail over
from primary to the backup servers (in the order in which they are configured)

Backup Servers
Priority

To add a backup server, click Add Backup. When the Backup 1 tab appears, you can
specify connection details for a backup server (same fields as for primary server,
specified below).
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Parameter Description

To remove a backup server, select the server name and click Remove. Select Move
Up or Move Down to change the server priority of the backup servers. This is the
order in which Policy Manager attempts to connect to the backup servers.

Primary Tab

The Primary Tab defines the settings for the primary server.

Figure 108 Token Server (Primary Tab)

General .m Attributes Summary

Connection Details

Server Name: |rsatoken.acme.com |
Port: 1812
Secret: [eassnnce |

( Back to Authentication Sources

Next = Save J Cancel

Table 90: Token Server (Primary Tab)

Parameter Description

Server Host name or IP address of the token server, and the UDP port at which the token server
Name/Port listens for RADIUS connections. The default portis 1812.

Secret RADIUS shared secret to connect to the token server.

Attributes Tab

The Attributes tab defines the RADIUS attributes to be fetched from the token server. These attributes can be used in
role mapping policies. (See "Configuring a Role Mapping Policy " on page 155for more information.) Policy Manager

load all RADIUS vendor dictionaries in the type drop down to help select the attributes.

Figure 109 Token Server (Attributes Tab)

General Primary Attributes Summary

Type Name Enabled as Role i
1.|Radius:IETF Class false ]
2.|Radius:IETF Callback-Number false @
3. [=] [
4| RadiusIETF

Radius:Clavister

Radius:Cisco-VPN3000

Radius:Acc

Radius:Tropos

Radius:Cisco

Radius:ERX

Radius:Cablelabs

Radius:Mikrotik

Radius:Cosine

Radius:JRadius

Radius:Cisca-BBSM

Radius:BinTec

Radius:Ascend
Radius:Rearing-Penguin
More choices
{ Back to Authentication Sources
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Chapter 14

Identity: Users, Endpoints, Roles and Role Mapping

A Role Mapping Policy reduces client (user or device) identity or attributes associated with the request to Role(s) for
Enforcement Policy evaluation. The roles ultimately determine differentiated access.

Architecture and Flow

Roles range in complexity from a simple user group (e.g., Finance, Engineering, or Human Resources) to a combination
of a user group with some dynamic constraints (e.g., “San Jose Night Shift Worker”- - An employee in the Engineering
department who logs in through the San Jose network device between 8 PM and 5 AM on weekdays). It can also
apply to a list users. A role can be:

e Discovered by Policy Manager through role mapping ("Adding and Modifying Role Mapping Policies " on page
157). Roles are typically discovered by Policy Manager by retrieving attributes from the authentication source.
Filter rules associated with the authentication source tell Policy Manager where to retrieve these attributes.

e Assigned automatically when retrieving attributes from the authentication source. Any attribute in the
authentication source can be mapped directly to a role. ("Adding and Modifying Authentication Sources " on page
128)

e Associated directly with a user in the Policy Manager local user database ("Adding and Modifying Local Users "
on page 161 and "Adding and Modifying Guest Users " on page 162).

e Associated directly with a static host list, again through role mapping ("Adding and Modifying Static Host Lists "
on page 167).

Figure 110 Role Mapping Process

Far Select First Match rules, Policy Manager fests the
reques agains! a sl of role-mapping ruies, in order of
prianiy, unfil the client malches a role or fadls on the last
e,

For Select All Matches ez, Folicy Maneger tests the
request agains! all rofe-mapping nifes

Role Mapping

Role match{es)?

Mo matchias)

i Policy Manager
Pdppenmy Mdan;ger appends mapped
de?ﬁwhﬂ: tgeth roles (roles derived by
i mapping) to the
request
request

Configuring a Role Mapping Policy

After authenticating a request, an Policy Manager Service invokes its Role Mapping Policy, resulting in assignment of
a role(s) to the client. This role becomes the identity component of Enforcement Policy decisions.

A service can be configured without a Role Mapping Policy, but only one Role Mapping Policy can be configured for
each service.

Policy Manager ships with the following pre-configured roles:

e [Contractor] - Default role for a Contractor
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e [Employee] - Default role for an Employee

o [Guest] - Default role for guest access

e [Other] - Default role for other user or device

e [TACACS API Admin] -API administrator role for Policy Manager admin

e [TACACS Help Desk] - Policy Manager Admin Role, limited to views of the Monitoring screens

o [TACACS Network Admin] - Policy Manager Admin Role, limited to Configuration and Monitoring Ul screens
e [TACACS Read-only Admin] - Read-only administrator role for Policy Manager Admin

e [TACACS Receptionist] - Policy Manager Guest Provisioning Role

e [TACACS Super Admin] - Policy Manager Admin Role with unlimited access to all Ul screens

E Additional roles are available with AirGroup and Onboard licenses

You can also configure other roles. Refer to "Adding and Modifying Roles " on page 160.

Configuring Single Sign-On
Single Sigh-On allows ClearPass users to access the Policy Manager, Guest, and Insight applications without re-signing
in once they have signed in to one of the applications.

To configure single sign-on

1. Go to Configuration > Identity > Single Sign-On.
Configuration » Identity » Single Sign-On (SS0)

Single Sign-On (SSO)

IdP 550 URL:

Enable S5O for

Insight [l
Guest =
PolicyManager [l

IdP Certificate

Select Certificate: e -

Click here to download CPPM Service Provider (SP) Metadata

Save Cancel

2. Enter the IdP (Identity Provider) Single sign-on URL. (See below for details.)

3. In the Enable SSO for section, select the check box for the applications you want users to access with single sign-
on.

4. If you want to do a certificate comparison, select the IdP Certificate to use.
5. Click Save.
Table 91: Single Sign-On parameters.

Parameter Description

IdP This is the Identity Provider's HTTP-REDIRECT URI, which is the URL a user is redirected
SSO URL to with a SAMLRequest when that user accesses a SAML protected resource.

IdP Single sign-on will operate with or without a certificate comparison. The certificates you
Certificate can choose in this list are the ones defined in "Certificate Trust List " on page 289.
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After authenticating a request, an Policy Manager Service invokes its Role Mapping Policy, resulting in assignment of
a role(s) to the client. This role becomes the identity component of Enforcement Policy decisions.

A Service can be configured without a Role Mapping Policy, but only one Role Mapping Policy can be configured for

each service.
HNOTE

Policy Manager ships with the following pre-configured roles:
[Guest] - Role for guest access
[TACACS Help Desk] - Policy Manager Admin Role, limited to views of the Monitoring screens
[TACACS Network Admin] - Policy Manager Admin Role, limited to Configuration and Monitoring UI screens
[TACACS Receptionist] - Policy Manager Guest Provisioning Role
[TACACS Super Admin] - Policy Manager Admin Role with unlimited access to all Ul screens

You can also configure additional roles. Refer to "Adding and Modifying Roles " on page 160 for more information.

Adding and Modifying Role Mapping Policies

From the Services page (Configuration > Service), you can configure role mapping for a new service (as part of the

flow of the Add Service wizard), or modify an existing role mapping policy directly (from the Configuration >
Identity > Role Mappings page).

Figure 111 Role Mapping Policies

Configuration » Identity » Role Mappings
Role Mappings " Add Role Mapping
& Import Role Mappings]
& Export Role Mappings
P Pping:
Filter:| Name ¥ contains Clear Filter Show |20 + | records
# [ Namea Description Default Role
i ‘ [ Employee Roles Role mapping policies for employees Role_Engineer
2. ‘ [Tl Enterprise Role Mapping Policy Role mapping policy for all managed users eTIPS_Guest
3. ‘ [ Handheld Roles Roles for handheld devices Not_Handhelds
S ‘ ] RMP_DEPARTMENT eTIPS_Guest
5. ‘ [Tl switch Port Role Mapping Policy Unknown Client
6. ‘ [l TG Role Mapping (AD) AD Roles for traffic generator eTIPS_Guest
7. ‘ [l unmanaged Clients Role Mapping Roles for handheld devices Not_Handhelds
Showing 1-7 of 7 Copy | Export | Delete

When you click Add Role Mapping from any of these locations, Policy Manager displays the Add Role Mapping
popup, which contains the following three tabs:

Policy
Mapping Rules

Summary

Policy Tab

The Policy tab labels the method and defines the Default Role (the role to which Policy Manager defaults if the
mapping policy does not produce a match for a given request).
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Figure 112 Role Mapping (Policy Tab)

Configuration » Identity » Role Mappings » Add

Role Mappings

Mapping Rules Summary

Policy Name:

Description:

Default Role: [Contractor] pd| View Details Modify Add new Role

Table 92: Role Mapping (Policy tab)

Parameter Description

Policy Name Freeform label and description.
/Description

Default Role Select the role to which Policy Manager will default when the role mapping policy
does not produce a match.

View Details / Click on View Details to view the details of the default role. Click on Modify to
Modify / Add new modify the default role. Click on Add new Role to add a new role.
Role

Mapping Rules Tab
The Mapping Rules tab selects the evaluation algorithm, adds/edits/removes rules, and reorder rules.

On the Mapping Rules tab, click the Add Rule button to create a new rule, or select an existing rule (by clicking on
the row) and then click the Edit Rule button or Remove Rule button.

Figure 113 Role Mapping (Mapping Rules Tab)

Policy Mapping Rules Summary

Rules Evaluation Algorithm: @ Select first match © Select all matches

Role Mapping Rules:

Conditions Role Name
(Authorization:[Admin User Repository]:Role_Name EQUALS ADMIN})
OR (Authorization:[Admin User Repository]:Role_Name EQUALS SYSADMIN)
(Authentication:Status EQUALS Machine)
OR (Authorization:[Admin User Repository]:Role_Name EQUALS ADMIN)

[Contractor]

[Contractor]

When you select Add Rule or Edit Rule, Policy Manager displays the Rules Editor popup.
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Figure 114 Rules Editor

Rules Editor o

Matches @ ANY or © ALL of the following conditions:

Type Name Operator Value b
1.‘Authent\cat\un Status EQUALS Machine a
2.“Authorlzat|on:Avenda AL [*] [memberof [*] [EQuaLs | = |[CorporateAssets [
department Monday, Tuesday,

3.|Date title ZLONGS_TO Wednesday, Thursday, I
countryCode Friday

4_‘C|ick to add... mshPAllowDialin

0 memberQf |

distinguishedName

name
Role Name: ‘ Conferencelaptop hd ‘

Table 93: Role Mappings Page (Rules Editor)

Label Description

Type The rules editor appears throughout the Policy Manager interface. It exposes different
namespace dictionaries depending on context. (Refer to "Namespaces" on page 329.)
In the role mapping context, Policy Manager allows attributes from following namespaces:
o Application
o Authentication
o Authorization
o Authorization:<authorization_source_instance> - Policy Manager shows each instance of
the authorization source for which attributes have been configured to be fetched. ("Adding
and Modifying Authentication Sources " on page 128). Only those attributes that have
been configured to fetched are shown in the attributes dropdown.
o Certificate
e Connection
e Date
e Device
e Endpoint
o GuestUser
e Host
o LocalUser
e Onboard
e TACACS
o RADIUS - All enabled RADIUS vendor dictionaries
Name Drop-down list of attributes presentin the selected namespace.
(of
attribute)
Operator | Drop-down list of context-appropriate (with respect to the attribute data type) operators.
Operators have their obvious meaning; for stated definitions of operator meaning, refer to
"Operators" on page 335.
Value of | Depending on attribute data type, this may be a free-form (one or many line) edit box, a drop-
attribute down list, or a time/date widget.

The Operator values that display for each Type and Name are based on the data type specified for the Authentication

E Source (from the Configuration > Authentication > Sources page). If, for example, you modify the UserDN Data type on

with values that are specific to Integers.

the Authentication Sources page to be an Integer rather than a string, then the list of Operator values here will populate
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When you save your Role Mapping configuration, it appears in the Mapping Rules tab list. In this interface, you can
select a rule (click and the background changes color), and then use the various widgets to Move Up, Move Down,
Edit the rule, or Remove the rule.

Adding and Modifying Roles
Policy Manager lists all available roles in the Roles page. From the menu, select Configuration > Identity > Roles.

Figure 115 Roles

Configuration » Identity » Roles
Roles =" Add Roles
&, Import Roles
& Export Roles
Filter: | Description ~ [=]contains Role show [10_[=] records
# M Name 4 Description
1.[E [Cuntrac‘éu“ri._ . Default role for a Contractor
2.|@ [Employee] Default role for an Employee
3.(@ [Guest] Default role for a Guest
4.0 [Other] Default role for other user or device
5. (@ [TACACS API Admin] API administrator role for Policy Manager Admin
6. 0 [TACACS Help Desk] Help desk role for Policy Manager Admin
7.|E [TACACS Network Admin] Network administrator role for Policy Manager Admin
8.|@ [TACACS Read-only Admin] Read-only administrator role for Policy Manager Admin
0.|@ [TACACS Receptionist] Receptionist role for Policy Manager Admin
10.| [TACACS Super Admin] Super administrator role for Policy Manager Admin
Showing 1-10 of 10 Export | Delete

You can configure a role from within a Role Mapping Policy (Add New Role), or independently from the menu
(Configuration > Identity > Roles > Add Roles). In either case, roles exist independently of an individual Service and
can be accessed globally through the Role Mapping Policy of any Service.

When you click Add Roles from any of these locations, Policy Manager displays the Add New Role popup.
Figure 116 Add New Role

Add New Role

Name: [ |

Description:

Save | Cancel

Table 94: Add New Role

Parameter Description

Role Name /Description Freeform label and description.

Local Users, Guest Users, Onboard Devices, Endpoints, and Static
Host List Configuration

The internal Policy Manager database (/Local User Repository], [Guest User Repository]) supports storage of user
records, when a particular class of users is not present in a central user repository (e.g., neither Active Directory nor
other database); by way of an example of such a class of users, guest or contractor records can be stored in the local
user repository.

To authenticate local users from a particular Service, include [Local User Repository] among the Authentication

Sources.

ClearPass Policy Manager 6.1 | User Guide



The endpoints table lists the endpoints that have authenticated requests to Policy Manager. These entries are
automatically populated from the 802.1X, MAC-based authentications, and web authentications processed by Policy
Manager. These can be further modified to add tags, known/unknown, disabled status.

A static host list comprises of list of MAC and IP addresses. These can be used as white or black lists to control access
to the network.

Refer to "Adding and Modifying Local Users " on page 161 for information on how to configure Local Users.

Adding and Modifying Local Users

Policy Manager lists all local users in the Local Users page (Configuration > Identity > Local Users):

Figure 117 Fig: Local Users Listing

Configuration » Identity » Local Users
Local Users “ Add User
& Import Users
& Export Users

Fiter: UserD [v] contains| ® Show records

# [  useriba Name Role Status
1[0 ootesccisase India Test Laptop Role_Engineer Enabled
2|0 akra Akira Kurosawa Senior_Mgmt. Enabled
3|0 arthur Arthur Denver Senior_Mgmt Enabled
4|0 ashwath Ashwath Murthy [TACACS Super Admin] Enabled
5./ avendaconference Avenda Conference Room ConferencelLaptop Enabled
6|0 bhprasad Bhagya Prasad NR TestQa Enabled
7|8 bob Bil Gecko Device SuperAdmin Enabled
8|0 camie Carrie Lipton Senior_Mgmt. Enabled
o clay Clay Pepp Role_Engineer Enabled
0.0 david David Hamel Senior_Mgmt. Enabled
showing 1-10 of 42 B> B

To add a local user, click Add User to display the Add Local User popup.
Figure 118 Add Local User

Add Local User o

User ID | gabriel |
Name | Gabriel Hawthore |
Password |""l.l""'-.l |
Verify Password |""l.l""'-.l |
Enable User (Check to enable local user)
Role | [TACACS Nework Admin] [~]
Attributes

Attribute Value i, *
1.|Phone = 408-555-1212 o
2.|Emai| = gabriel@acme.com b}
3.|De5\gnation = Network Admin Consultant if
4.|L0cation = HQ In)
5. click to add... -

[ |

Table 95: Add Local User

Parameter Description

User ID/ Freeform labels and password.
Name

/Password/

Verify

Password
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Parameter Description

attributes. By default, four custom attributes appear in the Atiribute dropdown: Phone,
Email, Sponsor, Designation. You can enter any name in the attribute field. All attributes
are of String datatype. The value field can also be populated with any string. Each time you
enter a new custom attribute, it is available for selection in Attribute dropdown for all local

users.

NOTE: All attributes entered for a local user are available in the role mapping rules editor
under the LocalUser namespace.

Enable Uncheck to disable this user account.

User

Role Select a static role for this local user.

Attributes Add custom attributes for this local user. Click on the “Click to add...” row to add custom

Additional Available Tasks

e To edit a local user, in the Local Users listing page, click on the name to display the Edit Local User popup.

o To delete a local user, in the Local Users listing page, select it (via the check box) and click Delete.

e To export a local user, in the Local Users listing page, select it (via the check box) and click Export.

e To export ALL local users, in the Local Users listing page, click Export Users.

e To import local users, in the Local Users listing page, click Import Users.

Adding and Modifying Guest Users

An administrator with the Policy Manager Receptionist role provisions users specifically as Guests (local users with a
pre-defined role of Guest). From the menu, select Configuration > Identity > Guest Users.

Figure 119 Guest Users Listing

Guest Users

Configuration » Identity » Guest Users

“® Add Guest User
& Import Guest Users
& Export Guest Users

Showing 1-4 of 4

F\\tar:contams Show records
‘ # [ usernamea Sponsor Name Guest Type Status Expired Source Application
1.‘|:| abartz admin USER Enabled Valid Policy Manager
2.‘|:| dmoore admin USER Enabled Valid Policy Manager
3.“:‘ mohara admin USER Enabled Valid Policy Manager
4.‘|:| skale admin USER Enabled Valid Policy Manager

Table 96: Guest Users Listing

Parameter Description

User Name

Guest user name.

Sponsor Name

Sponsor who sponsored the guest.

Guest Type USER (for guest users) and DEVICE (for devices registered from the GuestConnect
product).
Status Enabled/Disabled status.
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Parameter Description

Expired Whether the guest/device account has expired
Source Where this account was created: From Policy Manager or the GuestConnect guest
Application provisioning product.

In the Guest Users listing:
e To add a guest user or device, click Add User. This opens the Add New Guest User popup.

Figure 120 Add New Guest User

Add New Guest User o

Guest Type ® User © DEVICE
User ID: |johndoe |
Password: | vyWZkRN2aS [l Auto Generate
Expiry Time: ? November, 2012 ®
Enable Guest: -
wk |Sun Mon Tue Wed Thu Fri Sat
@ 1 2 3 4 5 ¢
Attribute Valud 44| 7 8[ 9] 10 11 12 13
45( 14 15 16 17 18 19 20
S —ompany Name = (AEDIL 46( 21 22 23 24 25 26 27
2.|Sponsor = jane 47| 28 29 30
3.|Phone = 408554—1ME: [10]:[59]
Select date
4. |Click to add...

m Cancel

Figure 121 Add New Guest Device

Add New Guest User o

Guest Type © USER @ DEVICE

MAC Address : |00-21-70-9C-85-2B |
Expiry Time: [2010-11-16 11:04:36 |
Enable Guest:

Attribute Value i
1.|Device Type = XBox 360 jing
2.|Sponsor = johndoe g
g

[ 00

Table 97: Add New Guest User/Device

Parameter Description

Guest Type Add a guest user or a guest device

User ID/ Name /Password/ | Freeform labels and password.
Verify Password (Guest Click Auto Generate to auto-generate a password for the guest user.
User only)
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Parameter Description

MAC Address (Guest MAC address of the guest device.

Device only)

Enable Guest Check to enable guest user.

Expiry Time Use the date widget to select the date and time on which this Guest User’'s

access expires.

Attributes Add custom attributes for this guest user. Click on the “Click to add...” row to
add custom attributes. By default, six custom attributes appear in the
Attribute dropdown: Company-Name, Location, Phone, Email, Sponsor,
Designation. You can enter any name in the attribute field. All attributes are
of String datatype. The value field can also be populated with any string.
Each time you enter a new custom attribute, it is available for selection in
Attribute drop down for all guest users.

NOTE: All attributes entered for a guest user are available in the role
mapping rules editor under the GuestUser namespace.

e To edit a guest user, in the Guest Users listing page, double-click on the name to display the Edit Local User
popup.

e To delete a guest user, in the Guest Users listing page, select it (via check box) and click Delete.

e To export a guest user, in the Guest Users listing page, select it (via check box) and click Export.

e To export ALL guest users, in the Guest Users listing page, click Export Users.

e To import guest users, in the Guest Users listing page, click Import Users.

Onboard Devices

The Configuration > Identity > Onboard Devices page lists all devices that have authenticated. The information
within this page includes the device name, owner, status, whether the device is expired, and the expiry time.

Figure 122 Onboard Devices

Configuration » Identity » Onboard Devices
Onboard Devices & Export Onboard Devices
Filter:| Device Name [=]contains Show [10_[+] records
# [ Device Name 4 Oowner Status Expired Expiry Time
1.|[0]  ies:172:mdps_generic Enabled valid Apr 25, 2013 17:24:34 PDT
2.|0 ios:174:mdps_generic Enabled Valid Apr 25, 2013 17:35:25 PDT
3.|[0  i0s:177:mdps_generic Enabled valid Apr 25, 2013 17:42:32 PDT
4.|0 sam:178:mdps_generic Enabled Valid Apr 26, 2013 09:28:26 PDT
5.|[0]  sam:180:mdps_generic Enabled valid Apr 26, 2013 09:31:25 PDT
6.0 sam:182:mdps_generic - Enabled Valid Apr 26, 2013 09:43:03 PDT
7.|[01  sam:184:mdps_generic Enabled valid Apr 26, 2013 09:47:46 PDT
8.0 sam:185:mdps_generic Enabled Valid Apr 26, 2013 09:49:48 PDT
9.|[C1  sam:186:mdps_generic Enabled valid Apr 26, 2013 10:09:38 PDT
10.|0 sam:187:mdps_generic Enabled Valid Apr 26, 2013 10:13:30 PDT
Showing 1-10 of 11 B> Export | Delete

Click on a device name within a row to drill down and view detailed information about the device, including the
device password, start and expiry times, owner, serial number, UUID, product name, and product version. You can also
use the Enable Device check box to enable or disable the device.

Figure 123 View Onboard Devices
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View Onboard Devices o

Device Name :
Password:
Start Time:
Expiry Time:
Owner:

Enable Device

on

Attribute
1.| Device Serial
2.| Device UDID
3.| Product Mame
4.| Product Versi

ios:174:mdps_generic

Apr 25, 2012 17:05:25 PDT
Apr 25, 2013 17:35:25 PDT

Value

= iPod4,1
= 9A405

Adding and Modifying Endpoints

Policy Manager automatically lists all endpoints (that have authenticated) in the Endpoints page (Configuration >

Identity > Endpoints):

Figure 124 Endpoints Listing

Endpoints

Filter: | MAC Address
# [ mMACAddress
1.| 001644b19320
2. | O oo1ag27fefcf
3.|D 247703478518

Showing 1-3 of 3

4" Add Endpoint
£, Import Endpoints
& Export All Endpoints

E\:UntamS “ Clear Filter Show |20 Erecnrds

A Hostname

Category 0S Family Status Profiled
Unknown No
Unknown No

Unknown N

o
Authentication Records | Export

o To view the authentication details of an endpoint, select an endpoint by clicking on its check box, and then click

the Authentication Records button. This opens the Endpoint Authentication Details popup.

Figure 125 Endpoint Authentication Details

Endpoint Authentication Details L]

MAC Address

Username

001644b19320

Device

10.2.50.29

10.2.50.29

10.2.50.29

10.2.50.29

10.2.50.29

10.2.50.29

10.2.50.29

Authentication  Start Time Roucy Manager Session ID IS
Server

2012/04/25 .

ACCEPT 11:23:17 10.2.50.177 RO0O000175-01-4f984115
2012/04/25 e

ACCEPT 11:23:03 10.2.50.177 RO0000174-01-4f984107 1
2012/04/25 o 3

ACCEPT 11:17:45 10.2.50.177 RO0000173-01-4f983fc9

ACCEPT 2012/04/25 10.2.50.177 RO0000172-01-4f983fba
11:17:31

ACCEPT 2012/04/25 10.2.50.177 RO0000171-01-4f983ebe L4
11:11:59
2012/04/25 e

ACCEPT 11:06:39 10.2.50.177 RO0000170-01-4f983d2f

ACCEPT i?l;éﬂ;éZE 10.2.50.177 RO000016f-01-4f283d22

Anan i iar

Close

To manually add an endpoint, click Add Endpoint to display the Add Endpoint popup.
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Figure 126 Add Endpoint

MAC Address 00-21-70-9C-85-2B
Description:
Status ® Known client © Unknown client © Disabled client
Attributes
Attribute Value
1.|Device Type = Turnstile o
[

Table 98: Add Endpoint

Parameter Description

MAC MAC address of the endpoint.
Address
Status Mark as Known, Unknown or Disabled client. The Known and Unknown status can be used

in role mapping rules via the Authentication:MacAuth attribute. The Disabled status can be
used to block access to a specific endpoint. This status is automatically set when an
endpointis blocked from the Endpoint Activity table (in the Live Monitoring section).

under the Endpoint namespace.

Attributes Add custom attributes for this endpoint. Click on the “Click to add...” row to add custom
attributes. You can enter any name in the attribute field. All attributes are of String datatype.
The value field can also be populated with any string. Each time you enter a new custom
attribute, it is available for selection in Attribute dropdown for all endpoints.

NOTE: All attributes entered for an endpoint are available in the role mapping rules editor

To edit an endpoint, in the Endpoints listing page, click on the name to display the Edit Endpoint popup.

Notice that the Policy Cache Values section lists the role(s) assigned to the user and the posture status. Policy
Manager can use these cached values in authentication requests from this endpoint. Clear Cache clears the computed

policy results (roles and posture).

Figure 127 Endpoint Popup

MAC Address 90840d6dal4e
Description:
Status @ Known client @ Unknown client © Disabled client
Attributes
Attribute Value i
1.|lick to add...
Policy Cache Values
Roles [User Authenticated], Senior_Mgmt
Posture Status UNKNOWN (100)
Last Updated at Nov 18, 2010 17:24:07 PST
Cache Expires at Nov 18, 2010 17:24:07 PST

To delete an endpoint, in the Endpoints listing page, select it (via check box) and click the Delete button.
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To export an endpoint, in the Endpoints listing page, select it (via check box) and click the Export button.

To export ALL endpoints, in the Endpoints listing page, click the Export All Endpoints link in the upper right corner
of the page.

To import endpoints, in the Endpoints listing page, click the Import Endpoints link in the upper right corner of the
page.

Adding and Modifying Static Host Lists
A static host list comprises a named list of MAC or IP addresses, which can be invoked the following ways:

e In Service and Role-mapping rules as a component.

e For non-responsive services on the network (for example, printers or scanners), as an Authentication Source.

Only static host lists of type MAC address are available as authentication sources. A static host list often functions, in the
context of the Service, as a white list or a black list. Therefore, they are configured independently at the global level.

Figure 128 Static Host Lists (Listing Page)

Configuration » Identity » Static Host Lists

Static Host Lists 4 Add Static Host List
& Import Static Host Lists

&£, Export Static Host Lists

Fiter: [ Name =] contains # Show [10 [=] records
# [ Namea Format Type Description
1[5 Handnelds List MACAddress Handhelds Whitelist
2|0 p-whitelist List IPAddress
3./0  Macintosh and Phone Clients Regex MACAddress MAC Address st for Apple vendor endpoints
4|0 MAc whitelist - No Posture List MACAddress MAC Address list where posture rules are ignored
5.1 ) and Bangalore Endpoints Regex IPAddress All San Jose & Bangalore Endpoints
6.0 s Endpoints Subnet IpAddress All San Jose Endpoints

Showing 1-6 of 6 [Export| [ Detete |
To add a Static Host List, click the Add Static Host List link. This opens the Add Static Host List popup.

Figure 129 Add Static Host List

Add Static Host List a

MName: [Handhelds] |

Description: Handhelds Whitelist

Host Format: O Subnet
) Regular Expression
@ List
Host Type © 1P Address
@ MAC Address
List: 00-23-df-21-9b-a7 -

00-21-e9-40-46-a5

Add Host
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Table 99: Add Static Host List

Parameter Description

Name/ Freeform labels and descriptions.

Description

Host Format Select a format for expression of the address: subnet, IP address or regular
expression.

Host Type Select a host type: IP Address or MAC Address (radio buttons).

List Use the Add Host and Remove Host widgets to maintain membership in the current
Static Host List.

Additional Available Tasks

To edit a Static Host List from the Static Host Lists listing page, click on the name to display the Edit Static Host
List popup.

To delete a Static Host List from the Static Host Lists listing page, select it (via check box) and click the Delete
button.

To export a Static Host List, in the Static Host Lists listing page, select it (via check box) and click the Export
button.

To export ALL Static Host Lists, in the Static Host Lists listing page, click the Export Static Host Lists link.
To import Static Host Lists, in the Static Host Lists listing page, click the Import Static Host Lists link
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Chapter 15

Posture

Policy Manager provides several posture methods for health evaluation of clients requesting access. These methods all
return Posture Tokens (E.g., Healthy, Quarantine) for use by Policy Manager for input into Enforcement Policy. One or
more of these posture methods may be associated with a Service.

Posture Architecture and Flow
Policy Manager supports three different types of posture checking:

e Posture Policy. Policy Manager supports four pre-configured posture plugins for Windows, one plugin for Linux
and one plugin for MAC OS X, against which administrators can configure rules that test for specific attributes of
client health and correlate the results to return Application Posture Tokens for processing by Enforcement Policies.

e Posture Server. Policy Manager can forward all or part of the posture data received from the client to a Posture
Server. The Posture Server evaluates the posture data and returns Application Posture Tokens. Policy Manager
supports the Microsoft NPS Server for Microsoft NAP integration.

e Audit Server. Audit Servers provide posture checking for unmanageable devices (i.e., devices lacking adequate
posture agents or supplicants); in the case of such clients, the audit server’s post-audit rules map clients to roles.
Policy Manager supports two types of Audit Servers: NMAP audit server, primarily to derive roles from post-audit
rules; NESSUS audit server, primarily used for vulnerability scans (and, optionally, post-audit rules).

Figure 130 Posture Evaluation Process

Falicy Manager allows configuration of any
combination of haalth-chacking regimens: posture
policies, posture servers, and'or audif servers. Each
configured health check refums an “application”
token representing health status,

Posture Evaluation

Policy Manager invokes
internal posiure policies.
4— which evaluate client health [4— ¥es
and returns application

Posture Folicies
corfigured?

f—

Apply intemal/external audit
server checking, which

evaluates client health and [#— &

returns application posture
token.

Vel irTatian.

posiure token.
Policy Managar P ne
evaluates all .
application
mmf:sns Apply external posture
server checking, which Posture Servers

fﬁm %“:‘“m «—| evaluates client health and [ & configured?
J‘raa.lg::?atfnag retums application posture

Loked.
eguivalent o the oken
lowesi-rated
application P Mo
postura token.

Audit Server
configured?

Mg

Pasterudt rules may append

Pasture Tokens: Healthy, Checkup, Transition, Quaranting, Infected, Unknown

Policy Manager uses posture evaluation to assess client consistency with enterprise endpoint health policies,

specifically with respect to:

e Operating system version/type
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e Registry keys/services present (or absent)

e Antivirus/antispyware/firewall configuration
o Patch level of different software components
e Peer to Peer application checks

e Services to be running or not running

e Processes to be running or not running
Each configured health check returns an application token representing health:

e Healthy. Client is compliant: there are no restrictions on network access.

e Checkup. Client is compliant; however, there is an update available. This can be used to proactively remediate to
healthy state.

o Transient. Client evaluation is in progress; typically associated with auditing a client. The network access granted
is interim.
e Quarantine. Client is out of compliance; restrict network access, so the client only has access to the remediation

SCTVErS.

o Infected. Client is infected and is a threat to other systems in the network; network access should be denied or
severely restricted.

o Unknown. The posture token of the client is unknown.

Upon completion of all configured posture checks, Policy Manager evaluates all application tokens and calculates a
system token, equivalent to the most restrictive rating for all returned application tokens. The system token provides the
health posture component for input to the Enforcement Policy.

A Service can also be configured without any Posture policy.

The following image displays how to configure Posture at the Service level. Note that the Posture Compliance check
box must be selected on the Service tab in order for Posture to be enabled.

Figure 131 Posture Features at the Service Level

Summary Service Authentication Roles m Enforcement

Posture Policies:

Posture Policies: Basic Linux Health Check o Remove
18 Modify
~Selectio Add~— [=]
Default Posture Token: UNKNOWN (100) |Z|
Remediate End-Hosts: [“] Enable auto-remediation of non-compliant end-hosts
Remediation URL: http:/fremediation_internal.us.acme.com
Posture Servers:
Posture Servers: [PS_NPS [RADIUS] icrosotNps) I vomove |
:
~Selsctio Add— [=]

You can configure the following features of posture:
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Table 100: Posture Features at the Service Level

Configurable
Component

How to Configure

Sequence of Posture
Policies

Select a Policy, then select Move Up, Move Down, Remove, or View Details.

e To add a previously configured Policy, select from the Select drop-down
list, then click Add.

e To configure a new Policy, click the Add New Policy link and refer to
"Adding and Modifying Posture Policies " on page 171.

o To editthe selected posture policy, click Modify and refer to "Adding and
Modifying Posture Policies " on page 171.

Default Posture Token

Remediation End-Hosts

Remediation URL

Sequence of Posture
Servers

Select a Posture Server, then select Move Up, Move Down, Remove, or

View Details.

e To add a previously configured Posture Server, select from the Select
drop-down list, then click Add.

e To configure a new Posture Server, click Add New Posture Server (link)
and refer to "Adding and Modifying Posture Servers " on page 197.

e To editthe selected posture server, click Modify and refer to "Adding and
Modifying Posture Servers " on page 197.

Enable auto-remediation
of non-compliant end-
hosts

Select the Enable auto-remediation of non-compliant end-hosts check box
to enable the specified remediation server to enable auto-Remediation.
Remediation server is optional. A popup appears on the client box, with the
URL of the Remediation server.

Adding and Modifying Posture Policies

Policy Manager supports pre-configured posture plugins, against which administrators can configure rules that test for

specific attributes of client health and correlate the results to posture tokens:

o If you have NAP Agent (USHA) running on a NAP-compatible client (Windows 8, Windows 7, Windows Vista,

Windows XP SP3, Windows Server 2008), use:

ClearPass Windows Universal System Health Validator. Configurable checking for present/absent Registry Keys,
Services and processes, and product-/version-/update- specific checking for Antivirus, Antispyware, and Firewall
applications. Checks for peer-to-peer applications or networks, patch management applications, hotfixes, USB

devices, virtual machines, and network devices.

e Ifyou have ClearPass Linux NAP Agent running on a Linux client (CentOS, Fedora, Red Hat Enterprise Linux,

SUSE Linux Enterprise Desktop), use:

ClearPass Linux Universal System Health Validator. Configurable checking for present/absent Services, and

product-/version-/update- specific checking for Antivirus application, and Firewall configuration.

o Ifyou have a Microsoft NAP Agent running on the client, use:

= Windows System Health Validator. Configurable checking for required operating system versions and service

packs.
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Windows Security Health Validator. Configurable checking for Antivirus/Antispyware/Firewall applications,
as well as automatic updates and security updates.

If you have ClearPass OnGuard Agent (dissolvable or persistent) running on the client (Windows 8, Windows 7,
Windows XP SP3, Windows Vista, Windows Server 2008, Windows 2003, SUSE Linux, Redhat Enterprise Linux,
Fedora Linux, CentOS Linux, MAC OS X), use:

ClearPass Windows Universal System Health Validator. Configurable checking for present/absent Registry
Keys and Services, and product-/version-/update- specific checking for Antivirus, Antispyware, and Firewall
applications. Checks for peer-to-peer applications or networks, patch management applications, hotfixes, USB
devices, virtual machines, and network devices.

Windows System Health Validator. Configurable checking for required operating system versions and service
packs.

ClearPass Linux Universal System Health Validator. Configurable checking for present/absent services.

ClearPass Mac OS X Universal System Health Validator. Configurable checking for product-/version-/update-
specific checking for Antivirus/Antispyware application, and Firewall configuration.

Note that ClearPass OnGuard Agent - both persistent and dissolvable forms - can be used in the following scenarios:

An environment that does not support 802.1X based authentication (legacy Windows Operating Systems, or legacy
devices in the network)

An OS that supports 802.1X natively, but does not have a built-in health agent. For example, MAC OS X.

Refer to "Configuring Posture Policy Plugins " on page 172 for additional information.

Configuring Posture Policy Plugins

From the Services page (Configuration > Service) or using the Add Posture Policy button (Configuration > Posture >
Posture Policies), you can configure posture for a new service (as part of the flow of the Add Service wizard), or
modify an existing posture policy or server directly (Configuration > Posture > Posture Policies, then click on its
name in the Posture Policies listing page).

When you click Add Posture Policy from any of these locations, Policy Manager displays the Add Posture Policy
page, which contains three configurable tabs:

The Policy tab labels the policy and defines operating system and the type of deployed agent.
Figure 132 Add Posture Policy (Policy Tab)

Configuration » Posture » Posture Policies » Add

Posture Policies

Posture Plugins Rules Summary

Policy Name:

Description:
Posture Agent: @ NAP Agent © OnGuard Agent (Persistent or Dissolvable)
Host Operating System: @ Windows © Linux Mac 0S X

Restrict by Roles:

Remove

Select or type role names

- T

Back to Posture Policies
Save Cancel
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Table 101: Add Posture Policy

Parameter Description

Policy Freeform label and description.
Name/Description

Posture Agent o NAP Agent - Use this to configure posture policies for host operating systems
with an embedded NAP-compliant agent (Microsoft Windows NAP Agent or
ClearPass Linux NAP Agent). Currently, the following OSes are supported:
Microsoft Windows 8, Microsoft Windows 7, Microsoft Windows Vista, Microsoft
Windows XP SP3, Microsoft Windows Server 2008, Microsoft Windows Server
2008 R2, and Linux OSes supported by ClearPass Linux NAP Agent.

o OnGuard Agent - Use this to configure posture policies for guest or web portal
based use cases (via a dissolvable Java-applet based agent), or for use cases
where ClearPass (persistent) OnGuard Agent is installed on the endpoint.
Currently, the following OSes are supported by the OnGuard Agent: Microsoft
Windows 8, Microsoft Windows 7, Microsoft Windows Vista, Microsoft Windows
XP SP3, Microsoft Windows Server 2008, Microsoft Windows Server 2008 R2,
Microsoft Windows Server 2003, MAC OS X 10.5 or above, and Linux OSes
supported by ClearPass Linux NAP Agent.

Host Operating Select Linux, Windows or Mac OS X. Note that Mac OS X is not available if the
System Posture Agentis NAP.

Restrict by Roles Select role(s) that the Posture policy will apply to. Leave empty for the Posture policy
to apply to all riles.

e To add arole, select a role from the drop-down list, and then click Add.
e Toremove arole, select a role in the list, and then click Remove.

e The Posture Plugins tab provides a selector for posture policy plugins. Select a plugin (by enabling its check box),
then click Configure.

Figure 133 Add Posture Policy (Posture Plugins Tab) - Windows NAP Agent

Rules Summary
Select one/more plugins:
Plugin Name Plugin Configuration Status
B |CIearPass Windows Universal System Health validator Configure \ View | =
[ | Windows System Health Validator Configure \ View | -
] | Windows Security Health Validator Configure ‘ View | =

< Back to Posture Policies

Figure 134 Add Posture Policy (Posture Plugins Tab) - Linux NAP Agent

Policy Posture Plugins Rules Summary

Select one/more plugins:
Plugin Name Plugin Configuration Status

(=] | ClearPass Linux Universal System Health Validator Configure | View | =

< Back to Posture Policies
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Figure 135 Add Posture Policy (Posture Plugins Tab) - Windows OnGuard Agent

Rules Summary
Select one/more plugins:
Plugin Name Plugin Configuration Status
O |CIearPass Windows Universal System Health Validator Configure ‘ View | =
[ | Windows System Health Validator Configure \ View | =
] | Windows Security Health Validator Configure ‘ View | =

< Back to Posture Policies

Figure 136 Add Posture Policy (Posture Plugins Tab) - Linux OnGuard Agent

Policy Posture Plugins Rules Summary

Select one/more plugins:
Plugin Name Plugin Configuration Status

|:||ClearPass Linux Universal System Health Validator Configure | View | =

( Back to Posture Policies

Figure 137 Add Posture Policy (Posture Plugins Tab) - Mac OS X OnGuard Agent

Policy Rules Summary
Select one/more plugins:
Plugin Name Plugin Configuration Status
D‘ ClearPass Mac 0S X Universal System Health validator Configure View | =

( Back to Posture Policies

Refer to the following sections for plugin-specific configuration instructions:

e "ClearPass Windows Universal System Health Validator - NAP Agent " on page 175

e "Windows System Health Validator - NAP Agent " on page 196

e "Windows Security Health Validator - NAP Agent " on page 195

e "ClearPass Windows Universal System Health Validator - OnGuard Agent " on page 191
e "ClearPass Linux Universal System Health Validator - NAP Agent" on page 191

e "ClearPass Linux Universal System Health Validator - OnGuard Agent " on page 193

e "Windows System Health Validator - OnGuard Agent " on page 196

e "Windows Security Health Validator - OnGuard Agent " on page 195

e "ClearPass Mac OS X Universal System Health Validator - OnGuard Agent " on page 193

The Rules tab matches posture checking outcomes.

1. Select one of the following plugin checks.
o Passes all System Health Validator (SHV) checks
e Passes one or more SHV checks
o Fails all SHV checks
o Fails one or more SHV checks
2. Select the plugin.
3. Specify one of the following posture tokens:
o Healthy. Client is compliant: there are no restrictions on network access.

o Checkup. Client is compliant; however, there is an update available. This can be used to proactively remediate
to healthy state.
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e Transition. Client evaluation is in progress; typically associated with auditing a client. The network access
granted is interim.

e Quarantine. Client is out of compliance; restrict network access, so the client only has access to the remediation
servers.

o Infected. Client is infected and is a threat to other systems in the network; network access should be denied or
severely restricted.

e Unknown. The posture token of the client is unknown.

4. Click Save when you are finished.

Figure 138 Fig: Add Posture Policy (Rules Tab)

Policy Posture Plugins m Summary

Rules Evaluation Algorithm: First applicable

Conditions Posture Token

Passes all SHV checks -
ClearPass Windows Universal System Health Validator
Windows System Health Validator LEALLIY
Windows Security Health Validator

Add Rule Move Up | Move Down | Edit Rule
Rules Editor o
Select Plugin Checks: Fails one or more SHV checks -
Select Plugins: [C] ClearPass Windows Universal System Health Validator

Windows System Health Validator
Windows Security Health Validator

Posture Token: { QUARANTINE (20) i ‘

Save J| Cancel

< Back to Posture Policies

ClearPass Windows Universal System Health Validator - NAP Agent

The ClearPass Windows Universal System Health Validator page popup appears in response to actions in the
Posture Plugins tab of the Posture configuration.

Figure 139 ClearPass Windows Universal System Health Validator - NAP Agent

‘windows XP | [JEenable checks for Windows XP

-| Services
Processes
Registry Keys

-| Antivirus

-| AntiSpyware

-| Firewall
Peer To Peer

-| Patch Management

-| windows Hotfixes
USB Devices
Virtual Machines

-| Network Connections
‘Windows Vista O
‘Windows 7 O
‘Windows Server 2008

‘Windows 8

Quarantine Message
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Select a version of Windows and click the check box to enable checks for that version. Enabling checks for a specific

version displays the following set of configuration pages.These pages are explained in the sections that follow.

"Services" on page 176
"Processes" on page 177
"Registry Keys" on page 180
"AntiVirus" on page 181
"AntiSpyware" on page 183
"Firewall" on page 184
"Peer To Peer" on page 185

e '"Patch Management" on page 186

e "Windows Hotfixes" on page 187

e "USB Devices'

'"on page 188

e "Virtual Machines" on page 188

e '"Network Connections" on page 189

Services

The Services page provides a set of widgets for specifying specific services to be explicitly running or stopped.

Figure 140 Services Page

Available Services

Remediation checks Auto Remediation

| | Insert

Alerter

Application Layer Gateway Service
Application Management
Automatic Livelpdate Scheduler
Automatic Updates

Cryptographic Services

Distributed Link Tracking Client
IPSEC Services

NetLogon

Netmeeting Remote Desktop Sharing
Network Location Awareness (NLA)

-

m

User Notification

Services to run

Windows Update

Services to stop

HTTP 85L
Terminal Services

Table 102: Services Page

Parameter Description

Auto Enable to allow auto remediation for service checks (Automatically stop or start services
Remediation | based on the entries in Service to run and Services to stop configuration).

User Enable to allow user notifications for service check policy violations.

Notification

Available This scrolling list contains a list of services that you can select and move to the Services

Services to run or Services to stop panels (using their associated widgets). This list is different for
the different OS types.
Click the >> or << to add or remove, respectively, the services from the Service to run or
Services to stop boxes.

Insert To add a service to the list of available services, enter its name in the text box adjacent to
this button, then click Insert.

Delete To remove a service from the list of available services, select it and click Delete.
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Processes

The Processes page provides a set of widgets for specifying specific processes to be explicitly present or absent on the
system.

Figure 141 Processes Page (Overview)

Remediation checks Auto Remediation User Notification

Processes to be Present m
Process Path Process Name o
Processes to be Absent m
Process MD5 Sum Process Name o

Table 103: Process Page (Overview - Pre-Add)

Parameter Description

Auto Enable to allow auto remediation for registry checks (Automatically add or remove
Remediation registry keys based on the entries in Registry keys to be present and Registry keys to
be absent configuration).

User Enable to allow user notifications for registry check policy violations.

Notification

Processes to Click Add to specify a process to be added, either to the Processes to be present or
be Processes to be absent lists.

present/absent

Click Add for Process to be present to display the Process page detail.
Processes to be Present

Figure 142 Process to be Present Page (Detail)

Process to be Present - Add

Process Location | SystemDrive El

Enter the Process name | |

Enter the Display name | |

Table 104: Process to be Present Page (Detail)

Parameter Description

Process Choose from one of the pre-defined paths, or choose None.
Location e SystemDrive - For example, C:
o SystemRoot - For example, C:\Windows
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Parameter Description

ProgramFiles - For example, “C:\Program Files”
HOMEDRIVE - For example, C:
HOMEPATH - For example, \Users\JohnDoe

None - By selecting None, you can enter a custom path name in the Process Name
field.

Enter the
Process
name

A pathname containing the process executable name. Some valid examples are listed

below:

o If SystemRoot is specified in the Process Location field, then entering notepad.exe in
this field specifies that the following full pathname for the process should be checked:
%SystemRoot%\notepad.exe. Typically, this expands to: C:\Windows\notepad.exe

e If ProgramFiles is specified in the Process Location field, then entering “Mozilla
Firefox\firefox.exe” in this field specifies that the following full pathname for the process
should be checked: “%ProgramFiles%\Mozilla Firefox\firefox.exe”. Typically, this
expands to: “C:\Program Files\Mozilla Firefox\firefox.exe”

o IfNone is specified in the Process Location field, then entering “temp\usurf.exe” in this
field specifies that the following full pathname for the process should be checked:
“c:\temp\foo.exe”

Note that when the agent looks for running processes on the system, it looks for a process

started from the specified location. For example, if the process to be running is specified to

be C:\Windows\notepad.exe, the agent checks to see if there is a process running on the
system that was started from the location C:\Windows. Even if the agent finds another
process with the same name (notepad.exe) but started from a different location (C:\Temp),
it will not match with what it is looking for. In this case, it will still start the process

C:\Windows\notepad.exe.

Enter the
Display
name

Enter a user friendly name for the process. This is displayed in end-user facing messages.

When you save your Process details, the key information appears in the Processes to be present page list.
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Processes to be Absent

Figure 143 Process to be Absent Page (Detail)

Process to be Absent - Add

Check Type : B! process Name © MDS5 Sum

Enter the Process name | |

Enter the Display name | |

Process to be Absent - Add

Check Type : © Process Name MDS Sum

MD5 Sum

Enter the Display name |

Save Cancel

Table 105: Process to be Absent Page (Detail)

Parameter Description

Check Select the type of process check to perform. The agent can look for

Type e Process Name - The agent looks for all processes that matches with the given name.
For example, if notepad.exe is speicfied, the agent kills all processes whose name
matches, regardless of the location from which these processes were started.

o MD5 Sum - This specifies one or more (comma separated) MD5 checksums of the
process executable file. For example, if there are multiple versions of the process
executable, you can specify the MD5 sums of all versions here. The agent enumerates
all running processes on the system, computes the MD5 sum of the process executable
file, and matches this with the specified list. One or more of the matching processes are
then terminated.

Enter the Enter a user friendly name for the process. This is displayed in end-user facing messages.
Display
name
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Figure 144 Process Page (Overview - Post Add)

Remediation checks Auto Remediation

Processes to be Present

Process Path Process Name

User Notification

SystemDrive \system32\notepad.exe

Processes to be Absent

Process MD5 Sum Process Name

usurf.exe

e1ab298bafc8eccaBc322a29c5fdc68
3f0ebc940fa292bbsf1d87dd544b5de0

UltraSurf

i
i
i
o
i

Registry Keys

The Registry Keys page provides a set of widgets for specifying specific registry keys to be explicitly present or

absent.

Figure 145 Registry Keys Page (Overview)

Remediation checks Auto Remediation

Registry keys to be present

User Notification

.H

Key Name Value Type
Registry keys to be absent m
Key Name Value Type i

Table 106: Registry Keys Page (Overview - Pre-Add)

Parameter Description

Remediation
be absent configuration).

Auto Enable to allow auto remediation for registry checks (Automatically add or remove
registry keys based on the entries in Registry keys to be present and Registry keys to

User
Notification

Enable to allow user notifications for registry check policy violations.

Registry keys
to be
present/absent

or Registry keys to be absent lists.

Click Add to specify a registry key to be added, either to the Registry keys to be present

Click Add for either condition to display the Registry page detail.
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Registry Keys to be Absent

Figure 146 Registry Keys Page (Detail)

Registry key to be Absent - Add

Select the Registry Hive HKEY_CLASSES_ROOT -

Enter the Registry key | |

[eg: Software\Samplevendor\SampleApp\Samplekey]

Enter the Registry value name | |

Select the Registry value data type | Any

Enter the Registry value data | |

Save Cancel

Table 107: Registry Keys Page (Detail)

Parameter Description

Hive/Key/value (name, type, data) | Identifying information for a specific setting for a specific registry key.

When you save your Registry details, the key information appears in the Registry page list.

Figure 147 Registry Keys Page (Overview - Post Add)

Remediation checks Auto Remediation User Notification
Registry keys to be present

Key Name Value Type
HKEY _CLASSES_ROOT'\oftware\Samplevendor .
\SampleApp\SampleKey edd did SUE

Add
]
i
Registry keys to be absent m
]
o

Key Name Value Type

HKEY_LOCAL_MACHINE\Software\Avenda -

\TestApp\Init TestkeyMName @Ncdsnn String
AntiVirus

In the Antivirus page, you can specify that an Antivirus application must be on and allows drill-down to specify
information about the Antivirus application. Click An Antivirus Application is On to configure the Antivirus
application information.

Figure 148 Antivirus Page (Overview - Before)

[T An antivirus application is on

When enabled, the Antivirus detail page appears.
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Figure 149 Antivirus Page (Detail 1)

An antivirus application is on
Remediation checks Auto Remediation

Antivirus

User Notification

= = = Dat
Prd Version Eng Version Dat Version

Display Update URL

a .
update Last Scan Rip Check T

Click Add to specify product, and version check information.

Figure 150 Antivirus Page (Detail 2)

Product-specific checks (Uncheck to allow any product)

Select the antivirus product Symantec AntiVirus -
Product version check Is Latest |z|

Engine version check Na Check E

Data file version check Mo Check |Z|

Data file has been updated in 2 Hour(s) |Z|

Last scan has been done before 2 Hour(s) |Z|
Real-time Protection Status ® No Check @ on ® off

Check

After you save your Antivirus configuration, it appears in the Antivirus page list.

Figure 151 Antivirus Page (Overview - After)

An antivirus application is on

Remediation checks Auto Remediation

User Notification

Display Update URL

Antivirus Prd Version Eng Version Dat Version 3:date Last Scan Ritp Check T
Symantec AntiVirus isLatest no check no check 2 Hour{s) 2 Hour(s) on i
Table 108: Antivirus Page
Interface Parameter Description
Antivirus e An Antivirus e Check the Antivirus Application is On check box to enable
Page Application is On testing of health data for configured Antivirus application(s).
e Auto o Check the Auto Remediation check box to enable auto
Remediation remediation of anti-virus status.
e User Notification e Check the User Notification check box to enable user
Display Update notification of policy violation of anti-virus status.
URL o Check the Display Update URL check box to show the
origination URL of the update.
Antivirus Add e To configure Antivirus application attributes for testing against
Page e Trashcan icon health data, click Add.
(Detail 1) e To remove configured Antivirus application attributes from the
list, click the trashcan icon in that row.
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Interface Parameter Description
Antivirus Product/Version/Last | Configure the specific settings for which to test against health data.
Page Check All of these checks may not be available for some products. Where
(Detail 2) checks are not available, they are shown in disabled state on the Ul.
o Selectthe antivirus product - Select a vendor from the list
o Product version check - No Check, Is Latest (requires
registration with ClearPass portal), At Least, In Last N Updates
(requires registration with ClearPass Portal)
o Engine version check - Same choices as product version check.
o Data file version check - Same choices as product version check
e Data file has been updated in - Specify the interval in hours,
days, weeks, or months.
e Lastscan has been done before - Specify the interval in hours,
days, weeks, or months.
o Real-time Protection Status Check - No Check, On, or Off.
AntiSpyware

In the AntiSpyware page, an administrator can specify that an AntiSpyware application must be on and allows drill-
down to specify information about the AntiSpyware application. Click An Antipyware Application is On to configure
the AntiSpyware application information.

Figure 152 AntiSpyware Page (Overview Before)

[C] An antispyware application is on

When enabled, the AntiSpyware detail page appears.
Figure 153 AntiSpyware Page (Detail 1)

An antispyware application is on

Remediation checks Auto Remediation User Notification Display Update URL

Add

- 5 5 - Dat §
Antispyware Prd Version Eng Version Dat Version update Last Scan Rtp Check T

Click Add to specify product, and version check information.

Figure 154 AntiSpyware Page (Detail 2)

Product-specific checks

Real-time Protection Status
Check

Select the antispyware product AVG Anti-Malware [AntiSpyware] -
Product version check Is Latest |Z|

Engine version check Is Latest |Z|

Data file version check Mo Check

Data file has been updated in 2 Hour(s) |Z|

Last scan has been done before Hour(s)

(Uncheck to allow any product)

@ Mo Check = On ' Off
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Figure 155 AntiSpyware Page (Overview After)

An antispyware application is on

Remediation checks Auto Remediation User Motification Display Update URL

Add
£ f . = at §
Antispyware Prd Version Eng Version Dat Version update Last Scan Rtp Check T
AVG Anti-Mal N
nrematvare iIsLatest iIsLatest no check 2 Hour{s) no check nocheck T

[AntiSpyware]

When you save your AntiSpyware configuration, it appears in the AntiSpyware page list.

The configuration elements are the same for antivirus and antispyware products. Refer to the previous

AntiVirusconfiguration instructions

Firewall

In the Firewall page, you can specify that a Firewall application must be on and allows drill-down to specify

information about the Firewall application.

Figure 156 Firewall Page (Overview Before)

[ A firewall application is on

In the Firewall page, click A Firewall Application is On to configure the Firewall application information.

Figure 157 Firewall Page (Detail 1)

A firewall application is on

Remediation checks User Notification

Product Version T

Auto Remediation

Product-specific checks (Uncheck to allow any product)

Firewall Product Name

When enabled, the Firewall detail page appears.
Figure 158 Firewall Page (Detail 2)

Select the firewall product BitDefender Internet Security 2009 -

Product version is at least 12

When you save your Firewall configuration, it appears in the Firewall page list.

Figure 159 Firewall Page (Overview After)

A firewall application is on

Remediation checks

Auto Remediation User Notification

Product-specific checks (Uncheck to allow any product)

Firewall Product Name Product Version T
BitDefender Internet Security 2009 12 o
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Table 109: Firewall Page

Interface Parameter Description
Firewall e AfFirewall e Check the Firewall Application is On check box to enable testing of
Page Application health data for configured firewall application(s).
is On o Check the Auto Remediation check box to enable auto remediation
e Auto of firewall status.
Remediation | e Check the User Notification check box to enable user notification of
e User policy violation of firewall status.
Notification e Uncheck the Uncheck to allow any product check box to check
e Uncheckto whether any firewall application (any vendor) is running on the end
allow any host.
product
Firewall e Add e To configure firewall application attributes for testing against health
Page e Trashcan data, click Add.
(Detail 1) icon e To remove configured firewall application attributes from the list, click
the trashcan icon in that row.
Firewall Product/Version Configure the specific settings for which to test against health data. All of
Page these checks may not be available for some products. Where checks are
(Detail 2) not available, they are shown in disabled state on the UL.
o Selectthe firewall product - Select a vendor from the list
o Productversion is at least - Enter the version of the product.

Peer To Peer

The Peer To Peer page provides a set of widgets for specifying specific peer to peer applications or networks to be
explicitly stopped. When you select a peer to peer network, all applications that make use of that network are stopped.

Figure 160 Peerto Peer Page

A Peer to Peer application is on

Remediation checks Auto Remediation User Notification

@ By Application © By Network
Available applications Applications to stop
Anatomic P2P BitTorrent -
Ares Gnotella
Azureus Kazaa

BadBlue UTorrent

BearShare .
BitComet
BitSpirit s
Blubster
Burst!
Cabos
Crux P2P - b

[l

Table 110: Peerto Peer Page

Parameter Description

Auto Enable to allow auto remediation for service checks (Automatically stop peer to peer
Remediation applications based on the entries in Applications to stop configuration).

User Enable to allow user notifications for peer to peer application/network check policy
Notification violations.

By Select the appropriate radio button to select individual peer to peer applications or a
Application / group of applications that use specific p2p networks.

By Network
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Parameter Description

Available This scrolling list contains a list of applications or networks that you can select and move
Applications to the Applications to stop panel.

Click the >> or << to add or remove, respectively, the applications or networks from the
Applications to stop box.

Patch Management

In the Patch Management page, you can specify that a patch management application must be on and allows drill-

down to specify information about the patch management application. Click An patch management application is On
to configure the patch management application information.

Figure 161 Patch Management Page (Overview - Before)

[C] A patch managment application is on

When enabled, the Patch Management detail page appears.
Figure 162 Patch Management Page (Detail 1)

A patch managment application is on
Remediation checks Auto Remediation User Notification
Product-specific checks {Uncheck to allow any product)

Add
PM Product Name Product Version Status Check jij

Click Add to specify product, and version check information.

Figure 163 Patch Management Page (Detail 2)

Select the Patch Mgmt product BigFix Enterprise Client -
Product version is atleast 3.0
Status Check Type Enabled -

When you save your patches configuration, it appears in the Patch Management page list.

Figure 164 Patch Management Page (Overview - After)

A patch managment application is on
Remediation checks Auto Remediation User Notification

Product-specific checks (Uncheck to allow any product)

PM Product Name Product Version Status Check i
BigFix Enterprise Client 3.0 Enabled i
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Table 111: Patch Management Page

Interface Parameter Description
Patch e Apatch o Check the Patches / Hot fixes Application is On check box to
Management management enable testing of health data for configured Antivirus application
Page application is (s)-
on e Check the Auto Remediation check box to enable auto
o Auto remediation of patch management status.

Remediation o Check the User Notification check box to enable user notification
of policy violation of patch management status.

e User e Uncheck the Uncheck to allow any product check box to check
Notification whether any patch management application (any vendor) is
e Uncheckto running on the end host.
allow any
product
Patch e Add e To configure patch management application attributes for testing
Management against health data, click Add.
Page (Detail | © Trashcan e To remove configured patch management application attributes
1) icon from the list, click the trashcan icon in that row.
Patch Product/Version Configure the specific settings for which to test against health data.
Management All of these checks may not be available for some products. Where
Page (Detail checks are not available, they are shown in disabled state on the Ul.
2) o Select the Patch Mgmt product - Select a vendor from the list

e Productversion is at least - Enter version number
e Status check type - No check, Enabled, Disabled

Windows Hotfixes

The Windows Hotfixes page provides a set of widgets for checking if specific Windows hotfixes are installed on the
endpoint.

Figure 165 Windows Hotfixes Page

Enable checks for Windows 7

Windows Hotfixes

Remediation checks Auto Remediation User Notification
Available Hotfixes Hotfixes to be present

KB2032276 (CRITICAL) - .. -
Impartant KB2079403 (CRITICAL) = -
Maderate KB2160841 (CRITICAL)
Low KB2183461 {CRITICAL)
Unspecified KB2281679 (CRITICAL)

KB2286198 (CRITICAL)

= KB2296199 (CRITICAL) < i

Table 112: Windows Hotfixes

Parameter Description

Auto Enable to allow auto remediation for hotfixes checks (Automatically trigger updates of the
Remediation | specified hoffixes).

User Enable to allow user notifications for hotfixes check policy violations.
Notification
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Parameter

Description

Available The first scrolling list lets you select the criticality of the hoftfixes. Based on this selection,
Hotfixes the second scrolling list contains a list of hotfixes that you can select and move to the
Hotfixes to be present panel (using their associated widgets).
Click the >> or << to add or remove, respectively, the hotfixes from the Hotfixes to run
boxes.
USB Devices

The USB Devices page provides configuration to control USB mass storage devices attached to an endpoint.

Figure 166 USB Devices

Enable checks for Windows 7

USB Devices
Remediation checks

Mo Action v

Mo Action

Remove USB Mass Storage devices
Disable USE Mass Storage devices

Auto Remediation

Remediation Action for USB Mass Storage Devices

User Notification

Table 113: USB Devices

Parameter Description

Auto Remediation

Enable to allow auto remediation for USB mass storage devices attached
to the endpoint (Automatically stop or eject the drive).

User Notification

Enable to allow user notifications for USB devices policy violations.

Remediation Action for USB °
Mass Storage Devices

No Action - Take no action; do not eject or disable the attached
devices.

Remove USB Mass Storage Devices - Eject the attached devices.
Remove USB Mass Storage Devices - Stop the attached devices.

Virtual Machines

The Virtual Machines page provides
Figure 167 USB Devices

configuration to Virtual Machines utilized by your network.

Virtual Machine Detection is on
Remediation checks Auto Remediation

Allow access to clients running on Virtual Machine
Allow access to clients hosting Virtual Machines

Remediation Action for clients hosting Virtual Machines
‘ Mo Action - |

User Notification
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Table 114: Virtual Machines

Parameter Description

Auto Remediation

Enable to allow auto remediation for USB mass storage devices
attached to the endpoint (Automatically stop or eject the drive).

User Notification

Enable to allow user notifications for USB devices policy violations.

Allow access to clients
running on Virtual Machine

Enable to allow clients that running a VM to be accessed and validated.

Allow access to clients hosting
Virtual Machine

Enable to allow clients that hosting a VM to be accessed and validated.

Remediation Action for clients
hosting Virtual Machines

o No Action - Take no action; do not stop or pause virtual machines.
Stop all Virtual Machines running on Host - Stop the VM clients that
are running on Host.

e Pause all Virtual Machines running on Host - Pause the VM clients
that are running on Host.

Network Connections

The Network Connections page provides configuration to control network connections based on connection type.

Figure 168 Network Connections

Network Connections Check is on

Allow Bridge Network Connection

Allow Internet Connection Sharing

Allow Adhoc/Hosted Wireless Networks

Remediation checks Auto Remediation User Notification
O] check for Network Connaction Types

e . Remediation Action For Network
Network Connections Type Network Connections Allowed Connections Not Allowed

Remediation Action for Bridge Network Connection | No Action

Remediation Action for Internet Connection Sharing | No Action

Remediation Action for Adhoc/Hosted Wireless Networks | No Action

Select the Check for Network Connection Types check box, and then click Configure to specify type of connection

that you want to include.

Configure Network Connection Type
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Figure 169 Network Connection Type Configuration

Network Connection Types

Allowed Network Connections Type | Allow Only One Network Connection |Z|

Network Connections Types Network Connections Allowed
Others o -
Wired ==

Wireless

=<

Remediation Action For Network Connection Types Not Allowed ‘ No Action

Table 115: Network Connection Type Configuration Page

Parameter Description

Allow Network Connections Type

Allow Only One Network Connection
Allow One Network Connection with VPN
Allow Multiple Network Connections

User Notification

Enable to allow user notifications for hotfixes check policy
violations.

Network Connection Types

Click the >> or << to add or remove Others, Wired, and Wireless
connection types.

Remediation Action for USB Mass
Storage Devices

o No Action - Take no action; do not eject or disable the attached
devices.

o Disable Network Connections - Disable network connections
for the configured network type.

Click Save when you are finished. This returns you to the Network Connections Configuration page. The remaining

fields on this page are described below.

Table 116: Network Connections Configuration

Parameter Description

Auto Remediation Enable to allow auto remediation for network connections

User Notification Enable to allow user notifications network connection policy violations.

Connection network connections.

Remediation Action for If Allow Bridge Network Connection is disabled, then specify whether to take
Bridge Network no action when a bridge network connection exists or to disable all bridge

Sharing connection sharing.

Remediation Action for If Allow Internet Connection Sharing is disabled, then specify whether to take
Internet Connection no action when Internet connection sharing exists or to disable Internet

Networks adhoc/hosted wireless networks.

Remediation Action for If Allow Adhoc/Hosted Wireless Networks is disabled, then specify whether to
Adhoc/Hosted Wireless | take no action when a adhoc wireless networks exists or to disable all
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ClearPass Windows Universal System Health Validator - OnGuard Agent

The ClearPass Windows Universal System Health Validator - OnGuard Agent page popup appears in response to
actions in the Posture Plugins p of the Posture configuration. (When you select Windows and OnGuard Agent from
the posture policy page)

The OnGuard Agent version of the ClearPass Windows Universal System Health Validator supports all the features
supported by the NAP Agent validator. In addiiton, it also supports Windows Server 2003.

The configuration options and steps described under the ClearPass Windows Universal System Health Validator - NAP
Agent section also apply to the OnGuard Agent.

E Even though the Ul allows auto remediation configuration, the dissolvable OnGuard Agent does not support this feature.

ClearPass Linux Universal System Health Validator - NAP Agent

The ClearPass Linux Universal System Health Validator page popup appears in response to actions in the Posture
Plugins tab of the Posture configuration.

Figure 170 Fig: ClearPass Linux Universal system Health Validator - NAP Agent

Cent05 C Enable chacks for CentOS
Services
Services
Remediation checks Auto Remediation User Notification

Insert Services to run

Available Services

auditd

autofs
avahi-daemon
conman

crond

cups

dovecot

>>
<<
haldaemon s
<<

Services to stop

J»

Fedora [0 httpd
nfslock
Red Hat Enterprise Linux (C ntpd
Delete
SUSE Linux Enterprise (O 4
Desktop
General Configuration
Quarantine Message
|_reset ] |_seve ] concer |

Select a Linux version and click the Enable checks check box for that version.

The Services view appears automatically and provides a set of widgets for specifying specific services to be explicitly
running or stopped for the different Linux versions.

Table 117: Services View

Parameter Description

Auto Enable to allow auto remediation for service checks (Automatically start or stop services
Remediation | based on the entries in Service to run and Service to stop configuration).

User Enable to allow user notifications for service status policy violations.

Notification

Available This scrolling list contains a list of services that you can select and move to the Services
Services to run or Services to stop panels (using their associated widgets).
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Parameter Description

Insert To add a service to the list of selectable services, enter its name in the text box adjacent to
this button, then click Insert.

Delete To remove a service from the list of selectable services, select it and click Delete.

The last option, located on the bottom of the list of Linux versions, is the General Configuration section. This section
contains two pages: Firewall Check and Antivirus Check. Enable the check box in either page display its respective
configuration view:

The configurations done in the General Configuration section apply to all operating systems whose checks have been
turned on.

NOTE
Figure 171 General Configuration Section
Cent0S &) [ antivirus Check
Fedora )
Red Hat Enterprise Linux (+)
SUSE Linux Enterprise {+)
Desktop
General Configuration (=)
| AntiVirus
- Firewall
Select Firewall Check to display a view where you can specify Firewall parameters, specifically with respect to which
ports may be open or blocked.
Figure 172 Firewall view
Firewall Check
Remediation checks Auto Remediation User Notification
TCP ports to open | |
UDP ports to open | |
[T Block all other ports
TCP ports to block | |
UDP ports to block | |
Example: 90,100-200,256,1000-2000
Select Antivirus Check, then click Add in the view that appears to specify Antivirus details.
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Figure 173 Antivirus Check view

Antivirus Check
Select the Antivirus product  AVG Anti-Virus

Product version check Is Latest -
Engine version check Is Latest -
Data file version check Is Latest -

When you save your Antivirus configuration, it appears in the Antivirus page list.

Figure 174 Antivirus Check

Antivirus Check

Remediation checks Auto Remediation User Notification

Product-specific checks (Uncheck to allow any product)

product Prod!u:t Engil:le Dat f!le
Version Version Version
AVG Anti-Virus isLatest isLatest isLatest i
Table 118: Antivirus Check
Interface Parameter Description
Antivirus Add To configure Antivirus application attributes for testing against
Main health data, click Add.
view
Trashcan icon To remove configured Antivirus application attributes from the list,

click the trashcan icon in that row.

Antivirus Product/Version/Last | Configure the specific settings for which to test against health data.
Detail Check These fields all have their obvious meaning (described in the
view ClearPass Windows Universal System Health Validator section).

ClearPass Linux Universal System Health Validator - OnGuard Agent

The ClearPass Linux Universal System Health Validator - OnGuard Agent page popup appears in response to
actions in the Posture Plugins tab of the Posture configuration (When you select Linux and OnGuard Agent from the
posture policy page).

The dissolvable agent version of the ClearPass Linux Universal System Health Validator supports all the features
supported by the "ClearPass Linux Universal System Health Validator - NAP Agent" on page 191 except for the
following:

e Auto-remediation

e Firewall status check and control

ClearPass Mac OS X Universal System Health Validator - OnGuard Agent

The ClearPass Mac OS X Universal System Health Validator page popup appears in response to actions in the
Posture Plugins tab of the Posture configuration.
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Figure 175 ClearPass Mac OS X Universal System Health Validator - OnGuard Agent

NacCS S = [71 Enable checks for Mac 0S X

Antivirus X
X Checks for this version of Mac OS are currently disallowed
AntiSpyware

Firewall

Quarantine Message

e |

Select a check box to enable checks for Mac OS X. Enabling these check boxes displays a corresponding set of
configuration pages:

e In the Antivirus page, you can specify that an Antivirus application must be on and allows drill-down to specify
information about the Antivirus application. Click on An Antivirus Application is On to configure the Antivirus
application information.

Figure 176 Antivirus Page (Overview - Before)

[F An antivirus application is on

When enabled, the Antivirus detail page appears.

Figure 177 Antivirus Page (Detail 1)

An antivirus application is on
Remediation checks Auto Remediation User Notification
Antivirus Prd Version Eng Version Dat Version LastScan Ritp CheckT

Click Add to specify product and version check information.

Figure 178 Antivirus Page (Detail 2)

Product-specific checks {Uncheck to allow any product)
Select the antivirus product  Trend Micro Security for Macintosh -
Product version check Is Latest E
Engine version check Is Latest E
Data file version check Mo Check
Last scan has been done
before 2 Hour(s) E
Real-time Protection Status - . §
(i3] i@ (i3]
Check ' No Check @ on O Off

When you save your Antivirus configuration, it appears in the Antivirus page list. See "ClearPass Windows
Universal System Health Validator - NAP Agent " on page 175 for antivirus page and field descriptions.

e In the Antispyware page, an administrator can specify that an Antispyware application must be on and allows drill-

down to specify information about the Antispyware application.

194

ClearPass Policy Manager 6.1 | User Guide



In the Antispyware page, click An Antispyware Application is On to configure the Antispyware application
information. See Antivirus configuration details above for description of the different configuration elements.

When you save your Antispyware configuration, it appears in the Antispyware page list.

The configuration elements are the same for anti-virus and antispyware products. Refer to the anti-virus
configuration instructions above.

o In the Firewall page, you can specify that a Firewall application must be on and allows drill-down to specify
information about the Firewall application.

In the Firewall page, click A Firewall Application is On to configure the Firewall application information.

When enabled, the Firewall detail page appears. See "ClearPass Windows Universal System Health Validator -
NAP Agent " on page 175 for firewall page and field descriptions.

Windows Security Health Validator - NAP Agent

This validator checks for the presence of specific types of security applications. An administrator can use
the check boxes to restrict access based on the absence of the selected security application types.

Figure 179 Windows Security Health Validator

Windows Security Health Validator °
Windows 8 -) [#IEnable checks for Windows 8
Client computers can connect to your network, subject to the following checks -
Configuration Firewall

Client must have firewall enabled on the client

Virus Protection

Client must have an antivirus application. [T] Check if Antivirus is up to date

[¥ spyware Protection

Client must have an antispyware application. [ check if Antispyware is up to date

[# Automatic Updates

Check if Automatic Updates is enabled on the client

Security Updates

Client must have all available security updates installed: Important and above E

Client must have checked for new security updates within last: |22 hours

Additional sources required in your deployment: [ window Server Update Services

[Tl windows update

Windows 7
Windows Vista

Windows XP

=3

Windows Security Health Validator - OnGuard Agent

This validator checks for the presence of specific types of security applications. An administrator can use
the check boxes to restrict access based on the absence of the selected security application types.

ClearPass Policy Manager 6.1 | User Guide 195



Figure 180 Windows Security Health Validator

Windows Security Health validator L]
Windows 8 ) WEnable checks for windows 8
Client computers can connect to your network, subject to the following checks -
-| Configuration Firewall

Client must have firewall enabled on the client

Virus Protection

Client must have an antivirus application. [T check if Antivirus is up to date
[¥] spyware Protection

Client must have an antispyware application. [Tl check if Antispyware is up to date
[¥] Automatic Updates

Check if Automatic Updates is enabled on the client

Security Updates

Client must have all available security updates installed: Important and above E
Client must have checked for new security updates within last: |22 hours
Additional sources required in your deployment: [Cwindow Server Update Services
[CJwindows Update

‘Windows 7 0
‘Windows Vista 0

‘Windows XP 0

=3

Windows System Health Validator - NAP Agent

This validator checks for current Windows Service Packs. An administrator can use the check boxes to enable support

of specific operating systems and to restrict access based on service pack level.

Figure 181 Windows System Health Validator (Overview)

Windows System Health Validator

Client computers can connect to your network, subject to the following checks -
Windows 8

Windows 8 clients are allowed
[7] Restrict clients which have Service Pack less than

Jie]

Windows 7

Windows 7 clients are allowed
[] Restrict clients which have Service Pack less than

Windows Vista
Windows Vista clients are allowed
[7] Restrict clients which have Service Pack less than

m

Windows XP
Windows XP clients are allowed
[] Restrict clients which have Service Pack less than

Windows Server 2008

Windows Server 2008 clients are allowed M
[7] Restrict clients which have Service Pack less than

Windows Server 2008 R2
Windows Server 2008 R2 clients are allowed [

=3 [

Windows System Health Validator - OnGuard Agent

This validator checks for current Windows Service Packs. The OnGuard Agent also supports legacy Windows
operating systems such as Windows 2000 and Windows Server 2003. An administrator can use the check boxes to
enable support of specific operating systems and to restrict access based on service pack level.
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Figure 182 Windows System Health Validator - OnGuard Agent (Overview)

‘Windows System Health Validator

Client computers can connect to your network, subject to the following checks -
Windows 8 o

Windows 8 clients are allowed
[] Restrict clients which have Service Pack less than

Windows 7
Windows 7 clients are allowed
[7] Restrict clients which have Service Pack less than

Windows Vista

Windows Vista clients are allowed
[] Restrict clients which have Service Pack less than

m

Windows XP
Windows XP clients are allowed
[7] Restrict clients which have Service Pack less than

Windows Server 2008 W

Windows Server 2008 clients are allowed
[] Restrict clients which have Service Pack less than

Windows Server 2008 R2
Windows Server 2008 R2 clients are allowed S

et

Policy Manager can forward all or part of the posture data received from the client to Posture Servers. The Posture
Server evaluates the posture data and returns Application Posture Tokens.

From the Services page (Configuration > Service), you can configure a posture server for a new service (as part of the
flow of the Add Service wizard), or modify an existing posture server directly (Configuration > Posture > Posture
Servers, then click on its name in the Posture Servers listing).

Figure 183 Posture Servers Listing Page

Configuration » Posture » Posture Servers

Posture Servers % Add Posture Server
& Import Posture Servers
& Export Posture Servers

Filter:| Server Type [=] contains = Show [10 [7] records
# [ Namea Description Server Type Default State
1 ‘D Avenda CCA CAM Cisco Clean Access Manager GAMEV2 server Cisco CCA UNKNOWN
2|0 ps_wes NAP Posture Server Microsoft NPS UNKNOWN
Showing 1-2 of 2 [Copy | [Export] [ Detete

When you click Add Posture Server from any of these locations, Policy Manager displays the Posture Servers
configuration page.

Figure 184 Add Posture Server Page

Configuration » Posture » Posture Servers » Add

Posture Servers

Primary Server Backup Server Summary

Name:
Description:
P
Server Type: @ Microsoft NPS
Default Posture Token: UNKNOWN (100) |Z|

4 _Back to Posture Servers

Depending on the Protocol and Requested Credentials, different tabs and fields appear. Refer to "Microsoft NPS " on
page 197.

Microsoft NPS

Use the Microsoft NPS server when you want Policy Manager to have health - NAP Statement of Health (SoH)
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credentials - evaluated by the Microsoft NPS Server.

Table 119: Microsoft NPSSettings (Posture Server tab)

Parameter Description

Name/Description Freeform label and description.

Server Type

Always Microsoft NPS.

Token

Default Posture

failure. Select a status from the drop-down list.

Posture token assigned if the server is unreachable or if there is a posture check

Figure 185 Microsoft NPS Settings (Primary and Backup Server tabs)

Posture Server

Backup Server Summary

RADIUS Server Name: [ |

Shared Secret:

Timeout:

RADIUS Server Port: [ J(defaultis 1812)
Shared Secret: [ | Verify:
Timeout: seconds
Posture Server Primary Server
RADIUS Server Backup: [C] Enable to use backup when primary does not respond

RADIUS Server Name: [ |

RADIUS Server Port: [ l(defaultis 1812)

[ | Verify:
| |

seconds

( Back to Posture Servers

Table 120: Microsoft NPS Settings (Primary and Backup Server tabs)

Parameter  Description

RADIUS Hostname or IP address and RADIUS server UDP port

Server

Name/Port

Shared Enter the shared secret for RADIUS message exchange; the same secret has to be

Secret entered on the RADIUS server (Microsoft NPS) side

Timeout How many seconds to wait before deeming the connection dead; if a backup is
configured, Policy Manager will attempt to connect to the backup server after this timeout.
For the backup server to be invoked on primary server failover, check the Enable to use
backup when primary does not respond check box.
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Chapter 16

Audit Servers

Audit Servers evaluate posture and/or role for unmanaged or unmanageable clients; that is, clients that lack an
adequate posture agent or 802.1X supplicant (for example, printers, PDAs, or guest users may not be able to send
posture credentials or identify themselves.) A Policy Manager Service can trigger an audit by sending a client ID to a
pre-configured Audit Server, which retumns attributes for role mapping and posture evaluation.

Architecture and Flow

Audit servers are configured at a global level. Only one audit server may be associated with a Service. The flow-of-
control of the audit process occurs as follows:

Figure 186 Flow of Control of Policy Manager Auditing
AUdit (Folic_!.r Manager Service sends client address to .Hudit)

Server configured with Service-specific Scan Profile

L

Audit Server assigns "In Progress” posture status and
imvokes the Audit, scanning for health and identity
attributes and applying post-audit rules to infer identity

A i Progress” intervals, Policy Manager
e plls the Aucit Server for redurned Posfure
Tokens andior Rioles

Fualicy Manager triggers a re- M

authentication on the switch,

Audit finished?

Yes

Configured for re-authentication?

Mo

v

Policy Manager passes Posiure Tokens andior Roles fo the
Sarvica-spacific Enforcemant Policy to be cached for use

Refer to "Configuring Audit Servers" on page 199for additional information.

Configuring Audit Servers

The Policy Manager server contains built-in Nessus (version 2.X) and NMAP servers. For enterprises with existing
audit server infrastructure, or otherwise preferring external audit servers, Policy Manager supports these servers
externally.
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This section contains the following topics:

e "Built-In Audit Servers" on page 200
e "Custom Audit Servers" on page 202

e '"Nessus Scan Profiles" on page 205

Built-In Audit Servers

When configuring an audit as part of an Policy Manager Service, you can select the default Nessus (/Nessus Server]) or
NMAP (/Nmap Audit]) configuration.

Adding Auditing to a Policy Manager Service
1. Navigate to the Audit tab

o To configure an audit server for a new service (as part of the flow of the Add Service wizard), navigate to
Configuration > Services. Select the Add Services link. In the Add Services form, select the Audit tab.

You must select the Audit End-hosts check box on the Services tab in order for the Audit tab to display.

HOTE
o To modify an existing audit server, navigate to Configuration > Posture > Audit Servers, then select an audit
server from the list.
2. Configure auditing
Complete the fields in the Audit tab as follows:
Figure 187 Audit Tab
Configuration » Services » Add
Services
Service Authentication Roles Enforcement Summary
Audit Server: ~Select- |T| View Details Modify ‘ Add new Audit Server
Audit Trigger Conditions: Always
© when posture is not available
© For MAC authentication request
Action after audit: ° No Action
-C:I‘ Do SNMP bounce
© Trigger RADIUS CoA action
( Back to Services
Table 121: Audit Tab

Parameter Description

Audit Select a built-in server profile from the list:

Server/Add e The [Nessus Server]performs vulnerability scanning. It returns a Healthy/Quarantine

new Audit result.

Server o The [Nmap Audit] performs network port scans. The health evaluation always returns
Healthy. The port scan gathers attributes that allow determination of Role(s) through
post-audit rules.

NOTE: For Policy Manager to trigger an audit on an end-host, it needs to get the IP
address of this end-host. The IP address of the end-host is not available at the time of
initial authentication, in the case of 802.1X and MAC authentication requests. Policy
Manager has a built-in DHCP snooping service that can examine DHCP request and
response packets to derive the IP address of the end-host. For this to work, you need to
use this service, Policy Manager must be configured as a DHCP “IP Helper” on your
router/switch (in addition to your main DHCP server). Refer to your switch documentation
for “IP Helper” configuration.
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Parameter Description

To audit devices that have a static IP addresss assigned, itis recommended that a static
binding between the MAC and IP address of the endpoint be created in your DHCP
server. Refer to your DHCP Server documentation for configuring such static bindings.
Note that Policy Manager does notissue IP address; it just examines the DHCP traffic in
order to derive the IP address of the end-host.

Audit o Always: Always perform an audit
Trigger o When posture is not available: Perform audit only when posture credentials are not
Conditions available in the request.

e For MAC Authentication Request, If you select this option, then Policy Manager

presents three additional settings:

= Forknown end-hosts only. For example, when you want to reject unknown end-
hosts, but audit known clients for. Known end-hosts are defined as those clients
that are found in the authentication source(s) associated with this service.

= Forunknown end-hosts only. For example, when known end-hosts are assumed to
be healthy, but you want to establish the identity of unknown end-hosts and assign
roles. Unknown end-hosts are those end-hosts that are not found in any of the
authentication sources associated with this service.

= Forall end-hosts. For both known and unknown end-hosts.

Re- Check the check box for Force re-authentication of the client after audit to bounce the
authenticate | switch port or to force an 802.1X reauthentication (both done via SNMP).
client NOTE: Bouncing the port triggers a new 802.1X/MAC authentication request by the client.

If the audit server already has the posture token and attributes associated with this clientin
its cache, it returns the token and the attributes to Policy Manager.

Modifying Built-In Audit Servers
To reconfigure a default Policy Manager Audit Servers:
1. Open the audit server profile.

Navigate to Configuration > Posture > Audit Servers, then select an Audit Server from the list of available
servers.

Figure 188 Audit Servers Listing

Configuration » Posture » Audit Servers
Audit Servers “ Add Audit Server

& Import Audit Servers
& Export Audit Servers

Filter:[ Name [Z]contains B shov [0 [7] records

# [ Namea Description

Type
1|0 extema

Server (Sample) NESSUS

2|0 [Nessu

3|0 [Nmap Audit] Nmap default configuration NMAP

Showing 1-3 of 3 Copy | [Export | Delete

Nessus server running in the Policy Manager server NESSUS

2. Modify the profile, plugins, and/or preferences.
o In the Audit tab, you can modify the In Progress Posture Status and Default Posture Status.

e Ifyou selected a NESSUS Server, then the Primary/Backup Server tabs allow you to specify a scan profile. In
addition, when you add a new scan profile, you can select plugins and preferences for the profile. Refer to
"Nessus Scan Profiles" on page 205 for more information.

The built-in Policy Manager Nessus Audit Server ships with approximately 1000 of the most commonly used
Nessus plugins. You can download others from http://www.tenablesecurity.com, in the form all-2.0.tar.gz. To
upload them to the built-in Policy Manager Audit Server, navigate to Administration > Server Manager >
Server Configuration, select Upload Nessus Plugins, and then select the downloaded file.
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Figure 189 Upload Nessus Plugins Popup

Import from file

Select File:

Enter secret for the file (if any):

[impor ] conel |

o In the Rules tab, you can create post-audit rules for determining Role based on identity attributes discovered by
the audit. Refer to Post-Audit Rules.

Custom Audit Servers

For enterprises with existing audit server infrastructure, or otherwise preferring custom audit servers, Policy Manager
supports NESSUS (2.x and 3.x) (and NMAP scans using the NMAP plugin on these external Nessus Servers).

To configure a custom Audit Server:
1. Open the Audit page.

o To configure an audit server for a new service (as part of the flow of the Add Service wizard), navigate to
Configuration > Posture > Audit Servers, then click Add Audit Server.

o To modify an existing audit server, navigate to Configuration > Posture > Audit Server, and select an audit
server.

2. Add a custom audit server

When you click Add Audit Server, Policy Manager displays the Add Audit Server page. Configuration settings
vary depending on audit server type:

m  "NESSUS Audit Server" on page 202
= "NMAP Audit Server" on page 203

NESSUS Audit Server

Policy Manager uses the NESSUS Audit Server interface primarily to perform vulnerability scanning. It returns a
Healthy/Quarantine result.

The Audit tab identifies the server and defines configuration details.

Figure 190 NESSUS Audit Server (Audit Tab)

Configuration » Posture » Audit Servers » Add

Audit Servers

Primary Server Backup Server Rules Summary

Name: extern-nessus.acme.com
Description: External NEssus 3.0 served
Type: © NMAP @ NESSUS

In-Progress Posture Status: | TRANSITION (15)

-

Default Posture Status: UNKNOWN (100) -
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Table 122: NESSUS Audit Server (Audit tab)

Parameter Description

Name/Description Freeform label and description.

Type For purposes of an NESSUS-type Audit Server, always NESSUS.

In Progress Posture | Posture status during audit. Select a status from the drop-down list.

Status
Default Posture Posture status if evaluation does not return a condition/action match. Select a
Status status from the drop-down list.

The Primary Server and Backup Server tabs specify connection information for the NESSUS audit server.

Figure 191 Fig: NESSUS Audit Server (Primary & Backup Tabs)

Audit Backup Server Rules Summary
Nessus Server Name: |ex1.em-ﬂessus.acme.com |
Messus Server Port: (default is 1241)
Username: |adm|n |
Password: |eensene | Verify: [esseses |
Scan Profile: [ default - I Tl 2 d/Edit Scan Profile
In-Progress Timeout: E seconds
Audit Primary Server Rules Summary
Backup: Enable to use backup when primary does not respond
Nessus Server Name: | exterm-nessus-backup.acme conl
Messus Server Port: (default is 1241)
Username: |admin |
Password: [sensese | Verify: [esseses |
Scan Profile: [ default - I Tl 2 d/Edit Scan Profile
In-Progress Timeout: E seconds
4 Back to Audit Servers

Table 123: NESSUS Audit Server - Primary and Backup Server tabs

Parameter Description

Server Name and Standard NESSUS server configuration fields.

Port/ Username/ NOTE: For the backup server to be invoked on primary server failover, check the

Password Enable to use backup when primary does not respond check box.

Scan Profile You can accept the default Scan Profile or select Add/Edit Scan Profile to create
other profiles and add them to the Scan Profile list. Refer to "Nessus Scan Profiles”
on page 205.

The Rules tab provides specifies rules for post-audit evaluation of the request to assign a role. Refer to "Post-Audit
Rules" on page 207.

NMAP Audit Server

Policy Manager uses the NMAP Audit Server interface exclusively for network port scans. The health evaluation
always returns Healthy. The port scan gathers attributes that allow determination of Role(s) through post-audit rules.
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The Audit tab labels the Server and defines configuration details.

Figure 192 Audit Tab (NMAP)

Audit Servers

Se—

Configuration » Posture » Audit Servers » Add

Rules Summary

Name:

Description:

Type:
In-Progress Posture Status:

Default Posture Status:

( Back to Audit Servers

| Custom NMAP Profile |

Customized NMAP profile for custom port
scansg|

® NMAP O NESSUS

| TRANSITION (15) -

| UNKNOWN (100) -

Next = Save J Cancel

Table 124: Audit Tab (NMAP)

Parameter Description

Name/Description

Freeform label and description.

Type

For purposes of an NMAP-type Audit Server, always NMAP.

In Progress Posture
Status

Posture status during audit. Select a status from the drop-down list.

Default Posture
Status

Posture status if evaluation does not return a condition/action match. Select a
status from the drop-down list.

The NMAP Options tab

specifies scan configuration.

Figure 193 Options Tab (NMAP)

Audit Servers

Configuration » Posture » Audit Servers » Add

( Back to Audit Servers

R
TCP Scan: iNone hd
TCP S¥N scan
TCP Connectscan
TCP Null scan
TCP FIN scan
TCP Xmas scan
TCP ACK scan
TCP Window scan
TCP Maimon scan
UDP Scan: [71 Enabled
Service Scan: [C] Enabled
Detect Host Operating System: [C] Enabled
Port Range: [
Host Timeout: E seconds
In-Progress Timeout: E seconds
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Table 125: Options Tab (NMAP)

Parameter Description

TCP Scan To specify a TCP scan, select from the TCP Scan drop-down list. Refer to NMAP
documentation for more information on these options. NMAP option --scanflags.

UDP Scan To enable, check the UDP Scan check box. NMAP option -sU.

Service Scan To enable, check the Service Scan check box. NMAP option -sV.

Detect Host Operating | To enable, check the Detect Host Operating System check box. NMAP option -

System A.

Port Range/ Host Port Range - Range of ports to scan. NMAP option -p.

Timeout/ In Progress e Host Timeout - Give up on target host after this long. NMAP option --host-
Timeout timeout

In Progress Timeout - How long to wait before polling for NMAP results.

The Rules tab provides specifies rules for post-audit evaluation of the request to assign a role. Refer to "Post-Audit

Rules" on page 207.

Nessus Scan Profiles

A scan profile contains a set of scripts (plugins) that perform specific audit functions. To Add/Edit Scan Profiles, select
Add/Edit Scan Profile (link) from the Primary Server tab of the Nessus Audit Server configuration. The Nessus Scan
Profile Configuration page displays.

Figure 194 Nessus Scan Profile Configuration Page

Configuration » Posture » Audit Servers » Nessus Scan Profile Configuration - default

Nessus Scan Profile Configuration - default Refresh Plugins List

m Selected Plugins Preferences

Select Profile: default

New Profile Name: default

Available Plugins:

@ Filter plugins by family: i-Select- 1

(O Filter plugins by ID or name:

Go Clear

[ xd Plugin Name

< Back to Audit Servers

Delete | Copy

You can refresh the plugins list (after uploading plugins into Policy Manager, or after refreshing the plugins on your
external Nessus server) by clicking Refresh Plugins List. The Nessus Scan Profile Configuration page provides three
views for scan profile configuration:

e The Profile tab identifies the profile and provides a mechanism for selection of plugins:

= From the Filter plugins by family drop-down list, select a family to display all available member plugins in the
list below. You may also enter the name of a plugin in Filter plugins by ID or name text box.

= Select one or more plugins by enabling their corresponding check boxes (at left). Policy Manager will remember
selections as you select other plugins from other plugin families.

=  When finished, click the Selected Plugins tab.
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Figure 195 Nessus Scan Profile Configuration (Profile Tab)

Profile Selected Plugins Preferences
Select Profile: default - =
New Profile Name: default
Available Plugins:
@ Filter plugins by family: Windows (35) -
([ Filter plugins by ID or name: Go  Clear =

[ 1d Plugin Name
O

10006 pcAnywhere

=]

[¥]| 10144 Microsoft SQL TCP/IP listener is running

[[]| 10642 SMB Registry : SQL7 Patches

[F1| 10672 Microsoft's SQL Blank Password

[[]| 10674 Microsoft's SQL UDP Info Query

[T]| 10761 Detect CIS ports

[7]| 10763 Detect the HTTP RPC endpoint mapper
[[]| 10794 pcAnywhare TCP

[F1| 10829 scan for UPNP hosts

[F1| 10862 Microsoft's SQL Server Brute Force

[F1| 11067 Microsoft's SQL Hello Overflow

O

11119 SMB Registry : XP Service Pack version

<

[¥]| 11882 AOL Instant Messenger is Installed

<

[¥]| 11882 Gator/GAIN Spyware Installed

4 Back to Audit Servers

Delete | Copy

o The Selected Plugins tab displays all selected plugins, plus any dependencies.

To display a synopsis of any listed plugin, click on its row.

Figure 196 Nessus Scan Profile Configuration (Profile Tab) - Plugin Synopsis

Profile Selected Plugins Preferences

>

New Profile Name: default

Available Plugins:

m

@ Filter plugins by family: Windows (35) -

O Filter plugins by ID or name: Go Clear

[ 1d Plugin Name
|:|| 10006 pcAnywhere

Microsoft's SQL Server Brute Force (10862) o

The SQL Server has a common password for one or nore accounts.
These accounts may be used to gain access to the records in
the database or even allow remote command execution.

Solution: Pleasze =et a difficult to gusss password for these accounts.

Ri=k factor : High

Close

140 o =1

<« Back to Audit Servers

Delete | Copy

Select Profile: default hd I

Of special interest is the secton of the synopsis entitled Risks. To delete any listed plugin, click on its corresponding
trashcan icon. To change the vulnerability level of any listed plugin click on the link to change the level to one of HOLE,
WARN, INFO, NOTE. This tells Policy Manager the vulnerability level that is considered to be assigned QUARANTINE

status.
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Figure 197 Nessus Scan Profile Configuration (Selected Plugins Tab)

Profile Preferences
The list of selected plugins and their dependencies - Clear all selected plugins
Id Name Family Vulnerability Level w
1.|10132 Kuang2 the Virus Backdoors HOLE i
2.|10330 Services Service detection HOLE b
3.|14259 Nmap (NASL wrapper) Port scanners HOLE o

“. Back to Audit Servers Delete | Copy m

Figure 198 Nessus Scan Profile Configuration (Selected Plugins Tab) - Vulnerability Level

The list of selected plugins and their dependencies - Clear all selected plugins
Id Name Family Vulnerability Level i

-
1./10132 Kuang2 the Virus Backdoors mé‘gN j

| NOTE -

For each selected plugin, the Preferences tab contains a list of fields that require entries.

In many cases, these fields will be pre-populated. In other cases, you must provide information required for the
operation of the plugin.

By way of example of how plugins use this information, consider a plugin that must access a particular service, in
order to determine some aspect of the client’s status; in such cases, login information might be among the preference
fields.

Figure 199 Nessus Scan Profile Configuration (Preferences Tab)

Profile Selected Plugins

Select Plugin: ‘Services [

Specify preferences for the selected plugin -
Number of connections done in parallel :

6
Network connection timeout : 5
Network read/write timeout : 5

2

Wrapped service read timeout :

SSL certificate :
SSL private key :

PEM password :

ch fe

Test SSL based services Known SS5L ports -

4. Back to Audit Servers Delete | Copy

Upon saving the profile, plugin, and preference information for your new (or modified) plugin, you can go to the
Primary/Backup Servers tabs and select it from the Scan Profile drop-down list.

Post-Audit Rules

The Rules tab specifies rules for post-audit evaluation of the request to assign a role.
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Figure 200 A/l Audit Server Configurations (Rules Tab)

Summary Audit Primary Server Backup Server m

Rules Evaluation Algorithm: © Select first match @ Select all matches

Post-Audit Rules:

Conditions Role Name
Add Rule Move Up Move Down Edit Rule | Remove Rule |

( Back to Audit Servers Copy

Table 126: All Audit Server Configurations (Rules Tab)

Parameter Description

Rules Evaluation Select first matched rule and return the role or Select all matched rules and
Algorithm eturn a set of roles.

Add Rule Add a rule. Brings up the rules editor. See below.

Move Up/Down Reorder the rules.

Edit Rule Brings up the selected rule in edit mode.

Remove Rule Remove the selected rule.

Figure 201 A/l Audit Server Configurations (Rules Editor)

Rules Editor o

Matches @ ANY or © ALL of the following conditions:
| Name Operator Value i |
1.|0S-Info CONTAINS Linux i
2| =] ® ®
3 || Audit-Status
L Device-Type
Metwork-Apps
RO Mac-Vendor {CACS Help Desk] |Z|
05-Info

Table 127: All Audit Server Configurations (Rules Editor)

Parameter Description

Conditions The Conditions list includes five dictionaries: Audit-Status, Device-Type, Output-Msgs,
Mac-Vendor, Network-Apps, Open-Ports, and OS-Info.. Refer to "Namespaces" on page
329.

Actions The Actions list includes the names of the roles configured in Policy Manager.

Save To commit a Condition/Action pairing, click Save.
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NOTE

Chapter 17

Enforcement

Policy Manager controls network access by sending a set of access-control attributes to the request-originating
Network Access Device (NAD).

Policy Manager sends these attributes by evaluating an Enfocement Policy associated with the service. The evaluation
of Enforcement Policy results in one or more Enforcement Profiles; each Enforcement Profile wraps the access control
attributes sent to the Network Access Device. For example, for RADIUS requests, commonly used Enforcement Profiles
include attributes for VLAN, Filter ID, Downloadable ACL and Proxy ACL.

Enforcement Architecture and Flow

To evaluate a request, a Policy Manager Application assembles the request’s client roles, client posture (system posture
token), and system time. The calculation that matches these components to a pre-defined Enforcement Profile occurs
inside of a black box called an Enforcement Policy.

Each Enforcement Policy contains a rule or set of rules for matching Conditions (role, posture and time) to Actions
(Enforcement Profiles). For each request, it yields one or more matches, in the form of Enforcement Profiles, from which
Policy Manager assembles access-control attributes for return to the originating NAD, subject to the following
disambiguation rules:

e If an attribute occurs only once within an Enforcement Profile, transmit as is.

e If an attribute occurs multiple times within the same Enforcement Profile, transmit as a multi-valued attribute.

e If an attribute occurs in more than one Enforcement Profile, only transmit the value from the first Enforcement
Profile in priority order.

Optionally, each Enforcement Profile can have an associated group of NADs; when this occurs, Enforcement Profiles
are only sentif the request is received from one of the NADs in the group. For example, you can have the same rule for
VPN, LAN and WLAN access, with enforcement profiles associated with device groups for each type of access. Ifa
device group is not associated with the enforcement profile, attributes in that profile are sent regardless of where the
request originated.
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Figure 202 Flow of Control of Policy Manager Enforcement

Inpeet:

Enforcement Rolas
Y
Tt Policy Manager applies Enforcement Policy Inpt: Systsm
System {(maps role, posture and time inputs to Erforcement = Posrr.r..'s}?cikan

Time Profile)
Paoficy Mansger tssts the rofe, system health
foken. and system time sgainsl a izf of
enfareameant rules; first matching ruie or aif
rufes are fested,

Enforcament Rule
Mo match{es)?
match(ss) Watchies)
Policy Manager ai:."?:’:;:ﬁ
assigns the defaulf EEln reement 9
Enforcement Prafile Proflles

Profifes senfasa

Jist of altibotes: if h
mare than one . '
Enforcement Frofile Paolicy Manager sands Enforcament Profiles

appiles, refer to the < for the session to the switch
digambigianion
ruies in the

praceding section.

You configure Policy Manager Enforcement Profiles globally, but they must be referenced in an enforcement policy
that is associated with a Service to be evaluate,

From the Enforcement Policies page (Configuration > Enforcement > Policies), you can configure an Enforcement
Profile for a new enforcement policy (as part of the flow of the Add Enforcement Policy wizard), or modify an
existing Enforcement Profile directly (Configuration > Enforcement > Profiles, then click on its name in the
Enforcement Profile listing).

Figure 203 Enforcement Profiles Page

Configuration » Enforcement » Profiles
Enforcement Profiles < Add Enforcement Profile
2 Import Enforcement Profiles
& Export Enforcement Profiles

Filter: Type ~ contains ] Show 10~ records
# [ Namea Type Description

1.| O  Access Switches Control TACACS TACACS+ Enforcement Profile for Access Switches

2.|[F]  AirGroup Device Owner RADIUS RADIUS attributes returned for all valid AirGroup requests

3.| [l AirGroup Location Sharing RADIUS RADIUS attributes returned for devices shared by location name
4. [0 AirGroup Respanse RADIUS RADIUS attributes returned for empty AirGroup respanses

5.| [l AirGroup Role Sharing RADIUS RADIUS attributes returned for devices shared by role name

6.| [l AirGroup User Sharing RADIUS RADIUS attributes returned for devices shared with other users
7.| ] [Allow Access Profile] RADIUS System-defined profile to allow network access

s8.|[F]  Allow All Commands TACACS Allow all commands on the device

9.0 ArubaGuest RADIUS
10.| ] [Aruba Terminate Session] RADIUS_CoA  System-defined profile to disconnect user (Aruba)

Showing 1-10 of 68 B> B

Policy Manager comes pre-packaged with the following system-defined enforcement profiles:

o [Allow Access Profile]. System-defined RADIUS profile to allow network access; Policy Manager sends a RADIUS
AccessAccept message with no attributes.
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[Deny Access Profile]. System-defined RADIUS profile to deny network access; Policy Manager sends a RADIUS
AccessReject message with no attributes.

[Drop Access Profile]. System-defined profile to drop the network access request; Policy Manager silently drops
the RADIUS AccessRequest message.

[TACACS Deny Profile]. System-defined TACACS+ profile to deny network device access through the TACACS+
protocol.

There are several system-defined profiles associated with different vendors’ RADIUS CoA actions.
[Cisco - Terminate Session] - Terminate a session on a Cisco device.
[Cisco - Disable-Host-Port] - Disable a port on a Cisco Ethernet switching device.
[Cisco - Bounce-Host-Port] - Perform link-up/link-down action on a Cisco Ethernet switching device.
[Cisco - Reuthenticate-Session] - Trigger a session reauthentication on a Cisco device.
[HP - Terminate Session] - Terminate a session on an HP device.
[Aruba - Terminate Session] - Terminate a session on an Aruba Wireless Controller.

There are four built-in TACACS+ profiles that are mapped to the different administrator roles available in Policy
Manager. These profiles can be used to give permissions to log into the Policy Manager UL

[TACACS Help Desk]. System-defined profile to allow administrative access to Policy Manager using the
Helpdesk role.

[TACACS Network Admin]. System-defined profile to allow administrative access to Policy Manager using the
Network Administrator role.

[TACACS Receptionist]. System-defined profile to allow administrative access to Policy Manager using the
Receptionist role.

[TACACS Super Admin]. System-defined profile to allow administrative access to Policy Manager using the
Super Administrator role.

From the Enforcement Profile page, when you click Add Enforcement Profile, Policy Manager displays the Add
Enforcement Profile page:

Figure 204 Add Enforcement Profile Page

Configuration » Enforcement » Profiles » Add Enforcement Profile

Enforcement Profiles

m Attributes Summary

Template: Aruba RADIUS Enforcement [=]
Aruba RADIUS Enforcement

Aruba Downloadable Role Enforcement

Name:

Description: VLAN Enforcement

Filter ID Based Enforcement

RADIUS Based Enforcement

RADIUS Change of Authorization (CoA)
Type: | Agent Enforcement

. SNMP Based Enforcement
Action CLI Based Enforcement
Device Group List: TACACS+ Based Enforcement

Cisco Downloadable ACL Enforcement

Cisco Web Authentication Enforcement View Details
ClearPass Insight Enforcement Modity
Genenc Application Enforcement
ClearPass Entity Updale Enforcement
Session Restrictions Enforcement

Back to Enforcement Profiles m m

Policy Manager comes pre-packaged with several enforcement profile templates:

VLAN Enforcement - All RADIUS attributes for VLAN enforcement are pre-filled in this template.

Aruba RADIUS Enforcement - RADIUS tempate that can be filled with attributes from the Aruba RADIUS
dictionaries loaded into Policy Manager.
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Aruba Downloadable Role Enforcement - RADIUS template that can be filled with role attributes to create roles
that can be assigned to users after successful authentication.

Filter ID Based Enforcement - All RADIUS attributes for filter-id based enforcement are pre-filled in this template.
RADIUS Based Enforcement - Generic RADIUS tempate that can be filled with any attribute from the RADIUS
vendor dictionaries loaded into Policy Manager.

RADIUS Change of Authorization (CoA) - Enforcement profile that encapsulates CoA actions sent to the network
device. Note that the system comes pre-packaged with default Enforcement Profiles for “Disconnect” (Terminate
Session) actions for the different supported vendor devices; there is no need to create profiles for these actions.

TACACS+ Based Enforcement - TACACS+ based enforcement profile with UI customized for TACACS+ service &
command authorization.

SNMP Based Enforcement - Generic SNMP based enforcement profile with SNMP dictionaries for VLAN steering
and Reset Connection.

Cisco Downloadable ACL Enforcement - RADIUS based enforcement profile with UI customized for Cisco
Downloadable ACL Enforcement.

Cisco Web Authentication Enforcement - RADIUS based enforcement profile with pre-loaded attributes for
enforcement for Cisco switch-hosted web authentication.

Aruba GuestConnect Enforcement - Application specific enforcement profile with pre-loaded attributes for
authorization of GuestConnect users.

Aruba Insight Enforcement - Application specific enforcement profile with pre-loaded attributes for authorization of
Insight users.

Generic Application Enforcement - Application specific enforcement profile with customization attribute-value
pairs for authorization of generic applications.

CLI Based Enforcement - Enforcement profile that encapsulates CLI commands to be issued to the network device.
The “Target Device” attribute specifies the device on which the “Command” attribute is executed.

Agent Enforcement - Enforcement profile that encapsulates attributes sent to Aruba OnGuard agent. Attributes can
be specified to bounce the client or to send a custom message to the client.

ClearPass Entity Update Enforcement - Post-authentication enforcement profile that can be filled with attributes to
update the tag entries in endpoints and guest users.

Session Restrictions Enforcement - Post-authentication enforcement profile that can be filled with attributes to

restrict users based on various factors such as bandwidth usage, active session count, and also terminate sessions
when the limits are reached.

Table 128: Add Enforcement Profile page

Parameter Description

Name/ Freeform label for enforcement profile.
Description
Type Auto-filled based on the selected template: RADIUS, TACACS, SNMP, Application,
RADIUS_CoA
Action Relevant only for RADIUS type enforcement profiles. Accept, Deny or Drop the request.
Device Associate the profile with pre-configured Device Groups.
Group List e Add New Device Group to add a new device group.
o Add to add a device group from this drop-down list.
o Remove, View Details, Modify to remove, view the details of, or modify the selected
enforcement profile, respectively
NOTE: This feature does not work with RADIUS CoA type Enforcement Profiles.
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The remaining Enforcement Profile tabs vary in content, depending on the Template Type (auto-specified in the Type
field when a Template has been selected):

"RADIUS Enforcement Profiles " on page 213

"RADIUS CoA Enforcement Profiles" on page 215

"SNMP Enforcement Profiles " on page 216
"TACACS+ Enforcement Profiles " on page 216

"Application Enforcement Profiles " on page 218

"CLI Enforcement Profile " on page 219

"Agent Enforcement Profiles " on page 219

Post Authentication Enforcement Profiles

RADIUS Enforcement Profiles

RADIUS Enforcement Profiles contain name/value pairings of attributes from the RADIUS dictionaries; in this editing

context, Policy Manager displays only those attributes marked in the dictionary with the OUT or INOUT qualifier.

The following figures illustrate rules for several sample profiles:

A - VLAN Enforcement; B - Filter ID Based Enforcement; C - Cisco Downloadable ACL Enforcement; D - Cisco We

Authentication Enforcement; E - Generic RADIUS Enforcement; F - Aruba Downloadable Role Enforcement

Figure 205 RADIUS Enforcement Profile (Attributes Tab)

Profile Attributes Summary

Type Name Value i
1.|Radius:IETF Session-Timeout = 3600 o
2.|Radius:IETF Termination- Action = RADIUS-Request (1) i
3.|Radius:IETF Tunnel-Type = VLAN (13) i
4.|Radius:IETF Tunnel-Medium-Type = IEEE-802 (6) i
5.|Radius:IETF Tunnel-Private-Group-Id = Enter VLAN o
6.[Click to add...

Type Name Value
1.|Radius:IETF Filter-1d = Enter Filter Name i
2.|Click to add...

Type Name Value b

permit ip any any|
1. ‘Radius:cwscn |" |Ci5co-IP-DownIoadabIe-a \'| = [ @
2.|Click to add...

Type Name Value b
1.|Radius:Cisco Cisco-AVPair = priv-lvi=15 fid
2.|Radius:Cisco Cisco-AVPair = proxyacl# 10=permit ip any any m
3.|Click to add...

4« Back to Enforcement Profiles
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Figure 206 RADIUS Enforcement Profile (Attributes Tab) - Generic RADIUS Enforcement Profile

Type Value
1_”Radiu5:IErF "l |User7Name| "l | |'| [ @
RadiusIETF User-Name %{Autherization:Avenda AD:countryCede}
Radius:Clavister Service-Type %{Authorization:Avenda AD:department}
Radius:Cisce-VPN3000 Framed-Protocol Fe{Autharization:Avenda AD:distinguishedMame}
Radius:Acc Framed-1P-Address % Autherization:Avenda AD:memberQf}
Radius:Tropos Framed-1P-Netmask % Autherization:Avenda AD:msNPAllowDialin}
Radius:Cisco Framed-Routing Fe{Authorization:Avenda AD:name}
Radius:ERX Filter-Id %[Authorization:Avenda AD:title}
Radius:CableLabs Framed-MTU %[Authorization: Test RSA Token ServerETF.Class} E
Radius:Mikrotik Framed-Compression %{Authorization:Test RSA Token ServerETF Service-Type}
Radius:Cosine Login-IP-Host
Radius:JRadius Login-Service
Radius:Cisco-BBSM Login-TCP-Port
RadiusBinTec Reply-Message
Radius:Ascend Callback-Number
Radius:Roaring-Penguin Callback-1d
More choices More choices
2.‘C\|ck to add...
( Back to Enforcement Profiles

Figure 207 Aruba Downloadable Role Enforcement

Profile Attributes Summary

Type Name value it

ip access-list stateless denyping
any any svc-icmp deny
'

1.|Radius: Aruba Aruba-CPPM-Role user-role cppm1 % v
access-list stateless denyping
!

2.|Click to add...

(, Back to Enforcement Profiles

I T

Table 129: RADIUS Enforcement Profile (Attributes tab)

Enforcement
Profile Description

Template

A—-VLAN
Enforcement

Enforcement profile template to set IETF RADIUS standard VLAN attributes.

B—Filter ID
Based
Enforcement

Enforcement profile template to set IETF RADIUS standard filter ID attribute.

Downloadable
ACL
Enforcement

C—Cisco Enforcement profile template for Cisco I0S downloadable ACLs.
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Enforcement
Profile

Template

Description

D—Cisco Web Enforcement profile template to set Cisco Web Authentication ACLs.
Authentication
Enforcement
E—(Generic) Type is any RADIUS vendor dictionary that is pre-packaged with Policy Manager, or
RADIUS- imported by the Administrator. This field is prepopulated with the dictionary names.
Based Name is the name of the attribute from the dictionary selected in the Type field. The
Authentication attribute names are prepopulated from the dictionary.
Value is the value of the attribute. If the value has prepopulated values is the dictionary,
these appear in a drop-down list. Otherwise, you can enter freeform text.
An Enforcement Profile can also contain dynamic values (as received in the request or
authentication handshake, or as derived by the Policy Manager policy system).
For example, to set the name of the VLAN to the name of the role, enter ${Tips:Role}
as the value for RADIUS: IETF: Tunnel-Private-Group-Id. These dynamic values
must be entered in the following format, without any spaces: %
{namespace:attribute-name}.
For convenience, the value field also has a drop down that contains all the authorization
attributes. You can use these directly to assign dynamic values in the profile. Refer to
figure above.
F—Aruba Enforcement profile template for ClearPass Policy Manager to create user roles at the
Downloadable | time of user authentication.
Role Type is Aruba RADIUS dictionary.
Enforcement Name is the Aruba downloadable role.

Value is attribute for the downloadable role. You can enter freeform text to define the
role and policy.

For more information on defining roles and policies, refer to Aruba OS7.X User Guide.
The following is an example of an Aruba downloadable role:

ip access-list stateless denyping

any any svc-icmp deny

user-role cppm1

access-list stateless denyping

RADIUS CoA Enforcement Profiles

The RADIUS CoA tab contains a template type and the actions associated with that template type.

The RADIUS CoA Enforcement Profile tab loads the CoA template attributes supported a specific template.

Interface Description

Select The supported template types are:

RADIUS e Cisco - Disable-Host-Port

CoA e Cisco - Bounce-Host-Port

Template | o Cisco - Reauthenticate-Session
e HP-Change-VLAN
o HP - Generic-CoA

Attributes | The RADIUS (standard and vendor-specific) shown here are base on the CoA Template
selected from the drop down. Fill in values for all entries marked “Enter value here”. The
other pre-filled attributes must not be deleted, since the device requires these to be present.
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SNMP Enforcement Profiles
The SNMP tab contains a VLAN identifier and timeout.

Figure 208 Fig: SNMP Enforcement Profile (SNMP Tab)

Profile m Summary

Attribute Name Attribute Value i
1.‘VLAN D = 150 o
2.‘Sass\un Timeout (in seconds) = 3600 L]
3.‘|| I+ O =
4_‘ VLANID

Session Timeout (in seconds)

Reset Connection (after the settings are applied)
<« Back to Enforcement Profiles

The SNMP Enforcement Profile SNMP tab loads the SNMP dictionary attributes supported by Policy Manager.
Table 130: SNMP Enforcement Profile (SNMP tab)

Interface Description

VLAN Id VLAN ID to be sent to the device

Session Session timeout in seconds.

Timeout

Reset Reset Connection is a primitive that does different actions based on the capabilities of
Connection the network device. For devices that support the 802.1X re-authentication, Policy
(after the Manager triggers a re-authentication; in other cases, it bounces the port.

settings are

applied)

TACACS+ Enforcement Profiles

TACACS+ Enforcement Profiles contain attribute-value pairs and other permissions related to administrative access to
a network device. The built-in TACACS+ enforcement profiles can also be used to log into the Policy Manager UL
TACACS+ enforcement profiles use ARAP, Policy Manager:HTTP, PIX Shell, PPP:IP, PPP:IPX, PPP:LCP, Wireless-
WCS:HTTP, CiscoWLC:Common and Shell namespaces to define service attributes.
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Figure 209 TACACS+ Enforcement Profiles (Services Tab)

Configuration » Enforcement » Profiles » Add Enforcement Profile
Enforcement Profiles
N .. [—
Privilege Level: ‘ 15 (Privileged) v|
Selected Services: Shell -
i -Select—- - Add
PIX Shell
PPPIP
PPPIPX
PPPLCP
ARAP
eTIPSHTTP
Service Attributes
Type Name = Value i
1.|She|l priv_lvl = 15 ij
2.|Shsl| timeout = 180 T
3.|\ I=] M @
4_| Shell
PIX Shell
PPRIP
PPR:IPX
PPP:LCP
ARAP
eTIPS:HTTP
4 Back to Enforcement Profiles

Table 131: TACACS+ Enforcement Profile (Services tab)

Container Description

Privilege Enter a value, from 0 to 15.

Level NOTE: Refer to your network device documentation for definitions of the different privilege
levels.

Selected To add supported services, click Add.

Services To remove a service, select it and click Remove.
Policy Manager supports ARAP,eTIPS:HTTP (Policy Manager administrative interface
login), PIX shell, Shell, PPP:IP, PPP:IPX, Wireless-WCS:HTTP, CiscoWLC:Common and
PPP:LCP.

Service Once the services have been selected, you can select the attributes to send for those

Attributes services. Some services have pre-defined attributtes (which are automatically populated by
Policy Manager in a drop down listin the Name field). You can also add custom attributes in
the Name field. Add service attributes corresponding to the services selected in Selected
Services.
Policy Manager ships configured with attributes for some of the listed services.

Selections in the Commands tab configure commands and arguments allowed/disallowed for the selected Service

Type.
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Figure 210 TACACS+ Enforcement Profiles (Commands tab)

Summary Profile Services

Service Type: @ shell © PIX Shell

Unmatched Commands: Enable to permit unmatched commands

Specify which commands with arguments are permitted/denied Add
Command Arguments Permit Action Unmatched Arguments b

1,‘5huw vian Deny Permit [

2,‘5huw interface Deny Deny B

Configure Tacacs Command Authorization o

Shell Command: interface

Command Arguments Action b
1‘|vlam Deny b
2.|Click to add...

Unmatched Arguments: @ permit © Deny

< Back to Enforcement Profiles

Table 132: Commands tab (TACACS+ Enforcement Profiles)

Container Description

Service Select Shell or PIX shell radio button.
Type Subsequent selections in this tab configure commands and arguments allowed/disallowed
for this selection.

Unmatched | Enable to permit commands that are not explicitly entered in the Commands field.
Commands

Commands | Contains a list of the commands recognized for the specified Service Type:

To add a command, click Add. In the Configure Tacacs Command Authorization popup,

enter values for:

o Command. A string for the command. This is followed by one or more command
argument rows.

o Command Arguments. The arguments for the command.

Action. Click on Enable to permit check box to permit use of this command argument. If
this box is unchecked the column shows Deny and the command argument is not
allowed.

Click Trashcan to delete the command argument.

o Unmatched Arguments. Select Permit radio button to permit this command even if
Policy Manager receives arguments for the command that it does not recognize. Select
Deny radio button to deny the command if Policy Manager receives unrecognized
arguments.

To save and exit, click outside the row you are editing.

To delete a command, click the Trashcan icon for that row.

Application Enforcement Profiles

Application Enforcement Profiles contain attribute-value pairs and other permissions related to authorization of users of
Aruba Applications - GuestConnect and Insight. There are three different types of application enforcement profile
templates that can be selected:

e ClearPass Insight Enforcement - Attributes for users of Insight application.

e Generic Application Enforcement - Attributes for users of any generic application.
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Figure 211 Application Enforcement Profiles (Attributes Tab)
Configuration » Enforcement » Profiles » Add Enforcement Profile

Enforcement Profiles

Attribute Name Attribute Value
1.|Privilege-Level

Sponsor

2.|sponsor-Profile-Name

B —

4| Privilege-Level
Sponsor-Profile-Name

Enter Profile Name

g & = &8

Table 133: Application Enforcement Profiles (Attributes tab)

Description

Privile Enter a predefined value: Admin, Sponsor, Helpdesk; or enter an application-specific custom
ge- value.

Level NOTE: Sponsor is only valid for the GuestConnect application

Spons Valid only for GuestConnect application. This is the (case-sensitive) name of the sponsor
or- profile defined in the GuestConnect application.

Profile-
Name

Spons Enter the email address of the sponsor.
or-
Email

CLI Enforcement Profile

CLI Enforcement Profiles contain attribute-value pairs related to authorization of users/devices via CLI commands
executed on a target network device.

Figure 212 CLI Enforcement Profile (Attributes Tab)

Configuration » Enforcement » Profiles » Add Enforcement Profile

Enforcement Profiles

Attribute Name Attribute Value i
Target Device

-

9%{Connection:NAD-IP- Address}

&

~

.|Command
.[Click to add...

Enter Command i)

w

Table 134: CLI Enforcement Profiles (Attributes tab)

Container Description

Target Enter the device on which the CLI commands are executed. Typically, this is the edge
Device device on which the user/endpoint connected (%{Connection:NAD-IP-Address}).

Command Multiple commands (separated by a new line) that are executed on the target device.

Agent Enforcement Profiles

Agent Enforcement Profiles contain attribute-value pairs related to enforcement actions sent to Aruba OnGuard Agent.
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Figure 213 Agent Enforcement Profile (Attributes Tab)

Configuration » Enforcement » Profiles » Add Enforcement Profile

Enforcement Profiles

Profile Summary

Attribute Name Attribute Value b
1.|Bounce Client = false )
2.|Message = Enter message here L
3.|Click to add...

Table 135: Agent Enforcement Profiles (Attributes tab)

Container Description

Bounce Client If checked, the endpointis bounced by the OnGuard agent (this feature is only
available with the persistent agent)

Message A custom message to send to the endpoint.

Session Timeout (in Timeout after which the OnGuard agent forces a reauthentication on the endpoint.
seconds)

Post Authentication Enforcement Profiles

Post Authentication Enforcement Profiles contain combinations of type, attribute names, and values related to post
authentication. You can add more context to a user who is authenticated earlier and this information is used for
subsequent requests. Two post authentication profiles are provided:

e Entity Update Enforcement

o Session Restrictions Enforcement

Figure 214 Post Authentication Enforcement Profiles
This figure illustrates rules for the two sample profiles:

A— ClearPass Entity Update Enforcement, B—Session Restrictions Enforcement

Profile Attributes Summary

Type Name Value b}
1.|Endpoint Device Type = Del By @
2.|[status-Update I=] [Guestuser I=] = [Enabled =] B @ A
3.[Click to add...

Type Name Value b §
1.|Bandwidth- Check Start-Date = 2012-10-10 By @ B
2.|Bandwidth-Check Stop-Date = 2012-10-11 By @
3.|[post-Auth- Check I=] [action I=] = [pisconnect ) ®m @
4.|Click to add...

Table 136: Post Authentication Enforcement Profiles

Enforcement

Profile Description

Template

A- Enforcement profile template used to update tags in endpoints and guest users.
ClearPassEntity Type is any endpoint, guest user, or a session update.

Update Name is the name of an attribute associated with an endpoint, guest user, or a
Enforcement session update. If the type is session update, the tags are updated for either an

endpoint or a guest user.
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Enforcement

Profile

Template

Description

Value is the value of the attribute.

B—Session
Restrictions
Enforcement

Enforcement profile template used to restrict users based on bandwidth usage and
also disconnect users when the specified limits are crossed.

Type is any post authentication check or session check that is applicable to the user.
Name is the name of any specific check related the selected Type.

Value is the value of the attribute.

For example, if Bandwidth-Check is selected as the Type, you can select Start-Date
from the Name drop-down list, and specify the start date in the Value field.

If you have configured to disconnect users or devices that exceed bandwidth or session related limits, then the users or

devices that exceed the specified limit get added to the blacklist user repository. You must add the Blacklist User

Repository as an authentication source so that such users are denied access. For information on configuring
Authentication Sources, refer to Adding and Modifying Authentication Sources

Configuring Enforcement Policies

One and only one Enforcement Policy can be associated with each Service.

From the Services page (Configuration > Service), you can configure enforcement policy for a new service (as part of

the flow of the Add Service wizard), or modify an existing enforcement policy (Configuration > Enforcement >

Enforcement Policies, then click on its name in the Enforcement Policies listing page).

Figure 215 Enforcement Policies Listing Page

Configuration » Enforcement » Policies

Enforcement Policies

% Add Enforcement Policy
& Import Enforcement Policies
& Export Enforcement Policies

Filter: Name ~ + contains Show 10~ records
# ] NameA Type Description
1.| [ [Admin Network Login Policy] TACACS Enforcement policy controlling access to Policy Manager Admin
2.| [l [AirGroup Enforcement Policy] RADIUS Enforcement policy controlling access for AirGroup devices
3.| [ [Aruba Device Access Policy] TACACS Enforcement policy controlling access to Aruba device
4.|[] Guest - MAC Caching - Limit 1 Device RADIUS Limits guests to maximum 1 device for MAC caching purposes
5. ] Guest - MAC Caching - Limit 2 Devices RADIUS Limits guests to maximum 2 devices for MAC caching purposes
6./ [[] Guest Operator Logins Application  Enforcement policy controlling access to Guest application
7.| F1  [MAC Caching - 24 Hours] RADIUS Sample policy for MAC caching specifying a 24 hour lifetime
8. [[] MAC Caching - 5 Days RADIUS Sample policy for MAC caching specifying 2 5 day lifetime
9.| [l [MAC Caching - 8 Hours] RADIUS sample policy for MAC caching specifying 2 8 hour lifetime
10.| [[]  [MAC Caching By Role] RADIUS Sample policy for MAC caching specifying a lifetime depending on role
Showing 1-10 of 15 B> B

When you click Add Enforcement Policy, Policy Manager displays the Add Enforcement Policy wizard page:
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Figure 216 Add Enforcement Policy (Enforcement tab)

Configuration » Enforcement » Policies » Add
Enforcement Policies
e
Name: Employee Access Enforcement
Description: Enfoercement policy for employee access
Type: @ RADIUS © TACACS+ © WEBAUTH (SNMP/CLI) © Application
Default Profile: —Select- [=]_ View Details | Modify | Add new Enforcement Profile
« Back to Enforcement Policies

Table 137: Add Enforcement Policy (Enforcement tab)

Parameter Description

Name/Description | Freeform label and description.

Type Select: RADIUS, TACACS+, WebAuth (SNMP/CLI) or Application. Based on this
selection, the Default Profile list shows the right type of enforcement profiles in the
dropdown list (See Below). Note: Web-based Authentication or WebAuth (HTTPS) is
the mechanism used by authentications performed via a browser, and
authentications performed via Aruba OnGuard. Both SNMP and CLI (SSH/Telnet)
based Enforcement Profiles can be sent to the network device based on the type of
device and the use case.

Default Profile An Enforcement Policy applies Conditions (roles, health and time attributes) against
specific values associated with those attributes to determine the Enforcement Profile.
If none of the rules matches, Policy Manager applies the Default Profile.

Click Add new Enforcement Profile to add a new profile (This is integrated into the
flow. Once you are done creating the profile, Policy Manager brings you back to the
current page/tab.)

In the Rules tab, click New Rule to display the Rules Editor:
Figure 217 Add Enforcement Policy (Rules Tab)

Enforcement .:EH Summary

Rules Evaluation Algorithm: © Select first match @ Select all matches

Enforcement Policy Rules:
Conditions Actions

(Tips:Role MATCHES_ANY Role_Engineer
Senior_Mgmt)

(Tips:Role EQUALS eTIPS_Guest)

"|AND (Tips:Posture EQUALS HEALTHY (0))

Add Rule Move Up | Move Down Edit Rule | Remove Rule |

<« Back to Enforcement Policies

EMPLOYEE_VLAN

2 INTERNET_VLAN
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Figure 218 Add Enforcement Policy (Rules Editor)

Tips

[corditions
Match ALL of the following conditions:
‘ Type Name Operator Value i |
1.|Tips Posture EQUALS HEALTHY (0) @
Remote Worker
2.|Tips Role MATCHES_ANY role_engineer i}
testga
3| =] B @
4| Date

Enforcement Profiles

EroficMames: EMPLOYEE_VLAN n
Remote Employee ACL Move Up

Move Down

Remove

—Select-

- Add

Save J| Cancel

Table 138: Add Enforcement Policy (Rules tab)

Field

Add/Edit Rule

Description

Bring up the rules editor to add/edit a rule.

Move Up/Down

Reorder the rules in the enforcement policy.

Remove Rule

Remove a rule.

Table 139: Add Enforcement Policy (Rules Editor)

Field

Conditions/Enforcement
Profiles

Description

Select conditions for this rule. For each condition, select a matching action
(Enforcement Profile).

NOTE: A condition in an Enforcement Policy rule can contain attributes from
the following namespaces: Tips:Role, Tips:Posture, and Date.

NOTE: The value field for the Tips:Role attribute can be a role defined in
Policy Manager, or a role fetched from the authorization source. (Refer to to
see how Enable as Role can be turned on for a fetched attribute). Role names
fetched from the authorization source can be entered freeform in value field.
To commit the rule, click Save.

Enforcement Profiles

If the rule conditions match, attributes from the selected enforcement profiles
are sent to Network Access Device. If a rule matches and there are multiple
enforcement profiles, the enforcement profile disambiguation rules apply.
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Chapter 18

Network Access Devices

A Policy Manager Device represents a Network Access Device (NAD) that sends network access requests to Policy
Manager using the supported RADIUS, TACACS+, or SNMP protocol.

Refer to the following sections:

e "Adding and Modifying Devices " on page 225

e "Adding and Modifying Device Groups " on page 229
e "Adding and Modifying Proxy Targets " on page 231

Adding and Modifying Devices

To connect with Policy Manager using the supported protocols, a NAD must belong to the global list of devices in the
Policy Manager database.

Policy Manager lists all configured devices in the Devices page: Configuration > Network > Devices. From this
interface:

Figure 219 Network Devices page

Configuration » Network » Devices

Network Devices  Add Device
& Import Devices
& Export Devices

Filter: Name = contains aruba Show 0o records
# [ Name A 1P or Subnet Address Description
1. @ Aruba Controller 1 192.168.5.68
2.| @ Aruba Controller Building 1341 10.6.2.252
3. @ Aruba Controller Building 1341-2 10.6.2.241
Showing 1-3 of 3 ‘ Copy, H Export H Delete |

Adding a Device

To add a device, click the Add Device link, and then complete the fields in the Add Device popup. The tabs and
fields are described in the images that follow.

Figure 220 Device tab

Add Device o

SNMP Read Settings SNMP Write Settings CLI Settings

Name: |Contro|\er 1 | M
IP or Subnet Address: [192.168.5.4 | (e.g., 192.168.1.10 or 192.168.1.1/24)
Description: Access Switch - Building  «
1, Floor 1, Closet 1 -

RADIUS Shared Secret: |||||||||u||||u| | Verify: |--------------- |
TACACS+ Shared Secret: |"“""“"." | Werify: |....o.o..o..o.o | £
Vendor Name: ICisco [=]
Enable RADIUS CoA: =

Attribute Value i
1. |Location| [r] = Building 1 [*] e Ry
2,| Device Type = 0S5 12.2 i

Device Vendor =

Location
Controller Id
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Table 140: Device tab

Container Description

Name/ Description Specify identity of the device.

IP Address or Specify the IP address or the subnet (E.g., 192.168.5.0/24) of the device.
Subnet

RADIUS/TACACS+ | Enter and confirm a Shared Secret for each of the two supported request protocols.
Shared Secret

Vendor Optionally, specify the dictionary to be loaded for this device.

NOTE: RADIUS:IETF, the dictionary containing standard the set of RADIUS
attributes, is always loaded.

When you specify a vendor here, the RADIUS dictionary associated with this
vendor is automatically enabled.

Enable RADIUS Enable RADIUS Change of Authorization (RFC 3576/5176) for this device.
CoA Set the UDP port on the device to send CoA actions. Default value is 3799.
RADIUS CoA Port

Attributes Add custom attributes for this device. Click on the “Click to add...” row to add
custom attributes. By default, four custom attributes appear in the Attribute
dropdown: Location, OS-Version, Device-Type, Device-Vendor. You can enter any
name in the atiribute field. All attributes are of String datatype. The value field can
also be populated with any string. Each time you enter a new custom attribute, itis
available for selection in Attribute dropdown for all devices.

NOTE: All attributes entered for a device are available in the role mapping rules
editor under the Device namespace.

Add/Cancel Click Add to commit or Cancel to dismiss the popup.

Figure 221 SNMP Read/Write Settings tabs

Device SNMP Read Settings SNMP Write Settings CLI Settings

Allow SNMP Read: Enable Policy Manager to perform SNMP read operations
SNMP Read Setting: SNMP v2 with community strings |Z|
Community String: LI LI I I IIIL] Verify: SEERNIERNIRRNNS
Force Read: Enable to read switch information forcibly

Read ARP Table Info: Enable to read ARP table from this switch

Figure 222 SNMP Read/Write Settings tabs - SNMP v3 Details

SNMP Read Setting: SMMP v3 with Authentication using MDA and with Privacy -

Username:

Authentication Key: Verify:

Privacy Key: Verify:

Privacy Protocol: DES-CBC M
%
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Table 141: SNMP Read/Write Settings tabs

Container Description

Allow SNMP Toggle to enable/disable SNMP Read/Write.

Read/Write

Default VLAN VLAN port setting after SNMP-enforced session expires.

(SNMP Write

only)

SNMP SNMP settings for the device.

Read/Write

Setting

Community

String (SNMP

v2 only)

Force Read Enable this setting to ensure that all CPPM nodes in the cluster read SNMP information

(SNMP v1 from this device regardless of the trap configuration on the device. This option is

and v2 only) especially useful when demonstrating static IP-based device profiling because this does
not require any trap configuration on the network device.

Read ARP Enable this setting if this is a Layer 3 device, and you intend to use the ARP table on this

Table Info device as a way to discover endpoints in the network. Static IP endpoints discovered this
way are further probed via SNMP to profile the device.

Username Admin user name to use for SNMP read/write operations

(SNMP v3

only)

Authentication | SNMP v3 with authentication option (SHA & MD5)

Key (SNMP

v3 only)

Privacy Key SNMP v3 with privacy option

(SNMP v3

only)

Privacy Choose one of the available privacy protocols:

Protocol e DES-CBC

(SNMP v3 w/ o AES-128

privacy only)

Add/Cancel

Click Add to commit or Cancel to dismiss the popup.

In large or geographically spread cluster deployments you do not want all CPPM nodes to probe all SNMP configured
devices. The default behavior is fora CPPM node in the cluster to read network device information only for devices

configured to send traps to that CPPM node.
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Figure 223 CL/ Settings tab

Add Device L
Device SNMP Read Settings SNMP Write Settings CLI Settings

Allow CLI Access: Enable Policy Manager to perform CLI operations

Access Type: @ ssH © Telnet

Port: 22

Username: admin

Password: sssesssssssseee Verify Password: [esesesessesssse

Username Prompt Regex:
Password Prompt Regex:
Command Prompt Regex:
Enable Prompt Regex:

Enable Password: Verify Password:

Table 142: CL/ Settings tab

Container Description

Allow CLI Access Toggle to enable/disable CLI access.

Access Type Select SSH or Telnet. Policy Manager uses this access method to log into the
device CLI.

Port SSH or Telnet TCP port number.

Username/Password | Credentials to log into the CLI.

Username Prompt Regular expression for the username prompt. Policy Manager looks for this
Regex pattern to recognize the telnet username prompt.

Password Prompt Regular expression for the password prompt. Policy Manager looks for this
Regex pattern to recognize the telnet password prompt.

Command Prompt Regular expression for the command line prompt. Policy Manager looks for this
Regex pattern to recognize the telnet command line prompt.

Enable Prompt Regular expression for the command line "enable" prompt. Policy Manager looks
Regex for this pattern to recognize the telnet command line prompt.

Enable Password Credentials for "Enable" in the CLI

Add/Cancel Click Add to commit or Cancel to dismiss the popup.

Additional Available Tasks

e To import a device, click Import Devices. In the Import from File popup, browse to select a file, and then click
Import. If you entered a secret key to encrypt the exported file, enter the same secret key to import the device back.
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To export all devices from the configuration, click Export Devices. In the Export to File popup, specify a file path,
and then click Export. In the Export to File popup, you can choose to encrypt the exported data with a key. This
protects data such as shared secret from being visible in the exported file. To import it back, you specify the same
key that you exported with.

To export a single device from the configuration, select it (via the check box on the left), and then click Export. In
the Save As popup, specify a file path, and then click Export.

To delete a single device from the configuration, select it (via the check box on the left), and then click Delete.
Commit the deletion by selecting Yes; dismiss the popup by selecting No.

Policy Manager groups devices into Device Groups, which function as a component in Service and Role Mapping
rules. Device Groups can also be associated with Enforcement Profiles; Policy Manager sends the attributes associated
with these profiles only if the request originated from a device belonging to the device groups.

Administrators configure Device Groups at the global level. They can contain the members of the IP address of a
specified subnet (or regular expression-based variation), or devices previously configured in the Policy Manager
database.

Policy Manager lists all configured device groups in the Device Groups page: Configuration > Network > Device
Groups.

Figure 224 Device Groups Page

Configuration » Network » Device Groups

Network Device Groups “ Add Device Group
& Import Device Groups
& Export Device Groups
Select ALL matches @ Select ANY match

Filter: Name ~ contains Aruba
Filter: Name v contains Bangalore
Filter: Format v contains Subnet

Filter: Format ~ contains List

Filter: Name ~ contains San Jose

Clear Filter show 10~ records

* Name A Format Description
ArubaControllers List All Aruba Controllers

Bangalore Devices Subnet Devices in Bangalore

1

2

3 Remote Bangalore Subnet Remote Bangalore Devices
4 Remote San Jose Subnet San Jose VPN Devices

5

San Jose Devices List San Jose Switches

Showing 1-5 of 5

To add a Device Group, click Add Device Group. Complete the fields in the Add New Device Group popup:
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Figure 225 Add New Device Group Popup

Add New Device Group o

Name: | Test Device Group |

Description: This is a test device group]

Format: © Subnet
© Regular Expression
D List

Subnet:

(e.g., 192.168.1.1/24)

Add New Device Group o

Name: | Test Device Group 2

Description: This is a test device group 2|

Format: © Subnet
@ Regular Expression
D List

Regular Expression:

(e.g., ~192(.[0-91%){3}%)

Add New Device Group o

Name: | Test Device Group 2

Description: This is a test device group 2

Format: ) subnet
) Regular Expression
1@ List
List: Available Devices -
Filter
192.168.150.204 -~

192.168.5.208
192.168.5.214 -

192.168.150.60
192.168.150.80 E
192.168.5.12

Selected Devices -
Filter

-

Save J Cancel

Table 143: Add New Device Group popup

Container Description

Name/ Specify identity of the device.

Description/

Format

Subnet Enter a subnet consisting of network address and the network suffix (CIDR
notation); for example, 192.168.5.0/24

Regular Specify a regular expression that represents all IPv4 addresses matching that

Expression expression; for example, #192(.[0-9]*){3}$

List: Use the widgets to move device identifiers between Available and Selected. Click

Available/Selected | Filter to filter the list based on the textin the associated text box.

Devices

Save/Cancel Click Save to commit or Cancel to dismiss the popup.
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For SNMP enforcement on the network device, one or more of the following traps have to be configured on the device:
Link Up trap, Link Down trap, MAC Notification trap. In addition, one or more of the following SNMP MIBs must be
supported by the device: RFC-1213 MIB, IF-MIB, BRIDGE-MIB, ENTITY-MIB, Q-BRIDGE-MIB, CISCO-VLAN-
MEMBERSHIP-MIB, CISCO-STACK-MIB, CISCO-MAC-NOTIFICATION-MIB.

These traps and MIBs enable Policy Manager to correlate the MAC address, IP address, switch port, and switch
information.

HOTE

Additional Available Tasks

e To import a Device Group, click Import Device Groups; in the Import from File popup, browse to select a file,
then click Import.

e To export all Device Groups from the configuration, click Export Devices; in the Export to File popup, specify a
file path, then click Export.

e To export a single Device Group from the configuration, select it (using the check box on the left), then click
Export; in the Save As popup, specify a file path, then click Export.

e To delete a single Device Group from the configuration, select it (using the check box on the left), then click
Delete; commit the deletion by selecting Yes. dismiss the popup by selecting No.

In Policy Manager, a proxy target represents a RADIUS server (Policy Manager or third party) that is the target of a
proxied RADIUS request. For example, when a branch office employee visits a main office and logs into the network,
Policy Manager assigns the request to the first Service in priority order that contains a Service Rule for RADIUS proxy
Services and appending the domain to the Username.

Proxy targets are configured at a global level. They can then used in configuring RADIUS proxy Services. (Refer to
"Policy Manager Service Types" on page 80.)

Policy Manager lists all configured proxy servers in the Proxy Servers page: Configuration > Network > Proxy
Servers.

Figure 226 Proxy Targets Page

Configuration » Network » Proxy Targets

Proxy Targets =" Add Proxy Target
2, Import Proxy Targets
&, Expaort Proxy Targets

Fiter: (Name 0 ] contains Gl oo | cloarFitter show [10_[+] records

# T Name 4 Hostname Description

1‘|D 5] Branch OFfice Proxy acme.com 8] branch office

Showing 1-1 of 1 Export ‘ Delete ‘

Add a Proxy Target

To add a Proxy Target, click Add Proxy Target, and complete the fields in the Add Proxy Target popup. You can
also add a new proxy target from the Services page (Configuration > Service (as part of the flow of the Add Service
wizard for a RADIUS Proxy Service Type).

Figure 227 Add Proxy Target Popup
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Add Proxy Target o

Name: BRAMNCH OFFICE PROXY
Description: Branch Office

Hostname: branchlproxy.clearpass.com
Shared Secret: ssssssssssssnee

Verify Shared Secret: sssssssesssseee

RADIUS Authentication Port: |1812 (Default is 1812)
RADIUS Accounting Port: 1813 (Default is 1813)

Save J Cancel

Table 144: Add Proxy Target popup

Container Description

Name/Description Freeform label and description.

Hostname/Shared RADIUS Hostname and Shared Secret.

Secret Use the same secret that you entered on the proxy target (refer to your RADIUS
server configuration).

RADIUS Enter the UDP port to send the RADIUS request. Default value for this portis

Authentication Port 1812.

RADIUS Accounting Enter the UDP port to send the RADIUS accounting request. Default value for

Port this portis 1813.

Additional Available Tasks
e To import a Proxy Target, click Import Proxy Targets. In the Import from File popup, browse to select a file,
then click Import.

e To export all Proxy Targets from the configuration, click Export Proxy Targets. In the Export to File popup,
specify a file path, and then click Export.

e To export a single Proxy Target from the configuration, select it (check box on left), then click Export. In the Save
As popup, specify a file path, and then click Export.

e To delete a single Proxy Target from the configuration, select it (via the check box on the left), and then click
Delete. Commit the deletion by selecting Yes. Dismiss the popup by selecting No.
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Chapter 19

Administration

All administrative activities including server configuration, log management, certificate and dictionary maintenance,
portal definitions, and administrator user account maintenance are done from the Administration menus. The Policy
Manager Administration menu provides the following interfaces for configuration:

2 Adminictration E} e "Admin Users " on page 233
| E e "Admin Privileges " on page 236

-1 & Users and Privileges
ﬁ"hdmin Users e "Server Configuration" on page 240

#° Admin Privileges e "Log Configuration " on page 268
& Server Manager

& Server Configuration

e "Local Shared Folders " on page 270

.ﬁl’ Log Configuration e "Application Licensing " on page 271

& Local Shared Folders e "SNMP Trap Receivers " on page 273
o EthnL;TZr:ri:er e "Syslog Targets "on page 275

ﬁ" SNMP Trap Receivers e "Syslog Export Filters " on page 277

ﬁ" Syslog Targets e "Server Certificate " on page 284

& Syslog Export Filters
&° Messaging Setup
#° Endpoint Context Servers

e "Messaging Setup " on page 281

e "Endpoint Context Servers" on page 282

-1 & Certificates e '"Certificate Trust List" on page 289
& Server Certificate e "Revocation Lists " on page 290
&° Trust List o

. . e "RADIUS Dictionaries " on page 291

&° Revocation Lists

- || Dictionaries e "Posture Dictionaries " on page 292
&° RADIUS e '"TACACS+ Services "on page 293
éb Posture _ e "Fingerprints " on page 294
& TACACS+ Services
él’ Fingerprints e "Attributes " on page 295
&° Attributes e "Application Dictionaries" on page 298
& Applications e "OnGuard Settings " on page 298

-1 £, Agents and Software Updates
#° OnGuard Settings
#° OnGuard Portal e "Update Portal " on page 302
& Software Updates

e "OnGuard Portal " on page 300

Admin Users

The Policy Manager Admin Users menu Administration > Users and Privileges > Admin Users provides the
following interfaces for configuration:

e "Add User" on page 234
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e '"Import Users " on page 235

e "Export Users " on page 235

e "Export " on page 235

Figure 228 Admin Users

Administration » Users and Privileges » Admin Users

Admin Users

+ Add User
& Import Users
& Export Users

Fiters UserD = /contains Show 10~ racords
# [ UseridA Name Privilege Level
1| E  admin Super Admin Super Administrator
2.| [ apiadmin API Access Super Administrator
3./ [ ashwath ashwath Super Administrator
4| [F] bhprasad Bhagya Prasad NR Super Administrator
5| caros Carlos Gomez Gallego Super Administrator
6.| [ cesdaile Cameron Esdaile Super Administrator
7.| E choppe Carlen Hoppe Super Administrator
8| david David Hamel Super Administrator
9.  [] frontdesk frontdesk Receptionist
10.| 1 helpdesk Helpdesk Help Desk
Showing 1-10 0r 23 b M

Table 145: Admin Users

Container

Add User

Description

Opens the Add User popup form.

Import Users

Opens the Import Users popup form.

Export Users Exports all users to an XML file.
Export Exports a selected to an XML file.
Delete Deletes a selected User.

Add User

Select the Add User link in the upper right portion of the page.

Figure 229 Add Admin User

Add Admin User o

User ID:

Password:

|
Name: [
|
|

Verify Password:

Privilege Level

: Super Administrator

Super Administrator
Network Administrator
Help Desk
Receptionist
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Table 146: Add Admin User

Container Description

User ID

Name

Specify the identity and password for a new admin user.
Password

Verify Password

Privilege Level Select Privilege Level:

Help Desk

e Super Administrator

o Network Administrator

o Receptionist

or any other custom privilege level

Add/Cancel Add or dismiss changes.

Import Users

Select the Import Users link in the upper right portion of the page.
Figure 230 /mport (Admin) Users

Import from file o

Select File: | |[ Browse_ ]

Enter secret for the file (if any): | |

Table 147: Import (Admin) Users

Container Description

Selectfile Browse to select name of admin user import file.
Enter secret key for file (if any) Enter the secret key used (while exporting) to protect the file.
Import/Cancel Commit or dismiss import.

Export Users

Select the Export Users link from the upper right portion of the page.

The Export (Admin) Users link exports all (admin) users. Click Export. Your browser will display its normal Save As
dialog, in which to enter the name of the XML file to contain the export.

Export

Select the Export button on the lower right portion of the page.
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To export a user, select it (check box at left) and click Export. Your browser will display its normal Save As dialog, in
which to enter the name of the XML file to contain the export.

To view the available Admin Privileges, go to Administration > Users and Privileges > Admin Privileges.

Figure 231 Admin Privileges

|Administration » Users and Privileges » Admin Privileges
IAdmin Privileges & Import Admin Privileges
&2 Export Admin Privileges
Filter: Name ~ contains + show 10~ records
# [ Namead Description
1.[ [ API Administrator An APT administrator is only allowed API access to read/write all configuration elements
2.| [ Help Desk A help desk person logs in to troubleshoot problems reported by end users
3.| [0 Network Administrator A network administrator is allowed to configure all the policies in the system
4.| [[] Read-only Administrator A read-only administrator is only allowed to read all configuration elements
5.| [ Receptionist A receptionist is only allowed to configure guest users
6.| [ Super Administrator A super administrator is allowed read/write access to all configuration elements
Showing 1-6 of 6

See Custom Admin Privileges to create additional admin privileges and Exporting to export the definition
of one or more admin privileges.

While ClearPass Policy Manager doesn't let you change the definition of the built-in admin privileges, you can create
and import custom ones. Customer admin privileges are defined in a specifically formatted XML file and then imported
into Policy Manager on the Admin Privileges page.

Create a Custom Admin Privilege

You will need a plain text or XML editor, not a word processor such as Microsoft Word, to create a custom admin
privilege.

To create a custom admin privilege

1. Using a plain text or XML editor (not a word processor such as Microsoft Word), create an XML file that defines a
privilege and its definition. (See the following sections for information on the XML structure, and privilege
definitions.)

2. Go to Administration > Users and Privileges > Admin Privileges.

3. Import the admin privilege file you created in step 1. See Importing for details.

The admin privilege is added to the list.

Admin Privilege XML Structure
Admin privilege files are XML files and have a very specific structure.

A header must be at the beginning of an admin privilege XML file and must be exactly:

<?xml version="1.0" encoding="UTF-8" standalone="yes"?>

The root tag is TipsContents. It is a container for the data in the XML file and should look like this:

<TipsContents xmlns="http://www.avendasys.com/tipsapiDefs/1.0">

</TipsContents>

Following the TipsContents tag is an optional TipsHeader tag.
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The actual admin privileges information is defined with the AdminPrivilege and AdminTask tags. You use one
AdminPrivilege tag for each admin privilege you want to define. The AdminPrivilege tag contains two
attributes: name and description. Inside the AdminPrivilege tag are one or more AdminTask tags, each one
defining a lace within the Policy Manager application that a user with that privilege can view or change. The
AdminTask tag contains one taskid attribute and a single AdminTaskAction tag. The AdminTaskAction tag
has one attribute, type, and it can contain one of two values, RO *read only) or RW (read/write) The basic structure:

<AdminPrivileges>
<AdminPrivilege name="" description="">
<AdminTask taskid="">
<AdminTaskAction type=""/>
</AdminTask>
<AdminTask taskid="">
<AdminTaskAction type=""/>
</AdminTask>
</AdminPrivilege>
</AdminPrivileges>

Admin Privileges and IDs

The following section lists the areas and sub-areas of the Policy Manager application and the associated taskid of each
one.
Dashboard: taskId="dnd"
Monitoring: taskId="mon"
Live Monitoring: taskId="mon.1i"
Access Tracker: taskId="mon.1li.ad"
Accounting: taskId="mon.1li.ac"
Onguard Activity: taskId="mon.li.ag"
Analysis and TrendingL taskId="mon.1l1i.sp"
Endpoint Profiles: taskId="mon.1li.ep"
System Monitor: taskId="mon.li.sy"
Audit Viewer: taskId="mon.av"
Event Viewer: taskId="mon.ev"
Data Filters: taskId="mon.df"
Configuration: taskId="con"
Start Here (Services Wizard): taskld="con.sh"
Services: taskId="con.se"
Service Templates: taskId="con.st”
Authentication: taskId="con.au"
Methods: taskId="con.au.am"
Sources: taskId="con.au.as"
Identity: taskId="con.id"
Single Sign-On: taskId="con.id.sso”
Local Users: taskId="con.id.lu"
Guest Users: taskId="con.id.gu"
Onboard Devices: taskId="con.id.od"
Endpoints: taskId="con.id.ep"
Static Host Lists: taskId="con.id.sh"
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Roles: taskId="con.id.rs"
Role Mappings: taskId="con.id.rm"
Posture: taskId="con.pv"
Posture Policies: taskId="con.pv.in
Posture Servers: taskId="con.pv.ex"
Audit Servers: taskId="con.pv.au"
Enforcements: taskId="con.en"
Policies: taskId="con.en.epo"
Profiles: taskId="con.en.epr"
Network: taskID="con.nw"
Devices: taskId="con.nw.nd"
Device Groups: taskId="con.nw.ng"
Proxy Targets: taskId="con.nw.pr"
Policy Simulation: taskId="con.ps"
Profile Settings: taskId="con.prs"
Administration: taskId="adm"
User and Privileges: taskId="adm.us"
Admin Users: taskId="adm.us.au"
Admin Privileges: taskId="adm.us.ap"
Server Manager: taskId="adm.mg"
Server Configuration: taskId="adm.mg.sc"
Log Configuration: taskId="adm.mg.ls"
Local Shared Folders: taskId="adm.mg.sf"
Licensing: taskId="adm.mg.sf"
External Servers: taskId="adm.xs"
SNMP Trap Receivers: taskId="adm.xs.st"
Syslog Targets: taskId="adm.xs.es"
Syslog Export Filters: taskId="adm.xs.sx"
Messaging Setup: taskId="adm.xs.me"
Certificates: taskId="adm.cm"
Server Cettificate: taskId="adm.cm.mc"
Trust List: taskId="adm.cm.ctl"
Revocation List: taskId="adm.cm.crl"
Dictionaries: taskId="adm.di"
RADIUS: taskId="adm.di.rd"
Posture: taskId="adm.di.pd"
TACACS+ Services: taskId="adm.di.td"
Fingerprints: taskId="adm.di.df"
Attributes: taskId="adm.di.at"
Applications: taskid="adm.di.ad”
Agents and Software Updates: taskId="adm.po"
Onguard Settings: taskId="adm.po.aas"
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Guest Portal: taskId="adm.po.gp"
Software Updates: taskId="adm.po.es"

If you provide permission for an area, the same permission for all sub-areas is included by default. For
example, if you give RW permissions for Enforcements (con.en), you grant permissions for its sub-areas,
in this case, Policies (con.en.epo)and Profiles (con.en.epr), and you do not have to explicitly define the
same permission for those sub-areas.

Sample Admin Privilege XML
Read Only (RO) Privilege to all the sections (dnd, con, mon, adm)

<?xml version="1.0" encoding="UTF-8" standalone="yes"?>
<TipsContents xmlns="http://www.avendasys.com/tipsapiDefs/1.0">
<TipsHeader exportTime="Thu Jul 26 17:57:50 IST 2012" version="6.0"/>
<AdminPrivileges>
<AdminPrivilege name="Read-only Administrator" description="A read-only administrator is o
nly allowed to read all configuration elements">
<AdminTask taskid="con"> //Refers to Configuration
<AdminTaskAction type="RO"/>
</AdminTask>
<AdminTask taskid="dnd"> //Refers to DashBoard
<AdminTaskAction type="RO"/>
</AdminTask>
<AdminTask taskid="mon"> //Refers to Monitoring
<AdminTaskAction type="RO"/>
</AdminTask>
<AdminTask taskid="adm"> //Refers to Administration
<AdminTaskAction type="RO"/>
</AdminTask>
</AdminPrivilege>
</AdminPrivileges>
</TipsContents>

Only Read/Write access to Guest, Local and Endpoint Repository

<?xml version="1.0" encoding="UTF-8" standalone="yes"?>
<TipsContents xmlns="http://www.avendasys.com/tipsapiDefs/1.0">
<TipsHeader exportTime="Thu Jul 26 17:57:50 IST 2012" version="6.0"/>
<AdminPrivileges>
<AdminPrivilege name="Read/Write Access to Guest, Local and Endpoint Repository" descripti
on="A read-only administrator is only allowed to read all configuration elements">
<AdminTask taskid="con.id.lu"> //Refers to Local Users Section
<AdminTaskAction type="RW"/>
</AdminTask>
<AdminTask taskid="con.id.gu"> //Refers to Guest Users Section
<AdminTaskAction type="RW"/>
</AdminTask>
<AdminTask taskid="con.id.ep"> //Refers to Endpoints Section
<AdminTaskAction type="RW"/>
</AdminTask>
</AdminPrivilege>
</AdminPrivileges>
</TipsContents>

Read/Write permissions to DashBoard/ Monitoring and ReadOnly permissions to Server Configuration

<?xml version="1.0" encoding="UTF-8" standalone="yes"?>
<TipsContents xmlns="http://www.avendasys.com/tipsapiDefs/1.0">
<TipsHeader exportTime="Thu Jul 26 17:57:50 IST 2012" version="6.0"/>
<AdminPrivileges>
<AdminPrivilege name="Limited access permission" description="A read-only administrator is
only allowed to read all configuration elements">
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<AdminTask taskid="dnd"> //Refers to DashBoard
<AdminTaskAction type="RW"/>

</AdminTask>

<AdminTask taskid="mon"> //Refers to Monitoring
<AdminTaskAction type="RW"/>

</AdminTask>

<AdminTask taskid="adm.mg.sc"> //Refers to Server Configuration

<AdminTaskAction type="RO"/>
</AdminTask>
</AdminPrivilege>
</AdminPrivileges>
</TipsContents>

Server Configuration

The Policy Manager Server Configuration menu (Administration > Server Manager > Server Configuration)

provides the following interfaces for configuration:

e "Set Date/Time " on page 241

e "Change Cluster Password " on page 242
e "Manage Policy Manager Zones " on page 243
e '"NetEvents Targets" on page 244

e '"Virtual IP Settings" on page 244

e "Make Subscriber " on page 245

e "Upload Nessus Plugins " on page 246

e "Cluster-Wide Parameters " on page 246
e "Collect Logs " on page 250

e '"Backup " on page 252

e '"Restore" on page 253

e "Shutdown/Reboot " on page 254

e "Drop Subscriber " on page 254

Figure 232 Server Configuration

JAdministration = Server Manager » Server Configuration
Server Configuration 9 Set Date & Time
? Change Cluster Password
L5 Manage Policy Manager Zones
[5° NetEvents Targets
“7" Virtual IP Settings
‘% Make Subscriber
& Upload Nessus Plugins
7" Cluster-Wide Parameters
Publisher Server: doc26 [10.2.51.26]

# Server Name A Management Port  Data Port Zone Profile Cluster Sync Last Sync Time

1.| doc26 10.2.51.26 = default Enabled Enabled

Showing 1-1 of 1 Collect Logs Back Up Restore Shutdown Reboot

Clicking on the server row provides the following interfaces for configuration:

"System Tab " on page 254

e "Services Control Tab " on page 257

e '"Service Parameters Tab " on page 257
e "System Monitoring Tab " on page 264
e "Network Tab" on page 266

240
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Set Date/Time

Navigate to Administration > Server Manager > Server Configuration, and click on the Set Date and Time link.
This opens by default on the Date &Time tab.

Figure 233 Change Date and Time - Date & Time tab

Change Date and Time o

This will change Date & Time for all nodes in the cluster

Date & Time Time zone on publisher

[} synchronize time with NTP server

Date Time
Use yyyy-mm-dd Hour Minute Second
2012-09-28 [1a B0 Eiis &

Date & Time Time zone on publisher

[¥ synchronize time with NTP server

NTP server (primary) time.nistgov

NTP server (secondary)

: After command execution Policy Manager services need to be

restarted. This may take a while.

Table 148: Change Date and Time - Date & Time tab

Container Description

Date in yyyy-mm- To specify date and time, use the indicated syntax. This is available only when
dd format Synchronize time with NTP server is unchecked.

Time in hh:mm:ss

format

Synchronize Time To synchronize with a Network Time Protocol Server, enable this check box and
With NTP Server specify the NTP servers. Only two servers may be specified.

NTP Servers

After configuring the date and time, select the time zone on the Time zone on publisher tab. This displays a time zone
list alphabetical order. Select a time zone and click Save. Note that this option is only available on the publisher. To
set time zone on the subscriber, select the specific server and set time zone from the server-specific page.
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Figure 234 Time zone on publisher

Change Date and Time o

This will change Date & Time for all nodes in the cluster

Date & Time Time zone on publisher

To change the time zone, select your area from the list below

AfricafAbidjan

AfricafAccra K
AfricajAddis_Ababa
Africa/Algiers
Africa/Asmara
Africa/Bamako
Africa/Bangui
Africa/Banjul
Africa/Bissau
Africa/Blantyre

Current time zone: Etc/UTC{GMT 0:00)

: After command execution Policy Manager services need to be

restarted. This may take a while.

Change Cluster Password
Navigate to Administration > Server Manager > Server Configuration, and click on the Change Cluster Password

link.

Use this function to change the cluster-wide password.

Changing this password also changes the password for the CLI user - 'appadmin’.

Figure 235 Change Cluster Password

Change Cluster Password o

This will change Cluster Password for all nodes in the cluster

New Password

Verify Password
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Table 149: Change Cluster Password

Container Description

New Password Enter and confirm the new password.

Verify Password

Save/Cancel Commit or dismiss changes.

Manage Policy Manager Zones
CPPM shares a distributed cache of runtime state across all nodes in a cluster. These runtime states include:

e Roles and Postures of connected entities
e Connection status of all endpoints running OnGuard

e Endpoint details gathered by
CPPM uses this runtime state information to make policy decisions across multiple transactions.

In a deployment where a cluster spans WAN boundaries and multiple geographic zones, it is not necessary to share all
of this runtime state across all nodes in the cluster. For example, when endpoints present in one geographical area are
not likely to authenticate or be present in another area.

When endpoints present in one geographical area are not likely to authenticate or be present in another area, it is more
efficient from a network bandwidth usage and processing perspective to restrict the sharing of such runtime state to a
given geographical area.

You can configure Zones in CPPM to match with the geographical areas in your deployment. There can be multiple
Zones per cluster, and each Zone has a number of CPPM nodes that share runtime state.

Figure 236 Policy Manager Zones

Policy Manager Zones o

Name

.|default
.|EMEA-Zone
. |USA-Zone

El E | = | E} PEE

.|ASIAPAC-Zone

L R O B L

.|Click to add...

[ | Cose |

Table 150: Policy Manager Zones

Container Description

Name Enter the name of the configured Policy Manager Zone.

Delete Select the delete (trashcan) icon to delete a zone.
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NetEvents Targets

Netevents is a collection of details for various ClearPass Policy Manager such as users, endpoints, guests,
authentications, accounting details, and so on. This information is periodically posted to a server that is configured as
the NetEvents target.

If the ClearPass Insight feature is enabled on a ClearPass Policy Manager, it will receive netevents from all other server
nodes within the same CPPM cluster. If you want to post these details to any external server that can aggregate these
events or to an external dedicated ClearPass Insight server for multiple CPPM clusters, you have to configure an
external NetEvents Target.

Figure 237 NetEvents Targets

External targets can be configured to which ClearPass NetEvents will be sent periodically
Target URL Username
No external targets have been configured.
NetEvent Target Details -
Target URL:
Username:
Password: Verify Password:
Note: For an external Insight server, you may input https://<Insight-server-1P=/insight/netevents in Target URL
=X [ |

Table 151: NetEvents targets

Parameter Description

TargetURL | HTTP URL for the service that support POST and requires Authentication using Username /
Password.

NOTE: For an external Insight server, you may input https://<Insight-server-
IP>/insight/netevents in Target URL

Username Credentials configured for authentication for the HTTP service that is provided in the Target

URL.
Password
Reset Reset the dialog.
Delete Delete the information.

Virtual IP Settings

This configuration allows two nodes in a cluster to share a Virtual IP address. The Virtual IP address is
bound to the primary node by default. The secondary node takes over when the primary node is unavail-
able. Once the primary node becomes available again, the Virtual IP address is released to the primary.
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Figure 238 Virtual IP Settings

Virtual IP Settings o

Configure Virtual IPs for ClearPass High Availability
Virtual IP Primary Node Secondary Node Status

No Virtual IP have been configured
Virtual IP Details -
Virtual IP:

Node Interface Subnet
Primary Node: —select— = -
Secondary Node: —select— + -
Enabled:
R I T

Table 152: Virtual IP Settings Parameters

Parameter Description

Virtual IP Enter the IP address you want to define as the virtual IP address.

Node Select the servers to use as the primary and secondary nodes.

Interface Select the interface on each server where virtual IP address should be bound.
Subnet This value is automatically entered. you do not need to change it.

Enabled Select the check box to enable the Virtual IP address.

Make Subscriber

In the Policy Manager cluster environment, the Publisher node acts as master. An Policy Manager cluster can contain
only one Publisher node. Administration, configuration, and database write operations may occur only on this master
node.

The Policy Manager appliance defaults to a Publisher node unless it is made a Subscriber node. Cluster commands can
be used to change the state of the node, hence the Publisher can be made a Subscriber. When it is a Subscriber, you
will not see this link.

Navigate to the Administration > Server Manager > Server Configuration page, and click on the Make Subscriber
link.

Figure 239 Add Subscriber Node

Add Subscriber Node L

Publisher IP 10.4.33.168

Publisher Password
Restore the local log database after this operation
[Cl Do not backup the existing databases before this operation

: All application licenses on this server will be removed. Please
contact support to add and activate these licenses.
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Table 153: Add Subscriber Node

Container Description

Publisher IP Specify publisher address and password. Note that the password
specified here is the password for the CLI user appadmin

Publisher Password

Restore the local log database Enable to restore the log database following addition of a subscriber
after this operation node.
Do not backup the existing Enable this check box only if you do not require a backup to the

databases before this operation existing database.

Upload Nessus Plugins

Navigate to the Administration > Server Manager > Server Configuration page, and click on the Upload Nessus
Plugins link.

Figure 240 Upload Nessus Plugins

Import from file

Select File: Browse_

Enter secret for the file (if any): | |

Table 154: Upload Nessus Plugins

Container Description

Select File Click Browse and select the plugins file with the extension tar.gz.

Enter secret for the Always leave this blank.

file (if any)

Import/Cancel Load the plugins, or dismiss. If there are a large number of plugins, the load time
can be in the order of minutes.

Cluster-Wide Parameters

Navigate to the Administration > Server Manager > Server Configuration page, and click on the Cluster-Wide
Parameters link.
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Figure 241 Cluster-Wide Parameters dialog box, General tab

@ Cleanup Intervals Motifications

Standby Publisher

Virtual IP Configuration

Parameter Name

Policy result cache timeout

Maximum inactive time for an endpoint
Auto backup cenfiguration options
Free disk space threshold value

Free memory threshold value

Profile subnet scan interval

Database user "appexternal” password

Endpoint Context Servers polling interval

Parameter Value

5 minutes
0 days
Config -

30 %

30 %

24 hours
SRS RRRRRRNS

60 minutes

Default Value
L
0
Config
30
30
24

60

Figure 242 Cluster-Wide Parameters dialog box, Cleanup Interval tab

General

Motifications Standby Publisher

Virtual IP Configuration

Parameter Name

Parameter Value

Cleanup interval for Session log details in the database|7 days
Cleanup interval for information stored on the disk 7 days
Known endpoints cleanup interval 0 days
Unknown endpoints cleanup interval 0 days
Expired guest accounts cleanup interval 365 days
Profiled Unknown endpoints cleanup interval 0 days

Restore Defaults

Default Value
7
7
0
0
365

Figure 243 Cluster-Wide Parameters dialog box, Notification tab

General Cleanup Intervals

Parameter Name
System Alert Level
Alert Notification Timeout

Alert Notification - eMail Address

Alert Notification - SMS Address

Standby Publisher

Virtual TP Configuration

Parameter Value
WARN -

Disabled ~ hours

Restore Defaults

Default Value
WARN
2
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Figure 244 Cluster-Wide Parameters dialog box, Standby Publisher tab

General

Cleanup Intervals

Motifications Estandhv Puhlisher; Virtual IP Configuration

Parameter Name

Enable Publisher Failover

Failover Wait Time

Designated Standby Publisher - V]

Default Value
FALSE

Parameter Value
FALSE -

10 minutes 10

Figure 245 Cluster-Wide Parameters dialog box, Virtual IP Configuration tab

Cluster-Wide Parameters ]

General

Cleanup Intervals

Motifications Standby Publisher

Virtual IP

Parameter Name

Failover Wait Time

Parameter Value Default Value

10 seconds 10

Table 155: Cluster-Wide Parameters

Parameter Description

General

Policy result The number of minutes to store the role mapping and posture results derived by the

cache policy engine during policy evaluation. This result can then be used in subsequent

cleanup evaluation of policies associated with a service, if “Use cached Roles and Posture

timeout attributes from previous sessions” is turned on for the service. A value of 0 disables
caching.

Maximum The number of days to keep an endpointin the endpoints table since its last

inactive time authentication. If the endpoint has not authenticated for this period, the entry is removed

for an from the endpoint table. 0 specifies no time limit.

endpoint

Auto backup

e Off- Do not perform periodic backups.

configuration Config - Perform a periodic backup of only the configuration database.

options Config|Sessioninfo - Perform a backup of both the configuration database and the
session log database.

Free disk This controls the percentage below which disk usage warnings are issued in the Policy

space Manager Event Viewer. For example, a value of 30% indicates that a warning is issued if

threshold only 30% or below of disk space is available.

value
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Parameter Description

Free memory
threshold
value

This controls the percentage below which RAM usage warnings are issued in the Policy
Manager Event Viewer. For example, a value of 30% indicates that a warning is issued if
only 30% or below of RAM is available.

Profile
subnet scan
interval

Enter a value in hours.

Database
user
"appexterna
password

For this connection to the database, enter the password for the "appexternal” username.

Endpoint
Context
Servers
polling
interval

Enter the number of minutes between polling of endpoint context servers. The defaultis
60.

Cleanup Intervals

Cleanup
interval for
session log
details in the
database

The Number of days to keep the following data in the Policy Manager DB: session logs
(found on Access Tracker), event logs (found on Event Viewer), machine authentication
cache.

Cleanup
interval for
information
stored on
disk

The Number of days to keep log files, etc., written to disk.

Known or
disabled
endpoints
cleanup
interval

This controls how often (in days) endpoints with a status of Known or Disabled are
cleaned up from the endpoints table.

Unknown
endpoints
cleanup
interval

This controls how often (in days) endpoints with a status of Unknown are cleaned up from
the endpoints table.

Expired
guest
accounts
cleanup
interval

This controls the cleanup interval of expired guest accounts; this is number of days after
expiry that the cleanup happens. No cleanup is performed if the value is 0.

Profiled
endpoints
cleanup
interval

Enter a value in days.
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Parameter Description

Notifications

System Alert Alert notifications are generated for system events logged at this level or higher.

Level Selecting INFO generates alerts for INFO, WARN and ERROR messages. Selecting
WARN generates alerts for WARN and ERROR messages. Selecting ERROR generates
alerts for ERROR messages.

Alert This indicates how often (in hours) alert messages are generated and sent out. Selecting

Notification ‘Disabled” disables alert generation.

Timeout

Alert Comma separated list of email addresses to which alert messages are sent.

Notification -

eMail

Address

Alert Comma separated list of SMS addresses to which alert messages are sent. For example,

Notification - 4085551212@txt.att.net.

SMS

Address

Standby Publisher

Enable Select TRUE to authorize a node in a cluster on the system to act as a publisher if the
Publisher primary publisher fails.

Failover

Designated Select the server in the cluster to act as the standby publisher.

Standby

Publisher

Failover Wait
Time

Enter the number of minutes for the Secondary node to wait after Primary node failure
before it acquires the Virtual IP Address.The defaultis 10 minutes so the Secondary node
doesn't take over unnecessarily in conditions where the Primary node's unavailability is
brief, such as a restart.

Virtual IP Configuration

Fallover Wait
Time

Enter the number of seconds for the Secondary node to wait after Primary node failure
before it acquires the Virtual IP Address.The defaultis 10 seconds so the Secondary
node will take over and respond quickly to authentication access and requests.

Collect Logs

When you need to review performance or troubleshoot issues in detail, Policy Manager can compile and save
transactional and diagnostic data into several log files. These files are saved in Local Shared Folders and can be

downloaded to your computer.

To collect logs

1. Go to Administration > Server Manager > Server Configuration,

2. Click Collect Logs. The Collect Logs dialog box appears.
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Figure 246 Collect Logs

Collect Logs o

Output file name (ending with .zip or .tar.gz)

Collect the following logs

System logs

Logs from all Policy Manager services

[C] capture network packets Duration of dump: 60| secs.
Diagnostic dumps from Policy Manager services

[[] specify date range

For number of days until today 1

Enter a filename and add the .tar.gz extension to the filename.
4. Select which types of logging information you want to collect:
= System Logs
= Logs from all Policy Manager services

m Capture network packets for the specified duration. Use this with caution, and use this only when you want
to debug a problem. System performance can be severely impacted.

» Diagnostic dumps from Policy Manager services
5. Enter the time period of the information you want to collect. Either:

= Enter a number of days. The end of the time period will be defined as the moment you start the collection
and the beginning will be 24 hours multiplied by how many days you enter.

= Click the Specify date range check box, then enter a Start date and End date in yyyy.mm.dd format.
6. Click Start.
You'll see the progress of the information collection. When finished:

7. Click Close to finish or click Download File to save the log file to your computer.

The following information is useful if you are attempting to open a capture file (.cap or .pcap) using WireShark. First,
untar or unzip the file (based on the file extension). When the entire file is extracted, navigate to the PacketCapture
folder. Within this folder, you will see a file with a .cap extension. WireShark can be used to open this file and study the
network traffic.

Viewing Log Files

Log files contain transactional and diagnostic data separated by information type into separate files. They are collected
into a single file using the .tar file format, then compressed into a .gz file using the GZip compression utility. You will
need an application that can read and unpack a GZip file to view the files in a log file.

Aruba Networks cannot recommend specific software for viewing the contents of files compressed with GZip.

To view log files

1. Open the file in software that can read and extract from GZip files.
2. Extract the file in the .tar.gz file. The result will be a file with the .tar extension.
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3. Open the .tar file and extract the files within it. The result will be a folder named the same as the .tar file.

Inside that folder, you will find another folder with a randomly generated name that begins with "tmp." Inside that
folder, you will find one folder for each of the 4 types of information you wanted to save. For example, if you selected
System logs and Diagnostic dumps, you will have folders with the name SystemLogs and DiagnosticDumps. Inside
each of those folders will be files containing various types of information. Some of those files are in additional sub-
folders.

Backup

Navigate to the Administration > Server Manager > Server Configuration page, and click on the Back Up button.
Note that this action can also be performed using the "backup" CLI command

Figure 247 Backup Popup

Backup Policy Manager Database o

Generate file name

[C Do not backup log database
[Cl bo not backup password fields in configuration database

[Cl Backup databases for all installed applications

Figure 248 Post-Backup Popup

Backup eTIPS Database o

Backup complete

Backing up database and configuration...

INFO - Building tips-db-backup-2009-03-25-15-16-49.tar.gz ...

INFO - Starting backup. This may take some time...

INFO - Backup configuration database

INFO - Backup session log database

INFO - Backup complete

INFO - The backup file tips-db-backup-2009-03-25-15-16-49.tar.gz can be
ed by logging into https://etips

Backup complete

| 1 ] ¢

Download File m

Table 156: Back Up

Container Description

Generate Enable to have Policy Manager generate a filename; otherwise, specify Filename.
filename Backup files are in the gzipped tar format (tar.gz extension). The backup file is
automatically placed in the Shared Local Folder under folder type Backup Files (See
"Local Shared Folders " on page 270).

Filename

Do not backup Select this if you do not want to backup the log database.
log database
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Container Description

Do not backup Select this if you do not want to backup password fields in configuration database.
password
fields in
configuration
database

Backup Select this option if you want the backup to include databases for installed applications.
databases for
installed
applications

Restore

Navigate to the Administration > Server Manager > Server Configuration page, and click on the Restore button.
Note that this action can also be performed using the "restore" CLI command.

Figure 249 Restore

Restore Policy Manager Database o

Restore file location @Upload file to server  ©File is on server

Upload file:

I Browse_

Restore configuration DB

[C] Restore log DB (if it exists in the backup)

[[] 1gnore version mismatch and attempt data migration

[ rRestore cluster server/node entries from backup

[[] Do not backup the existing databases before this operation

Table 157: Restore

Container Description

Restore file location Select either Upload file to server or File is on server.

Upload file path Browse to select name of backup file (shown only when Upload file to
server radio button is selected).

Shared backup files Select a file from the files in the local shared folders (See "Local Shared
present on the server Folders "on page 270). This is shown only when File on server radio
button is selected.

Restore configuration DB Enable to include the configuration database in the restore.

Restore log DB (if it exists Enable to include the log database in the restore.

in the backup).

Ignore version mismatch This option must be checked when you are migrating configuration and/or

and attempt data migration | log data from a backup file that was created with a previous compatible
version.
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Container Description

Restore cluster Enable to include the cluster server/node entries in the restore.
server/node entries from
backup.

Do not backup the existing Enable this option if you do not want to backup the existing databases
databases before this before performing a restore.
operation.

Shutdown/Reboot

Navigate to the Administration > Server Manager > Server Configuration page, and click on the Shutdown or
Reboot buttons to shutdown or reboot the node from the UL

Drop Subscriber

Navigate to the Administration > Server Manager > Server Configuration page, and click on the Drop Subscriber
button to drop a subscriber from the cluster. Note that this button is not seen in a single node deployment.

System Tab

Navigate to the Administration > Server Manager > Server Configuration page, and click on a server name in the
table. The Server Configuration form opens by default on the System tab.

Figure 250 Fig: System Tab

Administration » Server Manager » Server Configuration - cppm52

Server Configuration - cppm52 (10.100.8.52) & Import Updates
System Services Control Service System itoril Network rf

Hostname:

Policy Manager Zone: Manage Policy Manager Zones
Enable Profile: Enable to allow this node to perform endpoint classification

Enable Insight: Enable to use insight on this node

Management Port: Data/External Port:

1P Address: 10.100.8.52 10.2.152.178

Subnet Mask: 255 255 7550 255.255 2550

Default Gateway: 10.100.8.1 10.2.152.201

DNS Settings: Primary Secondary

IP Address: 10.100.8.82 10.1.1.200

AD Domains: Policy Manager is not part of any domain. Join to domain here Join AD Domain

4 Back to Server Configuration

Table 158: Server Configuration System tab

Container Description

Hostname Hostname of Policy Manager appliance. Itis not necessary to enter the fully qualified
domain name here.

Policy Select a previously configured timezone from the drop down menu. Click on the Policy
Manager Manager Timezone link to add and edit timezones from within this page.
Timezone

Enable Profile Enable the profile to perform endpoint classifications.
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Container Description

Enable Insight Enable the Insight reporting tool on this node. Note:

e When the admin enables the checkbox for Insight on a node in cluster, Admin will
automatically update the [Insight Repository] configuration to point to the
management IP of that server.

o When enabling the checkbox for other servers in the cluster, they will be added as
backups for the same auth source.

e The order of the primary and backup servers in the [Insight Repository] is the same
in which the user enables Insight on the server.

Management Managementinterface IP address. You access the Policy Manager Ul via the
Port: IP management interface.
Address

Management Management interface Subnet Mask
Port: Subnet
Mask

Management Default gateway for management interface
Port: Default
Gateway

Data/External Data interface IP address. All authentication and authorization requests arrive on the
Port: IP data interface.
Address

Data/External Data interface Subnet Mask
Port: Subnet
Mask

Data/External Default gateway for data interface
Port: Default
Gateway

DNS: Primary Primary DNS for name lookup

DNS

DNS: Secondary DNS for name lookup

Secondary

DNS

AD Domains Displays a list of joined active directory domains Select Join Domain to join an Active

Directory domain. See below.

Multiple Active Directory Domains

You can join CPPM to an Active Directory domain to authenticate users and computers that are members of an Active
Directory domain.

Users can then authenticate into the network using 802.1X and EAP methods, such as PEAP-MSCHAPv2, with their
own their own AD credentials.

Joining CPPM to an Active Directory domain creates a computer account for the CPPM node in the AD database.

If you need to authenticate users belonging to multiple AD forests or domains in your network, and there is no trust
relationship between these entities, then you must join CPPM to each of these untrusting forests or domains.
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There is no need to join CPPM to multiple domains belong to the same AD forest because a one-way trust relationship

exists between these domains. In thsi case, you join CPPM to the root domain.

Join Domain - Click on this button to join this Policy Manager appliance to an Active Directory domain.

Leave Domain - Click on this button to disassociate this Policy Manager appliance from an Active Directory domain.

For most use cases, if you have multiple nodes in the cluster, you must join each node to the same Active Directory

domain.

Figure 251 Join Active Directory Domain

Join AD Domain o

Enter the FQDN of the controller and the short (NETBIOS) name for the

domain:

Short Name

Password

Domain Controller | myad mydomain.com

In case of a controller name conflict

“ Use user-specified Domain Controller
-Z:I' Use Domain Controller returned by DNS query
@ Fail on conflict

Use default domain admin user [Administrator]

mydomain

Save Cancel

Table 159: Join AD Domain

Container Description

Domain Fully qualified name of the Active Directory domain controller
Controller
Short The short name or NETBIOS name of the domain. Enter this value only if this is different
Name - from your regular Active Directory domain name. If this is different from your domain name
NETBIOS (usually a shorter name), enter that name here. Contact your AD administrator about the
name NETBIOS name.
(optional) Note that if you enter an incorrect value for the NETBIOS name, you see a warning
message in the Ul. If you see this warning message, leave the domain by clicking on the
Leave Domain button (which replaces the Join Domain button once you join the domain.
After leaving the domain, join again with the right NETBIOS name.
Domain In some deployments (especially if there are multiple domain controllers, or if the domain
Controller name has been wrongly entered in the last step), the domain controller FQDN returned by
name the DNS query can be different from what was entered. In this case, you may:
conflict e Continue to use the domain controller name that you entered
e Use the domain controller name returned by the DNS query
e Abort the Join Domain operation.
Use Check this box to use the Administrator user name to join the domain
default
domain
admin
user
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Container Description

User User ID of the domain administrator account
Name

Password Password of the domain administrator account

Services Control Tab
From the Services Control tab, you can view a service status and control (stop or start) Policy Manager services.

Figure 252 Services Control Tab

Service Parameters System Monitoring Network Interfaces
Service Name Status Action
1. Async DB write service Running
2. Async network services Running
3. DB change notification server Running
4. DB replication service Running
5. Domain service Running
6. Policy server Running
7. Radius server Running
8. System auxiliary services Running
9. System monitor service Running
10. Tacacs server Running
( Back to Server Configuration

Service Parameters Tab

Navigate to the Service Parameters tab to change system parameters of the services.

Figure 253 Policy Server Service Parameters

System Services Control System Monitoring Network Interfaces
Select Service: |iPcI|cyserver H ,‘
Parameter Name Parameter Value Default Value
Machine Authentication Cache Timeout 86400 | seconds 86400
Authentication Thread Pool Size [20 | threads 20
LDAP Primary Retry Interval (600 | seconds 600
External Posture Server Thread Pool Size 5 | threads 5
External Posture Server Primary Retry Interval [600 | seconds 600
Audit SPT Default Timeout [600 | seconds 600
Number of request processing threads [4 | threads

Audit Primary Retry Interval (600 | seconds 600
Audit TP Lookup Session Timeout [120 | seconds 120

Table 160: Service Parameters tab - Policy Server

Sl Description

Parameter P

Machine This specifies the time (in seconds) for which machine authentication entries are
Authentication cached by Policy Manager

Cache Timeout

Authentication This specifies the number of threads to use for LDAP/AD and SQL connections.
Thread Pool Size
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Service

Description
Parameter P
LDAP Primary Once a primary LDAP server is down, Policy Manager connects to one of the backup
Retry Interval servers. This parameter specifies how long Policy Manager waits before it tries to

connect to the primary server again.

Server Thread
Pool Size

External Posture This specifies the number of threads to use for posture servers.

External Posture Once a primary posture server is down, Policy Manager connects to one of the

Default Timeout

Server Primary backup servers. This parameter specifies how long Policy Manager waits before it
Retry Interval tries to connect to the primary server again.
Audit SPT Time for which Audit success or error response is cached in policy server.

connect to the primary server again.

Number of Maximum number of threads used to process requests.

request

processing

threads

Audit Primary Once a primary audit server is down, Policy Manager connects to one of the backup
Retry Interval servers. This parameter specifies how long Policy Manager waits before it tries to

proceeding with audit

Audit IP Lookup Temporary session timeout returned for a request that triggers an audit, and Policy
Session Timeout Manager needs to lookup IP address for the MAC address of the host before

Figure 254 RADIUS Server Service Parameters

Administration » Server Manager » Server Configuration - testlab178

Server Configuration - testlab178 (10.2.50.178)

System | services Control  [EEERUREESIL VG  System Monitoring  Network Interfaces

& Import Updates

« Back to Server Configuration

mn

Select Service: [Redussever  [7]
Parameter Name Parameter Value Default Value Allowed Values
Proxy
Maximum Response Delay seconds H 15
Maximum Reactivation Time seconds 120 60-3600
Maximum Retry Counts retries H 2-10
Security
Reject Packet Delay seconds 1 0-5
Maximum Attributes attributes 200 0-512
Process Server-Status Request FALSE
Main
Authentication Port 1812, 1645
Accounting Port [813 ) 1813, 1646
Maximum Request Time seconds 30 5-120
Cleanup Time seconds s 210 4
Local DB Authentication Source Connection Count 32 5-150
AD/LDAP Authentication Source Connection Count 64 5-300
SQL DB Authentication Source Connection Count 32 5-100
EAP-TLS Fragment Size bytes 1024 512-1500
Use Inner Identity in Access-Accept Reply [FasE  [¢] FALSE
TLS Session Cache Limit sessions 10000 1000-100000

Table 161: Service Parameters tab - Radius server

Service
Parameter

Description

Proxy
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Service
Parameter

Maximum
Response
Delay

Description

Time delay before retrying a proxy request, if the target server has not responded

Maximum
Reactivation
Time

Time to elapse before retrying a dead proxy server

Maximum Retry
Counts

Maximum number of times to retry a proxy request if the target server doesn't respond

Security

Reject Packet Delay time before sending an actual RADIUS Access-Reject after the server decides
Delay to reject the request

Maximum Maximum number of RADIUS attributes allowed in a request

Attributes

Process Server-
Status Request

Send replies to Status-Server RADIUS packets.

Main
Authentication Ports on which radius server listens for authentication requests. Default values are
Port 1645, 1812

Accounting Port

Ports on which radius server listens for accounting requests. Default values are 1646,
1813

Maximum
Request Time

Maximum time allowed for a processing a request after which itis considered timed
out

Cleanup Time

Time to cache the response sentto a RADIUS request after sending it. If the RADIUS
server gets a duplicate request for which the response is already sent, the cached
response is resent if the duplicate request arrives within this time period.

Local DB
Authentication
Source
Connection
Count

Maximum number of Local DB DB connections opened

AD/LDAP
Authentication
Source
Connection
Count

Maximum number of AD/LDAP connections opened
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Service
Parameter

SQL DB
Authentication
Source
Connection
Count

Description

Maximum number of SQL DB

EAP - TLS
Fragment Size

Maximum size of the EAP-TLS fragment size.

Use Inner
Identity in
Access-Accept
Reply

Specify TRUE or FALSE

TLS Session Number of TLS sessions to cache before purging the cache (used in TLS based
Cache Limit 802.1X EAP Methods)

Thread Pool

Maximum Maximum number of threads in the RADIUS server thread pool to process requests
Number of

Threads

Number of Initial

Initial number of thread in the RADIUS server thread pool to process requests

Threads

EAP-FAST

Master Key Lifetime of a generated EAP-FAST master key

Expire Time

Master Key Grace period for a EAP-FAST master key after its lifetime. If a client presents a PAC
Grace Time thatis encrypted using the master key in this period after its TTL, itis accepted and a

new PAC encrypted with the latest master key is provisioned on the client

PACs are valid
across cluster

Whether PACs generated by this server are valid across the cluster or not

Accounting

Log Accounting
Interim-Update
Packets

Store the Interim-Update packets in session logs.

Figure 255 TACACS+ Service Parameters

System Services Control System Monitoring Network Interfaces
Select Service: |"Tacacs server -‘
Parameter Name Parameter Value Default Value
TACACS+ Profiles Cache Timeout 86400 | seconds 86400
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Table 162: Service Paramters tab - TACACS server

Service Parameter Description
TACACS+ Profiles This specifies the time (in seconds) for which TACACS+ profile result entries
Cache Timeout are cached by Policy Manager

You can use the ClearPass system service parameters for PHP configuration as well as if all your http traffic flows

through a proxy server. Policy Manager relies on an http connection to the Aruba update portal in order to download
the latest version information for posture services.

Figure 256 ClearPass System Services Parameters

System Services Control System Monitoring Network Interfaces

Select Service: | ClearPass system services [+]
Parameter Name Parameter Value Default Value Allowed Values
PHP System Configuration
Memory Limit Megabytes 256 256-1024
Form POST Size Megabytes 10 1-256
File Upload Size Megabytes 5 1-256
Input Time seconds 60 0-600
Socket Timeout seconds 60 5-600
Enable zlib output compression FALSE
Include PHP header in web server response TRUE
HTTP Proxy
Proxy Server I:l
Port 3128
Username l:l
Password I:l

Table 163: Service Parameters - ClearPass system services

Service Parameter Description

PHP System Configuration

Memory Limit

Maximum memory that can be used by the PHP applications.

Form POST Size

Maximum HTTP POST content size that can be sent to the PHP
application.

File Upload Size

Maximum file size that can be uploaded into the PHP application.

Input Time

Time limit after which the server will detect no activity from the user
and will take some action.

Socket Timeout

Maximum time for any socket connections.

Enable zlib output compression

Setting to compress the output files.

Include PHP header in web
server response

Setting to include PHP header in the HTTP responses.

HTTP Proxy

Proxy Server

Hostname or IP address of the proxy server
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Service Parameter Description

Port Port at which the proxy server listens for HTTP traffic
Username Username to authenticate with proxy server
Password Password to authenticate with proxy server

The ClearPass Network Services parameters aggregate service parameters from the following services:

e DhcpSnooper Service

e Snmp Service
o WebAuth Service

e Posture Service

Figure 257 ClearPass Network Services Parameters

Parameter Name

Select Service: ClearPass network services ﬂ

Parameter Value

Default Value

Allowed Values

DhcpSnooper

MAC to IP Request Hold time
DHCP Request Probation Time
SnmpService

SNMP Timeout

SNMP Retries

LinkUp Timeout

1P Address Cache Timeout

Uplink Port Detection Threshold
SNMP v2c Trap Community

SNMP v2 Trap Username

SNMP v3 Trap Authentication Protocol
SNMP v3 Trap Privacy Protocol
SNMP v3 Trap Authentication Key
SNMP v3 Trap Privacy Key
Device Info Poll Interval

WebAuthService

PostureService

Audit Thread Pool Size

Max time to determine network device where client is connected

seconds
M seconds

seconcs

seconds
seconcs

minutes
seconds

[0 Jthreads

public

aruba

60-300
10-60

2-30
1-5
3-15
12-1200
0-20

10-1500

0-100

5-40

Table 164: Service Parameters - ClearPass network services

Sl Description

Parameters P

DhcpSnooper

MAC to IP Number of seconds to wait before responding to a query to get IP address

Request Hold corresponding to a MAC address. Any DHCP message received in this time period will

time refresh the MAC to IP binding. Typically, audit service will request for a MAC to IP
mapping as soon the RADIUS request is received, but the client may take some more
time receive and IP address through DHCP. This wait period takes into account the
latest DHCP IP address that the client got

Request
Probation

DHCP Number of seconds to wait before considering the MAC to IP binding received in a

DHCPREQUEST message as final. This wait would handle cases where client receives
a DHCPNAK fora DHCPREQUEST and receives a new IP address after going through
Time the DHCPDISCOVER process again

SnmpService
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Service

Description
Parameters P
SNMP Seconds to wait for an SNMP response from the network device
Timeout
SNMP Retries | Number of retries for SNMP requests
LinkUp Seconds to wait before processing link-up traps. If a MAC notification trap arrives in this
Timeout time, SNMP service will not try to poll the switch for MAC addresses behind a port for
link-up processing
IP Address Duration in seconds for which MAC to IP lookup response is cached
Cache
Timeout
Uplink Port Limit for the number of MAC addresses found behind a port after which the portis
Detection considered an uplink port and not considered for SNMP lookup and enforcement
Threshold
SNMP v2c Community string that must be checked in all incoming SNMP v2 traps
Trap
Community
SNMP v3 SNMP v3 Username to be used for all incoming traps
Trap
Username
SNMP v3 SNMP v3 Authentication protocol for traps. Must be one of MD5, SHA or empty (to
Trap disable authentication)
Authentication
Protocol
SNMP v3 SNMP v3 Privacy protocol for traps. Must be one of DES_CBC, AES_128 or empty (to
Trap Privacy disable privacy)
Protocol
SNMP v3 SNMP v3 authentication key and privacy key for incoming traps
Trap
Authentication
Key
SNMP v3
Trap Privacy
Key
Device Info This specifics the time (in minutes) between polling for device information.
Poll Interval
PostureService
Audit Thread This specifies the number of threads to use for connections to audit servers.
Pool Size
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Service

Description
Parameters P
Audit Result This specifies the time (in seconds) for which audit result entries are cached by Policy
Cache Manager
Timeout
Audit Host This specifies the number of seconds for which Policy Manager pings an end-host
Ping Timeout before giving up and deeming the host to be unreachable.

WebAuthService
Max time to In some usage scenarios where the web authentication request does not originate from
determine the network device. Policy Manager has to determine the network device to which the
network clientis connect through an out-of-band SNMP mechanism. The network device
device where deduction can take some time. This parameter specifies the maximum time to wait for
clientis Policy Manager to determine the network device to which the clientis connected.
connected

Figure 258 System Monitor Service Parameters

P ———— P [—r—
Select Service: System monitor service [v]

Parameter Name Parameter Value Default Value
Free Disk Space Threshold 30 % 30

1 Min CPU load average Thrashold % 3

5 Min CPU load average Threshold % 2

15 Min CPU load average Threshold [ T 1

Table 165: Services Parameters tab - System monitor service

Service
Parameter

Description

Free Disk This parameter monitors the available disk space. If the available disk free space falls
Space below the specified threshold (default 30%), then system sends SNMP traps to the
Threshold configured trap servers.

1 Min CPU These parameters monitor the CPU load average of the system, specifying thresholds for
load 1-min, 5-min and 15-min averages, respectively. If any of these loads exceed the
average associated maximum value, then system sends traps to the configured trap servers.
Threshold

5 Min CPU
load
average
Threshold

15 Min
CPU load
average
Threshold

System Monitoring Tab

Navigate to the System Monitor tab to configure the SNMP parameters. This ensures that external Management
Information Base (MIB) browsers can browse the system level MIB objects exposed by the Policy Manager appliance.
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Figure 259 System Monitoring Tab

System Services Control Service Parameters System Monitoring Network Interfaces

System Location: [

System Contact: [

SNMP Configuration:

Version: liv3 i
User Name: [ |
Security Level: | NDAUTH_NOPRIV -
Authentication Protocol: ‘ MD5 ‘

Authentication key: [

| verify: [ ]

Privacy Protocol: ‘ DES

Privacy Key: [

| verify: [ ]

System Services Control Service Parameters System Monitoring Network Interfaces

System Location: [

System Contact: [

SNMP Configuration:

Version: 2

Community String: [esssee

| verify: seseee

Table 166: System Monitoring tab details

Service Parameter Description

System Location

System Contact

Policy Manager appliance location and contact information

Community String

SNMP Configuration: V1,V2C or V3
Version
SNMP Configuration: Read community string.

SNMP Configuration:
SNMP v3: Username

Username to use for SNMP v3 communication

Authentication Protocol

SNMP Configuration:
SNMP v3:
Authentication key

SNMP Configuration: One of NOAUTH_NOPRIV (no authentication or privacy), AUTH_NOPRIV
SNMP v3: Security (authenticate, but no privacy), AUTH _PRIV (authenticate and keep the
Level communication private)

SNMP Configuration: Authentication protocol (MD5 or SHA) and key

SNMP v3:

SNMP Configuration:
SNMP v3: Privacy
Protocol

SNMP Configuration:
SNMP v3: Privacy Key

Privacy protocol (DES or AES) and key
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Network Tab

Navigate to the Network tab to create GRE tunnels and VLANSs related to guest users and to control
what applications have access to the node..

Figure 260 Network Interfaces Tab

System Services Control Service Parameters System Monitoring
GRE Tunnels: No GRE Tunnel created on this node
VLANs: No VLANs present
Application Access Control: No Access Restrictions added to this node

(Back to Server Configuration <
Save Cancel

Creating GRE tunnels

The administrator can create a generic routing encapsulation (GRE) tunnel. This protocol can be used to
create a virtual point-to-point link over standard IP network or the internet.

Navigate to the Network tab and click Create Tunnel.

Figure 261 Creating GRE Tunnel

Create Tunnel o

Display Name
Local Inner IP
Remote Outer IP

Remote Inner IP

Table 167: Creating GRE Tunnel

Container Description

Display Name Optional name for the tunnel interface. This name is used to identify the tunnel in the list
of network interfaces.

Local Inner IP Local IP address of the tunnel network interface.

Remote Outer IP address of the remote tunnel endpoint.
IP

Remote Inner Remote IP address of the tunnel network interface.
IP Enter a value here to automatically create a route to this address through the tunnel.

Create/Cancel | Commitor dismiss changes.
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Creating VLAN
Navigate to the Network tab and click Create VLAN.

Figure 262 Creating VLAN
s ——————————————

Physical Interface

1 10.15.212.91 [MGMT] [+]

VLAN Name

VLAN ID
IP Address

Netmask

Table 168: Creating VLAN Parameters

Parameter Description

Physical The physical port on which to create the VLAN interface. This is the interface through
Interface which the VLAN traffic will be routed.

VLAN Name Name for the VLAN interface. This name is used to identify the VLAN in the list of
network interfaces.

VLAN ID 802.1Q VLAN identifier. Enter a value between 1- 4094.
The VLAN ID cannot be changed after the VLAN interface has been created.

IP Address IP address of the VLAN.

Netmask Netmask for the VLAN.

Create/Cancel | Commit or dismiss changes.

Your network infrastructure must support tagged 802.1Q packets on the physical interface selected. VLAN ID 1 is often
reserved for use by certain network management components; avoid using this ID unless you know it will not conflict
with a VLAN already defined in your network.

Defining Access Restrictions

Use this function to define specific network resources and allow or deny them access to specific applic-
ations. You can create multiple definitions. Navigate to the Network tab and click Restrict Access.
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Figure 263 Restrict Access dialog box

Restrict Access o

Resource Name - Select - -
Access Allow -
Network Deny access for all except -

s

-

Mote: Network supports Hostname [/ IP Address / IP Subnet only

Cancel

Table 169: Restrict Access Parameters

Parameter Description

Eg;o;rce Select the applicvation you want to allow or deny access to.
Select:
Access o Allow to define allowed access

o Deny to define denied access.

Enter one or more hostnames, IP addresses, or UP subnets, separated by commas. The
Network devices defined by what you enter here will be either specifically allowed or specifically
denied access to the application you select.

Log Configuration

The Policy Manager Log Configuration menu at Administration > Server Manager > Log Configuration provides
the following interface for configuration:
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Figure 264 Log Configuration (Services Level tab)

Log Configuration

Select Service:

Default Log Level:

Module Name
Rules Engine
Xpip Server
Database
AD/LDAP
Request Handling

Common Framework

5 (G PG Fsa g R E

Audit Server support
10. SOAP API

Administration » Server Manager » Log Configuration

Service Log Configuration System Level

Select Server:| 10 2 50178 El

Policy senver |Z|
Module Log Level Settings: Enable to override default log level
WARN

External Posture Validation INFO
Internal Posture Validation INFO

Log Level
WARN
WARN
INFO
INFO
INFO
INFO

INFO
INFO

[ [ [ 5 B [ B [ [ E]

Table 170: Log Configuration (Services Level tab)

Container Description

Select Server Specify the server for which to configure logs. All nodes in the cluster appear in the drop

down list.
Select Specify the service for which to configure logs.
Service
Module Log Enable this options to set the log level for each module individually (listed in decreasing
Level level of verbosity. For optimal performance you must run Policy Manager with log level
Settings setto ERROR or FATAL):

e DEBUG

e INFO

e WARN

e ERROR

e FATAL

If this option is disabled, then all module level logs are set to the default log level.
Default Log This drop down is available if the Module Log Level Settings option is disabled. This
Level sets the default logging level for all modules. Available options include the following:

e DEBUG

e INFO

e WARN

e ERROR

FATAL

Set this option first, and then override any modules as necessary.
Module If the Module Log Level Settings option is enabled, select log levels for each of the
Name & Log available modules (listed in decreasing level of verbosity):
Level e DEBUG

e INFO

e WARN

e ERROR

e FATAL
Restore Click Save to save changes or Restore Defaults to restore default settings.
Defaults/Save
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Figure 265 Log Configuration (System Level tab)

Administration » Server Manager » Log Configuration
Log Configuration
Select Server:[ 102 50178 E
Service Log Configuration Eﬁgl
Number of log files: 6 (default is & files)
Limit each log file size to: 10 MB (default is 10 MB)
Syslog Settings:
Syslog Server:
Syslog Server Port: 514 (default is 514)
Service Name Enable Syslog Syslog Filter Level
1. Policy server o WARN
2. Radius server o WARN
3.  Tacacs server ] WARN
4. Admin server ] WARN
5.  Syslog client service ] WARN
6.  ClearPass network services o WARN

Table 171: Log Configuration (System Level tab)

Container Description

Select Server Specify the server for which to configure logs.

Number of Specify the number of log files of a specific module to keep at any given time. When a
log files log file reaches the specified size (see below), Policy Manager rolls the log over to
another file until the specified number of log files is reached; once this log files exceed
this number, Policy Manager overwrites the first numbered file.

Limiteach log | Limiteach log file to this size, before the log rolls over to the next file
file size to

Syslog Server | Specify the syslog server and port number. Policy Manager will send the configured
Syslog Port module logs to this syslog server.

Service For each service, you can select the Enable Syslog check box and then override the
Name Syslog Filter level. The current Syslog Filter level is based on the default log level
Enable specified on the Service Log Configuration tab.

Syslog

Syslog Filter

Level

Restore Click Save to save changes or Restore Defaults to restore default settings.

Defaults/Save

Local Shared Folders

To view backup files, log files, and generated reports, navigate to Administration > Server Manager > Local Shared
Folders.

Select the specific folder from the Select folder drop-down list. Currently supported folder types are listed below:

e Backup files - Database backup files backed up manually (tar.gz format)
e Log files - Log files backed up via the Collect Logs mechanism (tar.gz format)

e Generated Reports - Historical reports auto-generated on a configured schedule from the Reporting screens (PDF
and CSV formats)

e Automated Backup files - Database backup files backed up automatically on a daily basis (tar.gz format)

Select any file in the list to download it to your local machine. The browser download box appears.
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Figure 266 Local Shared Folders
Administration » Server Manager » Local Shared Folders

Local Shared Folders

Selact folder:|Backup files

Logfiles
Generated Reports
Automated Backup files

# File Name File Size Last Modified Time
1.‘ tips-db-backup- 2009-03- 25- 15- 16-49. tar.gz 3.08 MB T::rlé?éfg%g_r
2.‘ eTIPS_Backup_Mar24.tar.gz 2.95 MB Tf:rgéf’lszg%?r
3.‘ restore-2009-03-20-00- 16-07-backup.tar.gz 325.23 KB Tf:rlé?agg%g_r
4.‘ setup-2009-03- 20-00-05-40-backup. tar.gz 0.54 KB T;:roé?:ng%?r

The Administration > Server Manager > Licensing page shows all the licenses that have been activated for the entire
CPPM cluster. You mist have a ClearPass Policy Manager base license for every instance of the product. You can:

e Adding a License
e Activating an Application License

e Updating a License

On a VM instance of CPPM, the permanent license must be entered.

These licenses are listed in the tables on the License Summary tab. There is one entry per server node in the cluster. All
application licenses are also listed on the Applications tab.

In this release, you can add and activate OnGuard, Guest, Onboard, and Enterprise application licenses. The Summary
section shows the number of purchased licenses for Policy Manager, OnGuard,Guest, and Onboard.

Figure 267 Licensing Page - License Summary tab

¥ Add License

Servers

Cluster License Summary

Licanse Type Total Count Used Count Updated At
1 PolicyManager 5000 264 2012/09/27 00:06:51
2 onGuard 100 1 2012/09/27 00:06:51
3 ClearPass Enterprise 25 1 2012/09/27 00:06:51

Note: The ClearPass Enterprise license count is inclusive of 25 endpoints for each server node.

Server License Summary

Server License Type Total Count Used Count updated At

1 PolicyManager 5000 264 2012/09/27 00:06:51
2 OnGuard 100 1 2012/09/27 00:06:51
3 ) ClearPass Enterprise 25 1 2012/09/27 00:06:51

Figure 268 Licensing Page - Servers tab

License Summary E!a!! Applications
# Server IP Address Product License Type Native Number of i Duration i i Status License Added On
1| Policy Manager Permanent  No 5000 2 years @ Activated Mar 11, 2013 12:13:42 PDT

If the number of licenses used exceeds the number purchased, you will see a warning four months after the number is
exceeded. The licenses used number is based on the daily moving average.

Adding a License

You can add a license by clicking the Add License button on the top right portion of this page.
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Figure 269 Add License dialog box

Product: ClearPass Enterprise -

License Key

Terms and Conditions

Aruba Networks, Inc. End-User Software License Agreement (“Agreement”)
IMPORTANT

YOU SHOULD CAREFULLY READ THE FOLLOWING TERMS BEFORE INSTALLATION OR USE OF ANY
SOFTWARE PROGRAMS FROM ARUBA NETWORKS, INC. AND ITS AFFILIATES OR AIRWAVE
WIRELESS (COLLECTIVELY, "ARUBA"). INSTALLATION OR USE OF SUCH SOFTWARE PROGRAMS
SHAIL BE DEEMEDN T COMETRM YOI IR ACCEDTAMCE OF THESE TERMS TE THESE TERMS ARE

I agree to the above terms and conditions.

Cancel

Table 172: Add a License

Container Description

Product Select a product from the drop down menu.
License Enter the license key for the new license.
Key

Terms and Read the Terms and Conditions before adding a license. You must select the | agree to the
Conditions above terms and conditions check box to enable the Add button.

Activating an Application License

Adding an application license adds an Application tab on the Licensing page. Once you add or update an application
license, it must be activated.

To activate a license

1. Go to Administration > Server Manager > Licensing.

2. Click the Applications tab.

@ Activated Sep 26, 2012 17:26:54 PDT
Guest Permanent 100 - @ Activated  Sep 26, 2012 17:25:40 PDT
Onboard Permanent 100 = |® activare | sep 26, 2012 17:25:15 poT

3. Click Activate in the Activation Status column.
4. Click OK.

Updating a License

Licenses typically require updating when they expire (for example, in the case of an evaluation license) or when
capacity exceeds its licensed amount. You update an application's license by entering a new license key.

To update a license

1. Go to Administration > Server Manager > Licensing.

2. Click the Applications tab.
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3. Click an application anywhere except in the Activation Status column. The Update License dialog box appears.

Update License o

0ld License Key C63M-IM775F-IMCM-FPMGYW-HEPPKS- 21IV-EHIYIM-F4PTEP-RSZC-J7NG3A

MNew License Key

Terms and Conditions

o

Aruba Networks, Inc. End-User Software License Agreement (“Agreement™)
IMPORTANT

YOU SHOULD CAREFULLY READ THE FOLLOWING TERMS BEFORE INSTALLATION OR USE OF ANY

SOFTWARE PROGRAMS FROM ARUBA NETWORKS, INC. AND ITS AFFILIATES OR AIRWAVE

WIRELESS (COLLECTIVELY, "ARUBA™). INSTALLATION OR USE OF SUCH SOFTWARE PROGRAMS
Hall BE DEEMED TO COKMETRM YOI IR ACCERPTAMCE OF THESE TERM IE THESE TERMS ARF

1 agree to the above terms and conditions.

Cancel

4. Enter the New License Key.
5. Read the Terms and Conditions, then select the I agree to the above terms and conditions check box.
6. Click Update.

Policy Manager sends SNMP traps that expose the following server information:

e System uptime. Conveys information about how long the system is running
e Network interface statistics [up/down]. Provides information if the network interface is up or down.

o Process monitoring information. Check for the processes that should be running. Maximum and minimum number
of allowed instances. Sends traps if there is a change in value of maximum and minimum numbers.

o Disk usage.Check for disk space usage of a partition. The agent can check the amount of available disk space, and
make sure it is above a set limit. The value can be in % as well. Sends traps if there is a change in the value.

e CPU load information. Check for unreasonable load average values. For example if | minute CPU load average
exceeds the configured value [in percentage] then system would send the trap to the configured destination.

e Memory usage. Report the memory usage of the system.

The Policy Manager SNMP Trap Configuration page at Administration > External Servers > SNMP Trap Receivers
provides the following interfaces for configuration:

e "Add SNMP Trap Server " on page 274

e '"Import SNMP Trap Server " on page 275

e "Export all SNMP Trap Servers " on page 275

e "Export a Single SNMP Trap Server " on page 275

Figure 270 SNMP Trap Receivers Listing Page

Administration » External Servers » SNMP Trap Receivers
SNMP Trap Receivers 9" Add SNMP Trap Server
£, Import SNMP Trap Server
&, Export SNMP Trap Server
@ Select ALL matches @ Select ANY match

Filter: Host Address ~ contains 192
Filter: Description ~ contains snmp = Clear Filter Show 10~ records|
# [[] Host Address & Description
1.| B 192.168.150.3 Trap Receiver 1
2.0 @ 192.168.150.8 SNMP Trap Receiver 2

Showing 1-2 of 2
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Table 173: SNMP Trap Receivers

Container Description

Add Trap Opens the Add Trap Server popup.
Server
Import Trap Opens the Import Trap Server popup.
Server
Export Trap Opens the Export Trap Server popup.
Server
Export Opens the Export popup.
Delete To delete an SNMP Trap Configuration, select it (using the check box at the left), and
then click Delete.
Add SNMP Trap Server

To add a trap server, navigate to Administration > External Servers > SNMP Trap Receivers and select the Add
SNMP Trap Server link.

Figure 271 Add SNMP Trap Server

Add SNMP Trap Server o

Host Address:

Description: CentralView SNMP Trap
Receiver
SNMP Version: | VIC v|
Community String: [eeese | verify: [esese |
Server Port:

[192.168.24.33 |

Save || Cancel

Table 174: Add SNMP Trap Server fields

Container Description

Host Address Trap destination hostname or ip address.
NOTE: This server must have an SNMP trap receiver or trap
viewer installed.

Description Freeform description.

SNMP Version V1 orV2C.

Community String /Verify Community string for sending the traps.

Community String

Server Port Port number for sending the traps; by default, port 162.
NOTE: Configure the trap server firewall for traffic on this port.
Save/Cancel Click Save to commit the configuration or Cancel to dismiss.
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Import SNMP Trap Server

To import a trap server, navigate to Administration > External Servers > SNMP Trap Receivers and select the
Import SNMP Trap Server link.

Figure 272 Fig: Import SNMP Trap Server

Import from file

Select File:

Enter secret for the file (if any):

Table 175: Import SNMP Trap Server

Container Description

Select File Browse to the SNMP Trap Server configuration file to be imported.

Enter secret for the file (if If the file was exported with a secret key for encryption, enter the same key
any) here.

Import/Cancel Click Import to commit, or Cancel to dismiss the popup.

Export all SNMP Trap Servers

To export all SNMP trap servers, navigate to Administration > External Servers > SNMP Trap Receivers and select
the Export SNMP Trap Server link. This link exports all configured SNMP Trap Receivers. Click Export Trap
Server. Your browser will display its normal Save As dialog, in which to enter the name of the XML file to contain
the SNMP trap server configuration.

Export a Single SNMP Trap Server

To export a single SNMP trap servers, navigate to Administration > External Servers > SNMP Trap Receivers.
Select the SNMP Trap server that you want to export (using the check box at the left) and click the Export button in
the lower-right comer of the page. Your browser will display its normal Save As dialog, in which to enter the name of
the XML file to contain the export.

Syslog Targets

Policy Manager can export session data (seen in the Access Tracker ), audit records (seen in the Audit Viewer) and
event records (seen in the Event Viewer ). This information can be sent to one or more syslog targets (servers). You
configure syslog targets from this page.

The Policy Manager Syslog Targets page at Administration > External Servers > Syslog Targets provides the following
interfaces for configuration:

e "Add Syslog Target " on page 276

e '"Import Syslog Target " on page 276
e "Export Syslog Target " on page 277
e "Export " on page 277
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Figure 273 Syslog Target Listing Page

Administration » External Servers » Syslog Targets
Syslog Targets “F Add Syslog Target
ysiog 9 & Import Syslog Target
Export Syslog Target
© Select ALL matches © Select ANY match

~ contains 192

~ contains kii = ® Clear Filter show 10+ records

Host Address A e |

B 10.6.132.138 Kiwi syslog target

 192.168.5.233 My Test Syslog Target

1
2.
showing 1-2 of 2 Export_|[_Detete

Table 176: Syslog Target Configuration

Container Description

Add Syslog Target Opens the Add Syslog Target popup.

Import Syslog Target Opens the Import Syslog Target popup.

Export Syslog Target Opens the Export Syslog Target popup.

Export Opens the Export popup.

Delete To delete a Syslog Target, select it (check box at left) and click Delete.
Add Syslog Target

To add a Syslog Target, navigate to Administration > External Servers > Syslog Targets and select Add Syslog
Target.

Figure 274 Add Syslog Target

Add Syslog Target o

Host Address: [192.168.12.44 |
Description: Kangaroo Syslog Target]
Server Port: [514 |

Save J Cancel

Table 177: Add Syslog Target

Host Address Syslog server hostname or IP address.

Description Freeform description.

Server Port Port number for sending the syslog messages; by default, port 514.

Save/Cancel Click Save to commit the configuration or Cancel to dismiss.
Import Syslog Target

Navigate to Administration > External Servers > Syslog Targets and select Import Syslog Target.
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Figure 275 Import Syslog Target

Import from file

Select File:

Enter secret for the file (if any):

Table 178: Import from file

Container Description

Select File Browse to the Syslog Target configuration file to be imported.
Enter secret for the file (if If the file was exported with a secret key for encryption, enter the same key
any) here.
Import/Cancel Click Import to commit, or Cancel to dismiss the popup.
Export Syslog Target

Navigate to Administration > External Servers > Syslog Targets and select the Export Syslog Target link.

The Export Syslog Target link exports all configured syslog targets. Click Export Syslog Target. Your browser will
display its normal Save As dialog, in which to enter the name of the XML file to contain the Syslog Target
configuration.

Export
Navigate to Administration > External Servers and select the Syslog Targets button.

To export a syslog target, select it (check box at left) and click Export. Your browser will display its normal Save As
dialog, in which to enter the name of the XML file to contain the export.

Syslog Export Filters

Policy Manager can export session data (seen in the Access Tracker ), audit records (seen in the Audit Viewer) and
event records (seen in the Event Viewer ). You configure Syslog Export Filters to tell Policy Manager where to send
this information, and what kind of information should be sent (through Data Filters).

The Policy Manager Syslog Targets page at Administration > External Servers > Syslog Targets provides the
following interfaces for configuration:

e "Add Syslog Filter " on page 278

e '"Import Syslog Filter " on page 280
e "Export Syslog Filter " on page 280
e "Export " on page 280
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Figure 276 Syslog Filters Listing page

Administration » External Servers » Syslog Export Filters

Syslog Export Filters

© Select ALL matches © Select ANY match

Filter: Name ~ contains syslog

Filter: Description + contains failed =

Filter: Export Template + contains session =

Fiter: Status R o R—
# [ Name& Description

% Add Syslog Fiter
& Import Syslog Filter
& Export Syslog Filter

Show 10~ records

Export Template Status

[]  Audit Syslog Server

Bl Failed Authentications Stream This s the syslog export filter to stream all the failed
authetications to syslog target

[]  Failed Requests Stream Stream all failed requests to external syslog

This is the syslog export filter to stream all the logged in

) togged in Session Stream session information to the syslog target.

o

Syslog Accounting

Sl > BN B

[0 Syslog Export Filter for Audit

Showing 1-6 of 6

Table 179: Syslog Export Filters Configuration

Audit Records
Session Logs
Session Logs
Session Logs

Session Logs
Audit Records

Container Description

Add Syslog

Filter Filters > Add).

Opens Add Syslog Filter page (Administration > External Servers > Syslog Export

Import Syslog
Filter

Opens Import Syslog Filter popup.

Export Syslog
Filter

Opens Export Syslog Filter popup.

Enable/Disable

Click the toggle button Enable/Disable to enable or disable the syslog filter.

Export Opens Export popup.

Delete

To delete a Syslog Filter, select it (check box at left) and click Delete.

Add Syslog Filter

To add a Syslog Filter, navigate to Administration > External Servers > Syslog Filters > Add Syslog Filter. Refer to

the following image.

Figure 277 Add Syslog Filters (General tab)

Administration » External Servers » Syslog Export Filters » Add

Syslog Export Filters

Filter and Columns Summary
Mame: |Passed Radius requests |

Description: Stream passed radius requests to syslog

Export Template: ‘ Session Logs El

Syslog Server: [ 1921685233

‘ Back to Syslog Filters

] T

Add new Syslog target
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Table 180: Syslog Export Filters Configuration

Container Description

Name/Description

Freeform label.

Export Template

Session Logs, Audit Records or System Events

Syslog Server

A drop down list shows all Syslog Targets configured. (Refer to "Add Syslog
Target" on page 276).

Modify/Add new
syslog target

Click to Modify the selected syslog target, or select the Add new syslog target link
to add a new syslog target.

Save/Cancel

Click Save to commit the configuration or Cancel to dismiss.

If you selected Session Logs as the export termplate in the General tab, a new tab Filter and Columns appears. In this
tab you specify the Data Filter (See Adding Data Filters) you want to use. Specifying a data filter filters the rows that

are sent to the syslog target. You may also select the columns that are sent to the syslog target.

This form provides two methods for configuring data filters. Option 1 allows you to choose from pre-defined field

groups and to select columns based on the Type. Option 2 allows you to create a custom SQL query. You can view a

sample template for the custom SQL by clicking the link below the text entry field.

We recommend that users who choose the Custom SQL method contact Support. Support can assist you with entering
the correct information in this template.

Figure 278 Add Syslog Filters (Filter and Columns tab)

Syslog Export Filters

(LI Filter and Columns  [JEETETETS

Administration » External Servers » Syslog Export Filters » Add

Fnr common use-cases, select Data Filter and Columns for export:

Data Filter: | [AllRequests]

Columns Selection: Predefined Field Groups -

Add new Data filter

=
Selected Columns -

Logged in users -

Failed Authentications B

RADIUS Accounting

TACACS+ Administration <
Available Columns -
R —

Common Alerts -

Common Alerts-Present B
Commen.AuditPosture- Token

Commen Auth-Type

Common.Connection-Status

Commen Enforcement-Profiles

Common Error-Code -

Fnr advanced use-cases, specify custom SQL query for export :

Custom SQL:

MAC-Addre:

" I8 framad in

A,

SELECT "Common.Username”, "Common.Service", "Common.Roles", "Common.Host-
MAC-Address", "RADIUS.Acct-Framed-IP-Address”, "Common.NAS-1P- Address”,
"Commaon.Request-Timestamp”, "Common.Alerts" FROM dblink (--DB- CONNECTION-
STRING--, 'SELECT T1.user_name as "Common.Username", T1.service_name as
"Common.Service”, T3.roles as "Common.Roles", T1.host_mac as "Common.Host-
"RANNIS Acct-Framad-1P- Address”

4 Back to Syslog Filters

As an example,| click here to copy a sample SQL

Next > Save J Cancel

Table 181: Add Syslog Filters (Filter and Columns tab)

Container Description

Data Filter Specify the data filter. The data filter limits the type of records sent to syslog target.
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Container Description

Modify/ Modify the selected data filter, or add a new one.

Add new

Data filter

Columns This provides a way to limit the type of columns sent to syslog.

Selection There are Predfined Field Groups, which are column names grouped together for quick

addition to the report. For example, Logged in users field group seven pre-defined columns.
When you click Logged in users the seven columns automatically appear in the Selected
Columns list.

Additional Fields are available to add to the reports. You can select the type of attributes
(which are the different table columns available in the session database) from the Available
Columns Type drop down list. Policy Manager populates these column names by extracting
the column names from existing sessions in the session database. After you select a
column from the Available Columns Type, the columns appear in the box below. From here
you can click >> to add the selected column to the Selected Columns list. Click << to
remove a column from the Selected Columns list.

Import Syslog Filter

Navigate to Administration > External Servers > Syslog Filters > Import Syslog Filter.

Figure 279 Import Syslog Filter

Import from file

Select File:

Enter secret for the file (if any):

Table 182: Import from File

Container Description

Select File Browse to the Syslog Filter configuration file to be imported.

Enter secret for the file (if If the file was exported with a secret key for encryption, enter the same key
any) here.

Import/Cancel Click Import to commit, or Cancel to dismiss the popup.

Export Syslog Filter
Navigate to Administration > External Servers > Syslog Filters and select the Export Syslog Filter link.

The Export Syslog Filter link exports all configured syslog filters. Click Export Syslog Filter. Your browser will
display its normal Save As dialog, in which to enter the name of the XML file to contain the Syslog Filer
configuration.

Export

Navigate to Administration > External Servers > Syslog Filters and select Export button.
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To export a syslog filter, select it (check box at left) and click Export. Your browser will display its normal Save As

dialog in which to enter the name of

Messaging Setup

the XML file to contain the export.

The Policy Manager Messaging Setup menu at Administration > Server Manager > Messaging Setup provides the

following interface for configuration:

Figure 280 Messaging Setup (SMTP Servers)

Administration » External Servers » Messaging Setup

Messaging

SMTP Servers Mobile Service Providers

Common SMTP settings

Server name:

Configure the SMTP mail servers for email and SMS notifications : Select Server : | 192.168.5.217 El
Use the same settings for sending both emails and SMSes
| [ use s5L
] port:

User Name:

Password:

| I Show Password Connection timeout: E seconds

Default from address:

Save

Table 183: Messaging Setup (SMTP Servers tab)

Container Description

Select Server

Specify the server for which to configure messaging. All nodes in the
cluster appear in the drop down list.

Use the same settings for
sending both emails and SMSes

Check this box to configure the same settings for both your SMTP and
SMS email servers. This box is checked, by default.

Server name

Fully qualified domain name or IP address of the server.

Username/password

If your email server requires authentication for sending email
messages, enter the credentials here.

Default from address

All emails sent out will have this from address in the message.

Use SSL

Use secure SSL connection for communications with the server.

Port

This is TCP the port number that the SNMP server listens on.

Connection timeout

Timeout for connection to the server (in seconds).
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Figure 281 Messaging Setup (Mobile Service Providers tab)

Administration » External Servers » Messaging Setup
Messaging
Configure the SMTP mail servers for email and SMS notifications : Select Server : 1921685217 he
SMTP Servers Mobile Service Providers
" Add
# Provider Name Mail Address b
1.| Ilincis valley Cellular ivctext.com w*
2.| Verizon wvtext.com b
3.| Nextel T |z
Edit Mobile Service Provider o
4.| SunCom i
5.| Centennial wi Provider Name [Verizon | T
6.| Omnipoint Mail Address |vtextcom | &
8.| Cingular T
9.| CellularOne mobile.celloneusa.com g

Table 184: Messaging Setup (Mobile Service Providers tab)

Container Description

Add Add a mobile service provider
Provider Name Name of the provider
Mail Address Domain name of the provider

Endpoint Context Servers

Policy Manager provides the ability to collect endpoint profile information from different types of Aruba IAPs and
RAPs via Aruba activate. Policy Manager supports Aruba Activate, Palo Alto Networks' Firewall and Panorama, and
MDM (Mobile Device Management) from Aurwatch, JAMF, Maas360, Mobilelron, and SOTIL.

The mobile device management platforms run on MDM servers. These servers provision mobile devices to configure
connectivity settings, enforce security policies, restore lost data, and other administrative services. Information gathered
from mobile devices can include policy breaches, data consumption, and existing configuration settings.

Endpoint context servers are listed and managed at Administration > External Servers > Endpoint Context Servers.

Figure 282 Endpoint Context Servers

[Administration » External Servers » Endpoint Context Servers
Endpoint Context Servers ' Add Context Server
& Import Context Servers
& Export Context Servers
Filter: Semver Name ~ contains Clear Filter Show 10 = records
# [[]  Server Name Server Type &
1.| [l activate.arubanetworks.com Aruba Activate
2./ [[] MobileIron.com MobileIron
3.| [0 168.0.0.1 Palo Alte Networks Firewall
4.| [ 168.0.0.2 SOTI

e Add an endpoint context server

e Modify an endpoint context server
e Importing

e Exporting
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e Delete an endpoint context server

Add an endpoint context server

AW N =

information.

5. Click Save.

To add an endpoint context server.
Go to Administration > External Servers > Endpoint Context Servers.
Click Add Context Server.

Select a Server Type. The server type will determine what other configuration options you will enter.

Modify an endpoint context server

To modify an endpoint server

. Go to Administration > External Servers > Endpoint Context Servers.

. Click the server name .

1
2
3. Make any desired changes. See Endpoint Context Server Configuration Details for more information.
4

. Click Save.

Delete an endpoint context server

Enter the rest of the server configuration information. See Endpoint Context Server Configuration Details for more

Deleting an endpoint context server just removes its configuration information from Policy Manager. If you think you

might want to add it again, export it before you delete it and save the configuration so you can just import it at a later

date.

To delete an endpoint context server

. Go to Administration > External Servers > Endpoint Context Servers.

. Click the check box next to the server name.

1
2
3. Click Delete.
4. Click Yes.

Endpoint Context Server Configuration Details

The following table explains each field used for configuring endpoint context servers.

Table 185: Endpoint Context Server Configuration Fields

Item Description

Select Server Type

Select the type of server Several configuration options are specific to a server type.

Server Name

Enter a valid server name. This can be either a human-readable name, such as
yourserver.yourcompany.com, or an IP address.

Server Base URL

Enter the full URL for the server. The defaultis the name you entered above with
"hitps://" prepended., You can append a custom port, such as foran MDM server:
https:/lyourserver.yourcompany.com:customerporthnumber.

Username/password

Enter the username and password (twice)for the server.
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Item Description

Activate) and IAP information.

Device Filter (Aruba This field is populated with a default regex to retrieve only the information of RAP

Folder Filter (Aruba

Activate) This field is setto ™" by default.

API Key (airwatch)
Customer ID (JAMF) | Enter the values (provided by the vendor.
Group ID (SOTI)

Application Access

(Palo Alto Networks) | Alto firewall. It should not need to be changed.

Ke
Apglication D If you selected MaaS360 as the server type, then enter the access key, application
N . ID, version, platform ID, and billing ID associated with this MDM server. These
Application Version )
values are provided by the vendor.
Platform ID
Billing ID
Palo Alto Firewall
Names (Palo Alto Enter a valid Palo Alto firewall IP address or hostname.
Networks)
UserlD Post URL This URL is automatically generated and used internally to post information to Palo

Server Certificate

The Policy Manager Server Certificate menu at Administration > Certificates > Server Certificates provides the

following interfaces for configuration:

e '"Create Self-Signed Certificate " on page 285

e '"Create Certificate Signing Request " on page 286
e "Export Server Certificate " on page 288

e '"Import Server Certificate " on page 288

Figure 283 Server Certificates

Administration » Certificates » Server Certificate
Server Certificate =" Create Self-Signed Certificate
9" Create Certificate Signing Request
&, Import Server Certificate
P
& Export Server Certificate
Select Server: 10.2.48.217 -
Server Certificate:
Subject: O=PolicyManager, CN=etips
Issued by: O=PolicyManager, CN=etips
Issue Date: Mar 15, 2012 11:54:20 PDT
Expiry Date: Mar 15, 2013 11:54:20 PDT
Validity Status: Valid

Table 186: Server Cetrtificate

Container Description

Create Self-Signed Certificate Opens the Create Self-Signed Certificate popup.

Create Certificate Signing Request Opens the Create Certificate Signing Request popup.
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Container Description

Select Server

Select a server in the cluster for server certificate operations.

Export

Opens the Export popup.

Import

Opens the Import popup.

Create Self-Signed Certificate

Navigate to Administration > Certificates > Server Certificate and click the Create Self-Signed Certificate link.

This opens the Create Self-Signed Certificate form.

Figure 284 Create Self-Signed Certificate

Create Self-Signed Certificate

I

Commeon Name {CN):
Organization (0):
Organizational Unit (OU):
State (ST):

Country (C):

Location (L):

|clearpass

| Acme Systems

|Engineering
[cA

|San Jose |

Subject Alternate Name (SAN): |emailadmin@acme.com |

Private Key Password:

Verify Private Key Password: [ssssssssssssnse |

Key Length:
Digest Algorithm:

Valid for:

shat [+]
days

After you click Submit, you will be prompted to install the self-signed certificate

Figure 285 Generated Self Signed Certificate

Create Self-Signed Certificate o

Subject DN:

Issuer DN:

Subject Alternate Name (SAN):
Issue Date/Time:

Expiry Date/Time:

Validity Status:

Signature Algorithm:

Public Key Format:

L=San JOse, C=US, ST=CA, O=Acme Systems,
OU=Engineering, CN=clearpass

L=San JOse, C=US, ST=CA, O=Acme Systems,
OU=Engineering, CN=clearpass

email:admin@acme.com
Sep 28, 2012 17:16:30 UTC
Mar 27, 2013 17:16:30 UTC
Valid
SHA1WIithRSAENncryption
X.509
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Common
Name (CN)

Table 187: Create Self-Signed Certificate

Container Description

Name associated with this entity. This can be a host name, IP address or other
meaningful name.
This field is required.

Organization
(0)

Name of the organization.
This field is optional.

Organizational

Name of a department, division, section, or other meaningful name.

Unit (OU) This field is optional.

State (ST) State, country, and/or another meaningful location.
These fields are optional.

Country (C)

Location (L)

Subject Alternative names for the specified Common Name. Note that if this field is used, then
Alternate SAN has to be in the form email:email_address, URI:uri, |P:ip_address, dns:dns_name,
Name (SAN) or rid:id.

This field is optional.
Private Key Specify and verify password.
Password This field is required.
Verify Private

Key Password

Key Length Select length for the generated private key: 512, 1024 , or 2048.
Digest Select message digest algorithm to use: SHA-1, MD5, and MD2.
Algorithm

Valid for Specify duration in days.

Submit/Cancel

On submit, Policy Manager generates a popup containing the self-signed certificate.
Click on the Install button to install the certificate on the selected server.
NOTE: All services are restarted; you must relogin into the Ul to continue.

Create Certificate Signing Request

Navigate to Administration > Certificates > Server Certificates and click on the Create Certificate Signing Request
link. This task creates a self-signed certificate to be signed by a CA.
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Figure 286 Create Certificate Signing Request

Create Certificate Signing Request o

Common Name (CN): clearpass
Organization (0): Acme Systems
Organizational Unit (OU): Engineering
State (ST): CA

Country (C): Us

Location (L): Sunnyvale

Subject Alternate Name (SAN): |emailadmin-sunnyvale@acme.com

Private Key Password: sssssssssssseee

Verify Private Key Password:
Key Length: 1024 |Z| bits
Digest Algorithm: SHA-1 |Z|

A generated certificate signing request displays after you click Submit. Copy the certificate and paste it into the Web
form as part of the enrollment process.

Figure 287 Generated Certificate Signing Request

Create Certificate Signing Request o

Contents of the Certificate Signing Request

MIIE+TCCAWICAQAWDTEOHAwGAI TEARNFZERpcHH=FDASEgHVBASTCOVUEZ LuZiVy
aWEnHRewFOYDVOOKEwSEBdnVuZGEgT 3 1zdGV oz ELHAKGAI TECEBHCQOExC= ATBgHY
BAYTALVTHRIwEAYDVQOHEw 1 CYWEn YW avenUvgZ8wDOY JKoZThveHAQEBEQADg Y0 A
MIGTAoGEAN 7 cuQZLWFO0SoolINAKO7=zLE Bp7Cx9lzbEan86 29hi 0oj JTheRiS8v]
WnFuMECz0CPcf ¥B11-ENCFdIwgl st +xIHizHsHD - JFa- ThFIoud I TnwDMwam 93T
24rEEBgdatr1 9MOOWEEQk+Jg=I=IVi7ci 2101 loibwg THTEBGE SHAGMBAAGI TDRE
BgkghlkiG9wlBCO4xPTATHCOGAITAEQOAMBUBGHFLEW lu0GluZGlhInF2ZWsLYENS
cy5ib20wEvYDVRO1BAwwCgY IKwYEBOUHAwEYDQY JKoZ ThveHAQEFEQADGYEAVRES
=901 1Deckvo c4+UHZ - Hohhd ABKwgTCzv(04 31 1gIFTEB+Huch 24 Heqn 2 KS+ 51wl
K072dJEcrEhHA1ZISUSInDd =5 T8 THIIVEnCeW 7RV ugieZknacVehPDHALPWELpl
zcFoypeleA(910iCSgveZIInI0hEY IXPnz=zUldo=

Copy and paste this into the web form in the enroliment process

Download CSR File § Download Private Key File m

Table 188: Create Certificate Signing Request

Container Description
Common Name associated with this entity. This can be a host name, IP address or other
Name (CN) meaningful name.

This field is required.

Organization Name of the organization.
(O) This field is optional.

Organizational Name of a department, division, section, or other meaningful name.
Unit (OU) This field is optional.
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Container Description

State (ST) State, country, and/or another meaningful location.
These fields are optional.

Country (C)

Location (L)

Subject Alternative names for the specified Common Name. Note that if this field is used, then
Alternate SAN has to be in the form email:email_address, URI:uri, IP:ip_address, dns:dns_name,
Name (SAN) orrid:id.

This field is optional.

Private Key Specify and verify password.
Password This field is required.
Verify Private

Key Password

Key Length Select length for the generated private key: 512, 1024 , or 2048.
Digest Select message digest algorithm to use: SHA-1, MD5, and MD2.
Algorithm

Submit’‘Cancel | On submit, Policy Manager generates a popup containing the certificate signing

request for copying/pasting into the web form that you typically use to get the

certificate signed by a CA.

e To create a file containing the certificate signing request, click Download CSR File.
A .csrfile is downloaded to your local computer.

e To download the generated private key file, click Download Private Key File.
NOTE: Make sure that you save the downloaded private key in a secure place.

Export Server Certificate

Navigate to Administration > Certificates > Server Certificates, and select the Export Server Certificate link. This link
provides a form that enables you to save the file ServerCertifcate.zip. The zip file has the server certificate (.crt file) and the
private key (.pvk file).

Import Server Certificate
Navigate to Administration > Certificates > Server Certificates, and select the Import Server Certificate link.

Figure 288 Import Server Certificate

Import Server Certificate o

Certificate File: | Browse_
Private Key File: | Browse_

Private Key Password:
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Table 189: Import Server Certificate

Container Description

Certificate File Browse to the certificate file to be imported.

Private Key File Browse to the private key file to be imported.

Private Key Password Specify the private key password.

Import/Cancel Click Import to commit, or Cancel to dismiss the popup.

Certificate Trust List

To display the list of trusted Certificate Authorities (CAs), navigate to Administration > Certificates > Certificate
Trust List. To add a certificate, click Add Certificate; to delete a certificate, select the check box to the left of the
certificate and then click Delete.

Figure 289 Certificate Trust List

Administration » Certificates » Trust List

Certificate Trust List F Add Certificate
Filter: Subject ~ contains Show 10~ records
# [ Ssubject Validity Enabled ¥
1.| ] C=Us, 0=GeoTrust Inc., CN=GeoTrust Global CA valid Enabled
2. @ nc., OU=Class 1 Public Primary Certification Authority valid Enabled
3. B e rimary Certification Authority valid Enabled
4 0 e oTrust Global CA 2 valid Enabled
5. @ , OU=Class 3 Public Primary Certification Authority valid Enabled
6.| @ -VeriSign, Inc., OU=Class 2 Public Primary Certification Authority valid Enabled
7.| [ C=US, 0=GeoTrust Inc., CN=GeoTrust Universal CA 2 valid Enabled
s.| @ nc., CN=GeoTrust Universal CA valid Enabled
o O im elektr. D: GmbH, OU=A-Trust-nQual-03, CN=A-Trust-nQual-03 wvalid Enabled
10.| ] C=US, 0=Verisign, Inc., OU=Class 1 Public Primary Certification Authority valid Enabled
Showing 1-10 of 205 B> B Delete

Table 190: Certificate Trust List

Container Description
Subject The Distinguished Name (DN) of the subject field in the certificate

Validity This indicates whether the CA certificate has expired.

Enabled Whether this CA certificate is enabled or not.

To view the details of the certificate, click on a certificate row. From the View Certificate Details popup you can
enable the CA certificate. When you enable a CA certificate, Policy Manager considers the entity whose certificate is
signed by this CA to be trusted.

Add Certificate
Navigate to Administration > Certificates > Certificate Trust List and select the Add Certificate link.

Figure 290 Add Certificate

Add Certificate

Certificate File: Erowse..
Add Certificate
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Table 191: Add Certificate

Container Description

Certificate File Browse to select certificate file.

Add Certificate/Cancel Click Add Certificate to commit, or Cancel to dismiss the popup.

Revocation Lists

To display available Revocation Lists, navigate to Administration > Certificates > Revocation Lists. To add a
revocation list, click Add Revocation List. To delete a revocation list, select the check box to the left of the list and
then click Delete.

Figure 291 Revocation Lists

Administration » Certificates » Revocation Lists e
Certificate Revacation Lists  Add Revocation List
F\\ter:l Issuer DN v|conta\ns| |m Show records
# [] IssuerDNA Last Update Update Status
i, | [J CN=MARGI-CA, O=MARGI, C=MkK 17-May-12 14:45:50 PDT OK
Showing 1-1 of 1 Delete

Table 192: Revocation Lists

Container Description

Add Click to launch the Add Revocation List popup.

Revocation

List

Delete To delete a revocation list, select the check box to the left of the list that you want to
delete and then click Delete.

Add Revocation List

Navigate to Administration > Certificates > Revocation Lists and select the Add Revocation List link.
Figure 292 Add Certificate Revocation List

© File

Distribution File: || Choose File | No file chosen |

@ URL
Distribution URL: [ |

Auto Update: @ Update whenever CRL is updated
© Periodically update every days

Table 193: Add Revocation List

Container Description

File File enables the Distribution File option.
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Container Description

Distribution | Specify the distribution file (e.g.,
File C:/distribution/crl.verisign.com/Class3InternationalServer.crl) to fetch the certificate
revocation list.

URL URL enables the Distribution URL option.

Distribution | Specify the distribution URL (e.g., http://crl.verisign.com/Class3InternationalServer.crl) to

URL fetch the certificate revocation list.

Auto Select Update whenever CRL is updated to update the CRL at intervals specified in the

Update list. Or select Periodically update to check periodically and at the specified frequency (in
days).

RADIUS Dictionaries

RADIUS dictionaries are available on the Administration > Dictionaries > RADIUS. This page includes the list of
available vendor dictionaries.

Figure 293 RADIUS

Administration » Dictionaries » RADIUS

RADIUS Dictionaries & Import Dictionary
Filter:| Vendor Name Ecnntains Show |10 E| records
# Vendor Name Vendor ID Vendor Prefix Enabled 7
1. FreeRADIUS 11344 FreeRADIUS false
2. Aruba 14823 Aruba true
3.| Cisco 9 Cisco true
4.| Alvarion 12394 Alvarion true
5.| Microsoft 311 Microsoft true
6.| Airespace 14179 Airespace true
7. Juniper 2636 Juniper true
8. IETF 0 IETF true
9. Ascend 529 Ascend false
10.| Cosine 3085 Cosine false
Showing 1-10 of 103 B> B

Click on a row view the dictionary attributes, to enable or disable the dictionary, and to export the dictionary. For
example, click on vendor IETF to see all IETF attributes and their data type.

Figure 294 RADIUS IETF Dictionary Attributes

RADIUS Attributes Q

Vendor Name: IETF (0)
#  Attribute Name D Type In/Out |
1.| User-Name 1 String in out
2.| User-Password 2 String in
3.| CHAP-Password 3 String in
4. NAS-IP-Address 4 IPv4Address in
5. NAS-Port 5 Integer32 in
6. Service-Type 6 Integer32 in out
7.| Framed-Protocol 7 Integer32 in out
8.| Framed-IP-Address 8 IPv4Address in out
9.| Framed-IP-Netmask 9 IPv4Address in out
10.| Framed-Routing 10 Integer32 out il
 Disable | Export J close |
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Table 194: RADIUS Dictionary Attributes

Container Description

Export Click to save the dictionary file in XML format. You can make modifications to the
dictionary and import the file back into Policy Manager.

Enable/Disable | Enable or disable this dictionary. Enabling a dictionary makes it appear in the Policy
Manager rules editors (Service rules, Role mapping rules, etc.).

Import RADIUS Dictionary

You can add additional dictionaries using the Import too. To add a new vendor dictionary, navigate to Administration
> Dictionaries > RADIUS, and click on the Import Dictionary link. To edit an existing dictionary, export an existing
dictionary, edit the exported XML file, and then import the dictionary. To view the contents of the RADIUS
dictionary, sorted by Vendor Name, Vendor ID, or Vendor Prefix, navigate to: Administration > Dictionaries >
RADIUS.

Figure 295 /mport RADIUS Dictionary

Import from file o
Select File: | Browse_

Enter secret for the file (if any): | |

Table 195: Import RADIUS Dictionary

Container Description

Select File Browse to select the file that you want to import.

Enter secret for the file (if If the file that you want to import is password protected, enter the secret
any) here.

Posture Dictionaries

To add a new vendor posture dictionary, click on Import Dictionary. To edit an existing dictionary, export an existing
dictionary, edit the exported XML file, and then import the dictionary.

To view the contents of the Posture dictionary, sorted by Vendor Name, Vendor ID, Application Name, or Application
ID, navigate to: Administration > Dictionaries > Posture.
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Fig: Posture

Administration » Dictionaries » Posture

Posture Dictionaries & Import Dictionary

Filter: Vendor Name ~ contains Clear Filter Show 10+ records

# Vendor Name A Vendor ID ication Name ication ID

Avenda 25427 Audit 6
Avenda 25427 MacSHY 65282
d
d

Avenda 25427 WindowsSHV 65281

25427 65280

50 @ N0 0 s w N e
e e 0o oo o

F

oo s ow

Ciscy
Cisc
Ciscy
Cisc

Showing 1-10 of 16 B> B

Table 196: Posture

Container Description

Import Dictionary Click to open the Import Dictionary popup.

Click on a vendor row to see all the attributes and their data type. For example, click on vendor Microsoft/System
SHYV to see all the associated posture attributes and their data type.

Figure 296 Fig: Posture Dictionary

Posture Attributes o

Vendor Name: Microsoft (311)
Application Name: SystemSHV (65280)
# Attribute Name D Type In/Out
1.| Application-Posture-Token 1 Unsigned32 out
2.| System-Posture-Token 2 Unsigned32 out
3. SoH 3 SoH in
4. SoHR 4 SoH out
[ Expor | Closo |

Table 197: Posture Dictionary Attributes

Container Description

Export Click to save the posture dictionary file in XML format. You can make modifications to the
dictionary and import the file back into Policy Manager.

TACACS+ Services

To view the contents of the TACACS+ service dictionary, sorted by Name or Display Name, navigate to:
Administration > Dictionaries > TACACS+ Services.

To add a new TACACS+ service dictionary, click on the Import Dictionary link. To add or modify attributes in an
existing service dictionary, select the dictionary, export it, make edits to the XML file, and import it back into Policy
Manager.
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Figure 297 TACACS+ Services

Administration » Dictionaries » TACACS+ Services

TACACS+ Services Dictionaries

Filter: Mame + contains

# Name A

& Import Dictionary
& Export Dictionary

] Clear Filter

Show 10~ records

Display Name

arap
ciscowlc:common
cpass:http

pixshell

PPP:ip

ppp:ipx

ppp:lcp

shell
Wireless-WCS:HTTP

PO L
Oooo@oooo

Showing 1-9 of 9

ARAP
CiscowLC:Common
cpass:HTTP

PIX Shell

pPP:IP

PPP:IPX

PPPILCP

shell

Wireless-WCS :HTTP

Table 198: TACACS+ Services Dictionary

Container Description

Import Dictionary

Click to open the Import Dictionary popup. Import the dictionary (XML file).

Export Dictionary

Export all TACACS+ services into one XML file containing multiple dictionaries

To export a specific service dictionary, select a service and click on Export.

To see all the attributes and their data types, click on a service row. For example, click on shell service to

service attributes and their data type.

Figure 298 Fig: Shell Service Dictionary Attributes

TACACS+ Service Dictionary Attributes o

Display Mame: Shell

# Name Display Name Type Allowed Values
1., acl Access control list String =
2. autocmd Auto command String -
3.| callback-line Callback line String =
4. callback-rotary Callback rotary String -
5. idletime Idle time Unsigned32 -
6. nocallback-wverify Mo callback verify String true, false
7.| noescape No escape String true, false
8. nohangup No hangup String true, false
9. priv-hvl Privilege level Unsigned32 -

10.[ timeout Timeout Unsigned32 -

Fingerprints

see all shell

The Device Fingerprints table shows a listing of all the device fingerprints recognized by the Profile module. These
fingerprints are updated from the Aruba Update Portal (See "Update Portal " on page 302 for more information.)
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Figure 299 Device Fingerprints

Administration » Dictionaries » Fingerprints

Device Fingerprints

Filter:| Category [=]contains | Show |10 E records
# Category &4 Family Name

1 Access Points Symbol Symbol AP

2 Access Points Aruba Aruba AP

3 Access Points Cisco Cisco AP

4 Access Points Trendnet Trendnet AP

5 Access Points Enterasys Enterasys HiPath AP
6 Access Points Trapeze Trapeze AP

7 Access Points AeroHive AeroHive AP

8 Access Points Ruckus Ruckus Wireless

9 Access Points Enterasys/Trapeze Enterasys/Trapeze AP
10 | Access Points Bluesocket Bluesocket Controller

Showing 1-10 of 111 B~ [

You can click on a line in the Device Fingerprints list to drill down and view additional details about the category.

Figure 300 Fig: Device Fingerprints

Device Fingerprint Dictionary Attributes

Category: Computer
Family: Linux

Name: Fedora

# Field Value

1,28,2,3,15,6,12,40,41,42
28,2,3,15,6,12,40,41,42
1,28,2,3,15,6,12,40,41,42,26,119

1 |DHCP Cption55 1,28,2,3,15,6,12,40,41,42,26
1,28,2,121,15,6,12,40,41,42,26,119,3,121,249,252,42
1,28,2,121,15,6,12,40,41,42,26,119,3
1,28,2,3,15,6,12,40,41,42,26,119,121,249,252,42

Close

Attributes

The Administration > Dictionaries > Attributes page allows you to specify unique sets of criteria for LocalUsers,
GuestUsers, Endpoints, and Devices. This information can then be with role-based device policies for enabling
appropriate network access.

The Attributes page provides the following interfaces for configuration:
e "Add Attribute " on page 296
e '"Import Attributes" on page 297

e "Export Attributes" on page 297
e '"Export " on page 297
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Figure 301 Attributes page

Administration » Dictionaries » Attributes
Attributes =" Add Attribute
&, Import Attributes
&, Export Attributes
Filter:| Name [=] contains | ] m Show records
# g Name & Entity Data Type Is d y  Allow ip
1|0 [company Name] GuestUser String No Yes
2.|0 [Conference] GuestUser String Yes No
3.|O0 [Controller 1d] Device String No Yes
4.0 [Department] LocalUuser String No Yes
5. |0 [Designation] GuestUser String No Yes
6.0 [Designation] LocalUser String No Yes
7.| Device IMEI Endpoint String No Yes
8./ Device IMEI GuestUser String No Yes
9.|[0 Device Serial GuestUser String No Yes
10.| [Device Type] Device String No Yes
Showing 1-10 of 40 B> B Export | Delete

Table 199: Attribute settings

Container Description

Filter Use the drop down menu to create a search based on the available Name, Entity, Data
Type, Is Mandatory, or Allow Multiple settings.

Name The name of the attribute.

Entity Shows whether the attribute applies to a LocalUser, GuestUser, Device, or Endpoint.

Data Type Shows whether the data type is string, integer, boolean, list, text, date, MAC address, or
IPv4 address.

Is Shows whether the attribute is required for a specific entity.
Mandatory

Allow Shows whether multiple attributes are allowed for an entity.
Multiple

Add Attribute
To add a new Attribute dictionary, select Add Attribute in the upper right portion of the page.

Figure 302 Add Attributes

Add Attribute o

Entity | GuestUser [=]
Name |[vendor] |
Data Type  String [=]
Is Mandatory @ ves O Mo
Allow Multiple Yes @ No

Default Value (optional) | (Enter String without special characters

e.g., firstfloor)
[ | cancor |

|conferencercom

Enter information in the fields described in the following table. Click Add when you are done. To modify attributes in
an existing service dictionary, select the attribute, make any necessary changes, and then click Save.
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Table 200: Add Attribute settings

Container Description

Entity Specify whether the attribute applies to a LocalUser, GuestUser, Device, or Endpoint.

Name Enter a unique ID for this attribute.

Data Type Specify whether the data type is string, integer, boolean, list, text, date, MAC address, or
IPv4 address.

Is Specify whether the attribute is required for a specific entity.

Mandatory

Allow Specify whether multiple attributes are allowed for an entity. Note that multiple attributes are
Multiple not permitted if Is Mandatory is specified as Yes.

Import Attributes
Select Import Attributes on the upper right portion of the page.

The imported file is in XML format. To view a sample of this XML format, export a dictionary file and open itin an
XML viewer.

Figure 303 /mport from file

Import from file

Select File: | Browse_

Enter secret for the file (if any): | |

Table 201: Import from File settings

Container Description

Select File / Enter Browse to the dictionary file to be imported. Enter the secret key (if any) that
secret for the file was used to export the dictionary.
Import/Cancel Click Import to commit, or Cancel to dismiss the popup.

Export Attributes

Select Export Attributes on the upper right portion of the page to exports all attributes.

The Export Attributes button saves the file Attributes.zip. The zip file has the server certificate (.crt file) and the
private key (.pvk file).

Export

Select the Export button on the lower right side of the page.

To export just one attribute, select it (check box at left) and click Export. Your browser will display its normal Save
As dialog, in which to enter the name of the XML file to contain the export.
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Application Dictionaries

Application dictionaries define the attributes of the OnBoard and WorkSpacePolicy Manager applic-
ations and the type of each attribute. When Policy Manager is used as the Policy Definition Point (PDP),
it uses the information in these dictionaries to validate the attributes and data types sent in a WEB-AUTH
request.

Y ou can

e View an application dictionary
e Delete an application dictionary
e Importing

e Exporting.

View an application dictionary

To view an application dictionary
1. Go to Administration > Dictionaries > Applications.

2. Click the name of an application. The Application Attributes dialog box appears.

Application Attributes o
Application Name: Onboard
Description: Onboard Application Attributes
#  Attribute Name Attribute Type
1.| Device-MAC String
2.| Device-Product String
3.| Device-Serial String
4. Device-UDID String
5.| Device-Version String
6. Managed Boolean
7.| Onboard-Profile String
[“Erpor |

Delete an application dictionary

In general, you should have no need to delete an application dictionary. They have no effect on Policy
Manager performance.

To delete an application dictionary

1. Go to Administration > Dictionaries > Applications.

2. Click the check box next to an application name.
3. Click Delete.

Navigate to the Administration > Agents and Software Updates> OnGuard Settings page.
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Use this page to configure the agent deployment packages. Once the configuration is saved, agent deployment

packages are created for Microsoft Windows and MAC OS X operating systems and placed at a fixed URL on the

Policy Manager appliance. This URL can then be published to the user community. The agent deployment packages
can also be downloaded to another location.

Figure 304 OnGuard Settings

|Administration » Agents and Software Updates » OnGuard Settings -
OnGuard Settings - = Global Agent Settings
= Policy Manager Zones
Agent Version: 6.1.0.49783
Agent Installers
Agent Installers updated at Mar 29, 2013 21:44:19 UTC
f'.'utl Windows http://10.2.51.26/agent/installer/windows/ClearPassOnGuardinstall.exe (Full Install - EXE) 13MB
http://10.2.51.26/agent/installer/windows/ClearPassOnGuardInstall.msi (Full Install - MST) 13MB
é Mac 0S X htkp://10.2.51.26/agent/installer/ mac/ClearPassOnGuardnstall.dm (Full Install) 8MB
Agent Customization
Managed Interfaces: wired Wireless veN [ Other
Mode: Authenticate with health checks -
Username Text: Usemame
Password Text: Password
Client Certificate Chack: [7] Enable to use a certificate from User keystore during authentication
Agent action when an \gnore -
update is available: g
External Captive Portal Support
Enter the URL of a web page that can be accessed only after a successful authentication (e.g., http://www.arubanetworks.com). A network
device that is configured for captive portal-based authentication redirects requests to this URL to an authentication page.
URL:

Table 202: OnGuard Settings

Container Description

Global Agent
Settings

Configure global parameters for OnGuard agents. Parameters include the
following:

o CacheCredentialsForDays : Select the number of days the user credentials
should be cached on OnGuard agents.

o WiredAllowedSubnets : Add a comma-separated list of IP or subnet
addresses.

o WirelessAllowedSubnets : Add a comma-separated list of IP or subnet
addresses

o KeepAlivelntervalSeconds : Add a keep alive interval for OnGuard agents

o EnableClientLoadBalance : Enable this option to load balance OnGuard
authentication requests across ClearPass Policy Servers in a cluster

o AllowRemoteDesktopSession : Enable this option to allow OnGuard access
via a Remote Desktop session.

e HideLogoutButton : Enable this option to hide the Logout button.

Policy Manager
Zones

Configure the network (subnet) for a Policy Manager Zone

Agent Version

Current agent version.

Agent Installers

The URLs for the different agent deployment packages for Windows and MacOS.

Managed Interfaces

Select the type of interfaces that OnGuard will manage on the endpoint.

Mode

Select one of:

o Authenticate - no health checks.

e Check health - no authentication. OnGuard does not collect
username/password.

o Authenticate with health checks. OnGuard collects username/password and
also performs health checks on the endpoint.
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Container Description

Username/Password | The label for the username/password field on the OnGuard agent. This setting is

text not valid for the “Check health - no authentication” mode.
Client certificate Enable to also perform client certificate based authentication. OnGuard extracts
check the client certificate from the logged in user’s certificate store and presents this in

the TLS exchange with Policy Manager.

Agent action when This setting determines what the agent does when an update is available.

an update is Options are Ignore, Download Installer, Notify User.

available

URL In a captive portal scenario, the network device presents a captive portal page

prior to user authentication. This portal page is presented when the user browses
to a URL thatis not authorized to be accessed prior to authentication. Enter such
a URL here.

Save/Cancel Commit the update information and generate new deployment packages.

OnGuard Portal
Navigate to the Administration > Agents and Software Updates> OnGuard Portal page.

Click on any of the four editable sections of this page to customize the content for your enterprise:

Figure 305 OnGuard Portal

[rdministration » Agents and Software Updates » OnGuard Portal

OnGuard Portal | Global Portal Settings
Name: default

Portal URL: https://testlab32/agent/portal/

Select Mode: Authenticate - no health checks (HTML form) -

Enter authentication details

Usage Terms Text: [[] Enable to show terms and conditions of use
Resource Files: No resource files were uploaded. A ZIP archive containing resource files is supported EE.M

Customize Portal: @ Use default template © Upload custom template

DD D R OnGuard Portal

networks

ClearPass OnGuard Health Check Portal - Aruba Networks

Users must pass the health checks to access the network

Note: If you cannot access an enterprise resource, it may be because you are in the quarantine network.
Please visit User Policy Example for more information

© Copyright 2013 Aruba Networks. All rights reserved.

Figure 306 OnGuard Portal parameters

Parameter Description
Global Portal Attribute names and value configuration for the portal.
Settings
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Parameter Description

e UsernameFormat Format of username sentin authentication requests. This
can be used in service rules (Authentication:Full-Username attribute) to write
different service rules for different portals.

o SharedSecret. Secret shared with a Wireless Controller (for example, Xirrus
Wireless Controller) when Policy Manager is configured as an external
captive portal on the network device.

e ShowOriginalPageRedirectLink: Show a link that will take the user to the
original page (prior to being redirected to the captive portal).

Name Name is ‘default’.

Portal URL This is the URL that presents the OnGuard portal page. (Note that this is
automatically generated by Policy Manager).

Select Mode Select from the following for different modes of the portal:

e Authenticate - no health validation (HTML Form) - Policy Manager presents a
simple HTML form with the username and password. Health credentials are
not collected from the client.

e Authenticate - no health validation (Java Applet) - Policy Manager presents
an applet based form with the username and password. Health credentials
are not collected from the client. Note that, the Java applet collects the MAC
address of all interfaces on the client. In the case of a simple HTML form,
Policy Manager would have to perform the extra step of DHCP snooping to
collect the MAC address of the client.

e Check Health - no authentication (Java applet) - Username/password are not
collected. Health is evaluated via a Java applet.

o Authenticate with health checks (Java Applet) - Policy Manager prompts the
user for username and password, and also collects client health credentials
by means of a Java applet downloaded to the page.

e Authenticate with optional health checks (Dual mode) - User is presented
with a simple HTML form. User can choose to load the Java applet by clicking
on a link on this page; the java applet (dissolvable agent) also collects health
information.

e No Authentication and no health checks (HTML form) - User is presented
with a simple HTML form for the username, which is hidden.

Authentication Click within the Enter Authentication Details field to enter credential details. Note
Details that this section only appears for modes that require authentication.
Username/Password | Click on the Username/Password labels (D) to change the respective label

label strings.

Usage Terms Text

Select this check box to display the terms and conditions of use.

Resource Files

Click on Upload link to upload a zipped archive of resource files consisting of
images, style sheets, scripts, etc. These are hosted on the Policy Manager
appliance and can be referenced by prefixing the _eTIPS_GUEST_PORTAL_
RESOURCE_ to the patch component. For example, if there is a file named
logo.jpg in the zipped archive, refer to this resource as “_eTIPS_GUEST_
PORTAL_RESOURCE_/logo.jpg” on the OnGuard portal page.

After the zipped archive is successfully uploaded, a screen showing the
contained files is shown:
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Parameter Description

4 resource files are uploaded (Size: 211.8
KB)

Resource Files: & Update &, pownload T Delete

Resource Files Details

Name Size Modified

cam.jpg Hlrlds ?g:lg:lgézﬁ
chappatte.jpg 70 KB ?g:lgi:lglzfzﬁ
dcro656l.jog 20 iglgéls?ém
keefe.jpg 68.9 KB ?g:l:?é:lf‘sfzﬁ

To reference the uploaded resource, use
eTIPS_GUEST_PORTAL_RESOURCE_IRaiCUEIEE]

Customize Portal Use default template to edit the different fields as described above. To importa
custom HTML file to be used as the OnGuard portal, select Upload custom
template. Note that the following macros must be presentin the custom HTML
template:

e _eTIPS_GUEST_PORTAL_HEADER_

e _eTIPS_GUEST_PORTAL_BODY_

o _eTIPS_GUEST_PORTAL_FORM_

Title Click on the current title text to change the way the title appears.

Logo Image Click on the logo image to browse and select an image for the banner.

Header Message Click to enter text that will display in the header.

Footer Message Click to enter text that will display in the footer.

Copyright Message Click to enter copyright text.

Figure 307 Custom HTML Template Upload

-
_eTIPS_GUEST PCRTAL HEADER_
</head>
<body>
_eTIPS GUEST PORTAL BODY
<!-— Add page contents —->
<!-- Add more page contents --3> ]
<!—— Add Copyright —->
</body> i

Update Portal
Navigate to Administration > Agents and Software Updates > Software Updates.
Use the Software Updates page to register for and to receive live updates for:

e Posture updates, including Antivirus, Antispyware, and Windows Updates

o Profile data updates, including Fingerprint
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e Software upgrades for the ClearPass family of products

e Patch binaries, including Onboard, Guest Plugins and Skins

Updates are stored on ClearPass’s webservice server. When a valid Subscription ID is saved, the ClearPass Policy
Manager server periodically communicates with the webservice about available updates. It downloads any available
updates to the ClearPass Policy Manager server. The administrator can install these updates directly from this Software
Updates page. The first time the Subscription ID is saved, ClearPass Policy Manager contacts the webservice to

download the latest Posture & Profile Data updates and any available firmware and patch updates.When using an
evaluation version, no upgrade Images will be available.

Figure 308 Software Updates

‘Administration » Agents and Software Updates » Software Updates
Software Updates
Subscription ID
Subscription ID: 123456 Tp3aqid-ndbvax5z2vaT-abedel
=3
Posture & Profile Data Updates
Update Type Data Version Data Created Last Update Last Updated Update Status
AntiVirus & AntiSpyware Updates 1.9736 2013/04/05 15:10:22 Online 2013/04/05 15:56:25 Latest
Windows Hotfixes Updates 1.438 2013/04/05 04:09:21 File 2013/04/05 14:26:35 Latest
Endpoint Profile Fingerprints 2.29 2013/03/25 06:26:18 Online 2013/04/05 15:56:33 Latest
Import Updates
o manuslly import Posture  Profile Dats Upciates, refer o Help for this page.
Firmware & Patch Updates
Update Type  Name Version Size(MB) Update Released Last Checked Status.
Guest Skin ‘Aruba Demo Skin - Healthcare Skin 1.0.6-0 0.1241 2012/01/16 2013/04/05 15:56:48
Guest Skin Aruba Demo Skin - Education Skin 1.0.5-0 0.1570 2012/01/17 2013/04/05 15:56:48 =
Translation Chinese Translations 0.830 0.1446 2011/09/06 2013/04/05 15:56:48 =
Translation Japanese Translations 1.0.0-0 0.1852 2012/03/27 2013/04/05 15:56:48 =1
Import Updates
“eads Resta
= Restarts Administration U
Check Status Now

Table 203: Software Updates

Container Description

Subscription ID

Subscription | Enter the Subscription ID provided to you in this text box. This text box is enabled only on

ID publisher node. You can at any time opt out of automatic downloads by saving an empty
Subscription ID.

Save Click this button to save the Subscription ID entered in the text box. This button is enabled
only on publisher node.

Reset Performs an "undo" of any unsaved changes made in the Subscription ID field. Note that
this does not clear the text box.

Posture & Profile Data Updates

Import Use Import Updates to import (upload) the Posture and Profile Data into this server, if this
Updates server is not able to reach the webservice server. The data can be downloaded from
webservice server by accessing the URL:
https://clearpass.arubanetworks.com/cppm/appupdate/cppm_apps_updates.zip.

When prompted, enter the provided Subscription ID for the username and the password
for authentication.

NOTE: This button is enabled only on publisher node.

Firmware & Patch Updates
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Container Description

Import If the server is not able to reach the webservice server, click Import Updates to import the
Updates latest Firmware and Update patch binaries (obtained via support or other means) into this
server. When logged in as appadmin, the Upgrade and Patch binaries imported can be
installed manually via the CLI using the following commands:

e system update (for patches)

e system upgrade (for upgrades)

NOTE: The Onboard, Guest Plugins and Skins can only be downloaded and installed via
webservice.

If the auto-download fails because of connectivity issues or a checksum mismatch, a Retry

Ret
i button will appear. Click on this button to download that update from the webservice
server.

Install This button appears after the update has been downloaded. Clicking on this button starts
the installation of the update and displays the Install Update dialog box showing the log
messages being generated.

Needs This link appears when an update needs a reboot of the server in order to complete the

Restart installation. Clicking on this link displays the Install Update dialog box showing the log
messages generated during the install.

Installed This link appears when an update has been installed. Clicking on this link displays the
Install Update dialog box showing the log messages generated during the install.

This link appears when an update install encountered an error. Clicking on this link

Install Error
displays the Install Update dialog box showing the log messages generated during the
install.
Other
Check Click on this button to perform an on-demand check for available updates. Applies to
Status Now updates (only on publisher node) as well as Firmware & Patch Updates.

The Firmware & Patch Updates table will only show the data that is known to webservice. Additionally, it is only
visible if the ClearPass Policy Manager server is able to communicate with the webservice server.

Install Update dialog box

The Install Update dialog box shows the log messages generated during the install of an update. This popup appears
when an Install button is clicked. If the popup is closed, it can be brought up again by clicking the ‘Install in
progress...” link while and installation is in progress or by clicking the ‘Installed’, ‘Install Error’, ‘Needs Restart’ links
after the installation is completed.
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Figure 309 /Install Update

ta Upd pnotan update °
Last Up
are Upd: Installed - CPPM-x86_64-20120927-dummy-patch-1-patch.bin 2012/10
flates Installing patch from=CPPM-x86_64-20120927-dummy-patch-1-patch.bin 2012/19
rprints  Extracting patch... 2012/10
INFO: Preparing ...
INFO: Running pre-install scripts ...
INFO: Applying patch ...
INFO: Recording patch ...
INFO: Running post-install scripts ...
INFO: Patching complete with status - 0
Exiting with 0 ad Last Ch|
2012/104
2012/10
0927-dummy-patch-2 0.0022 2012/09/27 2012/10
ch Translations 0.1179 2012/06/06 2012/10

Table 204: Install Update dialog box buttons and descriptions

Container Description

Close Click on this button to close the dialog box.

Clear & Click on this button to delete the log messages and close the popup. This will also remove

Close the corresponding row from the Firmware & Patch Updates table.

Reboot This button appears only for the updates requiring a reboot to complete the installation.
Click on this button to initiate a reboot of the server.

Delete the log messages (using the Clear & Close button on the Install Update dialog box) for a failed install. After
the log messages are cleared, attempt the install again.

System Events (as seen on the Monitoring > Event Viewer page) show records for events, such as communication
failures with webservice, successful or failed download of updates, and successful or failed installation of updates.

The ClearPass Policy Manager server contacts the webservice server every hour in the background to download any
newly available Posture & Profile Data updates and every day at 4:00 a.m.for a current list of firmware and patch
updates. Any new list of firmware and update patches available are downloaded to thePolicy Manager server
automatically and kept ready for installation. The webservice itself is refreshed with the Antivirus and Antispyware
data hourly, with Windows Updates daily, and with Fingerprint data, Firmware & Patches as and when new ones are
available. An event is generated (showing up in Event Viewer) with the list of downloaded images. If an SMTP server,
any Alert Notification email addresses are configured, an email (from publisher only) is also sent with the list of
images downloaded.

By way of background, the Policy Manager Publisher node acts as master. Administration, configuration, and database
write operations are allowed only on this master node. The Policy Manager appliance defaults to a Publisher node
unless it is made a Subscriber node. A Policy Manager cluster can contain only one Publisher node. Cluster commands
can be used to change the state of the node, hence the Publisher can be made a Subscriber.

Upgrade the Image on a Single Policy Manager Appliance

Perform these steps to upgrade the image on a single Policy Manager appliance:
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1. From the ClearPass Policy Manager Ul, navigate to Administration > Agents and Software Updates > Software
Updates.

e Ifa Subscription ID has been entered, then the server can communicate with the webservice. Available upgrades
will be listed in the Firmware & Patches table. Download and install the upgrade, and then reboot the server.

o If the Subscription ID has not been entered, or if the appliance cannot communicate with the webservice, click
Import Updates to upload the upgrade image that you received from Support (or through other means). The
upgrade file is now available and can be specified in the system upgrade CLI command.

Alternatively, transfer the image file to a Policy Manager external machine and make it available via http or SSH.

1. Login to the Policy Manager appliance as appadmin user.

2. Use the command system upgrade, which will upgrade your second partition, then reboot. Policy Manager boots
into the upgraded image.

If you access the appliance via serial console, you should also be able to boot into the previous image by choosing that
image in the Grub boot screen.

NOTE

3. Verify that all configuration and session logs are restored and all services are running. Also verify that node-
specific configuration such as the server certificate, log configuration and server parameters are also restored.

Upgrade the Image on All Appliances

Perform these steps to upgrade the image on all appliances in an Policy Manager cluster.

1. Upgrade publisher Policy Manager first, and reboot into the new image.

2. On the first boot after upgrade, all old configuration data is restored. Verify that all configuration and services are
intact.

In the cluster servers screen, all subscriber node entries are present but marked as Cluster Sync=false (disabled for
replication). Any configuration changes performed in this state do not replicate to subscribers until the subscribers
are also upgraded (effectively no configuration changes are possible on subscribers in this state).

You can add a subscriber to the cluster from the User Interface: Configuration > Administration > Server Configuration

S— (page) > Make Subscriber (link).

3. One node at a time, upgrade the subscriber nodes to the same Policy Manager version as the publisher, using the
same steps as for a single Policy Manager server. On the first boot after upgrade, the node is added back to the
cluster (the publisher node must be up and available for this to work).

4. Login to the Ul and verify that the node is replicating and “Cluster Sync” is set to true.

If the publisher is not available when the subscriber boots up after the upgrade, adding the node back to the cluster fails.
In that case, the subscriber comes up with an empty database. Fix the problem by adding the subscriber back into the
NoTa cluster from the CLI. All node configuration, including certificates, log configuration and server parameters are restored
(as long as the node entry exists in the publisher with Cluster Sync=false).
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Appendix A

Command Line Configuration

The Policy Manager command line provides commands of the following types:

e "Cluster Commands" on page 309

e "Configure Commands" on page 312
e "Network Commands" on page 314
e "Service commands" on page 316

e "Show Commands" on page 317

e "System commands" on page 320

e '"Miscellaneous Commands" on page 322

Available Commands

Table 205: Command Categories

ad auth
See "Miscellaneous Commands" on page 322

ad netleave
See "Miscellaneous Commands" on page 322

ad netjoin
See "Miscellaneous Commands" on page 322

adtestjoin
See "Miscellaneous Commands" on page 322

alias
See "Miscellaneous Commands" on page 322

backup
See "Miscellaneous Commands" on page 322

cluster drop-subscriber

cluster list

cluster make-publisher

cluster make-subscriber

cluster reset-database

cluster set-cluster-passwd

cluster set-local-passwd
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configure date

configure dns

configure hostname

configure ip

configure timezone

dump certchain
See "Miscellaneous Commands" on page 322

dump logs
See "Miscellaneous Commands" on page 322

dump servercert
See "Miscellaneous Commands" on page 322

exit
See "Miscellaneous Commands" on page 322

help
See "Miscellaneous Commands" on page 322

krb auth
See "Miscellaneous Commands" on page 322

krb list
See "Miscellaneous Commands" on page 322

Idapsearch
See "Miscellaneous Commands" on page 322

network ip

network nslookup

network ping

network traceroute

network reset

quit
See "Miscellaneous Commands" on page 322

restore
See "Miscellaneous Commands" on page 322

service activate

service deactivate

service list

308
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service restart

service start

service status

service stop

show date

showdns

show domain

show all-timezones

show hostname

show ip

showlicense

show timezone

show version

system boot-image

system gen-support-key

system update

system restart

system shutdown

system install-license

system upgrade

Cluster Commands

The Policy Manager command line interface includes the following cluster commands:
e '"drop-subscriber" on page 309

e 'list" on page 310

e "make-publisher" on page 310

e '"make-subscriber" on page 310

e 'reset-database" on page 311

e 'set-cluster-passwd" on page 311

e 'set-local-passwd" on page 311

drop-subscriber

Removes specified subscriber node from the cluster.
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Syntax

cluster drop-subscriber [-f] [-1 <IP Address>] -s

Where:

Table 206: Drop-Subscriber Commands

Flag/Parameter Description

-f Force drop, even for down nodes

Management IP address of the node. If not
-i <IP Address> specified and the current node is a subscriber,
Policy Manager drops the current node.

Do notreset the database on the dropped node.
-S By default, Policy Manager drops the current node
(if a subscriber) from the cluster.

Example
[appadmin]# cluster drop-subscriber -f -i 192.168.1.1 -s

list
Lists the cluster nodes.

Syntax

cluster list

Example

[appadmin]# cluster list

cluster list

Publisher

Management port IP=192.168.5.227
Data port IP=None [local machine]

make-publisher
Makes this node a publisher.

Syntax

cluster make-publisher

Example

[appadmin]# cluster make-publisher
hhkkhkhkkkhkhkkhkhkhkhkkhkhkkhkkhkhkkhkhkhkkhkhkkhkhkhkhkkhkhkhkkkhkhkkhkhkhkkhkkhkhkkkhkhkkkhkkkkk

* WARNING: Executing this command will promote the *
* current machine (which must be a subscriber in the *
* cluster) to the cluster publisher. Do not close the *

* shell or interrupt this command execution. *
a2 T e s T 2 e

Continue? [y|Y]: y
make-subscriber
Makes this node a subscriber to the specified publisher node.

Syntax

make-subscriber -i <IP Address> [-1]
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Where:

Table 207: Make-Subscriber Commands

Flag/Parameter Description

Required.

-i <IP Address> Publisher IP address.

Optional.
-l Restore the local log database after this
operation.

Example
[appadmin]# cluster make-subscriber -i 192.168.1.1 -p !alore -1

reset-database
Resets the local database and erases its configuration.

Syntax

cluster reset-database

Returns

[appadmin]# cluster reset-database
hhkkhkhkhkhkkhkhkhkhkhkhkhkkhkhkhkhkhkhkhkkhkhkhkhkhhkhkhkkhkhkhkhkhhkhkhkkhkhkhkhkhhkhkhkkhkhkhkhkhkhkhkkkkx

* WARNING: Running this command will erase the Policy Manager *
* configuration and leave the database with default *

* configuration. You will lose all the configured data. *

* Do not close the shell or interrupt this command *

* execution. *

khkkhkhkhkhkhkhkhkhkhkhkhkhkkkhkhkhkhkhhhkhkhkhkhkhkhkhkhkhkkkhkhkhkhkhhhhkhkhkhkhkhkhkhkhkkkkkkk

Continue? [y|Y]: y

set-cluster-passwd

Changes the cluster password on all publisher nodes. Executed on the publisher; prompts for the new cluster password.

Syntax

cluster set-cluster-passwd

Returns

[appadmin]# cluster set-cluster-passwd

cluster set-cluster-passwd

Enter Cluster Passwd: santaclara

Re-enter Cluster Passwd: santaclara

INFO - Password changed on local (publisher) node
Cluster password changed

set-local-passwd

Changes the local password. Executed locally; prompts for the new local password.

Syntax

cluster sync-local-password

Returns

[appadmin]# cluster set-local-password
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cluster sync-local-passwd
Enter Password:
Re-enter Password:

'alore
'alore

Configure Commands

The Policy Manager command line interface includes the following configuration commands:

"date" on page 312
"dns" on page 312
"hostname" on page 313
"ip" on page 313

"timezone" on page 313

date

Sets System Date, Time and Time Zone.

Syntax

configure date -d <date>

or

[-t <time> ] [-z <timezone>]

configure date -s <ntpserver> [-z <timezone>]

Where:

Table 208: Date Commands

Flag/Parameter Description

-s <ntpserver>

Optional.
Synchronize time with specified NTP server.

Required.
-d <date> Syntax: yyyy-mm-dd
-t <time> Optional.

Syntax: hh:mm:ss

-z <timezone>

Optional.
Syntax: To view the list of supported timezone
values, enter: show all-timezones.

Example 1

Specify date/time/timezone:

[appadmin] #

Example 2

Synchronize with a specified NTP server:

[appadmin]# -s <ntpserver>

dns

configure date -d 2007-06-22 -t 12:00:31 -z America/Los_Angeles

Configure DNS servers. At least one DNS server must be specified; a maximum of three DNS servers can be specified.

312
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Syntax

configure dns <primary>

Example 1

[secondary] [tertiary]

[appadmin]# configure dns 192.168.1.1

Example 2

[appadmin]# configure dns 192.168.1.1 192.168.1.2

Example 3

[appadmin] # configure dns 192.168.1.1 192.168.1.2 192.168.1.3

hostname

Configures the hostname.

Syntax

configure hostname <hostname>

Example

[appadmin]# configure hostname sun.us.arubanetworks.com

ip

Configures IP address, netmask and gateway.

Syntax

[appadmin] # configure ip <mgmt|data> <ipaddress> netmask <netmask address> gateway <gateway ad

dress>

Where:

Table 209: /P Commands

Flag/Parameter Description

ip <mgmt|data> <ip
address>

Network interface type: mgmt or data
e Serverip address.

netmask <netmask
address>

Netmask address.

gateway <gateway
address>

Gateway address.

Example

[appadmin] # configure ip data 192.168.5.12 netmask 255.255.255.0 gateway 192.168.5.1

timezone

Configures time zone interactively.

Syntax

configure timezone

Example

[appadmin]# configure timezone
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configure timezone
khkkhkhkhkhkhkhkhkhkhkhkhkhkkkkhkkhkkhkhkhkhkhkhkhkhkhkhkhkhkhkkkkhkkkkhkhhkhkhkhkhkhkhkhkhkhkkkkkkx

* WARNING: When the command is completed Policy Manager services ¥*

* are restarted to reflect the changes. *
R 2 R e . 2 2 L 2 2 R R R R A R A T A T e TR e

Continue? [y|Y]: vy

Network Commands

The Policy Manager command line interface includes the following network commands:
e '"ip" on page 314

e '"nslookup" on page 315

e '"ping" on page 315

e 'reset" on page 316

e 'traceroute" on page 316

ip

Add, delete or list custom routes to the data or management interface routing table.
Syntax

network ip add <mgmt|data> [-1 <id>] <[-s <SrcAddr>] [-d <DestAddr>]>

Add a custom routing rule. Where:

Table 210: Network IP Add Commands

Flag/Parameter Description

<mgmt|data> Specify management or data interface

id of the network ip rule. If unspecified, the system will auto-generate an id. Note

-i <id>
i <id that the id determines the priority in the ordered list of rules in the routing table.

Optional. Specifies the ip address or network (for example, 192.168.5.0/24) or 0/0
-s <SrcAddr> (for all traffic) of traffic originator. Only one of SrcAddr or DstAddr must be
specified.

Optional. Specifies the destination ip address or network (for example,
-d <DestAddr> 192.168.5.0/24) or 0/0 (for all traffic). Only one of SrcAddr or DstAddr must be
specified.

Syntax

network ip del <-i <id>>

Delete a rule. Where:

Table 211: Network IP Delete Commands

Flag/Parameter Description
-i <id> Id of the rule to delete.
Syntax

network ip list
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List all routing rules.

Syntax

network ip reset

Reset routing table to factory default setting. All custom routes are removed.

Example 1

[appadmin] # network ip add data -s 192.168.5.0/24

Example 2

[appadmin] # network ip add data -s 192.168.5.12

Example 3

[appadmin] # network ip list

nslookup

Returns IP address of host using DNS.

Syntax

nslookup -g <record-type> <host>

Where:

Table 212: Nslookup Commands

Flag/Parameter Description

<record-type>

Type of DNS record. For example, A, CNAME,
PTR

<host>

Host or domain name to be queried.

Example 1

[appadmin] # nslookup sun.us.arubanetworks.com

Example 2

[appadmin] # nslookup -q SRV arubanetworks.com

ping

Tests reachability of the network host.

Syntax

network ping [-1 <SrcIpAddr>] [-t] <host>
Where:

Table 213: Ping Commands

Flag/Parameter Description

-i <SrclpAddr>

Optional.
Originating IP address for ping.

Optional.
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Flag/Parameter Description

Ping indefinitely.

<host> Host to be pinged.

Example
[appadmin] # network ping —-i 192.168.5.10 -t sun.us.arubanetworks.com

reset

Reset network data port.

Syntax

network reset <port>

Where:

Table 214: Reset Commands

Flag/Parameter Description
<port> Required.
Name of network port to reset.
Example

[appadmin] # network reset data

traceroute
Prints route taken to reach network host.

Syntax

network traceroute <host>

Where:

Table 215: Traceroute Commands

Flag/Parameter Description
<host> Name of network host.
Example

[appadmin]# network traceroute sun.us.arubanetworks.com

Service commands
The Policy Manager command line interface includes the following service commands:

e start
e stop
e status
e restart

e activate
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e deactivate

o list

These commands in this section have identical syntax; therefore, this section presents them as variations on <action>.

<action>
Activates the specified Policy Manager service.

Syntax

service <action> <service-name>

Where:

Table 216: Action Commands

Flag/Parameter Description

Choose an action: activate, deactivate, list, restart,

action start, status, or stop.

Choose a service: tips-policy-server, tips-admin-
server, tips-system-auxiliary-server, tips-radius-
server, tips-tacacs-server, tips-dbwrite-server,
tips-repl-server, or tips-sysmon-server.

service-name

Example 1

[appadmin]# service activate tips-policy-server

Example 2

[appadmin]# service list all

service list

Policy server [ tips-policy-server ]

Admin UI service [ tips-admin-server ]

System auxiliary services [ tips-system-auxiliary-server ]
Radius server [ tips-radius-server ]

Tacacs server [ tips-tacacs-server ]

Async DB write service [ tips-dbwrite-server ]
DB replication service [ tips-repl-server ]
System monitor service [ tips-sysmon-server ]
Example 3

[appadmin]# service status tips-domain-server

Show Commands
The Policy Manager command line interface includes the following show commands:

e '"all-timezones" on page 318
e '"date" on page 318

e '"dns" on page 318

e "domain" on page 318

e '"hostname" on page 319

e "ip" on page 319

e '"license" on page 319

e "timezone" on page 319
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e 'version" on page 320

all-timezones
Interactively displays all available timezones

Syntax

show all-timezones

Example

[appadmin]# show all-timezones
Africa/Abidjan
Africa/Accra

date

Displays System Date, Time, and Time Zone information.

Syntax

show date

Example

[appadmin]# show date
Wed Oct 31 14:33:39 UTC 2012

dns
Displays DNS servers.

Syntax
show dns
Example
[appadmin]# show dns
show dns

DNS Information
Primary DNS : 192.168.5.3
Secondary DNS : <not configured>
Tertiary DNS : <not configured>
domain

Displays Domain Name, IP Address, and Name Server information.

Syntax

show domain

Example

[appadmin]# show domain

318
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hostname
Displays hostname.

Syntax

show hostname

Example

[appadmin]# show hostname
show hostname

wolf

ip

Displays IP and DNS information for the host.

Syntax

show ip

Example

[appadmin]# show ip

show ip

Device Type : Management Port

IP Address : 192.168.5.227

Subnet Mask : 255.255.255.0

Gateway : 192.168.5.1

Device Type : Data Port

IP Address <not configured>

Subnet Mask <not configured>

Gateway <not configured>
DNS Information

Primary DNS : 192.168.5.3

Secondary DNS : <not configured>

Tertiary DNS : <not configured>

license

Displays the license key.

Syntax

show license

Example

[appadmin]# show license
show license

timezone

Displays current system timezone.

Syntax

show timezone
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Example

[appadmin]# show timezone
show timezone

version

Displays Policy Manager software version hardware model.

Syntax

show version

Example

[appadmin]# show version

Policy Manager software version : 2.0(1).6649
Policy Manager model number : ET-5010

System commands

The Policy Manager command line interface includes the following system commands:
e '"boot-image" on page 320

e '"gen-support-key" on page 320

e 'install-license" on page 321

e 'restart" on page 321

e 'shutdown" on page 321

e '"update" on page 322

e 'upgrade" on page 322

boot-image

Sets system boot image control options.

Syntax

system boot-image [-1] [-a <version>]

Where:

Table 217: Boot-Image Commands

Flag/Parameter Description

Optional.

- List bootimages installed on the system.

Optional.

-a <version> . . . .
a=versio Set active bootimage version, in A.B.C.D syntax.

Example
[appadmin]# system boot-image

gen-support-key
Generates the support key for the system.
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Syntax

system gen-support-key

Example

[appadmin]# system gen-support-key

system gen-support-key

Support key='01U2FsdGVkX1l+/WS9jZKQajERyzXhM8mF6zAKrzxrHvaM="
install-license

Replace the current license key with a new one.

Syntax

system install-license <license-key>

Where:

Table 218: Install-License Commands

Flag/Parameter Description

Mandatory.

<li - >
license-key This is the newly issued license key.

Example

[appadmin]# system install-license

restart

Restart the system

Syntax

system restart

Example

[appadmin]# system restart

system restart
R e T T

* WARNING: This command will shutdown all applications *

* and reboot the system *
hhkkhkkkhkkhkhkkhkhkhkhkhkkhkhkkhkhkhkhkkhkhkhkhkhkkhkhkkhkhkkhkkkhkkhkhkkhkkkhkkhkhkkhkkkhkx

Are you sure you want to continue? [y|Y]: y

shutdown
Shutdown the system

Syntax

system shutdown

Example
[appadmin]# system shutdown
hhkkhkkkhkkhkhkkhkhkhkhkkhkhkkhkhkkhkhkkhkhkkhkhkhkkhkhkkhkhkkhkhkhkhkkhkhkkhkkkhkkhkhkkhkkkhkx

* WARNING: This command will shutdown all applications *

* and power off the system *
Fkkkdkkkhkkkdkkkhkkkhkkkkkkkhkkkkkkkkkkhkkkkkkkkkkkkdkkkx

Are you sure you want to continue? [y|Y]: y
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update

Manages updates.

Syntax

system update [-i user@hostname:/<filename> | http://hostname/<filename>]
system update [-u <patch-name>]

system update [-1]
Where:

Table 219: Update Commands

Flag/Parameter Description

-i
user@hostname:/<filenam
e> |
http://hostname/<filename>

Optional.
Install the specified patch on the system.

-u <patch-name>

Optional.
Uninstall the patch. (For exact patch names, refer
to [-1]in this table.)

Optional.
List the patches installed on the system.

Example

[appadminl# system update

upgrade
Upgrades the system.

Syntax

system upgrade <filepath>
Where:

Table 220: Upgrade Commands

Flag/Parameter Description
Required.
<filepath> Enter filepath, using either syntax provided in the
two examples provided.
Example 1
[appadmin]# system upgrade admin@sun.us.arubanetworks.com:/tmp/PolicyManager-x86-64-upgrade-7
1.tgz
Example 2

[appadmin]# system upgrade http://sun.us.arubanetworks.com/downloads/PolicyManager-x86-64-upg

rade-71.tgz

Miscellaneous Commands

The Policy Manager command line interface includes the following miscellaneous commands:
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"ad auth" on page 323

"ad netjoin" on page 323

"ad netleave" on page 324
"ad testjoin" on page 324
"alias" on page 324

"backup" on page 324

"dump certchain" on page 325
"dump logs" on page 325

"dump servercert" on page 326

e 'exit" on page 326

e '"help" on page 326

e '"krb auth" on page 327
e '"krb list" on page 327

e '"ldapsearch" on page 327

e '"quit" on page 328

e 'restore" on page 328

ad auth

Authenticate the user agains AD.

Syntax

ad auth --username=<username>

Where:

Table 221: Ad Auth Commands

Flag/Parameter Description
<username> Required.
username of the authenticating user.
Example

[appadmin]# ad auth --username=mike

ad netjoin

Joins host to the domain.

Syntax

ad netjoin <domain-controller.domain-name> [domain NETBIOS name]

Where:

Table 222: Ad Netjoin Commands

Flag/Parameter Description

<domain-controller.
domain-name>

Required.
Host to be joined to the domain.

[domain NETBIOS name]

Optional.
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Example

[appadmin]# ad netjoin atlas.us.arubanetworks.com

ad netleave

Removes host from the domain.

Syntax

ad netleave

Example
[appadmin]# ad netleave

ad testjoin

Tests if the netjoin command succeeded. Tests if Policy Manager is a member of the AD domain.

Syntax

ad testjoin
Example

[appadmin]# ad testjoin

alias

Creates or removes aliases.

Syntax

alias <name>=<command>

Where:

Table 223: Alias Commands

Flag/Parameter Description

<name>=<command> Sets <name> as the alias for <command>.
<name>= Removes the association.
Example 1

[appadmin]# alias sh=show

Example 2
[appadmin]# alias sh=

backup
Creates backup of Policy Manager configuration data. If no arguments are entered, the system auto-generates a filename

and backups up the configuration to this file.

Syntax
backup [-f <filename>] [-L] [-P]

Where:
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Table 224: Backup Commands

Flag/Parameter Description

Optional. Backup target.

-f <filename> If not specified, Policy Manager will auto-generate
a filename.

L Optional. Do not backup the log database
configuration

) Optional. Do not backup password fields from the
configuration database

Example

[appadmin]# backup -f PolicyManager-data.tar.gz

Continue? [y|Y]: vy

dump certchain

Dumps certificate chain of any SSL secured server.

Syntax

dump certchain <hostname:port-number>

Where:

Table 225: Dump Certchain Commands

Flag/Parameter

Description

<hostname:port-number>

Specifies the hostname and SSL port number.

Example 1

[appadmin]# dump certchain ldap.acme.com:636

dump certchain

dump logs

Dumps Policy Manager application log files.

Syntax

dump logs -f <output-file-name> [-s yyyy-mm-dd] [-e yyyy-mm-dd]

h]

Where:

Table 226: Dump Logs Commands

Flag/Parameter Description

-f <output-file-name>

Specifies target for concatenated logs.

[-n <days>]

-s yyyy-mm-dd

Optional. Date range start (default is today).

-e yyyy-mm-dd

Optional. Date range end (default is today).

[-t <log-type>]

[_
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Flag/Parameter Description

-n <days> Optional. Duration in days (from today).

-t <log-type> Optional. Type of log to collect.

-h Specify (print help) for available log types.
Example 1

[appadmin]# dump logs —-f tips-system-logs.tgz -s 2007-10-06 —e 2007-10-17 -t Systemlogs

Example 2
[appadmin] # dump logs -h

dump servercert
Dumps server certificate of SSL

Syntax

dump servercert <hostname

Where:

secured server.

:port—-number>

Table 227: Dump Servercert Commands

Flag/Parameter

<hostname:port-number>

Description

Specifies the hostname and SSL port number.

Example 1
[appadmin]# dump serverc

exit
Exits shell.

Syntax

exit

Example
[appadmin]# exit

help
Display the list of supported co

Syntax

help <command>

Example

[appadmin]# help
help

alias

backup

cluster
configure

dump

ert ldap.acme.com:636

mmands

Create aliases
Backup Policy Manager data

Policy Manager cluster related commands

Configure the system parameters
Dump Policy Manager information
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exit
help
netjoin
netleave
network
quit
restore
service
show
system

krb auth

Exit the shell

Display the list of supported commands
Join host to the domain

Remove host from the domain

Network troubleshooting commands

Exit the shell

Restore Policy Manager database
Control Policy Manager services

Show configuration details

System commands

Does a kerberos authentication against a kerberos server (such as Microsoft AD)

Syntax

krb auth <user@domain>

Where:

Table 228: Kerberos Authentication Commands

Flag/Parameter

Description

<user@domain>

Specifies the username and domain.

Example

[appadmin]# krb auth mike@corp-ad.acme.com

krb list

Lists the cached kerberos tickets

Syntax
krb list

Example

[appadmin]# krb list

Idapsearch

The Linux ldapsearch command to find objects in an LDAP directory. (Note that only the Policy Manager-specific
command line arguments are listed below. For other command line arguments, refer to ldapsearch man pages on the

Internet).

Syntax

ldapsearch -B <user@hostname>

Where:

Table 229: LDAP Search commands

Flag/Parameter

Description

<user@hostname>

Specifies the username and the full qualified
domain name of the host. The -B command finds
the bind DN of the LDAP directory.
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Example
[appadmin]# 1ldapsearch -B admin@corp-ad.acme.com

restore
Restores Policy Manager configuration data from the backup file

Syntax

restore user@hostname:/<backup-filename> [-1] [-1i] [-c|-C] [-p] [-s]

Where:

Table 230: Restore Commands

Flag/Parameter Description

< - I

user@hostname:/<backup Specify filepath of restore source.

filename>

-C Restore configuration database (default).

-C Do not restore configuration database.

N Optional. If it exists in the backup, restore log
database.

i Optional. Ignore version mismatch errors and
proceed.

) Optional. Force restore from a backup file that

P does not have password fields present.

s Optional. Restore cluster server/node entries from

the backup. (Node entries disabled on restore.)
Example

[appadmin]# restore user@hostname:/tmp/tips-backup.tgz -1 -i -c -s

quit
Exits shell.
Syntax
quit

Example
[appadmin]# quit
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Appendix B

Rules Editing and Namespaces

In the Policy Manager administration User Interface (UI) you use the same editing interface to create different types of
objects:

e Service rules

e Role mapping policies

e Internal user policies

e Enforcement policies

e Enforcement profiles

e Post-audit rules

e Proxy attribute pruning rules

o Filters for Access Tracker and activity reports

e Attributes editing for policy simulation
When editing all these elements, you are presented with a tabular interface with the same column headers:

e Type - Type is the namespace from which these attributes are defined. This is a drop-down list that contains
namespaces defined in the system for the current editing context.

e Name - Name is the name of the attribute. This is a drop-down list with the names of the attributes present in the
namespace.

e Operator - Operator is a list of operators appropriate for the data type of the attribute. The drop-down menu shows
the operators appropriate for data type on the left (that is, the attribute).

e Value - The value is the value of the attribute. Again, depending on the data type of the attribute, the value field
can be a free-form one-line edit box, a free-form multi-line edit box, a drop-down menu containing pre-defined
values (enumerated types), or a time or date widget.

In some editing interfaces (for example, enforcement profile and policy simulation attribute editing interfaces) the
operator does not change; it is always the EQUALS operator:

Providing a uniform tabular interface to edit all these elements enables you to use the same steps while configuring
these elements. Also, providing a context-sensitive editing experience (for names, operators and values) takes the
guess-work out of configuring these elements.

The following sections describe namespaces and operators in more detail.

Namespaces

There are multiple namespaces exposed in the rules editing interface. The namespaces exposed depend upon what you
are editing. For example, when you are editing posture policies you work with the posture namespace; when you are
editing service rules you work with, among other namespaces, the RADIUS namespace, but not the posture namespace.

Enumerated below are the namespaces you will find in the different rules editing contexts:

e RADIUS Namespace - Dictionaries in the RADIUS namespace come pre-packaged with the product. The
administration interface does provide a way to add new dictionaries into the system (See "RADIUS Dictionaries "
on page 291 for more information). RADIUS namespace has the notation RADIUS:Vendor, where Vendor is the
name of the Company that has defined attributes in the dictionary. Sometimes, the same vendor has multiple
dictionaries, in which case the "Vendor" portion has the name suffixed by the name of device or some other unique
string. IETF is a special vendor for the dictionary that holds the attributes defined in the RFC 2865 and other

ClearPass Policy Manager 6.1 | User Guide 329



330

associated RFCs. Policy Manager comes pre-packaged with a number of vendor dictionaries. Some examples of
dictionaries in the RADIUS namespace are: RADIUS:IETF, RADIUS:Cisco, RADIUS:Juniper.

RADIUS namespace appears in the following editing contexts:

Service rules: All RADIUS namespace attributes that can appear in a request (the ones marked with the IN or
INOUT qualifier)

RADIUS Enforcement profiles: All RADIUS namespace attributes that can be send back to a RADIUS client
(the ones marked with the OUT or INOUT qualifier)

Role mapping policies

Policy simulation attributes

Post-proxy attribute pruning rules

Filter rules for Access Tracker and Activity Reports

Posture Namespace - Dictionaries in the posture namespace come pre-packaged with the product. The
administration interface does provide a way to add new dictionaries into the system (See "Posture Dictionaries " on
page 292 for more information.) Posture namespace has the notation Vendor:Application, where Vendor is the name
of the Company that has defined attributes in the dictionary, and Application is the name of the application for
which the attributes have been defined. The same vendor typically has different dictionaries for different
applications. Some examples of dictionaries in the posture namespace are: ClearPass:LinuxSHV,
Microsoft:SystemSHV, Microsoft: WindowsSHV Trend:AV.

Posture namespace appears in the following editing contexts:
Internal posture policies conditions - Attributes marked with the IN qualifier
Internal posture policies actions - Attributes marked with the OUT qualifier
Policy simulation attributes
Filter rules for Access Tracker and Activity Reports

Authorization Namespaces - Policy Manager supports a number of types of authorization sources. Authorization
sources from which values of attributes can be retrieved to create role mapping rules have their own separate
namespaces (prefixed with Authorization:). They are:

Authorization - The authorization namespace has one attribute: sources. The values are prepopulated with the
authorization sources defined in Policy Manager. Use this to check for the authorization source(s) from which
attributes were extracted for the authenticating entity.

AD Instance Namespace - For each instance of an Active Directory authentication source, there is an AD
instance namespace that appears in the rules editing interface. The AD instance namespace consists of all the
attributes that were defined when the authentication source was created. These attribute names are pre-populated
in the UI for administrative convenience. For Policy Manager to fetch the values of attributes from Active
Directory, you need to define filters for that authentication source (see "Adding and Modifying Authentication
Sources " on page 128 for more information).

LDAP Instance Namespace - For each instance of an LDAP authentication source, there is an LDAP instance
namespace that appears in the rules editing interface. The LDAP instance namespace consists of all the attributes
that were defined when the authentication source was created. These attribute names are pre-populated in the Ul
for administrative convenience. For Policy Manager to fetch the values of attributes from an LDAP-compliant
directory, you need to define filters for that authentication source (see "Adding and Modifying Authentication
Sources " on page 128 for more information).

SQL Instance Namespace - For each instance of an SQL authentication source, there is an SQL instance
namespace that appears in the rules editing interface. The SQL instance namespace consists of attributes names
that you have defined when you created an instance of this authentication source. The attribute names are pre-
poluated for administrative convenience. For Policy Manager to fetch the values of attributes from a SQL-
compliant database, you need to define filters for that authentication source.
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®m  RSAToken Instance Namespace - For each instance of an RSA Token Server authentication source, there is an
RSA Token Server instance namespace that appears in the rules editing interface. The RSA Token Server
instance namespace consists of attributes names that you have defined when you created an instance of this
authentication source. The attribute names are pre-poluated for administrative convenience.

m  Sources- This is the list of the authorization sources from which attributes were fetched for role mapping.
Authorization namespaces appear in the following editing contexts:
= Role mapping policies

o Date Namespace - The date namespace has three pre-defined attributes defined: Time-of-Day, Day-of-Week and
Date-of-Year. Depending on the attribute selected in the UL the operator and value fields change. For Day-of-
Week, the operators supported are BELONG_TO and NOT _BELONGS _TO, and the value field shows a multi-
select list box with days from Monday through Sunday. The Time-of-Day attribute shows a time widget in the
value field. The Date-of-Year attribute shows a date, month and year widget in the value field. The operators
supported for Date-of-Year and Time-of-Day attributes are the similar to the ones supported for the integer data type
(See section for more details.

Date namespace appears in the following editing contexts:
= Service rules

= Role mapping policies

= Enforcement policies

= Filter rules for Access Tracker and Activity Reports

o Connection Namespace - The connection namespace can be used in role mapping policies to define roles based on
where the protocol request originated from and where it terminated. The connection namespace has the following
pre-defined attributes:

Table 231: Connection Namespace Pre-defined Attributes

Attribute Description

Src-IP-Address Src-IP-Address and Src-Port are the IP address and port from
which the request (RADIUS, TACACS+, etc.) originated

Src-Port

Dest-IP-Address Dst-IP-Address and Dst-Port are the IP address and port at
which Policy Manager received the request (RADIUS,
TACACSH, etc.)

Dest-Port

Protocol Request protocol: RADIUS, TACACS+, WebAuth

NAD-IP-Address IP address of the network device from which the request
originated

Client-Mac-Address MAC address of the client

Client-Mac-Address-Colon, Client- Client MAC address in different formats

Mac-Address-Dot, Client-Mac-

Address-Hyphen, Client-Mac-

Address-Nodelim

Client-IP-Address IP address of the client (if known)

Connection namespace appears in the following editing contexts:
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= Service rules

= Role mapping policies

o Authentication Namespace - The authentication namespace can be used in role mapping policies to define roles
based on what kind of authentication method was used or what the status of the authentication is. The attribute

names and possible values with descriptions are shown in the table below:

Table 232: Authentication Namespace Attributes

Attribute

Name Values
InnerMethod PAP
CHAP
MSCHAP
EAP-GTC
EAP-MSCHAPV2
EAP-MD5
EAP-TLS
OuterMethod PAP
CHAP
MSCHAP
EAP-MD5
EAP-TLS
EAP-TTLS
EAP-FAST
EAP-PEAP
Phase1PAC o None - No PAC was used to establish the outer tunnel in the EAP-FAST
authentication method
e Tunnel - A tunnel PAC was used to establish the outer tunnel in the EAP-FAST
authentication method
e Machine - A machine PAC was used to establish the outer tunnel in the EAP-FAST
authentication method; machine PAC is used for machine authentication (See EAP-
FAST in "Adding and Modifying Authentication Methods" on page 111).
Phase2PAC o None - No PAC was used instead of an inner method handshake in the EAP-FAST
authentication method
o UserAuthPAC - A user authentication PAC was used instead of the user
authentication inner method handshake in the EAP-FAST authentication method
o PosturePAC - A posture PAC was used instead of the posture credential handshake
in the EAP-FAST authentication method
Posture o Capable - The clientis capable of providing posture credentials
o Collected - Posture credentials were collected from the client
o Not-Capable - The clientis not capable of providing posture credentials
e Unknown - Itis not known whether the client is capable of providing credentials
Status e None - No authentication took place
o User- The user was authenticated
e Machine - The machine was authenticated
o Failed - Authentication failed
o AuthSource-Unreachable - The authentication source was unreachable
MacAuth o NotApplicable - Not a MAC Auth request
o Known Client - Client MAC address was found in an authentication source

332

ClearPass Policy Manager 6.1 | User Guide



Attribute

Values
Name

e Unknown Client - Client MAC address was not found in an authentication source
Username The username as received from the client (after the strip user name rules are applied
Full- The username as received from the client (before the strip user name rules are applied
Username
Source The name of the authentication source used to authenticate the user

Authentication namespace appears in the following editing contexts:
= Role mapping policies

o Certificate Namespace - The certificate namespace can be used in role mapping policies to define roles based on
attributes in the client certificate presented by the end host. Client certificates are presented in mutually
authenticated 802.1X EAP methods (EAP-TLS, PEAP/TLS, EAP-FAST/TLS). The attribute names and possible
values with descriptions are shown in the table below:

Table 233: Certificate Namespace Attributes

Attribute Name Values

Version Certificate version

Serial-Number Certificate serial number

Subject-DN, Subject-DC, Subject-UID, Subject-CN, Attributes associated with the subject (user

Subject-GN, Subject-SN, Subject-C, Subject-L, Subject-ST, or machine, in this case). Not all of these

Subject-O, Subject-OU, Subject-emailAddress fields are populated in a certificate.

Issuer-DN, Issuer-DC, Issuer-UID, Issuer-CN, Issuer-GN, Attributes associated with the issuer

Issuer-SN, Issuer-C, Issuer-L, Issuer-ST, Issuer-O, Issuer- (Certificate Authorities or the enterprise

OU, Issuer-emailAddress CA). Not all of these fields are populated in
a certificate.

Subject-AltName-Email, Subject-AltName-DNS, Subject- Attributes associated with the subject (user

AltName-URI, Subject-AliName-DirName, Subject- or machine, in this case) alternate name.

AltName-IPAddress, Subject-AltName-RegisterdID, Not all of these fields are populated in a

Subject-AltName-msUPN certificate.

Certificate namespace appears in the following editing contexts:
= Role mapping policies

o Tips Namespace - Tips namespace has two pre-defined attributes: Role and Posture. Values are assigned to these
attributes at run-time after Policy Manager evaluates role mapping and posture related policies. The value for the
Role attribute is a set of roles assigned by the either the role mapping policy or the post-audit policy. The value
value of the Role attribute can also be a dynamically fetched “Enable as role” attribute from the authorization
source. The value for the Posture attribute is one of HEALTHY, CHECKUP, TRANSITION, QUARANTINE,
INFECTED or UNKNOWN. The posture value is computed after Policy Manager evaluates internal posture
policies, gets posture status from posture servers or audit servers.
Tips namespace appears in the following editing contexts:

= Enforcement policies
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e Host Namespace - Host namespace has a number of pre-defined attributes: Name, OSType, FQDN, UserAgent,
CheckType, UniquelD, AgentType and InstalledSHAs. Host:Name, Host:OSType, Host:FQDN, Host: AgentType,
Host:InstalledSHAs are only populated when request is originated by a Microsot NAP-compatible agent.
UserAgent and CheckType are present when Policy Manager acts as a Web authentication portal.

e Endpoint Namespace - Endpoint namespace has the following attributes: Disabled By, Disabled Reason, Enabled
By, Enabled Reason, Info URL. Use these attributes look for attributes of authenticating endpoints (present in the
Policy Manager endpoints list).

e Device Namespace - Device namespace has the attributes associated with the network device that originated the
request. Device namespace has four pre-defined attributes: Location, OS-Version, Device-Type and Device-Vendor.
Custom attributes also appear in the attribute list if they are defined as custom tags for the device. Note that these
attribtues can be used only if you have pre-populated the values for these attributes when a network device is
configured in Policy Manager.

o LocalUser Namespace - LocalUser namespace has the attributes associated with the local user (resident in the
Policy Manager local user database) who authenticated in this session. As the name suggests, this namespace is
only applicable if a local user authenticated. LocalUser namespace has four pre-defined attributes: Phone, Email,
Sponsor and Designation. Custom attributes also appear in the attribute list if they are defined as custom tags for
the local user. Note that these attribtues can be used only if you have pre-populated the values for these attributes
when a local user is configured in Policy Manager.

o GuestUser Namespace - GuestUser namespace has the attributes associated with the guest user (resident in the
Policy Manager guest user database) who authenticated in this session. As the name suggests, this namespace is
only applicable if a guest user authenticated. GuestUser namespace has six pre-defined attributes: Company-Name,
Location, Phone, Email, Sponsor and Designation. Custom attributes also appear in the attribute list if they are
defined as custom tags for the guest user. Note that these attribtues can be used only if you have pre-populated the
values for these attributes when a guest user is configured in Policy Manager.

e Audit Namespace - Dictionaries in the audit namespace come pre-packaged with the product. Audit namespace has
the notation Vendor:Audit, where Vendor is the name of the Company that has defined attributes in the dictionary.
An example of a dictionary in the audit namespace is: Avenda Systems:Audit or Qualys:Audit.

= Audit namespace appears when editing post-audit rules. (See " Audit Servers " on page 199for more
information.)

= Avenda Systems:Audit namespace appears when editing post-audit rules for NESSUS and NMAP audit servers.
The attribute names and possible values with descriptions are shown in the table below:

Table 234: Audit Namespace Attributes

Attribute Name Values

Audit-Status AUDIT_SUCCESS, AUDIT_INPROGRESS or AUDIT_ERROR
Device-Type Type of device returned by an NMAP port scan

Output-Msgs The output message returned by Nessus plugin after a vulnerability scan
Network-Apps String representation of the open network ports (http, telnet, etc.)
Mac-Vendor Vendor associated with MAC address of the host

OS-Info OS information string returned by NMAP

Open-Ports The port numbers of open applications on the host
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e Tacacs Namespace - Tacacs namespace has the attributes associated with attributes available in a TACACS+
request. Available attributes are AvendaA VPair, UserName and AuthSource.

e Application Namespace - Application namespace has a name attribute. This attribute is an enumerated type
currently containing the following string values: GuestConnect, Insight, Edge.

Variables

Variables are populated with the connection-specific values. Variable names (prefixed with % and enclosed in curly
braces; for example, %{Username}”) can be used in filters, role mapping, enforcement rules and enforcement profiles.
Policy Manager does in-place substitution of the value of the variable during runtime rule evaluation. The following
built-in variables are supported in Policy Manager:

Table 235: Policy Manager Variables

Variable Description

Y{attribute- attribute-name is the alias name for an attribute that you have configured to be
name} retrieved from an authentication source. See "Adding and Modifying
Authentication Sources " on page 128.

% MAC address of client in aa:bb:cc:dd:ee:ff format
{RADIUS:IETF:MAC-
Address-Colon}

% MAC address of client in aa-bb-cc-dd-ee-ff format
{RADIUS:IETF:MAC-
Address-Hyphen}

% MAC address of client in aabb.ccdd.eeff format
{RADIUS:IETF:MAC-
Address-Dot}

% MAC address of client in aabbccddeeff format
{RADIUS:IETF:MAC-
Address-NoDelim}

Note that you can also use any other dictionary-based attributes (or namespace attributes defined in this chapter) as
variables in role mapping rules, enforcement rules, enforcement profiles and LDAP or SQL filters. For example, you can
use %{RADIUS:IETF:Calling-Station-ID} or %{RADIUS:Airespace:Airespace-Wlan-Id} in rules or filters.

Operators

The rules editing interface in Policy Manager supports a rich set of operators. The type of operators presented in the Ul
is based on the data type of the attribute for which the operator is being used. Wherever the data type of the attribute
is not known, the UI treats that attribute as a string type. The following table lists the operators presented for common
attribute data types:
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Table 236: Attribute Operators

Attribute
Operators

Type

String EQUALS, NOT_EQUALS, CONTAINS, NOT_CONTAINS, BEGINS_WITH, NOT_
BEGINS_WITH, ENDS_WITH, NOT_ENDS_WITH, BELONGS_TO, NOT_BELONGS_TO,
EQUALS_IGNORE_CASE, NOT_EQUALS_IGNORE_CASE, MATCHES_REGEX, NOT_
MATCHES_REGEX, EXISTS, NOT_EXISTS

Integer EQUALS, NOT_EQUALS, GREATER_THAN, GREATER_THAN_OR_EQUALS, LESS_
THAN, LESS_THAN_OR_EQUALS, EXISTS, NOT_EXISTS, BELONGS_TO, NOT_
BELONGS_TO

Time or Date EQUALS, NOT_EQUALS, GREATER_THAN, GREATER_THAN_OR_EQUALS, LESS_
THAN, LESS_THAN_OR_EQUALS, IN_RANGE

Day BELONGS_TO, NOT_BELONGS_TO

List EQUALS, NOT_EQUALS, MATCHES_ANY, NOT_MATCHES_ANY, MATCHES_ALL,

(Example: NOT_MATCHES_ALL, MATCHES_EXACT, NOT_MATCHES_EXACT

Role)

Group BELONGS_TO_GROUP, NOT_BELONGS_TO_GROUP, and all string data types

(Example:

Calling-

Station-Id,

NAS-IP-

Address)

The following table describes all the operator types:
Table 237: Operator Types

Operator Description

EQUALS True if the run-time value of the attribute matches the configured value. For string data
type, this is a case-sensitive comparison.
E.g., RADIUS: IETF:NAS-Identifier EQUALS "SJ-VPN-DEVICE"
CONTAINS For string data type, true if the run-time value of the attribute is a substring of the
configured value.
E.g., RADIUS: IETF:NAS-Identifier CONTAINS "VPN"
BEGINS_ For string data type, true if the run-time value of the attribute begins with the configured
WITH value.
E.g., RADIUS: IETF:NAS-Identifier BEGINS WITH "SJ-"
ENDS_ For string data type, true if the run-time value of the attribute ends with the configured
WITH value.
E.g., RADIUS: IETF:NAS-Identifier ENDS WITH "DEVICE"
BELONGS_ | For string data type, true if the run-time value of the attribute matches a set of configured
TO string values.
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Operator Description

E.g., RADIUS:IETF:Service-Type BELONGS TO Login-User, Framed-
User,Authenticate-Only
For integer data type, true if the run-time value of the attribute matches a set of configured
integer values.
E.g., RADIUS: IETF:NAS-Port BELONGS TO 1,2,3
For day data type, true if run-time value of the attribute matches a set of configured days of
the week.
E.g., Date:Day-of-Week BELONGS_ TO MONDAY, TUESDAY, WEDNESDAY
When Policy Manager is aware of the values that can be assigned to BELONGS_TO
operator, it populates the value field with those values in a multi-select list box; you can
select the appropriate values from the presented list. Otherwise, you must enter a comma
separated list of values.
EQUALS_ For string data type, true if the run-time value of the attribute matches the configured value,
IGNORE_ regardless of whether the string is upper case or lower case.
CASE E.g., RADIUS: IETF:NAS-Identifier EQUALS IGNORE CASE "sj-vpn-device"
MATCHES_ | For string data type, true if the run-time value of the attribute matches the regular
REGEX expression in the configured value.
E.g., RADIUS: IETF:NAS-Identifier MATCHES REGEX sj-device[l-9]-dev*
EXISTS For string data type, true if the run-time value of the attribute exists. This is a unary
operator.
E.g., RADIUS: IETF:NAS-Identifier EXISTS
GREATER_ For integer, time and date data types, true if the run-time value of the attribute is greater
THAN than the configured value.
E.g., RADIUS: IETF:NAS-Port GREATER THAN 10
GREATER_ For integer, time and date data types, true if the run-time value of the attribute is greater
THAN_OR_ | than or equal to the configured value.
EQUALS E.g., RADIUS: IETF:NAS-Port GREATER THAN OR EQUALS 10
LESS_ For integer, time and date data types, true if the run-time value of the attribute is less than
THAN the configured value.
E.g., RADIUS: IETF:NAS-Port LESS THAN 10
LESS For integer, time and date data types, true if the run-time value of the attribute is less than
THAN_OR _ or equal to the configured value.
EQUALS E.g., RADIUS:IETF:NAS-Port LESS THAN OR EQUALS 10
IN_RANGE For time and date data types, true if the run-time value of the attribute is less than or equal
to the first configured value and less than equal to the second configured value.
E.g., Date:Date-of-Year IN RANGE 2007-06-06,2007-06-12
MATCHES_ | For listdata types, true if any of the run-time values in the list matches one of the
ANY configured values.
E.g., Tips:Role MATCHES ANY HR,ENG, FINANCE
MATCHES_ | For list data types, true if all of the run-time values in the list are found in the configured
ALL values.
E.g., Tips:Role MATCHES ALL HR, ENG,FINANCE. In this example, if the run-time values
of Tips:Role are HR,ENG,FINANCE,MGR,ACCT the condition evaluates to true.
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Operator Description

MATCHES_ | For listdata types, true if all of the run-time values of the attribute match all of the

EXACT configured values.

E.g., Tips:Role MATCHES ALL HR,ENG, FINANCE. In this example, if the run-time values
of Tips:Role are HR,ENG,FINANCE ,MGR,ACCT the condition evaluates to false, because
there are some values in the configured values that are not present in the run-time values.

BELONGS_ | For group data types, true if the run-time value of the attribute belongs to the configured
TO_ group (either a static host list or a network device group, depending on the atiribute).

GROUP E.g., RADIUS: IETF:Calling-Station-Id BELONGS TO GROUP Printers.
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Appendix C

Error Codes, SNMP Traps, and System Events

This appendix contains listings of ClearPass Policy Manager error codes, SNMP traps, and system

events.

e Error Codes

e SNMP Trap Details

e Important System Events

Error Codes
The following table shows the CPPM error codes.

Code Description Type

0 Success Success

101 Failed to perform service classification Internal Error

102 Failed to perform policy evaluation Internal Error

103 Failed to perform posture notification Internal Error

104 Failed to query authstatus Internal Error

105 Internal error in performing authentication Internal Error

106 Internal error in RADIUS server Internal Error

201 User not found Authentication failure
202 Password mismatch Authentication failure
203 Failed to contact AuthSource Authentication failure
204 Failed to classify request to service Authentication failure
205 AuthSource not configured for service Authentication failure
206 Access denied by policy Authentication failure
207 Failed to get client macAddress to perform webauth Authentication failure
208 No response from home server Authentication failure
209 No password in request Authentication failure
210 Unknown CA in client certificate Authentication failure
211 Client certificate not valid Authentication failure
212 Client certificate has expired Authentication failure
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Code

Description

Type

213 Certificate comparison failed Authentication failure
214 No certificate in authentication source Authentication failure
215 TLS session error Authentication failure
216 User authentication failed Authentication failure
217 Search failed due to insufficient permissions Authentication failure
218 Authentication source timed out Authentication failure
219 Bad search filter Authentication failure
220 Search failed Authentication failure
221 Authentication source error Authentication failure
222 Password change error Authentication failure
223 Username not available in request Authentication failure
224 CallingStationID not available in request Authentication failure
225 User accountdisabled Authentication failure
226 User account expired or not active yet Authentication failure
227 User account needs approval Authentication failure
5001 Internal Error Command and Control
5002 Invalid MAC Address Command and Control
5003 Invalid request received Command and Control
5004 Insufficient parameters received Command and Control
5005 Query - No MAC address record found Command and Control
5006 Query - No supported actions Command and Control
5007 Query - Cannot fetch MAC address details Command and Control
5008 Request - MAC address not online Command and Control
5009 Request - No MAC address record found Command and Control
6001 Unsupported Tacacs parameter in request TACACS Protocol
6002 Invalid sequence number TACSCS Protocol
6003 Sequence number overflow TACACS Protocol
6101 Not enough inputs to perform authentication TACACS Authentication
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Code Description Type

6102 Authentication privilege level mismatch TACACS Authentication
6103 No enforcement profiles matched to perform authentication TACACS Authentication
6201 Authorization failed as session is not authenticated TACACS Authorization
6202 Authorization privilege level mismatch TACACS Authorization
6203 Command not allowed TACACS Authorization
6204 gl?tsg:i(;;c:t?or?‘ent profiles matched to perform command TACACS Authorization
6301 New password entered does not match ;/:ggv(;?dChange
6302 Empty password ;’:g&%?d(:hange
6303 Change password allowed only for local users ;/:ggv(;?dChange
6304 Internal error in performing change password ;’:g&%?d(:hange
9001 Wrong shared secret RADIUS Protocol
9002 Request timed out RADIUS Protocol
9003 Phase2 PAC failure RADIUS Protocol
9004 Client rejected after PAC provisioning RADIUS Protocol
9005 Client does not support posture request RADIUS Protocol
9006 Received error TLV from client RADIUS Protocol
9007 Received failure TLV from client RADIUS Protocol
9008 Phase2 PAC not found RADIUS Protocol
9009 Unknown Phase2 PAC RADIUS Protocol
9010 Invalid Phase2 PAC RADIUS Protocol
9011 PAC verification failed RADIUS Protocol
9012 PAC binding failed RADIUS Protocol
9013 Session resumption failed RADIUS Protocol
9014 Cached session data error RADIUS Protocol
9015 Client does not support configured EAP methods RADIUS Protocol
9016 Client did not send Cryptobinding TLV RADIUS Protocol
9017 Failed to contact OCSP Server RADIUS Protocol
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CPPM leverages native SNMP support from the 'net-snmp' package to send trap notifications for the following events:

1. snmp daemon trap events
Trap OIDs:
1.3.6.1.63.1.1.5.1
1.3.6.1.63.1.1.5.2
2. CPPM processes stop and start events
Trap OIDs:
.1.3.6.1.2.1.88.2.0.2 [mteTriggerRising]
.1.3.6.1.2.1.88.2.0.3 [mteTriggerFalling]
3. Network interface up and down events
Trap OIDs:
.13.6.1.6.3.1.1.53:
1.3.6.1.63.1.1.54:
4. Disk utilization threshold exceed events
Trap OIDs:
.1.3.6.1.2.1.88.2.0.2 [mteTriggerRising]
.1.3.6.1.2.1.88.2.0.3 [mteTriggerFalling]
5. CPU load average exceed events for 1, 5 and 15 mins thresholds
Trap OIDs:
.1.3.6.1.2.1.88.2.0.2 [mteTriggerRising]
.1.3.6.1.2.1.88.2.0.3 [mteTriggerFalling]

The following are the OIDs for the various trap events that are sent from CPPM.

snmp daemon traps:

.1.3.6.1.6.3.1.1.5.1 ==> Coldstart trap indicating the reinitialization of 'netsnmp' daemon and its configuration
file may have been altered

.1.3.6.1.6.3.1.1.5.2 ==> Warmstart trap indicating the reinitialization of 'netsnmp' daemon and its configuration
file is not altered

Process status traps:

.1.3.6.1.4.1.2021.2.1.100.X ==> Error flag on a process status. The value will be set to 1, if the process is
stopped and set to 0 if the process is running.

.1.3.6.1.4.1.2021.2.1.101.X ==> Error message on the process status. The value will contain the error message
when the process is stopped and will be empty when the process is running.

.1.3.6.1.4.1.2021.2.1.2. X ==> Name of the process for which the status is reported as indicated by above trap
OIDs.

In all the above trap OIDs, the value of X varies from 1 through N depending on the number of process status being
checked. Details of the specific OIDs associated with the processes are listed in the next section.

Example 1

The following example shows the OIDs and the values set when Policy Server process is stopped

OID: .1.3.6.1.4.1.2021.2.1.100.1:

Value: INTEGER: 1:

.1.3.6.1.4.1.2021.2.1.2.1: policy server:
.1.3.6.1.4.1.2021.2.1.101.1: No policy server process running.:
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Example 2

The following example shows the trap OIDs and the values set when Policy Server process is running:

OID: .1.3.6.1.4.1.2021.2.1.100.1:

Value: INTEGER: O:
.1.3.6.1.4.1.2021.2.1.2.1: policy server:
.1.3.6.1.4.1.2021.2.1.101.1:

CPPM Processes and OIDs

The following is a list of monitored CPPM processes and the corresponding OID list associated with these processes:
.1.3.6.1.4.1.2021.2.1.2.1: policy_server: ==> Policy Server Module
.1.3.6.1.4.1.2021.2.1.2.2: TacacsServer: ==> Tacacs Server module
.1.3.6.1.4.1.2021.2.1.2.3: londiste: ==> Cluster operation process
.1.3.6.1.4.1.2021.2.1.2.4: radiusd: ==> Radius server
.1.3.6.1.4.1.2021.2.1.2.5: launch-dbcn-dae: ==> Database change notification module
.1.3.6.1.4.1.2021.2.1.2.6: frontend-tomcat: ==> Administration Ul instance
.1.3.6.1.4.1.2021.2.1.2.7: backend-tomcat: ==> System auxialiary service
.1.3.6.1.4.1.2021.2.1.2.8: snmpd: ==> net-snmp daemon
.1.3.6.1.4.1.2021.2.1.2.9: launch-async-ne: ==> Asynchronous network services
.1.3.6.1.4.1.2021.2.1.2.10: winbindd: ==> Domain services
.1.3.6.1.4.1.2021.2.1.2.11: launch-battery: ==> Multi-master cache

CPU Load Average Traps

.1.3.6.1.4.1.2021.10.1.100.1 ==> Error flag on the CPU load-1 average. Value of 1 indicates the load-1 has crossed
its threshold and 0 indicates otherwise.

.1.3.6.1.4.1.2021.10.1.2.1 ==> Name of CPU load-1 average

.1.3.6.1.4.1.2021.10.1.100.2 ==> Error flag on the CPU load-5 average. Value of 1 indicates the load-5 has crossed
its threshold and 0 indicates otherwise.

.1.3.6.1.4.1.2021.10.1.2.2 ==> Name of CPU load-5 average

.1.3.6.1.4.1.2021.10.1.100.3 ==> Error flag on the CPU load-15 average. Value of 1 indicates the load-15 has
crossed its threshold and 0 indicates otherwise.

.1.3.6.1.4.1.2021.10.1.2.3 ==> Name of CPU load-15 average

Disk space threshold traps:

.1.3.6.1.4.1.2021.9.1.100.1 ==> Error flag indicating the disk or partition is under the minimum required space
configured for it. Value of 1 indicates the system has reached the threshold and 0 indicates otherwise.

.1.3.6.1.4.1.2021.9.1.2.1 ==> Name of the partition which has met the above condition

Network interface status traps:

.1.3.6.1.6.3.1.1.5.3 ==> Indicates the linkdown trap with the 'ifAdminStatus' and 'ifOperStatus' values set to 2.
.1.3.6.1.6.3.1.1.5.4 ==> Indicates the linkup trap with the 'ifAdminStatus' and 'ifOperStatus' values set to 1.

In both the cases, 'iflIndex' value is set to 2 for management interface and 3 for the data port interface.
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This topic describes the important System Events logged by ClearPass. These messages are available for consumption
on the administrative interface, and in the form of a syslog stream. The events below are in the following format

<Source>, <Level>, <Category>, <Message>

Elements listed below within angular brackets (<content>) are variable, and are substituted by ClearPass as applicable
(such as an IP address).

Refer to the "Service Names" on page 348 section for the list of available service names.

Admin Ul Events

Critical Events

“Admin UI”, “ERROR” “Email Failed”, “Sending email failed”
“Admin UI”, “ERROR” “SMS Failed”, “Sending SMS failed”
“Admin UI”, “WARN”, “Login Failed”, “User:<X>"

"Admin UI", "WARN", "Login Failed", description

Info Events

"Admin UI", "INFO", "Logged out"

"Admin UI", "INFO", "Session destroyed"

"Admin UI", "INFO", "Logged in", description

"Admin UI", "INFO", "Clear Authentication Cache", “Cache is cleared for authentication source <X>"
"Admin UI", "INFO", "Clear Blacklist User Cache", “Blacklist Users cache is cleared for authentication source <X>"
"Admin UI", "INFO", "Server Certificate", "Subject:<X>*, "Updated"

"Admin UI", "INFO", "Updated Nessus Plugins"

"Install Update", "INFO", "Installing Update", "File: <X>", "Success"

"Admin UI", “INFO” “Email Successful”, “Sending email succeeded”

"Admin UI", “INFO” “SMS Successful”, “Sending SMS succeeded”

Admin Server Events

Info Events

1)

“Admin server”, “INFO”, “Performed action start on Admin server”

Async Service Events

Info Events
“Async DB write service”, “INFO”, “Performed action start on Async DB write service”
“Multi-master cache”, “INFO”, “Performed action start on Multi-master cache”

“Async netd service”, “INFO”, “Performed action start on Async netd service”
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ClearPass/Domain Controller Events

Critical Events

“netleave”, “ERROR”, “Failed to remove <HOSTNAME> from the domain <DOMAIN NAME>"

“netjoin”, “WARN?”, “configuration”, “<HOSTNAME> failed to join the domain <DOMAIN NAME> with domain
controller as <DOMAIN CONTROLLER>"

Info Events

“Netjoin”, “INFO”, "<HOSTNAME> joined the domain <REALM>"

“Netjoin”, “INFO”, “<HOSTNAME> removed from the domain <DOMAIN NAME>*

ClearPass System Configuration Events

Critical Events

“DNS”, “ERROR?”, “Failed configure DNS servers = <X>”

“datetime”, “ERROR”, “Failed to change system datetime.”

“hostname”, “ERROR”, “Setting hostname to <X> failed”

“ipaddress”, “ERROR?”, “Testing cluster node connectivity failed”

“System TimeCheck “, “ WARN ,” | “Restarting CPPM services as the system detected time drift , Current system
time= 2013-07-27 17:00:01, System time 5 mins back = 2013-01-25 16:55:01”

Info Events

“Cluster”, “INFO”, “Setup”, “Database initialized”

“hostname”, “INFO”, “configuration”, “Hostname set to <X>"

“ipaddress”, “INFO”, “configuration”, Management port information updated to - [pAddress = <X>, Netmask = <X>,
Gateway = <X>”

“IpAddress”, “INFO”, "Data port information updated to - [pAddress = <X>, Netmask = <Y>, Gateway = <Z>"
“DNS”, “INFO”, “configuration”, “Successfully configured DNS servers - <X>”

“Time Config”, “INFO”, “Remote Time Server”, “Old List: <X>\nNew List: <Y>"

“timezone”, “INFO”, “configuration”,

“datetime”, “INFO”, “configuration”, “Successfully changed system datetime.\nOld time was <X>"

ClearPass Update Events

Critical Events
“Install Update”, “ERROR?”, “Installing Update”, “File: <X>”, “Failed with exit status - <Y>"

)

“ClearPass Firmware Update Checker”, “ERROR”, “Firmware Update Checker”, “No subscription ID was supplied. To
find new plugins, you must provide your subscription ID in the application configuration”

Info Events

“ClearPass Updater”, “INFO”, “Hotfixes Updates”, “Updated Hotfixes from File”

“ClearPass Updater”, “INFO”, “Fingerprints Updates”, “Updated fingerprints from File”

“ClearPass Updater”, “INFO”, “Updated AV/AS from ClearPass Portal (Online)”

“ClearPass Updater”, “INFO”,” Updated Hotfixes from ClearPass Portal (Online)”
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Cluster Events

Critical Events

“Cluster”, “ERROR?”, “SetupSubscriber”, “Failed to add subscriber node with management [P=<IP>*

Info Events
"AddNode", “INFO”, "Added subscriber node with management [P=<IP>"

"DropNode", “INFO”, "Dropping node with management [P=<IP>, hostname=<Hostname>"

Command Line Events

Info Events

"Command Line”, “INFO”, “User:appadmin"

DB Replication Services Events

Info Events
"DB replication service”, “INFO”, “Performed action start on DB replication service”
"DB replication service”, “INFO”, “Performed action stop on DB replication service”

“DB change notification server”, “INFO”, “Performed action start on DB change notification server”

“DB replication service”, “INFO”, “Performed action start on DB replication service”

Licensing Events

Critical Events

“Admin UI”, “WARN”, “Activation Failed”, “Action Status: This Activation Request Token is already in use by
another instance\nProduct Name: Policy Manager\nLicense Type: <X>\nUser Count: <Y>"

Info Events

“Admin UI”, “INFO”, “Add License”, “Product Name: Policy Manager\nLicense Type: <X>\nUser Count: <Y>"

Policy Server Events

Info Events
“Policy Server”, “INFO”, “Performed action start on Policy server”

)

“Policy Server”, “INFO”, “Performed action stop on Policy server”

RADIUS/TACACS+ Server Events

Critical Events
“TacacsServer”, “ERROR”, “Request”, “Nad Ip=<X> not configured”
“RADIUS”, “WARN?, “Authentication”, “Ignoring request from unknown client <IP>:<PORT>"

“RADIUS”, “ERROR?”, “Authentication”, “Received packet from <IP> with invalid Message-Authenticator! (Shared
secret is incorrect.)”

“RADIUS”, “ERROR?”, “Received Accounting-Response packet from client <IP Address> port 1813 with invalid
signature (err=2)! (Shared secret is incorrect.)”
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“RADIUS”, “ERROR?”, “Received Access-Accept packet from client <IP Address> port 1812 with invalid signature
(err=2)! (Shared secret is incorrect.)”

Info Events

“RADIUS”, “INFO”, “Performed action start on Radius server”

“RADIUS”, “INFO”, “Performed action restart on Radius server

“TACACS server”, “INFO”, “Performed action start on TACACS server”

“TACACS server”, “INFO”, “Performed action stop on TACACS server”

SNMP Events

Critical Events

“SnmpService”, “ERROR”, “ReadDevicelnfo”, “SNMP GET failed for device <X> with error=No response
received\nReading sysObjectld failed for device=<X>\nReading switch initialization info failed for <X>”

"SnmpService","ERROR", "Error fetching table snmpTargetAddr. Request timed out. Error reading SNMP target table
for NAD=10.1.1.1 Maybe SNMP target address table is not supported by device? Allow NAD update. SNMP GET
failed for device 10.1.1.1 with error=No response received Reading sysObjectld failed for device=10.1.1.1 Reading
switch initialization info failed for 10.1.1.1”

Info Events

“SnmpService”, “INFO”, “Device information not read for <Ip Address> since no traps are configured to this node”

Support Shell Events

Info Events
“Support Shell” , “INFO”, “User:arubasupport”

System Auxiliary Service Events

Info Events

“System auxiliary service”, “INFO”, “Performed action start on System auxiliary service”

System Monitor Events

Critical Events

“Sysmon”, “ERROR”, “System”, “System is running with low memory. Available memory = <X>%"

“Sysmon”, “ERROR”, “System”, “System is running with low disk space. Available disk space = <X>%"
“System TimeCheck”, “WARN”, “Restart Services”, “Restarting CPPM services as the system detected time drift.
Current system time= <X>, System time 5 mins back = <Y>”

Info Events

“<Service Name>", “INFO”, “restart”, “Performed action restart on <Service Name>"

“SYSTEM”, “INFO”, “<X> restarted”, “System monitor restarted <X>, as it seemed to have stopped abruptly”
"SYSTEM", "ERROR", "Updating CRLs failed", "Could not retrieve CRL from <URL>."

“System monitor service”, “INFO”, “Performed action start on System monitor service”

"Shutdown” “INFO” system "System is shutting down" Success
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Service Names

e AirGroup notification service
e Async DB write service

e Async network services

e DB change notification server
e DB replication service

e Micros Fidelio FIAS

e Multi-master cache

e Policy server

e RADIUS server

e System auxiliary services

e System monitor service

o TACACS server

e Virtual IP service

e [YOURSERVERNAME] Domain service
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Appendix D

Software Copyright'and License Statements

This appendix lists the copyright notices for the binary distribution from Aruba Networks. A copy of the source code
is available for portions of the software whose copyright statement requires Aruba Networks to publish any modified
source code. To cover the costs of duplication and shipping, there is a nominal cost to obtain the source code material.
To obtain a copy of the source code, contact info@arubanetworks.com.

Copyright statements for portions of software are listed below.

PostgreSQL Copyright

PostgreSQL is Copyright © 2004-2010 by the PostgreSQL Global Development Group and is distributed under the
terms of the license of the University of California below.

Permission to use, copy, modify, and distribute this software and its documentation for any purpose, without fee, and
without a written agreement is hereby granted, provided that the above copyright notice and this paragraph and the
following two paragraphs appear in all copies.

IN NO EVENT SHALL THE UNIVERSITY OF CALIFORNIA BE LIABLE TO ANY PARTY FOR DIRECT,
INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES, INCLUDING LOST PROFITS, ARISING
OUT OF THE USE OF THIS SOFTWARE AND ITS DOCUMENTATION, EVEN IF THE UNIVERSITY OF
CALIFORNIA HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

THE UNIVERSITY OF CALIFORNIA SPECIFICALLY DISCLAIMS ANY WARRANTIES, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE. THE SOFTWARE PROVIDED HEREUNDER IS ON AN "AS-IS" BASIS, AND THE UNIVERSITY OF
CALIFORNIA HAS NO OBLIGATIONS TO PROVIDE MAINTENANCE, SUPPORT, UPDATES,
ENHANCEMENTS, OR MODIFICATIONS.

GNU LGPL

Version 2, June 1991

Copyright (C) 1991 Free Software Foundation, Inc.

51 Franklin St, Fifth Floor, Boston, MA 02110-1301, USA

Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is not allowed.

[This is the first released version of the library GPL. It is numbered 2 because it goes with version 2 of the ordinary
GPL.]

Preamble

The licenses for most software are designed to take away your freedom to share and change it. By contrast, the GNU
General Public Licenses are intended to guarantee your freedom to share and change free software--to make sure the
software is free for all its users.

This license, the Library General Public License, applies to some specially designated Free Software Foundation
software, and to any other libraries whose authors decide to use it. You can use it for your libraries, too.

When we speak of free software, we are referring to freedom, not price. Our General Public Licenses are designed to
make sure that you have the freedom to distribute copies of free software (and charge for this service if you wish), that
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you receive source code or can get it if you want it, that you can change the software or use pieces of it in new free
programs; and that you know you can do these things.

To protect your rights, we need to make restrictions that forbid anyone to deny you these rights or to ask you to
surrender the rights. These restrictions translate to certain responsibilities for you if you distribute copies of the library,
or if you modify it.

For example, if you distribute copies of the library, whether gratis or for a fee, you must give the recipients all the
rights that we gave you. You must make sure that they, too, receive or can get the source code. If you link a program
with the library, you must provide complete object files to the recipients so that they can relink them with the library,
after making changes to the library and recompiling it. And you must show them these terms so they know their rights.

Our method of protecting your rights has two steps: (1) copyright the library, and (2) offer you this license which gives
you legal permission to copy, distribute and/or modify the library.

Also, for each distributor's protection, we want to make certain that everyone understands that there is no warranty for
this free library. If the library is modified by someone else and passed on, we want its recipients to know that what
they have is not the original version, so that any problems introduced by others will not reflect on the original authors'
reputations.

Finally, any free program is threatened constantly by software patents. We wish to avoid the danger that companies
distributing free software will individually obtain patent licenses, thus in effect transforming the program into
proprietary software. To prevent this, we have made it clear that any patent must be licensed for everyone's free use or
not licensed at all.

Most GNU software, including some libraries, is covered by the ordinary GNU General Public License, which was
designed for utility programs. This license, the GNU Library General Public License, applies to certain designated
libraries. This license is quite different from the ordinary one; be sure to read it in full, and don't assume that anything
in it is the same as in the ordinary license.

The reason we have a separate public license for some libraries is that they blur the distinction we usually make
between modifying or adding to a program and simply using it. Linking a program with a library, without changing
the library, is in some sense simply using the library, and is analogous to running a utility program or application
program. However, in a textual and legal sense, the linked executable is a combined work, a derivative of the original
library, and the ordinary General Public License treats it as such.

Because of this blurred distinction, using the ordinary General Public License for libraries did not effectively promote
software sharing, because most developers did not use the libraries. We concluded that weaker conditions might
promote sharing better.

However, unrestricted linking of non-free programs would deprive the users of those programs of all benefit from the
free status of the libraries themselves. This Library General Public License is intended to permit developers of non-free
programs to use free libraries, while preserving your freedom as a user of such programs to change the free libraries that
are incorporated in them. (We have not seen how to achieve this as regards changes in header files, but we have
achieved it as regards changes in the actual functions of the Library.) The hope is that this will lead to faster
development of free libraries.

The precise terms and conditions for copying, distribution and modification follow. Pay close attention to the
difference between a "work based on the library" and a "work that uses the library". The former contains code derived
from the library, while the latter only works together with the library.

Note that it is possible for a library to be covered by the ordinary General Public License rather than by this special
one.

TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION
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0. This License Agreement applies to any software library which contains a notice placed by the copyright holder or
other authorized party saying it may be distributed under the terms of this Library General Public License (also called
"this License"). Each licensee is addressed as "you".

A "library" means a collection of software functions and/or data prepared so as to be conveniently linked with
application programs (which use some of those functions and data) to form executables.

The "Library", below, refers to any such software library or work which has been distributed under these terms. A
"work based on the Library" means either the Library or any derivative work under copyright law: that is to say, a
work containing the Library or a portion of it, either verbatim or with modifications and/or translated straightforwardly
into another language. (Hereinafter, translation is included without limitation in the term "modification".)

"Source code" for a work means the preferred form of the work for making modifications to it. For a library, complete
source code means all the source code for all modules it contains, plus any associated interface definition files, plus the
scripts used to control compilation and installation of the library.

Activities other than copying, distribution and modification are not covered by this License; they are outside its scope.
The act of running a program using the Library is not restricted, and output from such a program is covered only if its
contents constitute a work based on the Library (independent of the use of the Library in a tool for writing it). Whether
that is true depends on what the Library does and what the program that uses the Library does.

1. You may copy and distribute verbatim copies of the Library's complete source code as you receive it, in any
medium, provided that you conspicuously and appropriately publish on each copy an appropriate copyright notice and
disclaimer of warranty; keep intact all the notices that refer to this License and to the absence of any warranty; and
distribute a copy of this License along with the Library.

You may charge a fee for the physical act of transferring a copy, and you may at your option offer warranty protection
in exchange for a fee.

2. You may modify your copy or copies of the Library or any portion of it, thus forming a work based on the Library,
and copy and distribute such modifications or work under the terms of Section 1 above, provided that you also meet
all of these conditions:

a) The modified work must itself be a software library.

b) You must cause the files modified to carry prominent notices stating that you changed the files and the date of any
change.

¢) You must cause the whole of the work to be licensed at no charge to all third parties under the terms of this License.

d) If a facility in the modified Library refers to a function or a table of data to be supplied by an application program
that uses the facility, other than as an argument passed when the facility is invoked, then you must make a good faith
effort to ensure that, in the event an application does not supply such function or table, the facility still operates, and
performs whatever part of its purpose remains meaningful. (For example, a function in a library to compute square roots
has a purpose that is entirely well-defined independent of the application. Therefore, Subsection 2d requires that any
application-supplied function or table used by this function must be optional: if the application does not supply it, the
square root function must still compute square roots.)

These requirements apply to the modified work as a whole. If identifiable sections of that work are not derived from
the Library, and can be reasonably considered independent and separate works in themselves, then this License, and its
terms, do not apply to those sections when you distribute them as separate works. But when you distribute the same
sections as part of a whole which is a work based on the Library, the distribution of the whole must be on the terms of
this License, whose permissions for other licensees extend to the entire whole, and thus to each and every part
regardless of who wrote it.

Thus, it is not the intent of this section to claim rights or contest your rights to work written entirely by you; rather,
the intent is to exercise the right to control the distribution of derivative or collective works based on the Library.
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In addition, mere aggregation of another work not based on the Library with the Library (or with a work based on the
Library) on a volume of a storage or distribution medium does not bring the other work under the scope of this
License.

3. You may opt to apply the terms of the ordinary GNU General Public License instead of this License to a given copy
of the Library. To do this, you must alter all the notices that refer to this License, so that they refer to the ordinary
GNU General Public License, version 2, instead of to this License. (If a newer version than version 2 of the ordinary
GNU General Public License has appeared, then you can specify that version instead if you wish.) Do not make any
other change in these notices.

Once this change is made in a given copy, it is irreversible for that copy, so the ordinary GNU General Public License
applies to all subsequent copies and derivative works made from that copy.

This option is useful when you wish to copy part of the code of the Library into a program that is not a library.

4. You may copy and distribute the Library (or a portion or derivative of it, under Section 2) in object code or
executable form under the terms of Sections 1 and 2 above provided that you accompany it with the complete
corresponding machine-readable source code, which must be distributed under the terms of Sections 1 and 2 above on
a medium customarily used for software interchange.

If distribution of object code is made by offering access to copy from a designated place, then offering equivalent
access to copy the source code from the same place satisfies the requirement to distribute the source code, even though
third parties are not compelled to copy the source along with the object code.

5. A program that contains no derivative of any portion of the Library, but is designed to work with the Library by
being compiled or linked with it, is called a "work that uses the Library". Such a work, in isolation, is not a derivative
work of the Library, and therefore falls outside the scope of this License.

However, linking a "work that uses the Library" with the Library creates an executable that is a derivative of the
Library (because it contains portions of the Library), rather than a "work that uses the library". The executable is
therefore covered by this License. Section 6 states terms for distribution of such executables.

When a "work that uses the Library" uses material from a header file that is part of the Library, the object code for the
work may be a derivative work of the Library even though the source code is not. Whether this is true is especially
significant if the work can be linked without the Library, or if the work is itself a library. The threshold for this to be
true is not precisely defined by law.

If such an object file uses only numerical parameters, data structure layouts and accessors, and small macros and small
inline functions (ten lines or less in length), then the use of the object file is unrestricted, regardless of whether it is
legally a derivative work. (Executables containing this object code plus portions of the Library will still fall under
Section 6.)

Otherwise, if the work is a derivative of the Library, you may distribute the object code for the work under the terms of
Section 6. Any executables containing that work also fall under Section 6, whether or not they are linked directly with
the Library itself.

6. As an exception to the Sections above, you may also compile or link a "work that uses the Library" with the Library
to produce a work containing portions of the Library, and distribute that work under terms of your choice, provided
that the terms permit modification of the work for the customer's own use and reverse engineering for debugging such
modifications.

You must give prominent notice with each copy of the work that the Library is used in it and that the Library and its
use are covered by this License. You must supply a copy of this License. If the work during execution displays
copyright notices, you must include the copyright notice for the Library among them, as well as a reference directing
the user to the copy of this License. Also, you must do one of these things:

a) Accompany the work with the complete corresponding machine-readable source code for the Library including
whatever changes were used in the work (which must be distributed under Sections 1 and 2 above); and, if the work is
an executable linked with the Library, with the complete machine-readable "work that uses the Library", as object code
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and/or source code, so that the user can modify the Library and then relink to produce a modified executable
containing the modified Library. (It is understood that the user who changes the contents of definitions files in the
Library will not necessarily be able to recompile the application to use the modified definitions.)

b) Accompany the work with a written offer, valid for at least three years, to give the same user the materials specified
in Subsection 6a, above, for a charge no more than the cost of performing this distribution.

c) If distribution of the work is made by offering access to copy from a designated place, offer equivalent access to
copy the above specified materials from the same place.

d) Verify that the user has already received a copy of these materials or that you have already sent this user a copy.

For an executable, the required form of the "work that uses the Library" must include any data and utility programs
needed for reproducing the executable from it. However, as a special exception, the source code distributed need not
include anything that is normally distributed (in either source or binary form) with the major components (compiler,
kernel, and so on) of the operating system on which the executable runs, unless that component itself accompanies the
executable.

It may happen that this requirement contradicts the license restrictions of other proprietary libraries that do not
normally accompany the operating system. Such a contradiction means you cannot use both them and the Library
together in an executable that you distribute.

7. You may place library facilities that are a work based on the Library side-by-side in a single library together with
other library facilities not covered by this License, and distribute such a combined library, provided that the separate
distribution of the work based on the Library and of the other library facilities is otherwise permitted, and provided
that you do these two things:

a) Accompany the combined library with a copy of the same work based on the Library, uncombined with any other
library facilities. This must be distributed under the terms of the Sections above.

b) Give prominent notice with the combined library of the fact that part of it is a work based on the Library, and
explaining where to find the accompanying uncombined form of the same work.

8. You may not copy, modify, sublicense, link with, or distribute the Library except as expressly provided under this
License. Any attempt otherwise to copy, modify, sublicense, link with, or distribute the Library is void, and will
automatically terminate your rights under this License. However, parties who have received copies, or rights, from you
under this License will not have their licenses terminated so long as such parties remain in full compliance.

9. You are not required to accept this License, since you have not signed it. However, nothing else grants you
permission to modify or distribute the Library or its derivative works. These actions are prohibited by law if you do
not accept this License. Therefore, by modifying or distributing the Library (or any work based on the Library), you
indicate your acceptance of this License to do so, and all its terms and conditions for copying, distributing or
modifying the Library or works based on it.

10. Each time you redistribute the Library (or any work based on the Library), the recipient automatically receives a
license from the original licensor to copy, distribute, link with or modify the Library subject to these terms and
conditions. You may not impose any further restrictions on the recipients' exercise of the rights granted herein. You are
not responsible for enforcing compliance by third parties to this License.

11. If, as a consequence of a court judgment or allegation of patent infringement or for any other reason (not limited to
patent issues), conditions are imposed on you (whether by court order, agreement or otherwise) that contradict the
conditions of this License, they do not excuse you from the conditions of this License. If you cannot distribute so as to
satisfy simultaneously your obligations under this License and any other pertinent obligations, then as a consequence
you may not distribute the Library at all. For example, if a patent license would not permit royalty-free redistribution
of the Library by all those who receive copies directly or indirectly through you, then the only way you could satisfy
both it and this License would be to refrain entirely from distribution of the Library.

If any portion of this section is held invalid or unenforceable under any particular circumstance, the balance of the
section is intended to apply, and the section as a whole is intended to apply in other circumstances.
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It is not the purpose of this section to induce you to infringe any patents or other property right claims or to contest
validity of any such claims; this section has the sole purpose of protecting the integrity of the free software distribution
system which is implemented by public license practices. Many people have made generous contributions to the wide
range of software distributed through that system in reliance on consistent application of that system; it is up to the
author/donor to decide if he or she is willing to distribute software through any other system and a licensee cannot
impose that choice.

This section is intended to make thoroughly clear what is believed to be a consequence of the rest of this License.

12. If the distribution and/or use of the Library is restricted in certain countries either by patents or by copyrighted
interfaces, the original copyright holder who places the Library under this License may add an explicit geographical
distribution limitation excluding those countries, so that distribution is permitted only in or among countries not thus
excluded. In such case, this License incorporates the limitation as if written in the body of this License.

13. The Free Software Foundation may publish revised and/or new versions of the Library General Public License from
time to time. Such new versions will be similar in spirit to the present version, but may differ in detail to address new
problems or concermns.

Each version is given a distinguishing version number. If the Library specifies a version number of this License which
applies to it and "any later version", you have the option of following the terms and conditions either of that version or
of any later version published by the Free Software Foundation. If the Library does not specify a license version
number, you may choose any version ever published by the Free Software Foundation.

14. If you wish to incorporate parts of the Library into other free programs whose distribution conditions are
incompatible with these, write to the author to ask for permission. For software which is copyrighted by the Free
Software Foundation, write to the Free Software Foundation; we sometimes make exceptions for this. Our decision will
be guided by the two goals of preserving the free status of all derivatives of our free software and of promoting the
sharing and reuse of software generally.

NO WARRANTY

15. BECAUSE THE LIBRARY IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY FOR THE
LIBRARY, TO THE EXTENT PERMITTED BY APPLICABLE LAW. EXCEPT WHEN OTHERWISE STATED IN
WRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE THE LIBRARY "AS IS"
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED
TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.
THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE LIBRARY IS WITH YOU. SHOULD
THE LIBRARY PROVE DEFECTIVE, YOU ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR OR
CORRECTION.

16. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL ANY
COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY AND/OR REDISTRIBUTE THE
LIBRARY AS PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES, INCLUDING ANY GENERAL,
SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO
USE THE LIBRARY (INCLUDING BUT NOT LIMITED TO LOSS OF DATA OR DATA BEING RENDERED
INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A FAILURE OF THE LIBRARY TO
OPERATE WITH ANY OTHER SOFTWARE), EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

END OF TERMS AND CONDITIONS

Version 2, June 1991
Copyright (C) 1989, 1991 Free Software Foundation, Inc.
51 Franklin Street, Fifth Floor, Boston, MA 02110-1301, USA
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Everyone is permitted to copy and distribute verbatim copies
of this license document, but changing it is not allowed.
Preamble

The licenses for most software are designed to take away your freedom to share and change it. By contrast, the GNU
General Public License is intended to guarantee your freedom to share and change free software--to make sure the
software is free for all its users. This General Public License applies to most of the Free Software Foundation's software
and to any other program whose authors commit to using it. (Some other Free Software Foundation software is covered
by the GNU Lesser General Public License instead.) You can apply it to your programs, too.

When we speak of free software, we are referring to freedom, not price. Our General Public Licenses are designed to
make sure that you have the freedom to distribute copies of free software (and charge for this service if you wish), that
you receive source code or can get it if you want it, that you can change the software or use pieces of it in new free
programs; and that you know you can do these things.

To protect your rights, we need to make restrictions that forbid anyone to deny you these rights or to ask you to
surrender the rights. These restrictions translate to certain responsibilities for you if you distribute copies of the
software, or if you modify it.

For example, if you distribute copies of such a program, whether gratis or for a fee, you must give the recipients all the
rights that you have. You must make sure that they, too, receive or can get the source code. And you must show them
these terms so they know their rights.

We protect your rights with two steps: (1) copyright the software, and (2) offer you this license which gives you legal
permission to copy, distribute and/or modify the software.

Also, for each author's protection and ours, we want to make certain that everyone understands that there is no
warranty for this free software. If the software is modified by someone else and passed on, we want its recipients to
know that what they have is not the original, so that any problems introduced by others will not reflect on the original
authors' reputations.

Finally, any free program is threatened constantly by software patents. We wish to avoid the danger that redistributors
of a free program will individually obtain patent licenses, in effect making the program proprietary. To prevent this, we
have made it clear that any patent must be licensed for everyone's free use or not licensed at all.

The precise terms and conditions for copying, distribution and modification follow.
TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION

0. This License applies to any program or other work which contains a notice placed by the copyright holder saying it
may be distributed under the terms of this General Public License. The "Program", below, refers to any such program or
work, and a "work based on the Program" means either the Program or any derivative work under copyright law: that is
to say, a work containing the Program or a portion of it, either verbatim or with modifications and/or translated into
another language. (Hereinafter, translation is included without limitation in the term "modification".) Each licensee is
addressed as "you".

Activities other than copying, distribution and modification are not covered by this License; they are outside its scope.
The act of running the Program is not restricted, and the output from the Program is covered only if its contents
constitute a work based on the Program (independent of having been made by running the Program). Whether that is
true depends on what the Program does.

1. You may copy and distribute verbatim copies of the Program's source code as you receive it, in any medium,
provided that you conspicuously and appropriately publish on each copy an appropriate copyright notice and
disclaimer of warranty; keep intact all the notices that refer to this License and to the absence of any warranty; and
give any other recipients of the Program a copy of this License along with the Program.

You may charge a fee for the physical act of transferring a copy, and you may at your option offer warranty protection
in exchange for a fee.
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2. You may modify your copy or copies of the Program or any portion of it, thus forming a work based on the Program,
and copy and distribute such modifications or work under the terms of Section 1 above, provided that you also meet
all of these conditions:

a) You must cause the modified files to carry prominent notices stating that you changed the files and the date of any
change.

b) You must cause any work that you distribute or publish, that in whole or in part contains or is derived from the
Program or any part thereof, to be licensed as a whole at no charge to all third parties under the terms of this License.

¢) If the modified program normally reads commands interactively when run, you must cause it, when started running
for such interactive use in the most ordinary way, to print or display an announcement including an appropriate
copyright notice and a notice that there is no warranty (or else, saying that you provide a warranty) and that users may
redistribute the program under these conditions, and telling the user how to view a copy of this License. (Exception: if
the Program itself is interactive but does not normally print such an announcement, your work based on the Program is
not required to print an announcement.)

These requirements apply to the modified work as a whole. If identifiable sections of that work are not derived from
the Program, and can be reasonably considered independent and separate works in themselves, then this License, and
its terms, do not apply to those sections when you distribute them as separate works. But when you distribute the same
sections as part of a whole which is a work based on the Program, the distribution of the whole must be on the terms
of this License, whose permissions for other licensees extend to the entire whole, and thus to each and every part
regardless of who wrote it.

Thus, it is not the intent of this section to claim rights or contest your rights to work written entirely by you; rather,
the intent is to exercise the right to control the distribution of derivative or collective works based on the Program.

In addition, mere aggregation of another work not based on the Program with the Program (or with a work based on
the Program) on a volume of a storage or distribution medium does not bring the other work under the scope of this
License.

3. You may copy and distribute the Program (or a work based on it, under Section 2) in object code or executable form
under the terms of Sections 1 and 2 above provided that you also do one of the following:

a) Accompany it with the complete corresponding machine-readable source code, which must be distributed under the
terms of Sections 1 and 2 above on a medium customarily used for software interchange; or,

b) Accompany it with a written offer, valid for at least three years, to give any third party, for a charge no more than
your cost of physically performing source distribution, a complete machine-readable copy of the corresponding source
code, to be distributed under the terms of Sections 1 and 2 above on a medium customarily used for software
interchange; or,

¢) Accompany it with the information you received as to the offer to distribute corresponding source code. (This
alternative is allowed only for noncommercial distribution and only if you received the program in object code or
executable form with such an offer, in accord with Subsection b above.)

The source code for a work means the preferred form of the work for making modifications to it. For an executable
work, complete source code means all the source code for all modules it contains, plus any associated interface
definition files, plus the scripts used to control compilation and installation of the executable. However, as a special
exception, the source code distributed need not include anything that is normally distributed (in either source or binary
form) with the major components (compiler, kernel, and so on) of the operating system on which the executable runs,
unless that component itself accompanies the executable.

If distribution of executable or object code is made by offering access to copy from a designated place, then offering
equivalent access to copy the source code from the same place counts as distribution of the source code, even though
third parties are not compelled to copy the source along with the object code.

4. You may not copy, modify, sublicense, or distribute the Program except as expressly provided under this License.
Any attempt otherwise to copy, modify, sublicense or distribute the Program is void, and will automatically terminate
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your rights under this License. However, parties who have received copies, or rights, from you under this License will
not have their licenses terminated so long as such parties remain in full compliance.

5. You are not required to accept this License, since you have not signed it. However, nothing else grants you
permission to modify or distribute the Program or its derivative works. These actions are prohibited by law if you do
not accept this License. Therefore, by modifying or distributing the Program (or any work based on the Program), you
indicate your acceptance of this License to do so, and all its terms and conditions for copying, distributing or
modifying the Program or works based on it.

6. Each time you redistribute the Program (or any work based on the Program), the recipient automatically receives a
license from the original licensor to copy, distribute or modify the Program subject to these terms and conditions. You
may not impose any further restrictions on the recipients' exercise of the rights granted herein. You are not responsible
for enforcing compliance by third parties to this License.

7. If, as a consequence of a court judgment or allegation of patent infringement or for any other reason (not limited to
patent issues), conditions are imposed on you (whether by court order, agreement or otherwise) that contradict the
conditions of this License, they do not excuse you from the conditions of this License. If you cannot distribute so as to
satisfy simultaneously your obligations under this License and any other pertinent obligations, then as a consequence
you may not distribute the Program at all. For example, if a patent license would not permit royalty-free redistribution
of the Program by all those who receive copies directly or indirectly through you, then the only way you could satisfy
both it and this License would be to refrain entirely from distribution of the Program.

If any portion of this section is held invalid or unenforceable under any particular circumstance, the balance of the
section is intended to apply and the section as a whole is intended to apply in other circumstances.

It is not the purpose of this section to induce you to infringe any patents or other property right claims or to contest
validity of any such claims; this section has the sole purpose of protecting the integrity of the free software distribution
system, which is implemented by public license practices. Many people have made generous contributions to the wide
range of software distributed through that system in reliance on consistent application of that system; it is up to the
author/donor to decide if he or she is willing to distribute software through any other system and a licensee cannot
impose that choice.

This section is intended to make thoroughly clear what is believed to be a consequence of the rest of this License.

8. If the distribution and/or use of the Program is restricted in certain countries either by patents or by copyrighted
interfaces, the original copyright holder who places the Program under this License may add an explicit geographical
distribution limitation excluding those countries, so that distribution is permitted only in or among countries not thus
excluded. In such case, this License incorporates the limitation as if written in the body of this License.

9. The Free Software Foundation may publish revised and/or new versions of the General Public License from time to
time. Such new versions will be similar in spirit to the present version, but may differ in detail to address new
problems or concerns.

Each version is given a distinguishing version number. If the Program specifies a version number of this License which
applies to it and "any later version", you have the option of following the terms and conditions either of that version or
of any later version published by the Free Software Foundation. If the Program does not specify a version number of
this License, you may choose any version ever published by the Free Software Foundation.

10. If you wish to incorporate parts of the Program into other free programs whose distribution conditions are different,
write to the author to ask for permission. For software which is copyrighted by the Free Software Foundation, write to
the Free Software Foundation; we sometimes make exceptions for this. Our decision will be guided by the two goals of
preserving the free status of all derivatives of our free software and of promoting the sharing and reuse of software
generally.

NO WARRANTY

11. BECAUSE THE PROGRAM IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY FOR THE
PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE LAW. EXCEPT WHEN OTHERWISE STATED IN
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WRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE THE PROGRAM "AS IS"
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED
TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.
THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE PROGRAM IS WITH YOU. SHOULD
THE PROGRAM PROVE DEFECTIVE, YOU ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR
OR CORRECTION.

12. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL ANY
COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY AND/OR REDISTRIBUTE THE
PROGRAM AS PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES, INCLUDING ANY GENERAL,
SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO
USE THE PROGRAM (INCLUDING BUT NOT LIMITED TO LOSS OF DATA OR DATA BEING RENDERED
INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A FAILURE OF THE PROGRAM TO
OPERATE WITH ANY OTHER PROGRAMS), EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

END OF TERMS AND CONDITIONS

Copyright (c) 2004, Jan Kneschke, incremental
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the
following conditions are met:

- Redistributions of source code must retain the above copyright notice, this list of conditions and the following
disclaimer.

- Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following
disclaimer in the documentation and/or other materials provided with the distribution.

- Neither the name of the 'incremental' nor the names of its contributors may be used to endorse or promote products
derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT
SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED
TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY
WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Version 2.0, January 2004

http://www.apache.org/licenses/

TERMS AND CONDITIONS FOR USE, REPRODUCTION, AND DISTRIBUTION
1. Definitions.

"License" shall mean the terms and conditions for use, reproduction, and distribution as defined by Sections 1 through
9 of this document.

ClearPass Policy Manager 6.1 | User Guide



"Licensor" shall mean the copyright owner or entity authorized by the copyright owner that is granting the License.

"Legal Entity" shall mean the union of the acting entity and all other entities that control, are controlled by, or are
under common control with that entity. For the purposes of this definition, "control" means (i) the power, direct or
indirect, to cause the direction or management of such entity, whether by contract or otherwise, or (ii) ownership of
fifty percent (50%) or more of the outstanding shares, or (iii) beneficial ownership of such entity.

"You" (or "Your") shall mean an individual or Legal Entity exercising permissions granted by this License.

"Source" form shall mean the preferred form for making modifications, including but not limited to software source
code, documentation source, and configuration files.

"Object" form shall mean any form resulting from mechanical transformation or translation of a Source form, including
but not limited to compiled object code, generated documentation, and conversions to other media types.

"Work" shall mean the work of authorship, whether in Source or Object form, made available under the License, as
indicated by a copyright notice that is included in or attached to the work (an example is provided in the Appendix
below).

"Derivative Works" shall mean any work, whether in Source or Object form, that is based on (or derived from) the
Work and for which the editorial revisions, annotations, elaborations, or other modifications represent, as a whole, an
original work of authorship. For the purposes of this License, Derivative Works shall not include works that remain
separable from, or merely link (or bind by name) to the interfaces of, the Work and Derivative Works thereof.

"Contribution" shall mean any work of authorship, including the original version of the Work and any modifications or
additions to that Work or Derivative Works thereof, that is intentionally submitted to Licensor for inclusion in the
Work by the copyright owner or by an individual or Legal Entity authorized to submit on behalf of the copyright
owner. For the purposes of this definition, "submitted" means any form of electronic, verbal, or written communication
sent to the Licensor or its representatives, including but not limited to communication on electronic mailing lists,
source code control systems, and issue tracking systems that are managed by, or on behalf of, the Licensor for the
purpose of discussing and improving the Work, but excluding communication that is conspicuously marked or
otherwise designated in writing by the copyright owner as "Not a Contribution."

"Contributor" shall mean Licensor and any individual or Legal Entity on behalf of whom a Contribution has been
received by Licensor and subsequently incorporated within the Work.

2. Grant of Copyright License. Subject to the terms and conditions of this License, each Contributor hereby grants to
You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable copyright license to reproduce, prepare
Derivative Works of, publicly display, publicly perform, sublicense, and distribute the Work and such Derivative
Works in Source or Object form.

3. Grant of Patent License. Subject to the terms and conditions of this License, each Contributor hereby grants to You
a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable (except as stated in this section) patent
license to make, have made, use, offer to sell, sell, import, and otherwise transfer the Work, where such license applies
only to those patent claims licensable by such Contributor that are necessarily infringed by their Contribution(s) alone
or by combination of their Contribution(s) with the Work to which such Contribution(s) was submitted. If You
institute patent litigation against any entity (including a cross-claim or counterclaim in a lawsuit) alleging that the
Work or a Contribution incorporated within the Work constitutes direct or contributory patent infringement, then any
patent licenses granted to You under this License for that Work shall terminate as of the date such litigation is filed.

4. Redistribution. You may reproduce and distribute copies of the Work or Derivative Works thereof in any medium,
with or without modifications, and in Source or Object form, provided that You meet the following conditions:

1. You must give any other recipients of the Work or Derivative Works a copy of this License; and

2. You must cause any modified files to carry prominent notices stating that You changed the files; and
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3. You must retain, in the Source form of any Derivative Works that You distribute, all copyright, patent, trademark,
and attribution notices from the Source form of the Work, excluding those notices that do not pertain to any part of the
Derivative Works; and

4. If the Work includes a "NOTICE" text file as part of its distribution, then any Derivative Works that You distribute
must include a readable copy of the attribution notices contained within such NOTICE file, excluding those notices
that do not pertain to any part of the Derivative Works, in at least one of the following places: within a NOTICE text
file distributed as part of the Derivative Works; within the Source form or documentation, if provided along with the
Derivative Works; or, within a display generated by the Derivative Works, if and wherever such third-party notices
normally appear. The contents of the NOTICE file are for informational purposes only and do not modify the License.
You may add Your own attribution notices within Derivative Works that You distribute, alongside or as an addendum
to the NOTICE text from the Work, provided that such additional attribution notices cannot be construed as
modifying the License.

You may add Your own copyright statement to Your modifications and may provide additional or different license
terms and conditions for use, reproduction, or distribution of Your modifications, or for any such Derivative Works as a
whole, provided Your use, reproduction, and distribution of the Work otherwise complies with the conditions stated in
this License.

5. Submission of Contributions. Unless You explicitly state otherwise, any Contribution intentionally submitted for
inclusion in the Work by You to the Licensor shall be under the terms and conditions of this License, without any
additional terms or conditions. Notwithstanding the above, nothing herein shall supersede or modify the terms of any
separate license agreement you may have executed with Licensor regarding such Contributions.

6. Trademarks. This License does not grant permission to use the trade names, trademarks, service marks, or product
names of the Licensor, except as required for reasonable and customary use in describing the origin of the Work and
reproducing the content of the NOTICE file.

7. Disclaimer of Warranty. Unless required by applicable law or agreed to in writing, Licensor provides the Work (and
each Contributor provides its Contributions) on an "AS IS" BASIS, WITHOUT WARRANTIES OR CONDITIONS OF
ANY KIND, either express or implied, including, without limitation, any warranties or conditions of TITLE, NON-
INFRINGEMENT, MERCHANTABILITY, or FITNESS FOR A PARTICULAR PURPOSE. You are solely responsible
for determining the appropriateness of using or redistributing the Work and assume any risks associated with Your
exercise of permissions under this License.

8. Limitation of Liability. In no event and under no legal theory, whether in tort (including negligence), contract, or
otherwise, unless required by applicable law (such as deliberate and grossly negligent acts) or agreed to in writing,
shall any Contributor be liable to You for damages, including any direct, indirect, special, incidental, or consequential
damages of any character arising as a result of this License or out of the use or inability to use the Work (including but
not limited to damages for loss of goodwill, work stoppage, computer failure or malfunction, or any and all other
commercial damages or losses), even if such Contributor has been advised of the possibility of such damages.

9. Accepting Warranty or Additional Liability. While redistributing the Work or Derivative Works thereof, You may
choose to offer, and charge a fee for, acceptance of support, warranty, indemnity, or other liability obligations and/or
rights consistent with this License. However, in accepting such obligations, You may act only on Your own behalf
and on Your sole responsibility, not on behalf of any other Contributor, and only if You agree to indemnify, defend,
and hold each Contributor harmless for any liability incurred by, or claims asserted against, such Contributor by reason
of your accepting any such warranty or additional liability.

END OF TERMS AND CONDITIONS

/¥

* Copyright (c) 1998-2007 The OpenSSL Project. All rights reserved.
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* Redistribution and use in source and binary forms, with or without

* modification, are permitted provided that the following conditions

* are met:

*

* 1. Redistributions of source code must retain the above copyright

* notice, this list of conditions and the following disclaimer.

*

* 2. Redistributions in binary form must reproduce the above copyright

* notice, this list of conditions and the following disclaimer in

* the documentation and/or other materials provided with the

* distribution.

*

* 3. All advertising materials mentioning features or use of this

* software must display the following acknowledgment:

* "This product includes software developed by the OpenSSL Project

* for use in the OpenSSL Toolkit. (http://www.openssl.org/)"

*

* 4, The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to

* endorse or promote products derived from this software without

* prior written permission. For written permission, please contact

* openssl-core@openssl.org.

*

* 5. Products derived from this software may not be called "OpenSSL"

* nor may "OpenSSL" appear in their names without prior written

* permission of the OpenSSL Project.

*

* 6. Redistributions of any form whatsoever must retain the following

* acknowledgment:

* "This product includes software developed by the OpenSSL Project

* for use in the OpenSSL Toolkit (http://www.openssl.org/)"

*

* THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT "AS IS" AND ANY
* EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
* IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
* PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE OpenSSL PROJECT OR
* ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
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* SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT
* NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;

* LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)

* HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,
* STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
* ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED

* OF THE POSSIBILITY OF SUCH DAMAGE.

*

*

* This product includes cryptographic software written by Eric Young

* (eay@cryptsoft.com). This product includes software written by Tim

* Hudson (tjh@cryptsoft.com).

*

*/

Original SSLeay License

/* Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com)

* All rights reserved.

*

* This package is an SSL implementation written

* by Eric Young (eay@cryptsoft.com).

* The implementation was written so as to conform with Netscapes SSL.
*

* This library is free for commercial and non-commercial use as long as
* the following conditions are aheared to. The following conditions

* apply to all code found in this distribution, be it the RC4, RSA,

* Thash, DES, etc., code; not just the SSL code. The SSL documentation
* included with this distribution is covered by the same copyright terms
* except that the holder is Tim Hudson (tjh@cryptsoft.com).

*

* Copyright remains Eric Young's, and as such any Copyright notices in
* the code are not to be removed.

* If this package is used in a product, Eric Young should be given attribution
* as the author of the parts of the library used.

* This can be in the form of a textual message at program startup or

* in documentation (online or textual) provided with the package.

*

ClearPass Policy Manager 6.1 | User Guide



* Redistribution and use in source and binary forms, with or without

* modification, are permitted provided that the following conditions

* are met:

* 1. Redistributions of source code must retain the copyright

* notice, this list of conditions and the following disclaimer.

* 2. Redistributions in binary form must reproduce the above copyright

* notice, this list of conditions and the following disclaimer in the

* documentation and/or other materials provided with the distribution.

* 3. All advertising materials mentioning features or use of this software

* must display the following acknowledgement:

* "This product includes cryptographic software written by

* Eric Young (eay@cryptsoft.com)"

* The word 'cryptographic' can be left out if the rouines from the library

* being used are not cryptographic related :-).

* 4. If you include any Windows specific code (or a derivative thereof) from

* the apps directory (application code) you must include an acknowledgement:

* "This product includes software written by Tim Hudson (tjh@cryptsoft.com"

*

* THIS SOFTWARE IS PROVIDED BY ERIC YOUNG "AS IS" AND

* ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE

* IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
* ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE

* FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
* DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS
* OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)

* HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT
* LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY
* OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF

* SUCH DAMAGE.

*

* The licence and distribution terms for any publically available version or

* derivative of this code cannot be changed. i.e. this code cannot simply be

* copied and put under another distribution licence

* [including the GNU Public Licence.] */

The OpenLDAP Public License
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Version 2.8, 17 August 2003

Redistribution and use of this software and associated documentation ("Software"), with or without modification, are
permitted provided that the following conditions are met:

1. Redistributions in source form must retain copyright statements and notices,

2. Redistributions in binary form must reproduce applicable copyright statements and notices, this list of conditions,
and the following disclaimer in the documentation and/or other materials provided with the distribution, and

3. Redistributions must contain a verbatim copy of this document. The OpenLDAP Foundation may revise this license
from time to time. Each revision is distinguished by a version number. You may use this Software under terms of this
license revision or under the terms of any subsequent revision of the license.

THIS SOFTWARE IS PROVIDED BY THE OPENLDAP FOUNDATION AND ITS CONTRIBUTORS "AS IS" AND
ANY EXPRESSED OR IMPLIED WARRANTIES,INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED.
IN NO EVENT SHALL THE OPENLDAP FOUNDATION, ITS CONTRIBUTORS, OR THE AUTHOR(S) OR
OWNER(S) OF THE SOFTWARE BE LIABLE FOR ANY DIRECT, INDIRECT,INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY,
OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

The names of the authors and copyright holders must not be used in advertising or otherwise to promote the sale, use
or other dealing in this Software without specific, written prior permission. Title to copyright in this Software shall at
all times remain with copyright holders.

OpenLDAP is a registered trademark of the OpenLDAP Foundation. Copyright 1999-2003 The OpenLDAP
Foundation, Redwood City, California, USA. All Rights Reserved. Permission to copy and distribute verbatim copies
of this document is granted.

Portions created by gSOAP are Copyright (C) 2001-2004 Robert A. van Engelen, Genivia inc. All Rights Reserved.

THE SOFTWARE IN THIS PRODUCT WAS IN PART PROVIDED BY GENIVIA INC AND ANY EXPRESS OR
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT
SHALL THE AUTHOR BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE
GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE."
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